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1. OVERVIEW 
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Beginner, Intermediate , and Advanced workspaces , the DOS Programs 
screen , and a note about document templates . 

GETTING TO KNOW GEOWORKS PRO 

2. GETTING STARTED 
Installing your softwa re and a step-by-step tutorial. 

3. BASIC TOOLS AND SKILLS 

T s 
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fro m using your mo use to printing yo ur docume nts . 

A DETAILED REFERENCE 

4. THE APPLIANCES 
Six easy-to -use tools, including Note p ad (a s imple line edito r) Ca lcula to r 
(exactl y th at) Address Book (a place to keep na mes and addresses) Pl anne r 
(a way to plan your time) Solita ire (the ca rd ga me) Banne r (fo r making real 
lo ng signs). 

S. THE CALCULATOR 
An o n-screen ca lcul ato r w ith a few mo re features than its a ppliance cou sin. 

6. THE DOS PROGRAMS SCREEN 
A place to launch regular DOS programs at the click of a button. We 've also 
included icons for many p o pular programs so you can crea te butto ns for 
your fav orites. 

7. EXTRAS 
Some "freebie " applications, including one th at lets you take pictures of 
GeoWo rks Pro scre ens, another that le ts yo u convert Nimbus fonts to 
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8. THE FILE CABINET 
All about using the File Cabinet, the centerpiece of the Intermediate 
Workspace. Creating , coping, moving , and renaming files and directories 
without using a single cryptic DOS command. Opening directories, and the 
files in them. 

9. GEOCOMM 
Using GeoComm and your modem to communicate with other computers 
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10. GEODEX 
Adding names and addresses to your GeoDex address books. Searching for 
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Linking GeoDex to GeoPlanner. 

11. GEODRAW 
Using GeoDraw: a powerful and easy-to-use drawing application that lets 
you produce full-color graphics with integrated text. 

12. GEOMANAGER 
Using GeoManager in the Advanced Workspace to manage your files and 
directories-with no mysterious DOS commands. Using the built-in directory 
tree. Starting applications, opening documents , and running DOS programs. 

13. GEOPLANNER 
Planning your days with GeoPlanner-a calendar, planner, and alarm clock 
rolled into one. 

14. GEOWRITE 
How GeoWrite can help you create professional looking documents. Using 
different fonts and styles, creating tables , headers and footers, multi-column 
documents , and adding graphics. Importing and exporting text files . Adding 
color. Using the built-in spelling checker. 

15. THE NOTEPAD 
A simple text editor for working with DOS text files (files without 
formatting). 

16. PREFERENCES 
Using the Preferences application to tell GeoWorks Pro when you add or 
change hardware on your system. Tailoring GeoWorks Pro to work the way 
you do. 



17. THE QUATTRO PRO VIEWER 
Using the Viewer to look at spreadsheets and charts in a GeoWorks Pro 
window. Copying Quattro Pro spreadsheets and charts to GeoWrite , 
GeoDraw, and the Scrapbook. Having the Viewer launch Quattro Pro SE and 
open a spreadsheet for you. 

18. THE SCRAPBOOK 
Storing images and text you use often as scraps in a scrapbook. Importing 
graphics from other DOS programs. Using the Scrapbook to scale graphics. 

19. SOLITAIRE 
Taking a break from your work. 

20. TETRIS 
Taking a longer break . 

21. GEOWORKS PRO IN THE REAL WORLD 
Using GeoWorks Pro with a network. Task switching with MS-DOS 5.0, and 
DR DOS 6.0 TaskMax. Running under Windows 3.0 

THE APPENDIX AND INDEX 

A. SPECIAL CHARACTERS 
How to type all sorts characters you never had on your typewriter. 
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0 V E R V E W 

Welcome! We think you're going to enjoy 

using GeoWorks Pro. This chapter gives 

you a general idea of W"hat you can do 

vvith GeoWorks Pro and explains hoW" to 

get the most out of this manual. If you 

haven't yet installed GeoWorks Pro, you 

should do so noW" by f ollovving the 

instructions in the "Getting Started" section 

of this book. 



GEOWORKS PRO: A NEW WORK 
ENVIRONMENT 

Computers . They're supposed to 
make life easier. But the time it takes 
to learn a new program-all the com
mands you must remember, all the trial 
and error you must go through-these 
things can take the fun out of using a 
computer. 

So we created GeoWorks Pro , which 
includes both an exciting new envi
ronment to work in and a family of 
applications (including GeoWrite and 
GeoDraw) that make full use of its 
power. GeoWorks Pro is designed to 
give you powerful tools for doing 
your work , and to bring a little fun 
back into it , too . 

GeoWorks Pro is easy to use because 
it 's visual and intuitive. Instead of 
using hard-to-remember commands , 
the screen shows you pictures of 
things, like buttons and icons. Every
thing you can do in GeoWorks Pro is 
represented somewhere on the screen, 
whether it 's in a menu, in a list , or on 
a button. You spend less time trying to 
remember how to do things and more 
time actually doing them. Simply move 
an arrow-shaped pointer around on the 
screen with your mouse until it points 
at a visual representation of what you 
want to do , then press and release the 
mouse button. 

With the graphic abilities of GeoWorks 
Pro, things appear on the screen as they 
will on the printer. Whether it 's a busi
ness letter you 're writing or some art
work you're creating, what you see is 
what you get (WYSIWYG). And if you 
have a Postscript-compatible color print
er, you can print in color, too. 

These are just a few of the reasons 
that GeoWorks Pro is easy and fun to 
use. Go ahead and explore ... Find a 
few reasons of your own. 
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USING THIS MANUAL 

LEARNING THE BASICS If you haven 't yet 
installed the software, flip to the "Get
ting Started" chapter to see how. There 
you 'll also find a step-by-step tutorial 
that touches on just about every aspect 
of GeoWorks Pro-from installing the 
software to creating your own document. 
However, any basic concepts that aren 't 
covered in the "Getting Started" chapter 
(and even some things that are) you 'll 
find in "Basic Tools and Skills"-a chap
ter geared toward those who aren 't nec
essarily new to computers, but may be 
new to graphical operating environments 
like GeoWorks Pro. 

DEALING WITH THE DETAILS Once you're com
fortable with the basics , if you ever have 
a specific question about an application 
(such as how to make a table in 
GeoWrite) turn to the Reference section . 
Whereas the Getting Started chapter is 
designed to be read from front to back, 
the "Reference" section is designed to 
be read more like an encyclopedia-it 's 
meant to be skimmed for specific topics. 

Pick a topic your interested in-say, 
making a table in GeoWrite-and turn 
right to the section about creating 
tables in the "GeoWrite " chapter. 
There , as you would expect, you 'll 
find important details about making 
tables . Keep in mind , though, that you 
won 't find instructions on how to 
select text or drag an item (things you 
also need to know to make a table)
these are basic skills that the "Refer
ence" section assumes that you have 
already learned from the "Getting 
Started" and "Basic Tools and Skills" 
chapters. 



EXPLORING When you do have the basics 
down , you 're ready to get to work using 
GeoWorks Pro for your own projects. 
Don 't worry if there are still things you 
don 't understand-the best way to learn 
about GeoWorks Pro is to try it. As you 
try things out, and become more com
fortable experimenting, GeoWorks Pro 
becomes easier to use. And , if you're 
worried about accidentally damaging 
something important , remember this: 
GeoWorks Pro asks you for permission 
before it updates or removes anything 
important . 

ABOUT THE SPECIAL SYMBOLS USED IN THIS BOOK 
The special symbols in this manual
like 0, 0 , and (rJ -represent keys 
on your keyboard . The may not match 
the keys on your keyboard. For exam
ple , not all "Control " keys are marked 
@fill ; sometimes they're marked with 
the full word "Control " instead . Also , 
the I Backspace I key appears as a EJ key 
on some keyboards. You get the idea. 
Refer to your computer owner 's manual 

The Welcome screen, 
your gateway to the 
four different areas of 
GeoWorks Pro. Click 
one of the four buttons 
to enter the area af 
your choice. Or click 
Exit to shut down 
GeoWorks Pro and 
return to DOS. 

~ 
~ 

Beginner 
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for more information about your partic
ular keyboard and its layout. 

When you see a group of keys sepa
rated by a + sign, it means to hold 
down the first set of keys while press
ing the second. For example, if you see 
I Shift I @fill + 0 , it means to hold down 
both the I Shift I and @fill keys while 
pressing the 0 key. 

THE WELCOME SCREEN 

When you first start GeoWorks Pro , 
the Welcome screen greets you. The 
Welcome screen provides a friendly 
and simple starting place . Everything is 
large and clearly labeled . This is your 
gateway to GeoWorks Pro. It 's from 
here that you can enter any of the 
three workspaces (Beginner, Intermedi
ate, or Advanced) and go to th e DOS 
Programs screen-a place where you 
can run your regular DOS programs. 

Welcome 

OVERVIEW 



ENTERING AND EXITING THE WORKSPACES When 
you click one of the buttons on the 
Welcome screen (see "Basic Tools and 
Skills" for more about clicking buttons) 
you immediately enter one of the three 
workspaces, or the DOS Programs 
screen. (Once in one of the workspaces 

OVERVIEW 

or the DOS programs 
screen, you can 
always return to the 
Welcome screen by 
pressing the m key 
on your keyboard.) 

The Beginner Workspace is 
where you'll find the 
GeoWorks Pro appliances. 
These simple programs make it 
easy for people who've never 
used computers before to get 
up to speed. All you have to 
know how to do is point, click, 
and type. Simple. 

Address: 
1224 Mandolin Lane 
Sweetwater, CA 99001 I 
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THE BEGINNER WORKSPACE 

Anybody in your household who 
can use a familiar home appliance-a 
washing machine, phone answering 
machine, or a blender-can also use 
the GeoWorks Pro appliances in the 
Beginner Workspace . These appliances 
are designed to be especially easy to 
learn. All you have to know is how to 
point and click. 

The Beginner Workspace comes with 
six appliances: 

• An Address Book for looking up 
names and addresses 

• A Planner for showing important 
upcoming events 

•A Calculator for quick calculations 
•A Notepad for making notes 
•A Solitaire game that 's just like the 

game you play on the living room rug 
•A Banner-maker for creating long 

banners 
For more information, turn to the 6 Appliances" chapter in 
the "Reference" section of this manual. 



THE INTERMEDIATE WORKSPACE 

Like its name implies , the Inte rme 
di a te Wo rkspace fit s conce ptuall y 
be tween the ultra-s imple goof-proof 
Beg inne r Wo rksp ace , and the high
p owe red Advanced Wo rksp ace . Like 
the la tte r wo rksp ace , you ca n use a ll 
o f th e GeoWo rks a pplica tio ns , but yo u 
use th e m in a s imple r way- each 
a ppli ca tio n fill s the sc reen comple te ly, 
and DO S fil e manage me nt is grea tly 
s implified . 

Like yo u d o w ith the o the r areas of 
GeoWorks Pro , yo u e nte r th e Inte rme
diate Workspace via the We lcome 
screen . The File Ca bine t docume nt 
manage r is the first thing yo u see . 
From the re yo u ca n o pe n d ocume nts
yo urs and ours- as well as manage 
yo ur fil es, direc to ries , and disks . 

Yo u d o most o f yo ur wo rk in th e 
Inte rme di ate Workspace us ing ready
mad e doc ume nts ca lled te mpl a tes. 

C&{HARO DRIUE] \GEOWORKS\llOCUMEKT - Selected. 1 Item (2.352 bvtes) of 25. 4,769,792 bUtes free. 
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"" Tetris 
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Te mplates make your work easy: the 
formatting in the m has already been 
done for you . So to create a great look
ing docume nt all you have to d o is 
open a template and add your own 
text-and even graphics, if you 'd like . 

Best of a ll , whenever you leave the 
Inte rmediate Workspace , Ge oWorks Pro 
reme mbe rs exactly wha t you w e re 
do ing , so you can come back to the 
wo rkspace and have all your work 
wa iting for you , just as you left it . 
For more information, turn to the uFile Cabinet" chapter in 
the "Reference" section of this manual. 

The File Cabinet, the 
center of the Intermediate 
Workspace. The icons in 
the middle represent files 
and directories on your 
disk. Select a file and 
click one of the buttons at 
the top or bottom to do 
something to the file (like 
move or copy ii). 

OVERVIEW 



THE ADVANCED WORKSPACE 

Whereas the Intermediate Workspace 
boils file management down to a few 
basic tasks, limits what DOS directories 
you can get into , and only lets you 
look at one application window at a 
time, the Advanced workspace sets you 
free. There, you can resize windows 
and strew them around the screen as 
you see fit. That way, on the screen, 
you can have a GeoWrite document 
and right next to it a GeoDraw docu
ment. 

Central to the Advanced Workspace 
is GeoManager, File Cabinet 's "big 
brother. " Like the File Cabinet, it repre
sents your files as icons within the 
window. You also use these icons to 
open documents and manage your files 
and directories. But that 's where the 

OVERVIEW 1.6 

similarity stops. GeoManager offers a 
wealth of additional features-you can 
look at many directories at once, view 
your disk structure as a tree, and view 
any directory on any disk that your 
computer has access to. 

And, like the Intermediate 
Workspace, you can stop working at 
any time-you don't need to finish 
what you are doing before you shut 
down your computer and go home . 
Everything in the Advanced Workspace 
stays exactly as you left it, ready for 
you when you start working again, no 
matter how long you are gone, and no 
matter what you do in the meantime 
(you can even turn off your computer). 
Nothing is ever lost , misplaced, or 
rearranged. 
For more information, turn to the "GeoManager" chapter in 
the "Reference" section of this manual. 

A typical picture of the 
Advanced Workspace, which
unlike the Intermediate 
Workspace-can have 
different applications sharing 
the screen at the same time. 
Here, both GeoDraw and 
GeoWrite are open, making it 
simple to transfer artwork 
from the former to the latter. 



THE DOS PROGRAMS SCREEN 

The DOS Programs screen offers a 
quick way to run DOS programs and 
batch files at the press of a button. Cre
ate a button for each DOS program and 
batch file you use , giving each button its 
own picture and title. Then simply click 
the button to shut down GeoWorks Pro 
and run the corresponding DOS program. 

At first this screen has only one 
button , labeled "Enter DOS. " Click it to 
temporarily shut down GeoWorks Pro 
and enter DOS , where you can invoke 
normal DOS commands. When you 're 
finished in DOS , type "exit" and press 
I Enter ) to return to GeoWorks Pro and 
the DOS Programs screen . 

~ DOS Programs 
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DOCUMENT TEMPLATES 

In your Document directory , you 'll 
find folders containing handy tem
plates-ready-made documents that 
can save you a lot of time because all 
the layout work is already done . For 
instance , if you plan to create a 
newsletter, open the NEWSL TTR folder 
and one of the template documents 

you find there. When in 
the document, select 
the preformatted text 
and replace it with your 
own. To add a quick 
graphic , look through 

the scrapbooks in the CLIPART folder 
(also in the DOCUMENT directory) for 
ready-to-use clip art. 

The DOS Programs screen. It comes 
standard with only one button-the 
Enter DOS button at the upper left. The 
other buttons were added later. Clicking 
them shuts down GeoWorks Pro and 
runs the associated DOS program (or 
batch file). 

OVERVIEW 
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GETTING S T A R T E D 

We'd like to introduce you to 

GeoWorks Pro, show- you how- to 

use it right aw-ay to do simple tasks, 

and give you the basic skills you can build 

on later. This chapter w-orks to get you up 

and running w-ith GeoWorks Pro fast

telling you how- to install the sofrtvare on 

your computer, how- to start it once it's 

installed, and how- to do some common 

things with key applications. So sit back 

and prepare to be pleasantly 

surprised at how friendly your 

computer's become! 



INSTALLING GEOWORKS PRO 

Before you can use GeoWorks Pro you must install it on your hard disk. With our 
automated Setup utility, it 's easy. The Setup utility takes you through all the installa
tion steps and even starts GeoWorks Pro for you automatically when finished. 

When you finish installing the software, you should take a moment to fill out 
and mail in the registration card, packed separately in the box. This will make you 
a registered owner. We 'll keep you informed about new versions of GeoWorks Pro 
and other new products. (Better yet, we usually give special discounts to registered 
owners ordering software upgrades.) 
0 Start your computer in the normal manner (see the DOS reference manual that 
came with your computer for more information about using DOS). 
8 Place the disk labeled "Disk 1" in the proper drive (usually drive A, the floppy 
disk drive-or the top drive, if you've got two). 
8 At the DOS prompt, type a: setup (orb: setup if you 've placed the disk in 
the second floppy drive) and press I Return J. The Setup program explains every
thing else you need to do. 

You 'll need to use your mouse to complete the installation. If you've never 
used a mouse before, turn to page 2.5 ("Using the Mouse") for some simple 
instructions. 

If for any reason the installation did not go smoothly and successfully, don 't 
despair. At the dos prompt, type c:\geoworks\geohelp and press !Return). This acti
vates a special help program that will help you to successfully install GeoWorks 
Pro. Just follow the directions that appear on the screen . 

GETTING STARTED 2.2 



STARTING GEOWORKS PRO 

The Setup utility auto matica lly s tarts GeoWo rks Pro fo r you , so yo u won 't need 
to fo llow these ste ps until you run GeoWo rks Pro th e secon d tim e. During insta l
la tio n you 're asked if you would like to b e abl e to start GeoWo rks Pro n o matte r 
w h at DOS direc to ry yo u 're in ; if you answer yes, then ski p s tra ig ht to ste p 3. 
0 Switch to the disk drive w h e re you in sta lled GeoWo rks Pro. Normally, this is 
drive C, unless you changed this during install a tio n . Typ e 

c : 
and press !Return). (Re membe r, you a lways have to press !Return) aft e r you e nte r a 
DOS command .) 
8 Switch into the p ro p e r direc to ry. The Setup p rogram load s eve rything into the 
GEOWO RKS direc to ry unl ess you to ld it o the rw ise; if yo u did , in fac t, te ll it o th
e rw ise, the n type th e direc to ry name you specified instead o f GEOWORKS. 

Type th e fo llowing , 
cd \geoworks 

and press !Return), o f course. 
8 Sta rt PC/ GEOS by typing 

geos 
and press ing I Return J. 

The firs t thing you see is the Welco me screen , which is your ga teway to the 
diffe rent pa rts o f GeoWorks Pro. 

2.3 GETTING STARTED 



PERUSING THE WELCOME SCREEN 

The Welcome screen is the first thing you see when you enter GeoWorks Pro. 
Here are some of the things you see: 
•Your personal serial number. Use this number if you call customer support and 

also in your correspondence with GeoWorks. 
•There 's a button that gives you on-line help if you need it. ((i)) 

•There 's a button that sends you back to DOS . Click the Exit button to leave 
GeoWorks Pro. Don't click it now. C(i)) 

• One button takes you to the Beginner Workspace . If you 've never used a com
puter or mouse before, then this is a handy place to start. Here you find soft
ware appliances-programs as simple to use as the toaster in your kitchen. All 
you have to know how to do is click the mouse . CO)) 

• The next button takes you to the Intermediate Workspace , a simplified version 
of the Advanced Workspace . The same applications are available to you , but 
your interaction with them is kept very simple and straightforward. ((.4)) This is 
the workspace that we 'll explore in this tutorial. 

• And there 's a button that takes you to the Advanced Workspace. Here you have 
access to all the power and functionality of GeoWorks Pro applications . C(.5)) 

• The DOS Programs button brings you to the DOS programs screen. There you 
can set up buttons to launch DOS based programs. ((p)) 

If you 've used a mouse before , go ahead and click the Intermediate button. If 
you're new to using a mouse, read on to learn some basic mouse techniques. 

GETTING STARTED 2.4 
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USING THE MOUSE 

The mouse, pointer, and buttons are to GeoWorks Pro what a hammer and 
nails are to a carpenter-indispensable. But , like any new tool , using a mou se 
takes a little practice, and sometimes a little patience . 
0 Put the mouse down on the table top, with its rolling ball underneath . 
8 Hold it in your hand with your fingers resting lightly on the buttons. 
8 Now move it around. As you move the mouse , an arrow-like pointer moves 
around the screen , following the movement of your mouse. Move the mo use left , 
and the pointer moves left. Move it right , and the pointer moves right . 
0 As the pointer moves across the screen, it changes shape depending on what 's 
underneath it. When it 's over a place where you can type text , it changes into an 1-
beam. And when the computer's busy doing something and you have to wait , the 
pointer turns into an hourglass . 
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CLICKING A BUTTON 

When you press buttons on a microwave or an answering machine, you make 
something happen . If it 's the on/ off button, you turn the machine 's power on or off. 
If it 's the rewind button on your answering machine , you rewind the tape. You also 
use GeoWorks Pro buttons to make things happen. 
0 Move the mouse to position the tip of the pointer over the Intermediate button. 
8 Being careful not to jiggle the mouse out of position , press down on the left 
mouse button. The button on the screen turns black to show that it 's being 
clicked. 
8 Release the mouse button . On the screen , the button returns to normal , and 
whatever action clicking the button causes to happen actually happens. 
0 If you haven 't already, click the Intermediate button. This brings up the File 
Cabinet Window. File Cabinet and any other appli cations you use in GeoWorks 
Pro appear in what 's called the workspace. The workspace is like your desktop
it 's where you put everything you 're working on (and possibly a few things 
you 're not). 

PAPER POSTERS 

RESUMES Area Tes l Defaull Scrapbook Firs\ Address Book My Schedule 

New document New drawing NOTES .TXT Printer Verifical ... 
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STARTING THE FILE CABINET 

Whe n yo u e nte r the Inte rmediate a rea , th e Fil e Cabine t w indow a ppea rs . Like 
the pa pe rs o n your desk , w indows are the medium you use to d o work . Everything 
tha t you d o, you d o insid e a w indow of some sort , a nd each kind o f w indow has a 
specifi c purpose . Yo u manage docume nts insid e th e Fil e Ca bine t window, o r write 
le tte rs ins ide th e GeoWrite w indow. 
• If you have n 't a lread y d o ne so , in th e We lco me sc ree n , cli ck the Inte rm e dia te 

b utto n . The File Cab in e t w ind ow a ppea rs . (1) 

• o tice th a t th a t the re a re diffe re nt typ es o f icons (pic tures) in th e w indow. (2) 
• Eac h ico n th a t looks lik e three pieces o f p a pe r in a pil e re presents a GeoWo rks 

Pro doc ume nt. (Whe n yo u o p e n o ne o f th ese doc um e nts, its wind o w cove rs up 
th e Fi le Ca bine t w indow.) (3) 

• Eac h ico n th a t looks like a ma nil a fo ld e r re presents a directo ry . (4) 
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OPENING A FOLDER 

A directory is the computer equivalent of a file folder. A file folder usually contains 
documents and-with difficulty-other file folders. Similarly, computer directories also 
contain documents, but, unlike their real-world counterparts, they can just as easily 
contain other directories. These other directories can, in turn, contain directories too. 
And so on. Directories that contain other directories are called parent directories. 

Unlike DOS, documents in the File Cabinet not only have names (and long 
ones at that) but a lso little pictures to represent them. These pictures are known 
as icons. You 'll find little pictures such as these all over GeoWorks Pro, although 
not all of them represent documents. 

To perform some action on a document or directory-or just about anything for 
that matter-you must first select it. Selecting is your way of telling the computer 
that your next command should affect the se lected file. 

For example, let 's say that you want to open up a directory to see what's inside. 
0 Using the mouse , move the pointer so that its point is over the LETTERS 
directory icon. 
f) Click. The LETTERS icon darkens , indicating that it is selected. 
E> Click the Open Directory button (it 's labeled "Open Dir") . The LETTERS 
directory window appears. You are now looking at the contents of the LETTERS 
directory (which is contained within the DOCUMENT directory). 
e If you're ever confused about which directory you 're in , look at the path at the 
top of the File Cabinet window. It shows, from left to right, a ll the directories you 
went through to reach the directory you 're now viewing . Reading a path is a little 
like looking at one branch of a family tree: each directory is the parent of the 
directory to its right , where the rightmost directory is the one currently shown in 
the window . 

4 
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OPENING A TEMPLATE 

Whe reas directory ico ns look like fil e fo lde rs, doc ument icons look like , well , 
little documents . Whe n you ope n a document , it automatica lly starts a corres pond
ing application, the compute r p rogram that you use to c reate and edit the contents 
of the docume nt. Fo r example, if you wa nte d to write a le tte r, you would need to 
o pen a GeoWrite docume nt (one crea ted with the GeoWrite applica tion). GeoWrite 
gives you the w riting tools you need to crea te le tte rs , re po rts , newsle tte rs , or what
ever. Likewise, to pull some clip a rt o ut o f a scrapbook, you 'd need to ope n a 
Scrapbook docume nt (one crea ted w ith the Scrapbook a pplica ti on) . Diffe rent types 
of documents have diffe rent looks to the ir icons, so that you ca n readily te ll the 
kind o f applica tion associa ted w ith the d ocument. 

(If a ll this talk of applica tions confuses yo u , d on 't worry. Afte r you 've use d 
GeoWo rks Pro fo r a while , it will p robabl y make mo re sense to you .) 

Le t 's ope n a d oc ume nt th at was crea ted w ith GeoWrite. 
0 Cli ck the icon that says "Blank Le tte r" unde r it to se lect the d ocument. Man y 
of the File Ca bine t butto ns light up w he n yo u se lect th e doc ume nt-this le ts yo u 
know that they a re now ava il abl e fo r use . Before you se lec ted the d ocume nt , the 
buttons we re dimme d , mea ning th a t the ir ac ti o ns were no t ava il abl e to yo u a t 
that mo me nt . (la) 
8 Click the Ope n button. The GeoWrite applica tion starts and a dialog box 
appears , te lling you that the document you 've just opened is a template , so yo u 'll 
need to give it a name o f your own w he n you 're fini she d. 
8 Click th e OK button . This gets rid of the di alog box . (Clicking OK is , in a 
sense , yo ur pa rt of the "dialogue. " By cli cking it , yo u 're say ing th at yes , yo u 've 
read the message and you wa nt to ge t o n with yo ur wo rk .) 
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ADDING TEXT TO YOUR DOCUMENT 

You should now be looking at a blank GeoWrite document. The next step is to 
fill that blank document with words (we'll add some illustrations later) . In this sec
tion you'll use GeoWrite to type words into your document and in the next section 
you learn how to edit what you type . In fact, the text skills you learn here apply 
any time you ever need to enter text any place within GeoWorks Pro . 
0 Move the pointer around the white space in the center of the screen. (This is 
called the body area.) Notice how the pointer now looks like an I-beam, meaning 
that you can type here . 
f) With the I-beam pointer still somewhere in the body area, click . A thin blink
ing line appears at the upper left corner of the body a rea . This is the text cursor
showing you where the text will go. 
8 Type in the letter below. The cursor rides along at the e nd of the text you're 
typing, indicating where the next character will go. Note the order-first yo u click 
to place the text cursor, then you type. (Of course, if the text cursor is already 
where you want to type something, you don 't need to pl ace it there again.) Be 
sure to press (Return! when indicated . 

Murtnik Travel !Return! 
211 Mulberry Avenue (Return! 
Mudville, Maine 012783 (Return! 
(Return I 
Dear Frequent Traveler, (Return! 
First of a ll, I ' d like to t hank you for allowing Murtnik 
Travel to assist you in your travel plans. We hope our 
service has proved helpful . (Return! 
Because you are a frequent traveler (our records s h ow that 
you ' ve booked over 50 ,000 flight miles with us) we ' d l ike to 
offer you a special gift, one you can use in all your 
travels . Bring this letter with you the next time you visit 
our offices , a nd we'll give you your gift. You don't even 
need to be planning a trip! !Return! 
I Return J 

Sincerely , (Return! 
I Return J 

John Mur t nik !Return! 
Travel Consul tan t 
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0 Notice that when you type enough text to go beyond the right margin of the 
page, the cursor automatically moves down to the next line. Unlike using a type
writer, you do not need to manually return the carriage when you reach the end 
of a line. This is called text wrapping. If the last word hangs out past the right 
margin, the entire word is moved down to the next line. 

Here are four easy-to-remember rules that give your document a professional 
look: 
•Don't press I Return I at the end of every line-just those where you want to start a 

new paragraph. The application automatically jumps to the next line for you. 
•Press ~ at the end of each paragraph. 
•Press I Backspace I to delete the character to the left of the cursor, or I Delete I to 

delete the one to the right . 
•Type only one space after punctuation, including periods . (Trust us on this one.) 

..-.1~ .... 
.. [le 

(cit 
-

§llew llPtlona (!aragreph rants Sips 1"'88 Yndow 

lu.,.:J ~ 
::::::::: p " ~ p = Ji ~= ii = · 

I I I I I .. I I I 

t f i 11:1 ltl 1:111•1•1 •1-1 1=1 1=1 
.......................................... 

!Murtnik Travel 
!211 Mulberry Avenue 
!Mudville, Ma.ine 012783 

: : 
:Dear Frequent Traveller, : 
i First of all, td liki! to thank you for allowi.I\g Murtnik Travel to assist you in your travel! 
plans. We hope our service has proved helpful . i 
· Bee ause you are a frequent trave Iler (our re cords show that you've bookl!d over 50, 000 flisht i 
~les with us) we'd liki! to offer you a special gift, one you can use in all your travels . Bri.I\g this ! 
iletter with you the next time you visit our office , and we'll give you your gift. You don't even! 
!need to be planni.I\g a trip ! 

rni.,.nk You, 

John Murtnik 
fr'ra vel Consultant J 

I 
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EDITING TEXT 

Things you type in are not chiseled in stone-you can edit them at any time. 
This is the beauty of an electronic word processor: no matter where you type text, 
you can immediately change it. 

INSERTING TEXT 
0 Position the I-beam pointer at the spot in the text where you want to insert 
something. Click. You 'll see the text cursor appear at this point. Anything you type 
is inserted there. If you missed , simply move the I-beam pointer to the correct 
space and click again . 
8 Type. 

CHANGING TEXT 
8 Position the I-beam pointer to the left of the S in the word "Sincerely" at the 
bottom of the document. Press and hold down the left mouse button and drag the 
pointer to the right until you've highlighted all of the word "Sincerely." 

This new mouse action-pointing , holding down the mouse button, and moving 
the mouse-is called dragging. You 'll use dragging a lot as you work. (Dragging is 
something you use often to select text in GeoWrite. You can also use dragging in 
the File Cabinet to move documents around.) 
0 Type the words "Thank you. " The highlighted text is completely removed and 
replaced by whatever you type. (Instead of typing something, you could also press 
I Delete I to erase the highlighted text without actually inserting anything new in its place.) 
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CHANGING FONT, FONT SIZE, AND STYLE 

In this section you learn how to use double-clicking to select words in your 
text. You 'll also learn and how to use menu commands to change the font, size , 
and style of those words. A menu is simply a collection of commands or choices 
listed together under a common heading at the top of a window . When you 
choose one of the commands or choices from a menu , you perform an action or a 
select item. 
0 Move the I-beam pointer so that it 's on the word "Murtnik" in "Murtnik Travel. " 
e Quickly click the left mouse button twice (being careful not to jiggle the mouse 
so that it inadvertently moves). This technique is ca lled double-clicking, and general
ly speaking, you can double-click anything that you normally click (single-click, that 
is). The whole word "Murtnik" becomes highlighted to show you that it 's been 
selected . You can use this method to select words in lieu of the click-and-drag 
method you used earlier. 

Similarly , if you double-click on a word, then drag , each word you drag over is 
selected. This is useful when you want to replace , copy , or move a group of words. 
8 Move the pointer to the word "Fonts" in GeoWrite 's menu bar (near the top of 
the window). Notice that the I-beam pointer changes back to an arrow pointer. 
0 Click on the word Fonts. A list of different fonts appears. 
0 Click Cooperstown. The word "Murtnik" changes from its o ld font (URW 
Roman) to the new font (Coopers town). Generally , when you choose a command 
from a menu , it effects only what is currently selected. In this case , you had 
selected the word "Murtnik ," then you chose Cooperstown from the Fonts menu . 
Therefore only the word Murtnik changed . 
0 To try another menu command, choose 18 Point from the Sizes menu. Now 
you 've increased the size of the word from 12 points to 18 points . 

Try a few more fonts and sizes while you have "Murtnik" selected . Also try 
choosing different styles from the Style menu-make the word bold, italic, or 
both. Notice that you don 't need to re-select the word "Murtnik" each time you 
make a change- a great time saver when you 're trying a lot of different fonts and 
styles to find something you like . 
Note: uPoints" are units used to measure type in the publishing world. A point is about 1 /72 of an inch, so text that's 72 
points tall is one inch tall; 36 point text is half an inch tall, and so on. Generally speaking, text used in the body of a letter 
or story should be 10 or 12 points tall. 
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SELECTING PARAGRAPHS WITH THE MOUSE 

Whereas you can select words by double-clicking, you can select lines of text 
by triple-clicking, paragraphs by quadruple-clicking, and even a whole page by 
quintuple-clicking. Try using a quadruple-click and a drag to select two para
graphs of text . 
0 Move the I-beam cursor so that it is somewhere-anywhere-in the first para
graph of the letter. 
8 Click the left mouse button four times in rapid succession, and on the fourth click , 
hold down the mouse button. That's click, release , click, release , click, release , click 
and hold. (It 's a little tricky the first time you try, but as you practice it becomes as 
natural as writing with a pencil.) The paragraph should become highlighted. If it 
doesn 't, or just a word or line becomes highlighted, wait a second and try again. 
8 Still holding the mouse button, drag the I-beam pointer to the next paragraph. It 
highlights , too. 

!Murtnik Travel 
!211 Mulbeny Avenue 
jMudville, Maine 012783 

I - . 

FiI:::t of all. rd hke to th.:.rtk ','OU for allov?iIL,,;: ?i11urtni.k Tra.'?el to a.s:::ist ?OU llL ?Ottr tra.1.1el 
•lans. V..'e hope our :::eD>ice h.;,,::: i:•ro1.1ed helpful -•••••••••••••••••• 

0ec a.use :,'OU a.re a. freq1ie nt tra.1,eller (our record::: :::how th.it :,'ou' 17e booked 01,e r 50. 000 fli.:;:ht 
n-Lile::: with us) we'd hke to offer :,'OU a. special :;:ift. one :,'OU ca.rt use irt a.11 :,'•:•ur tra.1,el::: Brin.:;: tl-Li::: 
en~ r wi. th y·ou the ne::t tirfLe ?OU -;hsit our office. and \l.~ '11 -~i~.~e ?OU ?our .~ift "'lou don't e~,;oe n 

need to be •la.ruurt,;: a. tri 'I 
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CHANGING THE RULER 

Now that you 've selected a couple o f paragraphs, you ca n change the ir styles 
using the ruler. The rule r is the bar along the top of the GeoWrite window that looks 
like-no t suprisingly- a ruler. The top half of the rule r, with the tick marks, measures 
the width of the docume nt and the botto m half, w ith all the little icons , contro ls the 
style of the current paragraph. (The current paragraph is the o ne w ith the text cursor 
in it , or in the current exa mple , the selected paragraphs.) 
0 Move th e I-bea m po inte r so th at it 's in the ruler b ar. (Th e I-bea m turns back 
into a n a rrow p o inte r. ) Click o n the first line inde nta ti o n marke r-the to p ha lf of 
the little tri a ngle o n th e le ft s ide o f the ruler-and ho ld d own the mo use butto n . 
Thi s "picks up" the inde ntati o n ma rke r, and the a rrow p o inte r itse lf turns into a 
littl e tri a ngle . 
8 Still ho ldin g th e mo use hutto n down , drag the tri angle po inte r a qu a rte r inch to 
the rig ht (to ge t the measure me nt correct , use the rule r ti cks as a g uide) . 
E) Re lease the mouse butto n . The po inte r turns back into an arrow po inter and the 
inde ntation triangle is "d ropped " at its new positi o n. Look at the paragraphs . They 're 
now indented a qu arte r o f an inch . 
0 ow cha nge th e justifi ca ti o n o f your p a rag ra phs. Move th e p o inte r so th a t it 's 
ove r th e full justifi ca ti o n ico n . Cli ck . Yo ur p a rag raphs beco me full y justi fied
that is, s tre tche d to fit exactly w ithin the ma rg ins. 

urtnik Travel 
11 Mulbeny Avenue 
udville, Mallie 0 12783 
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SAVING YOUR WORK 

It 's very important for you to understand the concept of "saving" your work. 
You may think that the letter you've been working on is "in" the computer- and 
therefore available to you tomorrow, the next day, or a year from now-but in fact 
what you're currently working on is only temporary. Turn off your computer right 
now , and the letter is lost forever. You have to explicitly instruct the computer to 
store your letter away for later work. This instruction is referred to as saving the 
document, and you should get in the habit of saving your work often. (Imagine 
how yo u 'd fee l if you 'd spent hours working on a document and then accidentally 
turned off your computer before you saved it. Ouch!) 

Let 's save your GeoWrite document. 
0 Choose Save As from the Fi le menu . A file selector dialog box appears . Remem
ber, a dialog box is any box that GeoWorks Pro brings up to tell you something or 
ask you for information-often both. A file selector is just a specific kind of dialog 
box . We 'll show you more about using file selectors in the next section . 
8 Click in the box that says Name. A text cursor appears (if it doesn 't , try click-
ing again in the Name box). 2 

8 Type a name for your document , like "My Letter. " You can edit this text the 
sa me way you edited text in GeoWrite . (DOS lovers , take note: your document 
names can be up to 32 characters long, and can contain upper and lower case 
letters, spaces, even special characters!) 
0 Click Save when you 're ready to save the document-but not yet! First read 
the next section to learn some of the subtle points about File Selectors. 
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USING A FILE SELECTOR 

On your screen you should see , from the previous section, the Save As file 
selector. GeoWorks Pro usually uses a file se lector to ask you where you want to 
put a document or where it can find a document. In this case , GeoWorks Pro is 
asking you where (in which directory) you want to save your GeoWrite docu
ment. Let 's use the file selector to tell GeoWrite to save your document in the 
DOCUMENT directory. 

Before you begin , look at the current directory path , next to the Parent Directory 
button . It should say \ GEOWORKS \DOCUMENT\LETTERS, indicating that, if you 
saved the file right now, it would be saved in the directory containing the original 
GeoWrite template (the LETTERS directory). Your path may be different depending 
how you 've set up your system. 
0 Move up one level to the DOCUMENT directory by clicking the Parent Directory 
button . The second line of the path changes to read \ GEOWORKS \DOCUMENT. Also , 
the directory contents list changes to show the contents of the DOCUMENT directory. 
f) Actually, that's all you need to do . But just for practice, return to the LETTERS direc-

2 tory by double-clicking its name in the directory contents list (you 'll have to scroll the 
list until the name appears-see "Moving Through the Scrapbook ," below, to learn how 
to scroll a window) . To open any directory in the list, just double-click it. 

3 

8 Click the parent directory button again to go back to the DOCUMENT directo
ry , and click Save to save your document there. 

You 'll see file selectors all over GeoWorks Pro-not just in GeoWrite . And , 
whi le each one is a little bit different, you ' ll see that they a ll work basically the 
same way. 

A typical file selector 
dialog box. 
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SWITCHING BACK TO THE FILE CABINET 

GeoWorks Pro allows you to use several applications at the same time. Right 
now, if you've been following the steps so far, the File Cabinet application and the 
GeoWrite application are both running. If you look at the screen, though, you only 
see the GeoWrite window. That's because GeoWrite 's window is in front of the File 
Cabinet window (like those papers on your desk-you only see the ones at the top 
of the pile). 

It 's easy to switch back and forth between applications- all you need is the 
Express menu. (Remember that a menu is a collection of commands listed together 
under a common heading at the top of the window.) 

Let's use the Express menu to switch back to File Cabinet. 
0 Click the Express button at the upper left corner of the window. The Express 
menu appears. It lists any open applications (you shou ld see GeoWrite and File 
Cabinet listed) , as well as two commands: the Printer Control Panel , and Exit to 
DOS . 

Notice the Diamond-shaped buttons next to each application 's name . These 
are radio buttons. Radio buttons work together like the buttons on an old-fash- 2 
ioned car radio-if you push one in , the other pops out, so only one can be in at 
a time . In the same way, only one radio button can be "on " at any given time. 
You see radio buttons when you can only choose one option from many . (la) 
8 Click the radio button next to w here it says "File Cabinet. " The File Cabinet 
window pops up to the front. Although now you only see the File Cabinet window, 
GeoWrite is still there , with your document still open, behind the File Cabinet win
dow. The two windows have changed places. 
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OPENING A SCRAPBOOK DOCUMENT 

The Scrapbook application allows you to store a collection of pictures and text 
in one location-a scrapbook document-so you can retrieve them quickly and 
add them to your GeoWrite documents. In this section , you'll open a Scrapbook 
document that's already filled with images. But first, you need to go back to the 
DOCUMENT directory. 

MOVING UP DIRECTORIES To move back to a directory's parent directory (remember, the 
parent directory contains the directory that you currently see in the window) you 
must close the current directory. 
0 Click the Close Dir button. The DOCUMENT directory reappears in the window. 

OPENING GEOWORKS CLIPART Instead of opening a directory or document by selecting it 
and clicking Open, you can open it by double-clicking its icon. 
8 Place the pointer on the CLIPART folder and double-click the left mouse but
ton-using the same double-clicking action you used to select words in GeoWrite. 
The CLIPART directory window appears. 
8 Now double-click the Clipart document icon. 
0 You 'll see the "read-only" dialog box again-only this time it 's for the Clipart 
document. Click OK. 

The Scrapbook 
window. 
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MOVING THROUGH THE SCRAPBOOK 

The Clipart scrapbook is filled with images that you can easily add to your 
GeoWrite documents. In this section, you learn how to move through the scrap
book to find an image, how to see the whole image using scroll bars, and how to 
copy that image to the clipboard. The clipboard is an invisible holding place for 
text or pictures that you want to paste (place) into a document. 
0 Click the Next button until you come to the picture of the ship-it's number 7. 
(The word "Ship" should be in the Name box, below the picture .) If you go too 
far, click the Previous button. 
8 Choose Enlarged to 200% from the View menu. This doubles the size of the 
image , so now a larger version of the ship appears in the window. Notice that to 
the right of and below the image of the ship are two long thin bars with arrows 
at the end. These are scroll bars . Scroll bars appear in any window that can 't 
show its entire contents . Click the arrow that points down a few times. The ship 
seems to "move " up , but it 's better to think of it as your view of the ship moving 
down, in the direction of the arrow. (2a) Now click the arrow that points up. 
Your view of the ship moves back down. (2b) 2 
8 Choose Reduced to 50% from the View menu so that the ship is now half of 
its original size. 
0 Choose Copy at View % from the Edit menu. The image is copied (at half its 
original size) to the clipboard (where it will remain until you copy or cut some
thing else). You can now paste this image into other applications like GeoWrite 
or GeoDraw. 
Note: Enlarging the view to 200% or reducing it to 50% doesn't actually <hange the size of the image. It only <hanges how 
big it appears in the window, like you were looking through a magnifying glass. When you <hoose Copy at View % to pla<e 
it in the dipboard, you're <opying it at its adjusted size. If you had wanted to <opy the original version, you would have 
<hosen Copy instead. 2a 

2b 

4 3 
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PUTTING IMAGES INTO GEODRAW 

Now that you have something on the clipboard, you're almost ready to paste it 
into your letter. But first let 's paste it into a GeoDraw document, so we can mod
ify it slightly. 
0 Choose File Cabinet from the Express menu. This brings File Cabinet back to 
the front of the screen, making it the active window. You shou ld be looking at 
the CLIPART directory . Click the Close Dir button to go back up to the DOCU-
MENT directory. 
8 Open the document labeled "New drawing" by double-clicking its icon. Again, 
click OK when you get the read-only dialog box . GeoDraw starts and opens a 
new b lank document. In the center of the window, like in GeoWrite, is the 
space- called the drawing area-where you do your work. 
8 Choose Paste from the Edit menu . The illustration of the ship appears in the 

New dr .awing center of the drawing area. Where did it come from? From the clipboard , where 
you copied it in the last section. The ship is now a GeoDraw object-that is, 
something that you can manipulate with GeoDraw tools 

2 Notice the little black squares around the ship 's perimeter and the b lack dia-

3 

mond in its center. These are called handles , which you drag with the pointer to 
move, rotate, and stretch the object. 
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ADDING TEXT TO YOUR PICTURE 

GeoDraw comes with a collection of drawing tools, which you can use to change 
the samples that we've supplied or even create your own drawings. These tools are 
located in the Toolbox. To use a tool simply click its icon in the Toolbox. The point
er changes to reflect the tool you've selected, and stays that way until you select 
another tool. Let's use the text tool to add text to the picture of the ship. 
0 Click the Text Tool icon (the one that looks like a the letter "T") in the Tool
box. The icon turns black to indicate that it 's been selected. Then move the 
pointer into the drawing area-notice how the pointer changes to an I-beam 
pointer like the one you used in GeoWrite. 
f) Click somewhere in the drawing area. A box with a dotted-line border 
appears. This box is called the text box, and it shows where your text will be 
placed. You should recognize the thin blinking line that appears-the text cursor. 
Just as in GeoWrite , it shows you where text you type will go. 
8 Type "Murtnik Travel". The text you type shows up in the text box. 

The Toolbox. 
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ROTATING THE TEXT 

Like the Text Tool, most of GeoDraw 's tools are used to add text or objects in 
your drawing . But GeoDraw has two tools that actually create nothing-they are 
only used to manipulate objects that you 've already drawn or typed. The rotation 
pointer is an example of one of these tools (the other is the simple pointer tool). 
The rotation pointer is so named because it 's used to rotate objects , text blocks , 
or both. 
0 Click the rotation pointer icon (the one that looks like a curved pointer) in 
the Toolbox . Now move the pointer into the white drawing space. Notice how 
the arrow pointer is now curved-it looks like the icon in the Toolbox . 
8 Click anywhere on the text you just typed. The handles for the text box 
appear. You know an object (text objects included) is selected when you can see 
its handles. 
E) Position the pointer on the upper-right handle. Click and hold down the left 
mouse button. As you hold the button , move the mouse (drag it) up and to the 
left. An outline of the text box rotates around its center in the direction you 
move . (3a) 
0 Release the mouse button when the o utline is rotated 90 degrees. The text , 
handles and a ll , rotates to match the o utline. It should now be reading vertically . 
If the text is not quite 90 degrees from its original position , grab the handle and 
try again. (Rotating takes some practice so don 't dismay if you have a little trouble 
getting it right the first time. ) 
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MOVING YOUR SHAPE WITH THE POINTER 

Once you create an object, you can move it anywhere in the drawing area . 
Let 's move the ship next to the text you just rotated . 
0 Move the rotation pointer to the ship and click . The ship 's handles appear to 
show you that it 's selected. 
8 Click and drag the diamond-shaped handle in the center of the illustration (on 
the bow of the ship). An outline of the polygon moves in the direction you drag . 
Remember, to drag anything, you must click the left mouse button and hold it down. 
8 Drag the outline of the ship so that it 's right next to the words "Murtnik Travel. " 
8 Release the mouse button. The ship moves to its new location. 
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• • PUTTING YOUR MODIFIED IMAGE ON THE CLIPBOARD 

Now th at you have mo difie d the image , you ca n put it o n the clipboa rd so that 
yo u can tran sfe r it to your le tte r document . 
0 Choose Selec t All in the Edit me nu . Handles appea r a round your image and 
around th e text yo u just typ ed . Each o bject ca n be se lec ted individua lly o r 
togethe r as we 've d o ne he re . 
8 Choose Co py fro m the Edit me nu . This copies th e mo dified image to the clip
boa rd . Re me mbe r, anything you co py to th e clipbo ard o nly re m ains th e re until 
you copy (o r cut) some thing e lse . If yo u were to co py ano th e r ite m , the n e w 
ite m would re place this o ne o n th e clipboard . 
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PASTING IMAGES INTO YOUR DOCUMENT 

With the modified image on the clipboard, you're almost ready to paste it into 
your letter. But first, you must switch back to GeoWrite (that is, bring its window 
to the front). 
0 Choose GeoWrite from the Express menu. This brings GeoWrite back to the 
front of the screen, making it the active window (the windows out of sight 
behind it are, of course, inactive). 
8 Move the I-beam so it's just to the left of the M in the words "Murtnik Travel. " 
Click to place text cursor there . This is where your picture will be placed. 
8 Choose Paste from the Edit menu. The ship logo appears in your document 
where the text cursor was, and the text cursor moves to the right . For all practi
ca l purposes, this picture is just like any bit of text in the document-you can cut 
it, move it , and delete it quite like you wou ld regular text . 
8 Press !Return ] to move the words "Murtnik Trave l" down a line. 

I 
lour .Frequent Traveller, I 
i Fmt of all, td like to thank you for allowing Murtnik Travel to assist you in your traveli 
plans. We hope our service has proved helpful . i 
i Because you are a frequent traveller (our records show that you've bool<2d over 50,000 fliaht! 
!miles with us) we'd like to offer you a specia.l gift, one you can use in all your travels . Bring this ! 
ilener with you the next time you visit our office , and we'll give you your gift. You don't even! 
!need to be planning a trip ! 

fl'ha.nk You, 

~ohn Murtnik 
fl'ravel Consultant 
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PRINTING YOUR WORK 

If you installed a printer when you installed GeoWorks Pro, you can now print 
your document. The print command is found in the File menu . For practice, 
though , instead of using the mouse to pull down the File menu and select Print, 
let 's use the keyboard only. 
0 On your keyboard, hold down the (ED key and press~. The File menu pops 
down. The F corresponds to the underlined F in the word "File. " You can pull 
down any menu by pressing [ED and the menu 's underlined letter. 
8 Now press 0 (P is the underlined letter in the Print command in the File 
menu). Note that you only need to hold the [ED key when you want to pull down 
the menu. Once the menu is down, you can release it and simply press the letter 
of the command you want from the menu . 
8 The Print dialog box appears , letting you change the way the document is 
printed. You could choose to make a crude, quick printing, were your document 
only a rough draft and you didn 't need very sharp results. However, for the 
moment simply click Print . If you 've set up your printer correctly , your document 
should print out like it looks on the screen. 

The Print dialog box. 
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SAVING YOUR FINAL VERSION AND EXITING GEOWRITE 

Although you 've already saved your letter once, that saved version doesn 't 
contain any of the changes you've made since then . If you were to leave 
GeoWrite now, you would lose all your recent work. So before exiting GeoWrite, 
let 's save the changed letter one more time. 
0 Choose Save from the File menu. All the changes that you 've made are now 
automatically saved in the file "My Letter". 

Note that when you use the Save command (instead of the Save As command) 
GeoWrite does not ask you to name a new file . When you use the Save command, 
GeoWrite assumes you only want to update the original file-the one you've 
already named-not create a new one. 

When you are finished with a document, you should close it. That 's your way 
of telling GeoWorks Pro that you no longer need the document in front of you 
(and it frees up valuable computer resources) . Likewise , if you're also finished 
with the application, you should exit it too. The terminology for documents and 
applications is a little different-you close one and exit the other-but the result 
is essentially the same: the document or application window disappears from the 2 
screen. Let's close the document "My Letter" and then exit GeoWrite. 
f) Choose Close from the file menu . The document "My File" closes and its win
dow disappears, leaving a large black area in the GeoWrite window. Note that the 
GeoWrite window is still open. Although you closed the document you were work
ing on (My Letter) , you did not exit the application you working in (GeoWrite) . 
8 Choose Exit from the File menu. The GeoWrite window disappears. 
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EXITING GEODRAW AND SCRAPBOOK 

Now that you 've closed GeoWrite, GeoDraw should be in the front. Let 's close 
GeoDraw also, but by using a different method. 

Some menu commands have keyboard accelerators. A keyboard accelerator is 
a single keystroke you can use to choose a particular menu item or command. If 
an item has a keyboard accelerator, the accelerator appears at the right edge of 
the menu. Not every command has a keyboard accelerator, but the Exit command 
does. Let 's use it to exit GeoDraw. 
0 Press ffi to exit GeoDraw, which is the same as selecting Exit from the File 
menu . When it exits, GeoDraw automatically closes any documents you were 
working on . 
f) Since you've never saved this GeoDraw document, GeoDraw asks you if you 
want to save the changes before you exit . If you want to save the ship logo , click 
Yes and use the ensuing file selector to give the file a name . If you do not want 
to save the file, click No. GeoDraw will close without saving the file. While in 
this case you should probably answer "no ," generally speaking you should 
answer "yes " and save your work. 
t) Now the Scrapbook window should be in front . If it isn 't and File Cabinet is , 
use the Express menu to return to the Scrapbook application. 
0 Double-click the Control button (at the extreme upper-left corner of the win
dow, next to the Express menu) . Your Scrapbook closes and its window disap
pears. The File Cabinet window should now be in front. 

Double-clicking the Control button is identical to pressing ffi , which in turn 
is identical to choosing Exit from the File menu. Use whatever method you like 
best. 
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SHUTTING DOWN GEOWORKS PRO 

Now that you've created, saved, and printed a document using GeoWorks Pro, 
you are ready to tackle your own projects. Remember the tools you encountered 
in this tutorial, and know that there are many more you'll encounter as you 
explore. For now, shut down GeoWorks Pro and return to DOS. You should 
always do this before you turn your computer off. 
0 In the File Cabinet window, click the Exit to DOS button. A dialog box 
appears, asking you if you 're sure that you want to return to DOS. 
8 Click Yes. You'll see the File Cabinet shutting down , and in a few moments 
you 'll be back at the familiar DOS prompt. 
8 It 's OK to turn your computer off now. 
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BASIC TOOLS AND SKILLS 

If you're not new to computers, 

but you arene"W" to GeoWorks Pro, 

this is the section for you. Like 

. . · "Getting Started," this section lays 

the foundation for your work with all 

the GeoWorks Pro applications. But 

here you'll find in-depth discussions 

about the basic concepts fundamental to 

everything you do in GeoWorks Pro. Be 

sure to browse. Skip around. As a general 

rule, the chapter builds from the 

simplest concepts to the ll1ost 

advanced, with each section 

building on the one before. 



THE MOUSE 

The mouse is your pointer; in some 
ways, it 's an extension of your fingers. 
Use it to press buttons on your screen 
(the way you use your fingers to press 
buttons in real life) . Or use it to pick 
up a document and move it someplace 
else. The mouse and its attached on
screen pointer play an important part 
in working with different things in 
GeoWorks Pro . 

Moving the mouse around on a flat 
surface moves a little picture of an 
arrow-the pointer-around in a similar 
fashion on the screen. Move the mouse 
a little to the right, and the pointer 
moves right also. Move it left and the 
pointer moves left. The pointer also 
occasionally changes shape to remind 
you what you 're doing . For example, 
when your computer needs to take a 
moment to finish an operation, the 
pointer turns into an hourglass , indicat
ing that you should wait a moment. 
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THE POINTER AND SOME OF ITS MANY SHAPES Here 
are some common forms that the pointer 
takes on as you move it around. 
Arrow pointer This is the standard 
pointer. You usually use it to click 
buttons and select things. 
Hourglass pointer The hourglass (or 
busy) pointer indicates that the system is 
working hard to finish some operation
you shouldn't perform another task until 
this first one is completed. 
Circle/Slash pointer When the point
er is outside of the active area of the 
screen (often, a dialog box that 
demands an answer before you can 
continue) , it becomes a circle with a 
slash through it. This means hands 
off-you can 't do anything outside of 
the active area- but you can still do 
things within the active area. 
I-beam pointer When the pointer is 
over text or in a text box it turns into 
an I-beam pointer. You use the I-beam 
pointer to edit text. 



THE MOUSE BUTTONS While you use the 
mouse itself to point , you use its butto ns 
to actually take action. 

You can control GeoWorks Pro with 
e ithe r a two-button or three-button 
mouse. If you have a two-button mouse, 
the buttons are refe rre d to as "left " and 
"right. " If you have a three-button 
mouse , the buttons a re refe rred to as
no t surprisingly- "left ," "middle ," and 
"right. " 
Left button The left button pe rforms 
most ope rations in GeoWo rks Pro . If 
th e instru ctions d o n 't specify a pa rticu
la r mouse butto n to use, use the le ft 
o ne . 
Middle button The middle button is 
rare ly used in GeoWorks Pro because 
some mice don 't have one . (So do n 't feel 
le ft out if yours only has two buttons.) 
Right button The right butto n is for 
moving ite ms a round the scree n. This 
is ca lled direct m an ipu lation . Not a ll 
direc t manipula tio ns require you to use 
the right mo use butto n , so this book 
w ill make it cl ea r w he n you sho uld . 

HOLDING THE MOUSE Put the mo use on a fl at 
surface, like a tabl e to p o r a mouse 
pad , with its rolling b all unde rn ea th. 
The mo use 's ta il ( its cable) sho uld be 
fac ing the compute r. Not the way yo u 'd 
ho ld a rea l mo use, in a ll p robability, 
but this o rie ntatio n is impo rtant so th at 
the mouse works co rrectly. Ho ld it by 
the sides with yo ur index finge r resting 
lightly on the butto ns . 

3.3 

MOVING THE POINTER AND 
CLICKING 

To control GeoWorks Pro , you move 
the po inte r a round th e screen until it 's 
ove r an item you wa nt to use- such as 
a butto n , a menu item , o r an icon-and 
the n press and re lease th e mo use but
ton . Mov ing th e po inte r over an item is 
ca ll ed p oin ting to th e ite m . Press ing 
and re leasing the mo use butto n quickly 
is ca lle d click ing (or, mo re specifi ca lly , 
single-click ing). 

To move the pointer on the 
screen ... 
0 Place the mo use o n a fl at surface. 
The cord sh o uld face away fro m you . 
8 Move th e mouse in a ny direc tio n. 
The po inter movem ent corres po nds to 
the moveme nt of the mo use. 

If yo u ever w ant to move the mo use 
w itho ut moving th e po inte r, lift th e 
mouse o ff o f its sur face a nd place it 
d own somewhe re e lse. The po inte r 
stays whe re it is. 

----- .. "" ' ~ 

-----.., l' ~ 

To click an item on the screen ... 
0 Pos itio n the po inte r so tha t its tip is 
over the item you wa nt to cl ick . 
8 Press and release the mouse button
usua lly the left o ne- o nce . 
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ICONS 

Icons are small pictures on the 
screen that represent things you can 
work with. A file icon in the GeoMan
ager window represents a file on your 
disk drive. Different files have differ
ent icons , to identify the kind of files 
they are. 

A folder icon in the GeoManager 
window represents a directory on your 
disk drive . Because directories appear 
as fo lders in the GeoManager window, 
"directory" and "folder" are often used 
interchangeably. 

For instance , dragging a file icon to 
the Wastebasket deletes the file . (Be 
careful. Whatever you put in the Waste
basket is removed permanently from 
the disk and cannot be retrieved.) 
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BUTTONS 

When you press buttons on a 
microwave or an answering machine 
something happens. If it 's the on/ off 
button, you turn the machine's power 
on or off. If it 's the rewind button on 
your answering machine , you rewind 
the tape . You also use GeoWorks Pro 
buttons to make things happen. An 
example: Click the Intermediate button 
on the Welcome screen and you enter 
the Intermediate Workspace . 

On color or grayscale screens, buttons 
have 3-D styling that makes them look 
like slightly raised parts of the screen. On 
monochrome or CGA monitors , on the 
other hand, buttons are merely outlined. 
In GeoWorks Pro, buttons are usually 
distinguished from one another by an 
icon or a written title-sometimes both. 

The first buttons you see when you 
start GeoWorks Pro are the four buttons 
o n the Welcome screen: the Beginner, 
Intermediate, Advanced , and DOS Pro
grams buttons. 

The Welcome screen with the Beginner, 
Intermediate, Advanced, and DOS 
Programs buttons. 



CLICKING BUTTONS You activate buttons by 
clicking them. 

To click a button (or just about any
thing) ... 
0 Position the pointer so that its tip is 
over the button. 
8 Being very carefu l not to jiggle the 
mouse out of position , press down the 
left mouse button. 
8 When the button turns black to 
show that it 's being clicked, release 
the mouse button. On the screen, the 
button returns to normal. At this point , 
whatever action clicking the button 
causes actually happens . 

If you inadvertently moved the pointer 
off the button before you released the 
mouse button, the button would also return 
to normal , only the action wouldn't happen. 
It's important that the pointer still be on the 
button when you release the mouse button. 

DOUBLE-CLICKING 

A double-click often provides a short
cut way of doing something you would 
normally do with several single-clicks, 
such as starting an application with Geo
Manager. Double-clicking is done with 
two quick clicks of the mouse button. 

To double-click an item on the 
screen ... 
0 Position the pointer over the item 
you wish to double-click . 
8 Press and release the mouse button 
twice, rapidly in succession. That 's 
press , release , press , release. 

The trick to double-clicking is 
steadiness and speed: Don't jiggle the 
mouse as you press and release quick
ly . You might need some practice to get 
it just right. 

Position ... 

... dick ... 

... and release. 

Position ... 

dick and hold ... 

... and release. 
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TRIPLE-CLICKING, QUADRUPLE
CLICKING, QUINTUPLE-CLICKING, 
AND MORE. 

Above and beyond double-clicks , 
there are triple-clicks (three clicks) , 
quadruple-clicks (four clicks) , and 
even quintuple-clicks (five clicks). 
Mu ltiple clicks are useful in a variety 
of situations, such as selecting text. In 
a word processor, for example, each 
successive click se lects a larger unit of 
text-a double-click selects a word, a 
triple-click selects a line , a quadruple
click selects a paragraph, and a quintu
ple-click selects an entire page . 

PRESSING 

Pressing means positioning the 
pointer over something and then press
ing and holding down the mouse but
ton. Pressing an item on the screen is 
like pressing and holding a key on your 
keyboard-the keystroke repeats auto
matically , and keeps repeating until 
you take your finger off. In the same 
way, some buttons keep doing some 
thing while you keep holding down the 
mouse button. For example, pressing 
on a down arrow- such as those used 
to scroll through lists-ca uses the list to 
scroll contin uo usly. 

To press an item on the screen ... 
0 Position the pointer over the item 
you want to press . 
8 Press and hold down the mouse 
button , being carefu l not to move it 
out of position. The continuous action 
(if there is one-not everything works 
this way) begins. 
8 Release the mouse button. The con
tinuous action stops . 
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DRAGGING 

Dragging means pressing and hold
ing down the mouse button while mov
ing the mouse. Dragging is one way to 
browse through menus and choose 
commands. It is also convenient for 
moving and resizing windows, and for 
selecting text . 

You can also use dragging to pick 
up items and move them around the 
screen (direct manipulation). 

To drag an item on the screen ... 
0 Position the pointer where you want 
to begin dragging . 
f) Press and hold down the mouse but
ton. Depending on what you're trying to 
do, it can be the right or left button. 
8 Move the pointer in any direction. 
0 Release the mouse button. 

APPLICATIONS AND DOCUMENTS 

Programs you run in GeoWorks Pro 
are called applications. You use appli
cations to create and edit documents. A 
document can be a one-page letter, a 
ten-page report, an architectural draw
ing , or even a complete address book 
with names and addresses. Documents 
are stored as files on your disks . They 
are similar to the files you create and 
save with DOS programs. 

Each application in GeoWorks Pro 
uses a unique type of document. A 
graphics application uses graphics doc
uments, a word processor application 
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uses word processor documents, and an 
address book application uses address 
book documents. You can't open a 
word processor document with a graph
ics application, or vice versa, because 
the documents are of different types
but you can share information between 
the two documents by cutting and past
ing. More on this later. 

NAMING DOCUMENTS, DOS FILES, 
AND DIRECTORIES 

GEOWORKS PRO DOCUMENTS The names of 
GeoWorks Pro applications and docu
ments can be up to 32 characters long, 
including spaces and punctuation. 

Some good file names: 
Travel Report: 
Trip to Maine 
01/12 
Letter To Mom 
Cubism Study #1 

Cubism Study • 1 

DOS FILES AND DIRECTORIES The names of 
directories and DOS files must conform 
to the standard DOS format. The file
name can be from one to eight charac
ters long. You can use both numbers 
and letters in the filename , but no 
spaces or punctuation. An optional 
filename extension follows the file
name and begins with a period. 

Legal DOS file and directory names: 
MYFILEl.TXT 
RUN_THIS.BAT 
OVERTHEH.ILL 

Names that won't work: 
MYFILE1 .TXT 

BAD NEWS (no spaces) 
LONGFILENAME (Too long) 
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WINDOWS 

Windows are the rectangular areas of 
the screen where information appears. 
Windows may be moved and stacked 
like sheets of paper on a desktop , and, 
like a bunch of papers, they may over
lap one another. The metaphor doesn 't 
stop there-you may also flip back and 
forth from one window to another just 
as easily as if you were flipping from 
one sheet of paper to another. All you 
have to do is move the pointer over the 
w indow you want to see, and click ; the 
window pops to the top of the pile . 
Title bar The title bar names the con
tents of the window-or, more often , 
the application that corresponds to the 
window. Move a window by dragging 
its title bar. 
Menu bar If an applica tion has menus , 
the menu names appear on the menu 
bar, right below the title bar. Not all 
windows have menus. 

© (5) 0 

LJ 
BOOKLET 

LJ 
PAPER POSTERS 
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RESUMES SIGNS Area Test Cubism Study •1 • - fiJ 

Letter to Chris Letter to Pat My Schedule MYFILE1 .TXT 
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NOTES.TXT Printer Verificat ... Tetris 
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Menu name Clicking a menu name 
brings down the pull-down menu. 
Control button Double-clicking the 
Control button closes the window . Sin
gle-clicking the Control button disp lays a 
special menu , the Control me nu . 
Express button Clicking the Express 
button displays the Express menu. The 
Express menu contains options for 
switching between running applica
tions , starting new applications , re turn
ing to the Welcome screen , checking 
on documents being printed , setting 
your system preferences , and exiting 
directly to DOS . Very handy. 
Maximize/Restore button Clicking 
the Maximize button enlarges the win
dow to completely fill the screen . The 
window loses its resize borders and 
can no longer be moved or resized , 
and the Maximize button is replaced by 
the Restore button. Click the Restore 
button to return the window to its 
previous size . 

A typical window in GeoWorks 
Pro. The different parts of the 
window are: 
Title bar ( 0) 
Menu bar ((i)) 
Menu name ( (!)) 
Control Button I©) 
Express button ((.D) 

Maximize/Restore button(@) 
Minimize button((;)) 
Resize borders(@) 

Default Scrapbook First Address Book Scroll bar ( Q)) 

New document New drawing 
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Minimize button Clicking the Mini
mize button collapses the window into 
an icon, moving it out of your way 
temporarily . Minimizing an applica
tion's window does not exit the appli
cation or stop it from running, but 
merely makes it small enough so that 
it 's not in your way. Double-clicking 
the icon restores the window (and 
application) to its original size. 
Resize borders Dragging a resize bor
der in any direction resizes the window. 
Scroll bar When the contents of a 
window are larger than the window 
itself, scroll bars appear at the right 
and bottom edges of the window. 
Scroll bars let you scroll the contents 
of the window to see different parts. 

ACTIVATING WINDOWS The active window is 
the window you are currently working 
in. It's also the window in front of all the 
others-no part of the active window is 
underneath another. You can also tell 
which window is active by looking at 
the title bar. If it 's dark , the window is 
active; if it 's gray, the window isn 't. 

To activate a window ... 
Click in the window you wish to 

activate. The best place to click is the 
title bar (since you don 't run the risk of 
accidentally clicking some button within 
the window at the same time), although 
you can click anywhere inside the win
dow. The window moves to the top of 
the pile and its title bar is highlighted. 

If you've run more than one applica
tion, you can switch between them by 
activating their respective windows. If 
the window you want to activate is 
completely obscured by other 
windows, you should move or close 
the windows on top. 

MOVING AND RESIZING WINDOWS By moving 
and resizing windows you can rearrange 
the workspace to suit your needs, the 
way you might arrange your desk by 
putting some papers here and others 
over there. You move a window by 
dragging its title bar. You resize a win
dow by dragging its resize borders. 

To move a window ... 
0 Position the pointer over the title 
bar of the window you wish to move. 
8 Press and hold down the mouse 
button. The pointer changes and a 
rectangular outline of the window 
appears. 

+ 

8 Drag the outline in any direction. 
0 Release the mouse button. The win
dow redraws at the location of the 
outline . 

The easiest way 
to swit<h to 

- -another 
appli<ation is to 
di<k on that 
appli<ation' s 
window. 



To resize a window ... 
0 Pos itio n th e po inte r ove r o n e o f th e 
res ize b o rde rs o n the w indow. The 
po inte r ch anges sh a pe to show you 
w hich e dge o r edges you a re res izing . 
8 Press and ho ld down the mo use but
ton. An outline o f the w indow appea rs . 
8 Drag in any directio n . The o utline 
shrinks o r grows as yo u move the 
po inte r. 

If you drag a h o ri zonta l o r ve rti ca l 
bo rde r, the o utline shrinks o r grows 
ho rizo ntally o r ve rtica lly o nl y. If you 
drag a co rne r bo rd e r, the o utlin e 
shrinks o r grows in bo th dime nsio ns , 
ho rizo ntally and ve rtica lly . 
0 Re lease the mo use butto n . The w in
dow redraws to the s ize o f the o utline . 
Some w indows have a minimum s ize , 
beyond whi ch yo u ca nno t shrink it . If 
yo u try , the w indow w ill auto matically 
bo unce back to its minimum s ize . 

Windows w ith o ut res ize b o rde rs 
(like dia log boxes, o r maximized w in
do w s) ca n 't be res ized . 

MINIMIZING AND MAXIMIZING WINDOWS Win
dows are no rmally res izeable. Some 
times, tho ugh , you wa nt a w indow to 
be as big as possible , so that you ca n fit 
the most info rmatio n in it . Or you want 
it to be as small as poss ible , so that it 's 
out o f the way. With the Maximize and 
Minimize butto ns , you can quickly 
reach these extremes w itho ut hav ing to 
pa instakingly res ize the w indow. 
•Minimizing collapses a w indow to an 

icon . (Minimizing an applicatio n does 
no t exit the applica tio n o r sto p it fro m 
running, but mere ly shrinks it to an 
icon .) 

•Maximizing e nlarges the window to 
fill the whole sc reen. Whe n maxi
mized , a window has no res ize bo r
ders. If you want to resize the win
dow, restore it first . 

I~ 
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To minimize a window ... 
Click the Minimize button . 

Or, choose Minimize from the 
Control menu. 

To maximize a window ... 
Clic k th e Max imi ze butto n. 

Or, choose Maximi ze fro m the 
Contro l menu. O r, do ubl e 
click th e w indow 's titl e -bar. 

To restore a minimized 
window ... 

Do ubl e-click th e w ind ow 's 
icon . 

To restore a maximized window ... 
Click the Resto re butto n , w hich has 

now re placed the Maximize butto n a t the 
uppe r right corne r o f the w indow. Or, 

choose Restore fro m the Con- E , 1; .. 1 

tro l menu . Or simply doubl e- -- "" 
click the w indow 's titl e ba r. 

THE CONTROL BUTTON AND MENU The Contro l 
m en u is a special me nu that spe cifica lly 
g ives you control o ve r windo ws . To see 
the the Contro l menu , click th e Control 
button in th e uppe r-le ft co rne r o f most 
w indows . If you do uble -click th e Con
tro l butto n the curre nt w indow closes. 

He re a re the items on th e Control 
me nu : 
Restore is only available when a win
dow is maximized. It returns the window 
to its previous size so you can move and 
resize it as usual. 
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Move This item is always dimmed and 
unavailable. 
Size This item is always dimmed. 
Minimize collapses the window to an 
icon . 
Maximize enlarges the window to fill 
the entire screen. 
Close closes the window, and if it's an 
application window, also exits the appli
cation. 

SCROLLING WINDOWS When the contents of 
a window cannot fit completely within 
the window itself, scroll bars appear. 
Scroll bars let you scroll the window to 
view more of its contents. You can 
scroll a window to the right, for exam
ple, to see parts of a document located 
beyond the right edge of the window. 
Or you can scroll a window up, to see 
portions of a document located off the 
bottom edge. Scroll bars have several 
controls that allow you to move the 
contents of a window in different ways : 
Scroll arrows Clicking a scroll arrow 
scrolls the window a single step in a 
particular direction. For example, click
ing a down-facing arrow shifts the 
contents of the window up to reveal 
more of the document at the bottom. If 
clicking the down arrow to move the 
window up doesn 't sound completely 
logical, think of it as letting you see 
farther down the document. And the 
other way around with the up arrow 
(and left and right arrows), of course. 
Slider The entire length of the scroll 
bar represents the total length of the 
document , while the length of the slid
er within it represents that part of the 
document that is currently visible with
in the window. The longer the slider, 
the more of the document that 's show
ing . A short slider could mean that your 
document is much larger than the win
dow, or that the window's unusually 
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small, or both. If the slider covers the 
complete length of the scroll bar, the 
whole document is showing. 

In addition to indicating how much 
of the document is showing, the slider 
tells you what part of the document 
appears in the window. If the slider is 
at the bottom of the scroll bar, the 
bottom of the document is showing in 
the window. 

The slider allows you to move freely 
through the document. You can drag 
the slider across the whole scroll bar, 
or move it just a little. Your view of the 
document changes proportionally. 
Paging areas The paging areas on either 
side of the slider represent the portion of 
the document hidden from view. Clicking 
in a paging area scrolls the document 
one window-full at a time. 

To scroll a window in small steps ... 
Click the scroll arrow. The window 
scrolls a small step (usually one line) 
in the opposite direction of the arrow 
(click the down arrow to move the 
document up and reveal another line at 
the bottom of the window) . 

To scroll continuously, press (that is, 
click and hold down the mouse button) 
on the scroll arrow . 

To scroll a full window at a time ... 
Click one of the paging areas to scroll 

the window a window-full at a time. The 
window scrolls in the direction of the 
nearest scroll arrow. In other words, if 
you click the paging area below the 
slider, the document scrolls up to reveal 
more of the document below. And the 
other way around if you click the paging 
area above the slider. 

To scroll continuously a full win
dow at a time , press (hold down) the 
mouse button with the pointer over a 
paging area. 



To scroll directly to a particular 
position ... 
0 Positio n the po inte r ove r the slide r 
in a scroll b a r. 
8 Press and drag the slide r to a new 
pos iti o n . 
8 Re lease. The w indow scrolls to 
match th e pos itio n o f the s lide r. 

WINDOWS WITHIN WINDOWS Windows can 
contain almost anything you see in 
GeoWorks Pro , including othe r windows . 
Fo r instance , in GeoManager you can 
displ ay directories in overlapping win
dows so that each directo ry is re present
ed by a w indow inside the GeoManager 
w indow. You can res ize, maximi ze , and 
move these w indows , but you ca n 't 
minimize them. 

CLOSING WINDOWS Closing a w indow 
re moves the w indow fro m th e screen , 
and oft en exits the applica tion that 
corres ponds to the window as w ell. 

To close a window ... 
Do uble-cli ck the Co ntrol butto n of 

the w indow . The w indow closes . 
Yo u ca n also close a w indow by 

choos ing Close from the w indow 's 
Contro l me nu . 
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MENUS 

A GeoWorks Pro me nu , like its rea l 
wo rld counte rpart , is a lis t o f ite ms
ite ms yo u can po int to and say , "I want 
that ." In GeoWo rks Pro that 's exactly 
w hat you do . You use your mo use to 
first p ull down a me nu and the n choose 
an ite m by po inting to it and cl icking 
w ith the mouse butto n . The diffe re nce 
is that instead o f choosing Chicken 
Dijon o r Meatloa f Flambe , yo u choose 
commands o r optio ns . It 's with these 
co mmands and optio ns that you control 
GeoWo rks Pro appli ca ti ons. 

By choosing a command , yo u initiate 
some sort of action . For instance , choose 
the Save command fro m the File me nu 
and the docume nt you 're working w ith 
is saved . Or choose Print to p roduce a 
copy of your document on the printe r. 
Aside fro m commands , you also find 
options, w hich can be e ithe r on or off. 
O ne option in GeoManager, fo r example , 
is to have it ask you for confirmation 
w hen you de lete a fil e . Whe n the option 
is on (that is, currently in effect) , choos
ing it from the me nu turns it o ff. And 
when it 's off, choosing it turns it o n . 

Eve ry GeoWo rks Pro me nu has its 
own name w hich appea rs o n the appli
ca tio n 's me nu bar. Be nea th each me nu 
name , out of sight until you need it , is 
the me nu itse lf. Since many diffe re nt 
GeoWo rks appli ca ti o ns wo rk in ro ughl y 
the sa me manne r, yo u ' ll no ti ce th at 
most applica tions have simil a r collec
ti o ns of me nu s. Fo r example , every 
a pplica tio n has a File me nu , and 
almost eve ry o ne of these File me nu s 
has the Exit command on it . This kind 
o f consiste ncy ma kes it easy fo r yo u to 
learn how to o pe rate a pplica ti ons in 
GeoWo rks Pro , s ince o nce yo u know 
how to work the me nus in one of 
them , yo u know how to w o rk the same 
menus in all the othe rs, too . 
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Two special menus are the Control 
menu and the Express menu. You 
might not be able to immediately iden
tify them, since they 're represented by 
icons instead of names , and they 're 
located on the title bar, not the menu 
bar like other menus. Yo u pull down 
these two menus by clicking their 
icons, and even though they 're not on 
the menu bar, you use them the same 
way you use regular menus. 

CHOOSING FROM MENUS There are two differ
ent ways to choose from menus. You 
can use the clicking method-click once 
to display a menu and then click again 
to choose an item-or the dragging 
method-click the menu name, and, 
without letting up the mouse button , 
drag to the item you want and release 
the mouse button to choose the item. 

Sometimes items on a menu appear 
dimmed (gray and indistinct) which 
means they aren 't yet available for use. 
When you click these dimmed items , 
nothing happens . Usua lly the items are 
dimmed because conditions aren 't right 

To choose a 
menu item ... 

. .. click the 
menu name ... 
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for them. (For example, the Close com
mand in the File menu is dimmed until 
you actually open something, since 
until you do so there's nothing to 
close .) 

To choose from a menu by clicking ... 
0 On the menu bar, click the name of 
a menu. The menu appears. (If you 
don 't find the item you want, simply 
click the name of another menu, and 
another, until you find the item you 're 
looking for.) 
f) With a menu displayed , click the 
item you want. As long as the item 
isn 't dimmed , this selects the item , and 
the menu closes . If you are just brows
ing , you can close the menu without 
making a choice by clicking anywhere 
off the menu or clicking on the menu 
name again . 

To choose from a menu by 
dragging ... 
0 Position the pointer over the name 
of a menu on the menu bar. 
f) Press and hold down the mouse 
button. The menu appears . If you drag 



the pointer across the different menus 
on the menu bar, as you pass over 
different menu names the correspond
ing menus appear. 
8 Stop at the menu with the item you 
want . 
8 With a menu displayed , drag the 
pointer down the menu without releas
ing the mouse button. Available items 
highlight as the pointer passes over 
them. (Remember, you can 't choose 
dimmed items.) 
0 When the pointer is over the item 
you wish to choose , release the mouse 
button. The item is selected, and the 
menu closes . 

If you are just browsing , you can 
close the menu without making a choice 
by dragging the pointer off the menu 
and then releasing the mouse button. 

CASCADE MENUS Some menu ite ms have a 
right-facing arrow next to them. Choos
ing one of these items reveals another 
menu with additiona l choices. This 
secondary menu is ca ll ed a cascade 
menu. 

You choose items from a cascade 
menu in much the same way as you 
choose from other menus. 

To choose from a cascade menu by 
clicking ... 
0 Click to open a menu in the normal 
fashion . 
f) Click the cascade menu item (the 
item with the right-facing arrow). The 
cascade menu appears . 
8 On the cascade menu , click the item 
you want to choose. The item is selected, 
and the cascade menu closes. 

The border 
command 
and its 
cascade 
menu. 
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To choose from a cascade menu by 
dragging ... 
0 Drag open a menu in the normal 
fashion. 
f) Drag the pointer down the menu to 
highlight the cascade menu item (the 
item with the right-facing arrow). 
8 With the pointer on the cascade 
menu item , drag to the right so that the 
pointer is over the right-facing arrow. 
The cascade menu appears. 
8 Drag the pointer off of the main 
menu and onto the cascade menu. As 
you do this, be sure not to accidentally 
drag onto another cascade menu , or off 
the menu entirely. 
0 Drag the pointe r down the cascade 
me nu to the item you want to choose 
and re lease the mouse button. The 
item is selected , and both menus close. 

If you don 't want to make a choice 
from the cascade menu , drag the point
er back to the first me nu or o ff both 
menus comp letely. 

PINNING MENUS Menus don 't always have 
to disappear each time you make a 
selection. If you want to mak e a se ries 
of se lections from a menu without 
having to pull it down each tim e, you 
can kee p it hanging around , ready for 
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each choice you make. That is, you can 
"pin" a menu to the workspace (the 
way you 'd pin a piece of paper to a 
wall) so that it stays open and ready all 
the time. 

Once you pin a menu , yo u can 
move it around the workspace and 
place it wherever you need it most. 
When you 're finished with it , close the 
pinned menu so it no longer takes up 
space on the screen . 

To pin a menu ... 

If a menu can be 
pinned, it will have a 
little push-pin icon at 
the top (back). Click 
the icon to detach the 
menu and pin it to the 
workspace (front) 

Choose the push-pin item at the top 
of a menu you want to keep open. If 
there's no push-pin , you can 't pin the 
menu open . (The Express menu, for 
example , does n't have one .) 

The menu stays open. A title bar 
(fo r moving the me nu) and Control 
button (for closing it) appear on the 
menu. In fact, the me nu now resem
bles- and behaves like- a very small 
w indow . 

To move a pinned menu ... 
Move a pinned menu as you would 

move a window, by dragging its title 
bar. An outline of the menu moves as 
yo u drag. When you release the mouse 

BASIC TOOLS AND SKILLS 3.14 

button , the menu moves to its new 
position. 

To close (unpin) a menu ... 
Close a pinned menu in the same way 

you would close a window: Double-click 
the Control button in the upper-left cor
ner. The menu unpins and closes . 

KEYBOARD ACCELERATORS To speed up your 
work, some menu items have keyboard 
accelerators. A keyboard accele rator is 
a single keystroke you can use to 
choose a particula r me nu item or com
mand . Using the keyboard accelerator 
is identical to actually pulling down 
the menu and choosing the item. If an 
item has a keyboard accelerator, the 
accelerator appears at the right edge of 
the menu. (For example, in the menu 
at left the accelerator for "Bold" is [9ill 
+[ID.) 

Most keyboard accelerators require 
you to hold down the [9ill key whi le 
pressing another key , but sometimes 
you need to hold down the I Shift I key , 
too. There is a simple notation that 
indicates which keys you should press: 
When a plus ( +) sign separates two 
groups of keys, it means hold down 
the first set of keys while pressing the 
second. For instance, Ctrl+P means 
hold down the [9ill key while pressing 
(£] to choose the command. 

To choose from a menu by using a 
keyboard accelerator ... 

Press the accelerator key combina
tion indicated on the menu. The menu 
item is selected exactly as if you had 
chosen it using the mouse . 



NAVIGATING MENUS WITH THE KEYBOARD While 
you 'd normally use the mouse to navi
gate menus , you can a lso use the key
board. 

Knowing how to navigate menus 
with the keyboard can save you time , 
especially when you 're doing a lot of 
typing-you don 't need to take your 
hands off the keyboard to reach for the 
mouse. 

Navigate through menus using the 
[I] 0 8 G keys or by using mnemon
ics . A mnemonic is a si ngle letter, or 
number, that represents a menu name 
or item . First , use the mnemonic for 
the menu name to pull down the 
menu; then use the item 's mnemonic to 
choose it from the menu. 

To choose from a menu using the 
arrow keys ... 
0 Press and release the~ key . The 
name of the first menu on the menu 
bar is highlighted. 
8 If this highlighted menu isn 't the 
one you want, press the 8 and G 
keys to move left and right from menu 
to menu , highlighting each name as 
yo u go, until the right one is se lected. 
If you keep going past the edge of the 
menu bar, you 'll select the Control and 
Express buttons. Remember, these also 
have menus that you can pull down . 
8 Press the(±] , [Spacebar J, or [ReturnJ 

keys to display the menu for the cur
rently highlighted name. If you decide 
that the command you want is not in 
this menu , and yo u want to try anoth
er, use the 8 and G keys to move 
through the menu names again. 
0 Use the [I] and (±] keys to move up 
and down the menu, highlighting items 
as you go , until you reach the one yo u 
want. 
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If an item has a right-facing arrow 
and leads to a cascade menu , you can 
open the cascade menu by pressing the 
G key. With the cascade menu open , 
press the ~ and (±] keys again to 
move up and down the cascade menu. 
Press the 8 key to close the cascade 
menu and move back to the first menu. 
0 When the item yo u want to choose 
is highlighted , press I Spacebar I . The 
item is selected and the menu closes . 

If you are just browsing, you can 
press the l~I key to close the menu 
without making a choice. 

To choose from menus using 
mnemonics ... 
0 While holding down the ~ key , 
press the key corresponding to the 
underlined letter (the mnemonic) in 
the menu name. For example, hold 

down the ~ key and 
press the [8 key to display 
the file menu. (You 'll 
notice that the menus are 
designed so that each one 

has a unique-though not necessarily 
obvious-mnemonic.) 
8 With a menu open, press the 
mnemonic of the item you wish to 
choose , without pressing the ~ key . 
For examp le , press the [I] key to 
choose the .S.ave item from the a lready 
opened File menu . This se lects the 
item and closes the menu. 
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THE EXPRESS MENU 

The Express menu is another special 
menu that lets you quickly start an 
application, switch between running 
applications, change your system pref
erences , check your printing , return to 
the Welcome screen, or exit directly to 
DOS . The Express menu works just like 
any other menu in GeoWorks Pro. But 
to see it , instead of clicking a menu 
name, you click the Express button . 
The Express button appears only in the 
active window (don 't worry, since 
there 's always one active window , the 
Express menu is always available). 
Here are the items you have to choose 
from in the Express menu: 
Welcome returns you to the Welcome 
screen . 
Running Applications Any applica
tions that are currently running appear in 
the Express menu . Choose one to bring 
the application 's window to the front. 
Startup brings up a cascade menu 
from which you can start any 
GeoWorks Pro application. 
Printer Control Panel opens the 
Printer Control Panel dialog box where 
you can see what documents you have 
currently printing or waiting to print. 
You can also cancel the printing of any 
document . 
System Preferences starts the Prefer
ences application , where you can 
change the look and feel of your sys
tem, as well as let GeoWorks Pro know 
when you add or change any hard
ware. (See the "Preferences" chapter in 
this book for more information about 
this useful application.) 
Exit to DOS shuts down GeoWorks Pro 
and returns you to the DOS prompt. 
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To return to the Welcome screen ... 
0 Click the Express button in the 
active window. The Express menu 
appears. 
8 On the Express menu , click Wel
come. The Welcome screen immediate
ly reappears. 

You may also press the [ill key to 
return to the Welcome screen without 
using the Express menu. 

To exit directly to DOS ... 
0 Click the Express button in the 
active window. The Express menu 
appears. 
8 Choose Exit to DOS . GeoWorks Pro 
shuts down. 

Exiting directly to DOS is a shortcut 
way to exit , without returning to the 
Welcome screen. As when returning to 
the Welcome screen, nothing is lost 
when you exit directly to DOS. 

To switch between running applica
tions ... 

Choose the application 's name from 
the Express menu . The application 's 
windows immediately pop to the top 
(just as though you had clicked them). 

To start an application ... 
0 Choose Startup from the Express 
menu. A cascade menu appears with a 
list of available applications (basically, 
the same applications that are in the 
WORLD directory). 



8 Choose the applica ti on from the 
cascad e me nu . The cascade me nu dis
appea rs and the appli ca tio n sta rts up . 

To monitor your printing ... 
Choose Printe r Co ntrol Pa ne l fro m 

the Express me nu . The Printe r Co ntro l 
Pa ne l a ppea rs. Use it to mo nito r your 
printing and ca nce l docume nts th a t are 
wa iting to print . See "The Printe r Con
tro l Pane l," late r in this chapte r, fo r 
mo re informatio n . 

To change your system 
preferences ... 

Choose Syste m Prefe re nces fro m the 
Express me nu . The Prefe re nces appli
ca ti o n sta rts. (Fo r mo re abo ut th e Pre f
e re nces app lica tio n see the "Pre fe r
e nces" ch apte r in this manu a l. ) 

DIALOG BOXES 

Wheneve r GeoWorks Pro needs mo re 
informati o n fro m you , o r needs to a le rt 
yo u to a problem , a small window 
known as a d ialog box appea rs. 

Some dialog boxes are like w indows
they have a title bar for moving and a 
Control button for closing. You can keep 
these boxes open and switch between 
them and othe r w indows if you want . 
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Two examples of dialog 
boxes containing some 
common elements: 
Default buttonl0) 
Text field 10 ) 
Scrolling list ((!)) 
Radio buttons 10 ) 
Check boxes 10 ) 
Up and down arrows(@ ) 
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Othe r dialog boxes require a 
res po nse befo re yo u ca n continu e . 
Such boxes do no t have a titl e ba r o r a 
Co ntro l button , and the image o f th e 
p o inte r changes to a circl e-and-slash 
symbo l w hen yo u move o uts ide o f the 
box . 

Some boxes eve n use symbols indi 
ca ting th e ir purpose. 

ELEMENTS OF A DIALOG BOX Dialog boxes a re 
asse mbl e d fro m s ta nd ard e le me nts, 
s uch as text fi e lds, radi o butto ns, and 
sc ro ll ing lists. 
Button Every dia log box has butto ns. 
Cli cking a butto n ca uses an ac ti o n to 
occur. If the la be l o n a b utto n is fo l
lowed b y an e llipsis ( .. . ), the n th at 
butto n leads to ano the r dia log box. 

.--~~~~~~~180nlerT..,.~~~~~~~~ 

T!,ph v rtarmel +, 5hedaw v -lloubletlne (4) 
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Some common buttons include those 
marked OK and Cancel. You will see 
others, too , such as Yes, No , Apply, 
Reset, and Close. The function of a 
button is usually self-explanatory. 
•Apply Applies the current settings 

but leaves the dialog box open so 
you can continue to adjust them . 

•Reset Resets the box to its previous 
settings , undoing any changes you 
may have made. 

•Close Closes the box without applying 
the current settings. You can do the 
same thing by double-clicking the Con
trol button , if the dialog box has one. 

•OK Applies the current settings and 
closes the dialog box. 

•Cancel Closes the box without apply
ing the current settings. 

•Yes Answers "yes" to the question 
presented and closes the dialog box. 

•No Answers "no" to the question 
presented and closes the dialog box. 

•Stop Ends the task in progress at the 
next possible stopping point. 

Default button If a button is surround
ed by a thick border, then that button is 
the default button . The default button 
represents the safest or most common 
choice in the dialog box. Pressing the 
!Enter ) key selects the default button. 
Radio buttons Radio buttons always 
come in groups of two or more. Like 
the preset buttons in an old car radio, 

Humber of Copies: I IE I ~ 
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only one of the buttons in a group can 
be on at a time. Clicking a radio button 
turns that item on and turns off any 

others in the 
group. Radio 
buttons 
appear as 
small dia

mond buttons on EGA and VGA moni
tors and small round buttons on 
monochrome monitors . 
Check boxes A check box can be either 
on or off. When the box is highlighted 
(black) the item is on; otherwise, it is off. 

Like flipping a light switch , 
clicking a check box 
switches the box from on 
to off, or from off to on. 
Unlike radio buttons, a 
check box can be turned 

on or off independently from the other 
check boxes in the group. 
Up and down arrows Many items 
have up and down arrows for cycling 
through options or for increasing and 
descreasing a number. Clicking the up 
arrow cycles to the next item or 

increases the 
number. Click
ing the down 

arrow cycles to the previous item or 
decreases the number. Clicking and 
holding down the mouse button on an 
arrow (rather than simply clicking) 

The appearance of the buttons 
is a little bit different on a 
monochrome monitor. 



cycles the item continuously. (Items 
with these arrows are often called 
"spinners ," since clicking the arrows is 
a bit like twisting a knob on a piece of 
equipment.) You can also choose to 
simply type (or edit) the item directly. 
See "Entering and Editing Text, " later 
in this chapter for more information 
about editing text . 
Scrolling list When there is a list of 
options to choose from, these choices 
are provided in a scrolling list. A 
scrolling list is like a miniature win
dow, complete with a scroll bar along 
the right edge. 
Text field Text fields appear in a dia
log box when you need to enter text. 
You can edit the text in a text field just 
as you edit text anywhere e lse (see 
"Entering and Editing Text ," later in 
this chapter). 

RESPONDING TO A DIALOG BOX To respond to a 
dialog box you set the different options 
and fill in the text fields provided. Then, 
you click one of the buttons at the bot
tom of the dialog box to apply the set
tings and continue. 

UNITS OF MEASURE 

Units Abbreviation Exam~le 
inches in or" 1" 
Eicas Ei 6 Ei 
EOints Et 72 Et (1 inch) 
centimeters cm 2.54 cm 
millimeters mm 254 mm 
Ciceros ci 5.63 ci 
EuroEean Eoints eE 67.57 eE 
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To respond to a dialog box ... 
0 Set any options in the dialog box by 
clicking to turn them on or off. 
•To select an item from a list, click the 

item you wish to se lect. To change 
your selection, simply click another 
item. You may need to scroll the list 
to see more choices . Refer to "Win
dows" earlier in this chapter for more 
information on scrolling. 

•To enter and edit text in a text field , 
click in the text field you want to 
edit . The text cursor appears where 
you click. Now type your text. Char
acters appear at the text cursor. Press 
the I Backspace I key to delete characters 
if you make a mistake . Refer to 
"Entering and Editing Text" in this 
chapter for more information on text 
editing techniques. 

8 Click one of the buttons at the bot
tom of the box to proceed. 

Most dialog boxes have a default 
button, identified by a thick border. 
Pressing the I Enter) key is the same as 
clicking this button. If the dialog box 
has a Cancel button , pressing the [~) 
key is the same as clicking this button . 

ENTERING MEASUREMENTS In some dialog 
boxes you can enter units of measure. 
The default is usually inches, but you 
can use any of the following units as 
long as you type the correct abbrevia
tion. (See the chart be low.) 

RESPONDING TO A DIALOG BOX WITH THE KEYBOARD 
You can also use the keyboard to select 
options in a dialog box. When respond
ing with the keyboard, you move a 
dotted selection cursor to highlight 
different items and turn them on or off. 
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To respond to a dialog box using 
the keyboard ... 
0 Use the following techniques to 
move the selection cursor and set 
options in the dialog box: 
•If a dialog box has more than one 

group of options, press the~ or 
I Shift I + ~ keys to move forward 
and backward between the groups. 
Once the selection cursor is in a 
group, press the [!] [±] [!] [±] 
keys to move from item to item. 

•To jump quickly within a dialog box, 
press the mnemonic for one of the 
items . (As in menus , a mnemonic is a 
single character or number marked by 
an underline. To jump directly to an 
item titled swle, for example, you'd 
simply press the ITJ key) . If you are 
currently in a text field (where press
ing ITJ would just type a "T" in the 
field) you need to hold down the 0!] 
key while pressing the mnemonic. 

•To switch an item from on to off or 
from off to on, move the selection 
cursor to the item and press the 
I Spacebar J key . 

8 When you finish setting options, 
select one of the buttons at the bottom 
of the box to proceed. Use the follow
ing techniques: 
•Most dialog boxes have a default 

button, which is identified by a thick 
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The elements of a file 
selector: 
List window ((i)) 

border. To select this button press the 
I Enter) key. 

•You can press the~ or !Shift)+~ 
keys until the selection cursor sur
rounds the proper button, and then 
press the I Enter I or I Spacebar I key. 

•You can press the mnemonic of the 
button you want to select. If you are 
editing in a text field , you need to 
hold down the 0!] key while pressing 
the mnemonic. 

•If the dialog box has a Cancel button , 
pressing the ~ key is the same as 
clicking this button. 

FILE SELECTORS 

GeoWorks Pro usually uses a file 
selector to ask you where you want to 
put a document or where it can find a 
document. The file selector helps you 
negotiate through a sometimes confusing 
maze of directories and subdirectories to 
find a specific directory or file . Once you 
find it , you click a button to open the 
file-or copy it, or save it, or whatever. 

ELEMENTS OF A FILE SELECTOR All file selectors 
have these elements in common: 
List window Files and directories 
available for selection appear in this 

Name of current disk ( (i)) 
Current pathname ( 0)) 
Change disk button ((t)) 
Parent directory button ( (5)) 
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window. Use the scroll bar to see more 
of the list. Click a name in the list to 
select it, whether it 's a file or a directo
ry. Double-clicking a directory opens it 
and shows you the files inside , while 
double-clicking a file selects the file 
and closes the file selector. 

Important Note: Files only appear in 
the list window when the file selector is 
being used to open, load, or otherwise 
bring some file into an application. If 
you're using it to save a file out to a 
disk (Save, Save As, Export , etc.) only 
directories will appear in the list. 
Name of current disk The volume 
name of the disk whose directories are 
being shown appears at the top of the 
file list. If the disk doesn 't have a vol
ume name-many floppy disks don 't
its name is shown as "[Untitled]. " 
Current pathname The pathname of 
the current directory appears above the 
list window. 
Change Disk button Click the Change 
Disk button to switch to another disk 
drive. You 'll see all the available disk 
drive letters in the li st window. Dou
ble-click the one you want. 
Parent Directory button Click the 
Parent Directory button to close the 
current directory and display the con
tents of the directory that contains it
the "parent" directory-one level up. 
This button dims when you reach the 
root directory , since this has no parent 
directory. 

MOVING THROUGH DIRECTORIES 

To open a directory in a file list ... 
Double-click the name of the direc

tory you wish to open. (Small folder 
icons appear next to directory names 
in the file list.) 
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To close the current directory ... 
Click the Parent Directory but

ton. The current directory closes 
and the contents of its parent 
directory (the directory which 
contains this one within it) appear 
in the file list window. 

To display the contents of a 
different disk ... 
0 Click the Change Disk button locat
ed above the file list. A list of available 
disk drives appears in the list window. 

Disk drives are listed by drive 
letter. Floppy drives are A and B 

a? · on most computers. Your hard 
. . . ·· disk , hard disk partitions , and 

other disk devices appear as other 
letters , typically starting at C and pro
ceeding through the alphabet. 
8 To display the contents of a floppy 
disk , make sure that it 's in the correct 
floppy disk drive . 
E) Double-click the letter of the drive 
you wish to use. The contents of the 
disk display in the file list window. 

TAKING ACTION Once you find the directo
ry or file you 're looking for , click one 
of the buttons on the bottom of the file 
selector. If you 're saving a file , use the 
file selector to find and open the direc
tory you want to save the file into , then 
click Save . (Don 't be put off if the list 
window doesn 't show any files within 
the directory-for a Save, it only shows 
directories, not files.) If you 're opening 
a file , use the file selector to find the 
proper directory and file. Then, click to 
select the name of the file and click 
Open (or, alternatively, double-click on 
the name of the file in the list window). 

Keep in mind , though , that when you 
save a file it will be saved into the direc
tory indicated next to the parent directo
ry button , not the directory that is high-
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lighted in the file selector. It's always a 
good idea to pay close attention to 
where your files are being saved, so 
you can retrieve them easily later. 

SELECTING ITEMS (IN FILE 
CABINET, GEOMANAGER, AND 
GEODRAW) 

Many actions require that you first 
select an item in a window and then 
choose a command to act upon it. The 
act of selecting doesn 't in itself change 
the item; it's merely how you identify 
which item you want to work with. 

For example, to duplicate a file in 
GeoManager (or the File Cabinet), first 
select the file or files you wish to dupli
cate and then choose the Duplicate 
command from the File menu . 

Another example: To change the pat
tern or color of a shape in Geo Draw, 
first select the shape you want to change 
and then choose the pattern and color 
you want. The selected shape changes to 
reflect your choices. 

Note the order of events: First you 
select the item, then you choose the 
command. Select, then do. 

When you select 
an item, it becomes 
highlighted on the 
screen . Different 
applications have 
different ways of 
highlighting items . 
The most common 
method is to reverse 
the colors so that 
white becomes black, 
and vice versa. Some 
applications, such as 
those for drawing 
and painting, have 

• 
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• • When you select 
an item in 
GeoDraw, its 
handles appear. 

• 

• 
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other methods of highlighting. When 
an item is selected in GeoDraw, for 
instance, its handles appear. No matter 
what, though, selected items and unse
lected items are visually distinct. 

You can select a single item or you 
can select a group of items-selecting 
a group of items lets you change many 
items with one command. You can also 
select text, but you need to use differ
ent techniques to do so. See "Entering 
and Editing Text" later in this chapter 
for more information on selecting text. 

SELECTING A SINGLE ITEM Most of the time 
you only need to work with one item 
at a time, and so you only need to 
select a single item. 

To select a single item ... 
Click the item in the window. The 

item is highlighted to indicate the 
selection. If you accidentally select the 
wrong item, click another item to 
change the selection. (If the item you 
click won't highlight, it may not be 
selectable.) 

To deselect a single item ... 
Do one of the following: 

•Click a different item. The new item 
is selected and the original item is 
deselected . 

•Click an area of the window where 
no item appears. The original item is 
deselected. 

SELECTING A GROUP OF ITEMS By selecting a 
group of items you can work on many 
items at once. If you select a group of 
items and then choose a command, the 
command affects all items in the group. 

For example, if you 're using Geo
Manager and you want to duplicate 
more than one file, you can select all 



the files as a group and then choose 
the Duplicate command from the File 
menu. GeoManager duplicates each file 
in the group. 

There are many ways to select a 
group of items. You can select the 
items one at a time or you can select 
them by specifying a range. Once you 
have a group of items se lected , you 
can adjust or extend the selection to 
include items that are not yet selected. 
Or you can de-select certain ones to 
remove them from the group selection. 

To select a group of items one at a 
time ... 
0 Click the first item. The item is 
highlighted to indicate the selection . 
8 Hold down the @I.ill key and the 
click additional items you wish to add 
to the group. The items highlight as 
you add them to the group selection. If 
you make a mistake selecting an item 
and wish to deselect it , simply click 
the item again without releasing the 
@I.ill key . 
8 When finished selecting items , 
release the @I.ill key . 

To select a group of items by drag
ging ... 
0 Position the pointer near-but not 
on-the first item you want to select . 
8 Press and hold down the left mouse 
button while dragging the mouse. The 
outline of a box follows the pointer, 
changing size as you drag the mouse . 
Drag the outline so that it encloses the 
items you want to select. 
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8 When the outline of the box sur
rounds the items you want to select, 
release the mouse button. All items 
contained in the box are highlighted to 
indicate the selection. 

To select a group of items between 
two points ... 
0 Click the first item . The item is 
highlighted to indicate the selection. 
This is the first point. 
8 Hold down the I Shift I key and click 
another item. This is the second point. 
All items between the two points become 
selected. If you make a mistake selecting 
the item for the second point, click 
another item while holding down the 
I Shift I key. This changes the second point , 
thus selecting an entirely new group. 

To start over, release the I Shift I key 
and begin a new selection. 

To add additional items to a 
group ... 
0 With the @I.ill key held down , select 
items in the normal manner: Click an 
item to add it to the group, or drag to 
add a range of items . Items highlight to 
show they 're selected. 
8 When you finish selecting, release 
the @!ill key. 

You may repeat this process to add 
as many items to the group as you 
desire. Just make sure that you hold 
down the @I.ill key as you select the 
first item. 

To subtract items from a group ... 
0 With the @I.ill key held down , do 
one of the following: 
•Click a selected item to subtract it from 

the group. The item is deselected . 
•Drag over a range of selected items to 

remove the range of items from the 
group. The items in the range are 
deselected . 
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Once items are deselected, they are 
no longer part of the group . 
f) When you finish, release the @!ill key. 

You may repeat this process to 
remove as many items from the group 
as you desire. 

To select multiple ranges ... 
0 Select the first range of items in the 
normal manner, either by dragging or 
using some other method . 
f) With the @!ill key held down , select 
another range. Repeat this step as 
many times as you like to select addi
tional ranges. 
8 Release the @!ill key. 

To deselect a group of items ... 
Click in any area of the window 

where no item appears. You should not 
hold down any keys while doing this. 
The group of items is deselected. 

You can also click to select a single 
item (don 't hold down the @!ill or I Shift I 
key). The single item is selected, dese
lecting all the other items in the process. 

ENTERING AND EDITING TEXT 

Nearly every GeoWorks Pro applica
tion allows (if not requires) you to enter 
and edit text at some point. For some, 
like GeoWrite, this is their raison d 'etre. 

The techniques for entering and edit
ing text are the same in all applications. 
So once you learn to edit text in 
GeoWrite, you'll be able to edit text in 
GeoDraw, GeoDex, and GeoPlanner, too. 

THE TEXT CURSOR When you click in a text 
box to enter and edit text you'll notice 
a flashing text cursor. This little flash
ing line marks your insertion point-
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the place where new characters appear 
as you type on the keyboard. 

To position the text cursor ... 
Click anywhere in the text . The text 

cursor moves to where you click. (The 
cursor will always sit between charac
ters , though.) 

To enter characters ... 
Type on the keyboard. Characters 

appear at the location of the text cur
sor. 
•Press the I Backspace) key to delete char

acters to the left of the text cursor, 
one at a time. 

•Press the ~ key to delete characters 
to the right of the text cursor, one at 
a time. 

•Click to reposition the text cursor. 
You can also reposition the text cursor 
using the [!J (±] [B l±] keys to move it 
one character or line (depending on 
the direction) at a time. 

SELECTING TEXT Selecting text is a way of 
specifying a particular range of text 
you want to change as a whole . When 
you select a range of text, selected 
characters temporarily reverse their 
colors: Black becomes white, and 
white becomes black. 

The simplest way to select a range of 
text is to drag over the characters you 
want to select. But there are other ways 
of selecting text, including ways to 
quickly select words, lines, paragraphs, 
sometimes even whole pages at a time. 

To select a range of text by drag
ging ... 
0 Position the pointer in front of the 
first character you want to select. 
f) Press and hold down the mouse 
button while dragging across the text 
you want to select. Text is highlighted 



as you drag the pointer. Drag right , 
left, up , or down-no matter where 
you drag , the only text highlighted is 
that between your starting point and 
your current pos ition. 
f) When the range you want to se lect 
is highlighted , release the mouse but
ton. The text remains se lected. 

To select a range between two 
points ... 
0 Click to place the text cursor to the 
left of the first character you want to 
select. (Or to the right of the last char
acter you want to se lect.) 
f) Hold down the I Shift I key and click 
at the point where you want to extend 
the range. Text between the text cursor 
and your current position is selected. If 
you make a mistake in selecting the 
range , hold down the I Shift I key and 
click somewhere else . The selection 
adjusts to this new position . 

To select words quickly ... 
Double-click a word to select it. 
To select a range of words , start a 

double-click , but don 't release after the 
second click . (That 's click , release , 
click, and hold.) Instead , keep the 
mouse button pressed and drag in any 
direction . As you drag , whole words 
(instead of jus t single characters like 
before) are highlighted . You can a lso 
hold down the [Shift I key and click to 
extend the range of the word se lection. 

To select lines quickly ... 
Triple-click anywhere over a line to 

select that line . 
To select a range of lines , start a 

triple-click , but don ' t release after the 
third click. Instead, keep the mouse 
button pressed and drag up or down. 
Entire lines are highlighted as you 
drag. You can also hold down the 
I Shift I key and click to extend the 
range of the line se lection. 

To select larger units ... 
In the same way that you double

click to select words and triple-click to 
select lines, you can quadruple-click 
(four times) and quintu pie-click (five 
times) to select paragraphs and entire 
pages, respectively. Each successive 
click se lects a larger unit of text. 

As with words and lines, you can 
extend the se lection by dragging 
instead of releasing after the last 
click. Also, you can hold down the 
I Shift I key and click to extend the 
se lection in the larger units. 

To adjust a range ... 
Once you have se lected a range of 

text, you can adjust the range to 
include more or less text. 

To adjust the range , hold down the 
I Shift I key and click to where you want 
the range to end. The selection changes. 

If you hold down the I Shift I key and 
press the [!:] (±] [B G keys, you can 

\ 
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adjust the range a character or line at a 
time using the keyboard. See "Key
board Editing" later in this chapter for 
more information. 

DELETING AND REPLACING TEXT 

To delete a range of text ... 
0 Select the range of text you wish to 
delete. 
8 Press the ~ or I Backspace I key. The 
selected range is erased. 

To replace a range of text ... 
0 Select the range of text you wish to 
replace. 
8 Type your new text. The selected 
range is completely replaced by the 
characters you type. 

KEYBOARD EDITING As you become more 
proficient editing text, you 'll probably 
want to start editing mostly with the 
keyboard so you don 't have to reach 
for the mouse. 
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EDITING WITH THE 
KEYBOARD 

Moving the text cursor 
A character/line in any direction 

lil 0 8 G 
One word backward 
@!ill+ 8 
One word forward 
@!ill+ G 
One paragraph backward 
@!ill +[I] 

One paragraph forward 
©ill+ 0 
To beginning of line 
!Home) 

To end of line 
!End ) 

To beginning of text 
@!ill + I Home J 

To end of text 
@!ill+ [End) 

Selecting Text 
Select left , right, up , down 
[Shift ) + 8 G [I] 0 
Select to beginning of word 
I Shift I @!ill + 8 
Select to end of word 
I Shift I @!ill + G 
Select whole word 
@!ill + [ Spacebar J 

Select to beginning of line 
[Shift)+ !Home) 

Select to end of line 
[Shlill + I End J 

Select whole line 
I Home I, then [Shlill + [End] 
Select to beginning of paragraph 
I Shift I @!ill + [I] 

Select to end of paragraph 
I Shift I @!ill + 0 
Select whole paragraph 
[CB) +[I] , then I Shift I @!ill + 0 
Select to beginning of column/ page 
I Shift J @!ill + [Home J 



Selec t to e nd of co lumn/ page 
[Shift I ©.ill + [End) 
Selec t w ho le column/ page 
©_ill + I Home J, then I Shift J ©_ill + [End J 

Adjusting a Text Selection 
Adjust se lecti o n in any direction 
(S§l + (!J 0 8 G 
Adju st to previo us word 
(S§l ©.ill + 8 
Adju st to next word 
(S§l ©.ill + G 
Adju st to beginning of line 
(S§l + I Home J 

Adju st to e nd of line 
(S§l + [@) 
Adju st to beginning o f pa ragraph 
(S§l ©ill + (!] 
Adjust to end of pa ragraph 
(S§l (C@ + 0 
Adju st to beg inning of co lumn/ page 
(S§l [CW) + [Home J 

Adju st to end of column/ page 
[Shift J ©_ill + [End J 

Deleting Text 
De le te characte r to right 

~ 
De le te cha rac te r to left 
I Backspace J 

De le te to e nd of word 
@@ + ~ 
Dele te to beginning o f word 
@ED + [Backspace J 

De le te to end of line 
(S§l ©ill + ~ 
Dele te to beginning o f line 
[ Shift J @ED + [Backspace J 

De le te se lec tio n 
~ o r [Backspace J 
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OVERTYPING AND INSERTING Normally when 
yo u type, characters appear at the 
position of the text cursor and existing 
characte rs move to the right to make 
room . This is called insert mode 
because new characters are inserted at 
th e cursor position. 

There is another mode, ca lled over
typ e m od e, where characte rs you type 
run right ove r charac te rs to th e right , 
like a typewrite r, ra the r than pushing 
th em ove r. In insert mode the cursor is 
a thin blinking line that appe ars 
be tween cha racte rs, w he reas in over
type mo de it 's thicke r and it selects the 
le tte r th at you 'll ove rtype. 

To switch between insert and over
type mode ... 

Press the ~ key . Text editing switch
es from insert mode to overtype mode or 
vice ve rsa. The text cursor changes to 
indica te which mode you 're in . 

If no thing happe ns w he n you press 
the insert key, inse rt mode may be 
disa ble d in the Look & Feel option of 
Prefe re nces. (See the "Prefe re nces" 
chapte r in this manual. ) 

SPECIAL CHARACTERS One way to give your 
docume nt a profess io na lly typeset look 
is to use the spe cia l cha racte rs avail
able to you w ith GeoWo rks Pro. As 
examples, use bull e ts ( • ) to set o ff 
important paragraphs, put a copyright 
o n your work (©), o r even add accent
ed cha racte rs to your resume. For a 
comple te lis t of sp ecia l symbols and 
how to type them , flip to the Appendix 
in this guide. 
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CUTTING AND PASTING 

Cutting and pasting with GeoWorks 
Pro is like cutting and pasting with 
scissors and glue, just not as messy. In 
GeoWorks Pro, both text and graphics 
can be cut from one place and pasted 
in another, in effect moving them. You 
can move items in the same document, 
across documents , even across applica
tions. And anything you can cut you 
can also copy-that is, leave the origi
nal item intact and in place whi le you 
paste a copy of it in its new p lace . 

THE CLIPBOARD When you cut or copy 
something, it 's placed on the clipboard 
(a temporary holding place) ready for 
you to paste where you please. That 
destination can be the same document 
or another document-or even a docu
ment created in a completely different 
application. The clipboard can only hold 
one thing at a time, but it can hold it for 
a long time; items placed on the clip
board will stay there (and can be pasted 
into a document more than once) until 
you cut or copy something else. 

THE EDIT MENU Most cutting, copying, and 
pasting is done through the Edit menu 
and these commands: 
Cut The Cut command removes the 
selected text or graphics from the cur
rent document and places it onto the 
clipboard. 
Copy The Copy command places a 
copy of the selected text or graphics 
onto the clipboard, leaving the original 
selection intact. 
Paste The Paste command copies the 
contents of the clipboard into the cu r
rent document. If you are pasting into 
text, the contents are inserted at the 
text cursor. 
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To move text or graphics using the 
clipboard ... 
0 Select the text or graphics you want 
to move. 
f) Choose Cut from the Edit menu. 
The selected scrap is removed from the 
document and placed on the clipboard. 
8 Pick an insertion point where the 
scrap will be placed. This could be at 
another point in the same document , or 
in a different document , even in an 
entirely different application (you could, 
for example, cut a bit of text from 
GeoWrite and paste it to GeoDraw) . 
0 Choose Paste from the Edit menu. 
The scrap is pasted at the insertion 
point. If you like , choose Paste repeat
edly to paste additional copies. 

To copy text or graphics between 
two documents ... 
0 Select the text or graphics you want 
to copy. 
f) Choose Copy from the Edit menu . 
The selected scrap is copied from the 
document to the clipboard. 
8 Pick an insertion point where the 
scrap wil l be placed. This could be at 
another point in the same document , or 
in a different document, even in an 
entirely different application (you cou ld, 
for example, copy some text from 
GeoWrite and paste it to GeoDraw) . 



0 Choose Paste from the Edit menu. 
The scrap is pasted at the insertion 
point. If you like, choose Paste repeat
edly to paste additional copies . 

QUICK MOVE AND QUICK COPY WITH TEXT If you 
want to swiftly move or copy text 
between two documents (or even with
in the same document), use the Quick 
Move and Quick Copy features . Neither 
Quick Move nor Quick Copy use the 
clipboard , so the scrap on the clip
board remain intact. 

To Quick Copy text ... 
0 Select the text you want 
to Quick Copy. 
8 Position the pointer 
over the selected text. 
8 Press and hold down 
the right mouse button. 
The pointer changes to a Quick Copy 
pointer. 
0 With the right mouse button still 
held down, position the pointer where 
you want to copy the text. 
0 Release the right mouse button. A 
copy of the selected text appears at the 
position of the pointer. If the text 
doesn 't copy, then you positioned the 
pointer over an area of the screen that 
won 't accept Quick Copied text. 

To cancel a Quick Copy, position the 
pointer back over the original selection 
and release the right mouse button. 

To Quick Move text ... 
0 Select the text you want 
to Quick Move . 
8 Position the pointer 
over the selected text. 
8 Hold down the @TI key 
while pressing and holding 
down the right mouse button. The point
er changes to a Quick Move pointer. 

The Quick Copy 
pointer. 

The Quick Move 
pointer. 
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0 With the @TI key and the right 
mouse button stil l held down , position 
the pointer where you want to move 
the text. 
0 Release the right mouse button 
first, then the @TI key. The selected 
text moves to the position of the 
pointer. If the text doesn't move , then 
you positioned the pointer over an 
area of the screen that won 't accept 
Quick Move text . 

To cancel a Quick Move , position 
the pointer over the original selection, 
then release the right mouse button 
and the @TI key. 

WORKING WITH APPLICATIONS 

Before you can do anything with an 
application, you first need to start it
in much the same way that you can 't 
drive a car until you start it. Starting an 
application loads it into memory and 
opens its window. Once the applica
tion is started , you can work with its 
documents. When you are finished 
using an application, exit it , which 
closes its window and removes it from 
memory. 

You can start as many applications 
as you want (there is a limit , but it 's 
pretty high and you 're not liable to run 
into it during the course of normal 
operation), and you can easily switch 
between them . However, because every 
application you start takes up some 
precious memory in your computer, it 's 
a good idea to only start applications 
you think you're going to use immedi
ately. If you start too many applica
tions, and your computer seems slug
gish, you should exit a few of them to 
free up some memory. 
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STARTING AN APPLICATION You can start an 
application from the GeoManager win
dow by opening the actual application 
file or by opening one of its document 
files. Since, in the File Cabinet, you 
never actually see an application's file, 
you can only start an application by 
opening one of its documents . (In the 
Advanced Workspace, you can also 
start an application from the Express 
menu.) 

To start an application by opening 
its file (Advanced Workspace) ... 

In GeoManager, double-click 
the application icon (usually found 
in the WORLD directory) to select 
and open the application in one 
quick step. -••• 
To start an application by opening 
one of its documents ... 

In GeoManager or the File Cabi
net , double-click the document 
icon. The corresponding application 
starts and automatically opens the 
document (i.e., GeoWrite starts when 
you double-click a GeoWrite document). 

-iWIMIM 
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To start an application using the 
Express menu (Advanced Work
space only) ... 
0 Choose Startup from the Express 
menu. A cascade menu appears , show
ing all the available applications. 
f) On the cascade menu, click the 
name of the application you wish to 
open. The application loads from disk 
and its window opens. 

SWITCHING BETWEEN APPLICATIONS You can 
start as many applications as you want 
in the Professional Workspace. When 
you start a new application, its window 
appears on the screen and its name is 
added to the Express menu. You can 
then switch between running applica
tions by clicking their respective win
dows or by choosing a name from the 
Express menu. 

To switch between running applica
tions ... 

Do one of the following: 
•Click the window of the application 

you wish to use. 
•Choose an application from those 

listed at the top of the Express menu . 
The application's window comes to 

the front , making it the active window. 

To switch between 
r11nning applications, 
simply click the 
wil1dow of the 
appllcatio1 you wish 
to use, 11d it will 
become active. 



EXITING AN APPLICATION You exit an applica
tion when you finish working with it. 
Exiting an application removes the 
application from memory and closes its 
window . 

To exit an application ... 
Do one of the following: 

•Choose Exit from the File menu of the 
application. 

•Double-click the Control but
ton in the upper left corner of 
the application's window. 

The application closes its 
window and removes itself 
from memory. If you've made changes 
to any open documents , the applica
tion first asks you if you wish to save 
the changes before exiting. 

OPENING AND CLOSING 
DOCUMENTS 

To work with a document, you must 
first open it . There are two ways to do 
this: You can either start the document's 
application and use its File menu, or you 
can open the document directly (from 
GeoManager or the File Cabinet) , which 
automatically starts the application. 
Either way, two things happen: the 
application is started, and the document 
is opened. When you work with multiple 
documents (discussed later) you usually 
open them from within the application. 
On the other hand, in the File Cabinet 
you usually open a document directly by 
double-clicking its icon . 

As important as opening a document 
is closing it when you 're done. This 
gets it off the screen and out of your 
way and frees up valuable computer 

Use the file 
selector to open 
documents that 
are on different 
directories or 
drives. 
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memory for other work you want to 
do. Perhaps most importantly, it forces 
you to save the work you 've done, 
before it can be inadvertantly erased. 

To create a new, untitled 
document ... 

With the application started, choose 
New from the File menu. A new , unti
tled document appears. 

Since many applications automatical
ly open a new , untitled document 
when you start them, it may be easiest 
to just start the application when you 
want to create a new document. 
Note: This shortcut does not work in the File Cabinet where 
you see no applications. In this case, just open one of the 
"blank" documents provided (the ones actually named 
something like "Blank Document"). Some applications, such 
as GeoDex and GeoPlanner, open default documents when 
started in this manner, instead of creating new ones. 

To open a document from within an 
application ... 
0 Choose Open from the File menu. A 
file selector appears, listing the docu
ments you can open with the current 
application. 
e If you wish to open a document that 
is in a different directory or on a differ
ent disk drive , use the file selector to 
change directories or disk drives first. 
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E) When you see the document you 
wish to open, click to select its name 
in the list window of the file selector. 
0 Click Open. The dialog box goes 
away and the selected document opens. 

You may also double-click the name 
of the document in the file list to select 
and open the document in a single step. 

To open a document from within 
GeoManager or the File Cabinet ... 
0 With the GeoManager or File Cabinet 
windows displayed, find the document 
you wish to open. (For more about 
moving through directories in GeoMan
ager or the File Cabinet , see their 
respective chapters in this manual.) 
8 Double-click the document. The cor
responding application starts and auto
matically opens the selected document. 

To work on a copy of a document. .. 
0 Open a document in the normal 
manner. 
8 Choose Save As from the File menu. 
The Save As dialog box appears. 
8 Type a name for the new copy of 
the document. 
0 Click Save or press the !Return) key. 
An exact copy of the document is cre
ated and appears ready for editing. The 
original document is left unchanged. 

Another way to create a copy of the 
document is to use the Duplicate com
mand in either the Fi le Cabinet or Geo
Manager. 
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After you select 
Save As from the 
File menu, type a 
name for the 
new copy of 
your document. 
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To close a document when you are 
finished working with it ... 

Choose Close from the File menu. 
The document closes. 

If you've made changes to the docu
ment , a dialog box first appears asking 
if you wish to save your changes. Fol
low the directions in the dialog box if 
necessary. If you don 't save your 
changes when you close the document , 
the changes are lost forever-so think 
carefu lly before answering No! 

Another way to close a document is 
by exiting the app li cation. If you have 
any unsaved changes , the application 
automatically asks you if would like to 
save the changes before exiting. 

WORKING WITH MULTIPLE DOCU
MENTS 

Some appli cations let you work with 
more than one document at a time, 
making it easy to move text and graph
ics between documents. Every docu
ment appears in its own little window 
within the application window. If you 
opened three documents within 
GeoWrite, for instance, the GeoWrite 
window wou ld have three li tt le win
dows (that look and behave almost 
exactly like regular windows) within it. 

Normally app lications only show 
one document window at a time-even 
if many documents are in fact open at 
the moment. This is called full-sized 
window mode, a lthough a better name 
for it might be invisible window mode, 
since you can 't tell by looking at the 
GeoWrite w indow that there 's actually a 
separate little document window inside 
it; it just looks like a regular GeoWrite 
window with a document open . 



Even if you can't see them, though, 
the individual document windows are 
still there , as you can see by pulling 
down the Window menu. (You'll see 
each document identified by nam .e). 
The only way to switch between win
dows in full-sized mode is via the Win
dow menu. 

The Window menu is also useful for 
switching to overlapping view, in 
which each document is plainly visible 
as a little window within the applica
tion window. These little document 
windows are both resizeable and 
moveable-you can shift windows 
around to see others underneath , or 
size them to fit neatly side by side. 
One example of this is when you 
switch to overlapping view in GeoMan
ager. Each directory becomes a little 
window inside the larger GeoManager 
window. You can then position two 
windows side by side and move files 
between them . 

To open multiple documents ... 
While in the application, use the 

Open command on the File menu to 
open each document you want to work 
with , without closing the documents 
a lready open . (If the Open command is 
dimmed, then the application simply 
cannot open any more documents .) 

Remember, since applications nor
mally operate in full-sized mode , you'll 
only see one window at a time. Choose 
Overlapping from the Window menu to 
see all the document windows at once. 

Also note that you must open the 
document with the Open command-if 
you double-click the document 's icon 
in the GeoManager window, something 
very different happens: A second appli
cation starts. So , if you double-clicked 
a second GeoWrite document, say, a 
second GeoWrite would start. (And if 
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you looked in the Express menu, you 'd 
see two entries for GeoWrite.) 

To work with documents as over
lapping windows ... 

Choose Overlapping from the Win
dow menu. All the open documents 
become overlapping windows inside 
the application window . 

When working with documents as 
overlapping windows , they behave 
much like any other kind of window
they can be moved, resized, and activat
ed in the same way as application win
dows. The only difference is that docu 
ment windows cannot be moved beyond 
the borders of the application window. 

To switch back to full-sized docu
ment windows ... 

Use one of the following methods: 
• Choose Full-Sized from the Window 

menu . 
•Click the Maximize button on any one 

of the overlapping windows. 
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To switch between open 
documents ... 

If you are in full-sized mode, choose 
the name of the document from the 
Window menu. 

If you are in overlapping mode , 
either click in the window of the docu
ment you want to use or choose the 
name of the document from the Win
dow menu. 

To close a document window ... 
When working in either full -s ized or 

overlapping mode , activate the window 
of the document you wish to close , 
and choose Close from the File menu. 
The window closes . 

When working with overlapping 
windows, however, you can also dou
ble-click the Control button on the 
document window. Or s ingle-click the 
Control button , then choose Close from 
the Control menu that appears. 

THE WINDOW MENU Most applications have a 
window menu, which allows you to 
move between pages , documents , or 
directories (depending on the applica
tion). For instance, in GeoWrite you can 
use the Window menu to move through 
pages of a document and even between 
different documents. In GeoManager, 
you can hop between open directories . 
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The Window menu also allows you 
to change between overlapping and 
full-sized windows. While each appli
cation has a unique set of commands 
in its Window menu, there are some 
traits that are common to all: 
Overlapping changes to overlapping 
windows. The little windows can then be 
resized and moved to be side by side. 
Full-sized changes to full-sized win
dows . The top window grows to com
pletely fill the application window
which means that , by definition , you 
can only see one document window at 
a time. 

Also, each Window menu lists , at 
the bottom, each open window, even if 
the window isn 't currently visible (as is 
the case when you 're working in full
sized mode). 

SAVING A DOCUMENT 

Until saved, the work that you do is 
only temporary . If the electricity were 
to s uddenly go out, the computer 
would forget all the work you 've done. 
(The same would happen if you turned 
your computer off, too .) An important 
part of your work routine, then , is 
saving your work. When you save your 
work, you copy it on to your hard 
disk , where it remains intact even after 
the power has been turned off. In 
other words, the saved information is 
permanent. (This saved information 
becomes a document.) 

That doesn 't mean you need to save 
your work after every little change, 
though. GeoWorks Pro has a special safe
guard feature that periodically copies 
your work to disk and keeps it safe in 
case of a power outage or other mishap. 
Additionally, if you've made some 



changes you don 't want to keep , you can 
get rid of them and go back to the last 
saved version of a document by using 
the Revert command on the File menu . 
But remember, you lose a ll changes 
you 've made since your last save. 

All comma nds re lating to saving a 
document are found on th e Fil e me nu : 

SAVE The Save command te ll s GeoWo rks 
Pro to save the d ocument under its 
curre nt name. 

To save a document and make its 
changes permanent ... 

Choose Save from the File me nu . The 
docume nt is saved o nto the disk . o 
dialog boxes appear; your only indica
tion that the docume nt is be ing saved is 
a bit o f no ise fro m your disk drive. 

To save a document for the very 
first time ... 
0 Choose Save fro m the Fil e me nu . A 
fi le selec tor appea rs. 
f) Name th e document and ide ntify 
w hich directo ry w ill conta in it. The 
name ca n be up to 32 cha racte rs lo ng. 
8 Cli ck Save o r press the !Return) key . 
The newly created d ocume nt is saved 
unde r the name you gave. Whe n you 
switch to GeoMa nage r, yo u ' ll see th e 
doc ume nt. 

When you sove a 
document, remem· 
ber that it will be 
saved into the 
directory indicated 
next to the parent 
directory, not the 
directory that is 
highlighted in the 
file selector. 

SAVE AS Use Save As w he n you wa nt to 
save yo ur change d document unde r a 
diffe re nt name. That is , if you 're 
putting a d ocument throu gh severa l 
editing cycles, you may wa nt to keep 
earli e r ve rsio ns o f th e document intact. 
Fo r example, say a news le tte r named 
the Murtnik Monthly goes throu gh 
seve ra l changes befo re it 's sent to 
print. The first ve rsio n may saved 
unde r the name "Murtnik 's Mo nthly: 
Draft ," the next ve rsio n unde r "Murt
nik 's Mo nthl y: Second Try, " and fin ally 
"Murtnik 's Mo nthl y: Print it! " 

To save a copy of a document under 
a different name ... 
0 Choose Save As fro m th e Fil e me nu . 
A fil e selecto r a ppea rs. 
f) Type a new name fo r the document , 
up to 32 cha racte rs in length . The name 
you type appears in the text box, re plac
ing the o rigina l name o f the document . 
8 If you wish to save the docum ent in 
a diffe re nt pl ace, use th e fil e selecto r 
to change direc to ries o r disk drives. 
0 Click Save o r press th e I Return) key . 
The doc ume nt is saved o nto the disk 
unde r its new name , and the o rig inal 
docume nt is le ft uncha nged . 

Select Directory and Enter ttew Filename 

a? C:(HARO ORIUE) 
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REVERT Use the Revert command to undo 
changes you wish you hadn 't made. 
Revert restores the document to its last 
saved version, erasing any changes 
you 've made recently. Use Revert only if 
you're sure you want to discard your 
changes. If you're not absolutely sure , 
take the safe route and use Save As to 
save the changed document (for instance , 
"Murtnik's Monthly: Possible Additions"). 
Then reopen the last saved version. 

To revert to the last saved version 
of a document ... 
0 Choose Revert from the Fi le menu. 
A dialog box appears, asking if you are 
sure you wish to reve rt. 
f) Click Yes. The document is restored 
to its last saved version. If you have 
made changes since the last time you 
saved the document , those changes are 
permanently lost. 

SUMMARY OF THE FILE MENU 

Most app li cations have a File menu 
with at least the following commands: 
Open The Open command opens a 
document you have a lready created. 
New The New command creates a new, 
untitle d document. 
Close The Close command closes the 
current document. If you have made 
changes, you are asked if you wish to 
save your changes . 
Save The Save command saves the 
current document. 
Save As The Save As command saves 
the current document under a different 
name. The original document remains 
as it was when you last saved it and 
you are left editing the new document 
with the different name. 
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Revert The Revert command recovers 
the last saved version of the document. 
Any changes you have made since then 
are lost. 
Exit The Exit command exits the appli 
cations and closes all documents. If 
you have made changes to any docu
ments, you are asked if you want to 
save your changes. 

PRINTING 

When you first install GeoWorks Pro, 
you have the opportunity to identify 
the printer attached to your computer. 
If you ever want to change your print
er, or if you get a second printer, you 
can use the Preferences desk tool to 
tell GeoWorks Pro about it. 

You print from within most applica
tions by choosing the Print command 
from the File menu, bringing up a Print 
dialog box. The Print dialog box is more 
or less the same for most applications , 
and generally includes these options: 
Printer Options The Printer Options 
area displays the name of the current 
printer. Click the Change Options but
ton to switch printers (if you have 
more than one plugged into your com-



pute r) and change o the r settings , like 
p a pe r s ize a nd pape r tray . 
Print Quality With most printe rs you 
have a cho ice o f printing in e ithe r high 
o r low quality. The High se tting o ffe rs 
th e best results, produc ing d ocume nts 
th a t a lmost lo ok like th ey we re printe d 
o n a lase r printe r, but w ith th e draw
back tha t it takes a lo ng tim e to print 
eve n a s ing le page . The Low se tting 
o ffe rs mu ch fa ste r printing , but pro
du ces ve ry rou g h looking documents . 
(Some printe rs have an additio nal 
Me dium setting. ) 
Text Mode Only Turning o n this 
o pti o n prints a quick text-o nl y draft o f 
yo ur doc ume nt . The text-o nl y dra ft 
uses your printe r's inte rn a l fo nts , so it 
probabl y won 't look lik e th e doc um ent 
you see o n your screen . It does no t 
print in diffe re nt fonts o r s tyles , n o r 
does it print graphics . 
Print Pages You can choose to print 
your e ntire docume nt , o r o nl y so me o f 
the pages . 
Number of Copies and Collate Yo u 
ca n print mo re tha n o ne co py of the 
document . If the d ocume nt has mo re 
than o ne p age, you ca n a lso choose to 
co ll a te th e co pies . (Printing with the 
Co ll a te o ptio n on can be s lower th an 
printing w ith it o ff. ) 

The Print 
dialog box. 

To print with the standard 
settings ... 
0 Choose Print from th e File me nu . 
Th e Print dialog b ox appea rs . 
8 Click OK. The document prints with 
the s ta nda rd settings . 

To change the print quality ... 
0 Choose Print fro m the File me nu . 
The Print dialog box appea rs . 
8 Next to Print Quality , c hoose the 
se tting you want . Ge ne ra lly speaking, 
th e highe r the qu a lity , the lo nge r it 
takes yo ur docum e nt to print. 
8 If yo u w ant to ge t a tex t-o nl y draft , 
turn o n th e Text Mo d e Onl y o ptio n. 
This o ptio n prints us ing your printe r 's 
inte rn a l fonts and does no t print g raph
ics, but it does print ve ry quickly. 
0 Set any o th e r optio ns as d es ired . 
0 Click OK. The document prints 
us ing the se ttings you have chose n . 

To print a range of pages ... 
0 Choose Print from the Fil e me nu . 
The Print di alog b ox appea rs. 
8 Next to Print Pages, click to se lec t 
From . If your docume nt only has one 
page , this optio n is disa bl e d . 
8 Change th e From and To fi e lds to 
th e range o f p ages you w a nt to print. 
Change th ese fi e lds by cli cking the 

Printer Options---------.· 
I Canon BJ-1- on LPT1 

®fr''' 
..---------1DocumentOptlbn~~------------. ai 

High • Medk.m Low (Fast) 

r:.J Text t1pde Only 
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arrows or by typing new numbers. To 
print all the pages in your document, 
click All. 
0 Set any other options as desired. 
8 Click OK. The pages you have 
selected are printed using the settings 
you have made. 

To print more than one copy ... 
0 Choose Print from the File menu. 
The Print dialog box appears. 
8 Change the Number of Copies by 
clicking the arrows or typing a new 
number. 
e If you want to print the document 
so that each copy is printed and sorted 
independently, turn on the Collate 
option. (If you are only printing one 
page , the Collate option is disabled.) 
0 Set any other options as desired. 
8 Click OK. The document prints. 

CHANGING YOUR PRINTER AND PAPER OPTIONS The 
Change Options button in the Print 
dialog box leads to the Change Options 
dialog box, which you use to set the 
printer and paper options, such as: 
Printer The printers you have identi
fied as being attached to your computer 
are listed under this setting. The one 
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currently being used for printing is 
selected; select a different printer from 
the list if you want. To add printers to 
the list, use the Preferences application. 
Paper Size You can select the size of the 
pa per in your printer from those listed in 
the scrolling list. If your paper size isn't 
listed, you can change the Width and 
Height fields to make a custom size. 
Paper Source Some printers have sev
eral paper sources , such as different 
paper trays. Depending on your printer, 
you may be offered up to three tractor 
feed and three tray sources. Additional
ly, there may be a Manual Feed option, 
which pauses the printout between 
pages to let you insert sheets by hand. 

To change printer and paper 
options ... 
0 In the Print dialog box, click 
Options . The Options dialog box 
appears. 
8 Click to select the printer you want 
to use. 
8 Click to select the paper size. If you 
can 't find the paper size you want, 
enter the dimensions in the Width and 
Height fields. 
0 If your printer has more than one 
tractor feed, paper bin, or paper tray, 

The Change Options 
dialog box. 



change the Paper Source option. If you 
want to pause printing between pages 
so you can insert paper by hand, select 
the Manual Feed option. 
0 Click OK. The new options are set 
and the Print dialog box reappears. 

THE PRINTER CONTROL PANEL Printing takes 
time. If you print a lot of documents in 
succession you probably don 't have the 
time to sit around waiting for your 
printer to finish printing one document 
before you tell it to print another. 
Rather than making you wait , GeoWorks 
Pro gives you a way to "stack up " a list 
of documents that you want to print. 
The printer grabs the document at the 
top of the stack and starts printing, and 
as soon as it finishes that document, it 
starts printing the next one. And so on. 

You can see the list of documents 
currently printing (or waiting to print) ,,ia 
the Printer Control Panel. You can also 
change your mind and cancel the printing 
of any of the documents shown, includ
ing the one that 's currently printing. 

To see the list of documents waiting 
to print ... 
0 Choose Printer Control Panel from 
the Express menu . The Printer Control 
Panel appears . 

The Printer 
Control Panel. 
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8 The documents printing or waiting 
to print appear in the list in the middle 
of the Panel. You can scroll the list to 
see all of these documents . The ones at 
the top of the list print before the ones 
at the bottom-the one at the very top 
is the one currently printing. 
e If you have more than one printer 
attached to your system, click Other 
Printers to see any documents waiting 
to print on another printer. 
0 Click Close to make the Printer 
Control Panel go away . 

To cancel the printing of a docu
ment in the list ... 
0 Choose Printer Control Panel from 
the Express menu . The Printer Control 
Panel appears . 
8 Click to the name of the document in 
the list that you no longer want to print. 
8 Click Cancel Document. 
0 Cancel printing other documents if 
you want and click Close when you 're 
finished. 

If the document is currently print
ing, it may continue for a little while 
before it stops. 
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FONTS 

In many GeoWorks Pro applications, 
you can select text and then choose 
between different fonts, font sizes, and 
special styles (such as bold, italic, and 
underline) . In some applications, you 
can also color text, lighten it with a 
halftone, or adjust the character spac
ing for titles or headlines. 

WHAT IS A FONT? Font refers to the design 
of the individual characters. In one 
font, the letter "A" might be straight 
and simple, while in others the same 
letter might be very ornate and decora
tive. Some common fonts are: 

Sans 
Roman 
Mono 
L\jlµ~oA (Symbol) 
In GeoWorks Pro, the fonts appear 

on the screen exactly as they will 
appear on the printed page. 

You change the font by selecting 
text and 
•Choosing a font from the Fonts menu, 

or 
•Choosing the More Fonts command 

and selecting a font from the More 
Fonts dialog box 

The Fonts menu lists only some of 
the most frequently used fonts, while 
the More Fonts dialog box lists all 
the fonts currently installed on your 
system. When you select a font from 
the More Fonts dialog box, you're 
given a preview of the font so you 
can verify it. 

Not every GeoWorks Pro application 
lets you change fonts (the Notepad 
doesn't, for example). 

To choose a new font ... 
0 Select the text. 

BASIC TOOLS AND SKILLS 3.40 

8 In GeoDraw, choose Fonts 
from the Text menu, then 
choose a font from the ensuing 
cascade menu. In other appli
cations, like GeoWrite, simply 
choose a new font from the 
Fonts menu. The text changes 
to the new font. 

To change fonts with the More 
Fonts command ... 
0 Select the text. 
8 In GeoDraw, choose Fonts from the 
Text menu, then choose More Fonts 
from the ensuing cascade menu. In 

other applications, like 
GeoWrite, simply choose 
More Fonts from the Fonts 
menu. In either case, the 
More Fonts dialog box 
appears. 
8 Select a font from the list 
in the More Fonts dialog box. 
An example of the font you 
select is shown at the bottom 
of the dialog box. 

0 Click Apply to see the new font. If 
you like, select and apply other fonts 
while the More Fonts dialog box is still 
open. 
0 Click Close when you finish. 

CHANGING THE TEXT SIZE A point is a mea
surement of the height of a character. 
One point is 1/ 72 of an inch, so a 72-
point character is one inch tall, and a 
36-point character is half an inch . 

GeoWorks Pro allows a broad range 
of text size-from 4 to 792 points. At 
the maximum point size (792), you can 
fit roughly one character on a page. 

The Sizes menu (Sizes cascade menu 
in GeoDraw) contains the standard font 
sizes from 10 to 72 points. In addition, 
the Smaller and Larger commands let 
you make a gradual changes in the 



size. Yo u a lso have a Custo m Size com
mand tha t le ts yo u e nte r a specific 
point size . 

To change text size ... 
0 Select the text . 
8 Choose o ne of the sta ndard sizes 
fro m th e Sizes me nu . Or, to va ry the 
s ize inc re me ntally , choose the Large r 
o r Smalle r commands. 

To change text to a custom size ... 
0 Select the text , and choose Custo m 
Size fro m the Size me nu . The Custo m 
Size dia log box a ppears. 
8 Type a new s ize , o r cli ck the arrow 
butto ns to change the o ne shown , the n 
click Apply. In your document , you 'll 
see th e text change size. 
8 Click Close whe n fini she d . 

CHANGING THE TEXT STYLE With many 
GeoWo rks Pro applica tions, you ca n 
a lso change the text's style to any o ne 
(or a combinatio n) of seven styles: 

Pl a in 
Bold 
Ita lic 
Unde rline 
gErihe Tfln1 
Supe rscript 

Subscript 
Yo u ca n a pply mo re than one style 

to text a t a time, such as bo ld and 
ita lic. Choos ing Plain Tex t cancels an y 
of the other styles. 
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To change the text style ... 
0 Se lec t the text. 
8 Choose a style from the Styles me nu . 
Re peat the process if you want to apply 
additional styles to the selected text. 

ZOOMING IN AND OUT 

Zooming in and o ut refe rs to th e 
ability to magnify o r reduce the image 
o n the screen. The View me nu le ts you 
zoom in and out of the page you 're 
looking at. If the text you 're using in 
GeoWrite is so small that you 're hav ing 
trouble reading it , you can zoom into 
the page (make it larger). Note that the 
zoom has no effect o n printing-the 
page prints at th e regula r size rega rdless 
o f whether you 're zoomed in o r out. 

Exp e rime nt by choos ing diffe re nt 
magnifica tio n levels fro m the View 
menu to find the o ne th at 's m ost 
appro priate fo r the work at hand . For 
example, whe n you wa nt to prec isely 
a lign two o bjects, it 's eas ie r if you 
zoom in . Whe n you wa nt to ge t a n 
o verview of th e entire layo ut of a 
newsle tte r, a redu ced view is be tte r. 
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To magnify the view (zoom in or 
out) ... 

Choose the level of magnification or 
reduction you want from the View 
menu. 

To return the document to its original 
size ... 

Choose Actual Size from the View 
menu. 

CORRECTING THE ASPECT RATIO Some monitors , 
such as those that display Hercules and 
CGA graphics , have rectangular pixels 
rather than perfectly square ones. 
(Remember, pixels are the small dots in 
your screen that form the image.) These 
monitors have a rectangular aspect 
ratio which tends to distort the image , 
making it look stretched or squashed. 

If you're using GeoWrite or GeoDraw 
with one of these monitors , you can 
turn on the Correct for Aspect Ratio 
option. With this option on, your docu-

Februaiy 5, 1992 

Dear CeliaJ I 

ments appear in their proper propor
tions and more closely resemble their 
printed result. It takes a bit longer to 
draw the image on your screen, though , 
and the image is also a little harder to 
read, so you might want to use it only 
for previewing your document. 

To turn the Correct for Aspect 
option on or off ... 

Choose Correct for Aspect Ratio from 
the View menu. The option turns on and 
the document appears as if your monitor 
had square pixels . (If the Correct for 
Aspect ratio is dimmed , it is because 
your monitor already has square pixels 
and no correction is necessary .) 

To turn the option off, simply 
choose it from the View menu again. 

You can choose 
the level of 
magnification at 
which you want 
to view your 
document. 

I am veiy pleased with the quality of your work for th 
of Service exposition. In fact, Chris Dixon mentioned 
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GETTING HELP 

Getting he lp is easy w ith GeoWorks 
Pro. If a screen h as a He lp b utto n , 
click it to get a w indow w ith infor ma
tio n and instru ctio ns: 

To display the Help Window ... 
Click the He lp b utto n . The He lp 

wi ndow appea rs. 

To view different Help pages ... 
Click the p ag ing butto ns : 

• Click the Page Down butto n to v iew 
the next p age of he lp . 

• Cli ck the Page Up b utto n to view th e 
prev io us p age o f he lp . 

If o ne o f th e p aging b utto ns appea rs 
d imme d (lig ht gray) , the n yo u ca n go 
no furthe r in that direc tio n . If both 
b utto n s a re dimmed , the n the re is o nly 
o ne p age o f he lp and it 's curre ntly 
displayed . Clicking a dimme d b utto n 
has no e ffec t . 

To make the Help window go 
away ... 

Click th e Close butto n . The He lp 
w indow goes away . 

Close Dir 

Use the Page Up 
and Page Down 
buttons to flip 
between the 
different pages of 
help. Click the 
Close button when 
you are finished 
reading it. 

Click Close Dir to close the current directory and return to its parent 
directory. This button dims when you reach the 
C:\G EOWORK S\DOCUM ENT directory, File Cabinet's highest 
directory. 

Copy 
This button is active only when one or more icons are selected. Use it 
to put an exact replica of the file in another di re dory. When you click 
Copy, a file selector box appears asking you to specify a destination 

. . . 
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T H E A P P L A N C E S 

Anybody who can use a familiar 

hotne appliance-a -washing 

machine, telephone answ-ering 

machine, remote-control television-can 

also use Beginner Workspace's softw-are 

appliances. These appliances are 

designed to be especially easy 

to learn and foolproof in oper-

ation. GeoWorks Pro comes 

standard with six appliances: Address 

Book, Planner, Calculator, Notepad, 

Solitaire, and Banner. 



TURNING APPLIANCES ON AND OFF 

To use an appliance, you must first 
turn it on. Turning on an appliance is 
as simple as clicking a button. And, 
when you are finished using the appli
ance, another button turns it off. 

To turn on an appliance ... 
0 On the Welcome 
screen, click the large 
Beginner Workspace 
button. The Choose 
an Appliance screen 
appears. 
8 Click the button of the appliance 
you wish to use-for example, click 
the Calculator button. The appliance 
turns on and fills the screen . 

If you need help using an appliance, 
click the Help button in the upper-right 
corner of the screen. 

To turn off an appliance ... 
0 Click the Exit button in the upper
left corner of the appliance. The appli
ance turns off and the Choose an 
Appliance screen reappears. 
8 Click a button to use another appli
ance or click Exit to return to the Wel
come screen. 

THE APPLIANCES 

I ew 
112 cup flour 
112 cup mile 
I tbsp butter, melted 

ah 0 1 sugar 
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THE NOTEPAD APPLIANCE 

The Notepad appliance is a handy 
place to write quick notes or lists. 

The Notepad works like a very simple 
word processor-just start typing 
(0). Use the mouse to edit the text 
(as described in the ueasic Tools and 
Skillsn chapter). The buttons al the 
top of the window perform special 
operations: Click Print to actually 
print the contents of the Notepad 
((i)). Select some text, then click Cut 
or Copy to put it on the clipboard, 
from which it can be pasted back in 
when you click Paste. The Text Size 
options make the text larger or 
smaller ((j)). If you have more text 
than can fit on the screen, click Page 
Up or Page Down to see it ((.4)). 



THE CALCULATOR APPLIANCE 

The Calc ul ator appliance works like 
a norma l desktop calc ul ato r. 

The Calculator has more than 
a passing resemblance to the 
kind you usually see on a 
desk. Click the buttons to 
enter the numbers and 
perform operations (0). The 
results appear on the LED 
display at the top ((i)). 
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THE ADDRESS BOOK APPLIANCE 

The Address Book appli ance works 
mu ch like a commo n o ffi ce ca rd fil e. 

You can flip immediately to any section of the Address Book by 
clicking one of the index tabs (0). Or click the Next Card and 
Previous Card buttons to flip forward and backward one card at 
a time ((i)). To add a new card to the collection, click New Card 
(Q)) and fill in the blanks (G)). When you're done entering the 
information, flip to another card to have the Address Book 
record your changes. If you have a modem, the Address Book 
appliance can dial a phone number, too: just click the Dial 
button ((.5)). 
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THE PLANNER APPLIANCE 

The Planner appliance works like a 
desk calendar and date book. 

In the Planner's left window, which shows a monthly calendar, 
days that have events scheduled on them are marked with little 
triangles, and the day that you' re viewing is marked with a 
darkened square (0). The events scheduled on this day oppear 
in the Event window on the right ((i)). If there are more 
events on a given day than can be shown on the screen, the 
Page Up and Page Down buttons will darken (0))-dick them 
to see the other events. To add a new event to the list, dick 
the desired day on the calendar and then dick New Event (G)). 

(To see other months and years, dick the Go to buttons (i.) at 
the top.) To print a monthly calendar or the list of scheduled 
events, dick the Print buttons ( © ). 
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THE BANNER APPLIANCE 

The Banner appliance does one 
simple thing: It prints large, multipage 
banners you can hang on a wall, win
dow, or whatever. It 's easy to use and 
quick to master, so you should be cre
ating huge signs with cool fonts and 
special effects in no time. 

To begin typing the banner, dick the keyboard button in the 
upper-left corner (0). Type the text for your banner into the 
Banner Message box ((i)). (After a short delay your message 
will appear in the sample banner 0).) Scroll the sample left or 
right by dicking the four buttons at the bottom (G)). Change 
the font or add a special effect by dicking the appropriate 
buttons (0) and then dicking your choice on the menu that 
appears. When the banner looks good, dick the Printer button 
((5)) to print your banner. (The banner always prints with Low 
print quality to keep your printer from overheating-literally.) 

Call Uncle Oeve, pretend he's won e 
dream r-iae In the Cerlbbeen 

A 11130 AM Cell Uncle Oeve, expleln It wea a joke 
A 3&00 PH Call Uncle Oeve, epoklolze llQ8ln 
A 6:00 PH Buy Uncle 0- dinner 

0 



SOLITAIRE 

The Soli taire app liance lets you p lay 
the famo us Soli taire card game ca lled 
Klo nd ike . Be carefu l, it 's surprisingly 
addictive. 

4.5 

To play, drag cards from one 
stack to the next by placing 
the pointer over the card you 
want to move (0), pressing 
and holding down the left 
mouse button to upick up" 
the card, and moving it to the 
appropriate stack. (If the card 
can't legally be placed on 
that stack, it will bounce back 
to the original stack.) If you 
need additional instructions 
on how to play Solitaire, dick 
the Help button in the upper
right corner of the screen. 
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T H E CAL CUL AT 0 R 

The Calculator works much like a simple 

hand-held calculator. You can add, 

subtract, multiply and divide, calculate 

percentages, and store results in the 

calculator's memory. When you finish, 

you can paste the results into other 

applications, like GeoWrite or GeoCollllll. 



THE CALCULATOR WINDOW 

The Calculator window resembles a 
normal hand-held calculator. 
Parentheses ("(" and ")") Changes the 
order of operations. When you use 
parentheses, the quantity inside the 
parentheses is evaluated before any
thing else in the calculation. For more 
information , see "Order of Operations" 
in this chapter. 

Delete button Acts like a backspace 
key to erase the last digit of the num
ber in the display. 
C/CE button Clears the displayed 
number so that you can re-enter it 
without affecting a calculation in 
progress. If clicked twice , this clears 
everything, including any calculations 
in progress. 
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DOING CALCULATIONS 

Use the mouse to click the 
Calculator's buttons, or press the corre
sponding keys on the keyboard. You 
can use keys on the numeric keypad, 
but first make sure that I Num Lock I is on. 

ORDER OF OPERATIONS When you do calcula
tions involving more than two numbers, 
be aware that the Calculator may not do 
your calculation in the exact order you 
entered it. The Calculator follows a 
specific order of operations: operations 
in parentheses first , then multiplication 
and division , then addition and subtrac
tion . Arithmetic functions with the same 
precedence are performed left to right. 

For example, entering 3 + 4 x 6 would 
yield 27, not 42 as you would expect 
from the order in which you entered the 
calculation. The calculation is interpreted 
as 3+( 4x6) instead of (3+4)x6. 

OPERATING THE CALCULATOR 

Function Click On Keyboard 
Digits 0 through 9 [Q) through []] 
Decimal point 0 
Add + G 
Subtract G 
Multiply x *or 0 
Divide I 
Equals G or !Enter! 

Change sign ± [EJ 
Clear C/ CE © 
Delete Del IBackspaceJ 

Store in memory STO ~ 
Display memory RCL ® 
Add to memory STO+ ITJ 
Percent % % 

Parentheses ( ) ( ) 



THE ERROR INDICATOR When the Calc ulator 
cannot handle a calcula
tion , the word "Error" 
appears. This can happen 
when the result is greater 
than 2,147,483 ,647 or less 
than -2 , 147,483,648. This also happens 
if you divide by zero. 

When "Error" is displayed , click 
C/ CE once to clear it. 

USING THE MEMORY 

With the Calculator 's built-in memory, 
you can save the result of a calcu lation . 
In fact , the memory is a great way to 
keep a running total of your calculations . 
The memory can only hold one number, 
so each number you store erases the one 
previously stored . 

To store the displayed number ... 
Click STO or press ~ . The number 

on the disp lay is stored in memory. 

To recall the number from memory ... 
When you want to use the stored 

number in a calculation , click RCL or 
press [fil. The number appears on the 
display . You can then use this number 
in a calculation. 

To add to the number in memory ... 
If you want to add the number 

showing on the display to the number 
stored in memory, click STO+ or press 
IT] . The sum is then stored in memory . 

This is handy for keeping a running 
total of your calculations. 

To clear memory ... 
0 Enter a zero. 
8 Click STO or press ~. 
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CUTTING AND PASTING 

The number on the display can be 
cut or copied to the Clipboard in the 
normal way (with the Edit menu) and 
then pasted into another application. 
The reverse is also true: you can copy 
numbers in from other applications, 
such as the spreadsheet Viewer. (You 
can use Quick Copy and Quick Move 
to do these operations , too.) 

CHANGING OPTIONS 

With the Options menu you can set 
the number of decimal places you want 
disp layed, or make the Calculator work 
like a Hewlett Packard Reverse Polish 
Notation (RPN)-style calculator. 

To switch the method of operation 
to RPN ... 

Choose RPN from the Options menu. 
The Standard Calculator is replaced with 
the RPN Calculator. (See "Using the RPN 
Calculator," later in this chapter.) 

To switch back to Standard opera
tion, choose Standard from the Options 
menu . 

To set the number of decimal 
places ... 
0 Choose Decimal Places from the 
Options menu. The Decimal Places 
dialog box appears. 
8 Set the number of decimal places. 
You can choose from 0 to 8 decimal 
places. 
8 Click OK. 

When displayed, numbers are rounded 
to the number of places you specify, but 
this does not change the actual values 
being used for calculations. For example, 
if you set the number of decimal places 
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to two, the Calculator shows all your 
results rounded to two decimal places on 
the display. This means that 1.275 
appears as 1.28, but still has the value of 
1.275 when used in a calculation. 

USING THE RPN CALCULATOR 

The calculator can also function like 
a Hewlett Packard-style calculator, 
which uses Reverse Polish Notation 
(RPN). RPN is simply a different way to 
enter calculations. First you enter both 
numbers, then you click the arithmetic 
function. The numbers are kept on a 
stack, where they can be "popped" and 
used in operations. (The number of 
numbers that you can put on the stack 
is limited only by the amount of avail
able memory.) 

The buttons on the RPN Calculator 
are basically the same as those on the 
Standard Calculator, with a few differ
ences: 
Enter Button Click this button to 
place-or "push"-the number on the 
display onto the stack. Type the first 
number, click Enter, type the second 
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The Calculator, RPN· 
style. Note the slightly 
different buttons. 

5.4 

number, and then click an arithmetic 
function. 
Exchange Button ("x<>y") Exchange 
the number in the display with the top 
number on the stack. This is useful in 
switching the order of numbers to be 
subtracted or divided. 
C/CE Button When clicked once, this 
button erases the number you're cur
rently entering-provided you haven 't 
yet clicked Enter (at which point the 
number can't be erased). When clicked 
twice , it erases all the numbers on the 
stack, effectively resetting the calculator. 

All the RPN Calculator buttons are 
activated by the same keys on the key
board as the Standard Calculator. The 
two additions are the Enter key , which 
corresponds to the Enter key on the 
keyboard , and the Exchange Key, 
which corresponds to the [§] key. 

To do RPN calculations ... 
0 Type (or click) the first number, as 
you would for Standard calculator. 
f) Click Enter to "push" the first num
ber onto the stack. 
E> Type the second number. Do not 
click Enter this time. 
0 Click the arithmetic function you 
want. The result shows on the display . 
You can then use this result as the first 
number in another calculation. 

It 's important that you not click 
Enter after typing the second number, 
as this will both store the number on 
the stack and leave it on the display . If 
you then click an operation, the opera
tion will use the number on the display 
and the top number on the stack-the 
same number. 



THE DOS PROGRAMS SCREEN 

The DOS Programs screen offers a quick 

vvay to run DOS prograllls and batch 

files at the press of a button. Create 

a button for each program 

or batch file you use. Then 
I 

simply click the button to shut ~' / 
down GeoWorks Pro and run the ----_j 

program. (Before you attempt to set up 

buttons, though, you should make sure 

that you're comfortable vvorking vvith 

dialog boxes. If you're not, check the 

"Basic Tools and Skills" chapter for 

more information.) 



THE DOS PROGRAMS SCREEN 

The DOS Programs screen is one of the 
four choices on the Welcome screen
simply click the DOS Programs button to 
get to it. Like the Beginner Workspace 
screen it has large , friendly Help and 
Exit buttons, which you use to get help 
and return to the Welcome screen , 
respectively. And just as the Beginner 
Workspace has buttons for starting the 
appliances , the DOS Programs screen 
can be set up to have buttons for start
ing DOS programs and batch files. 

Well , not at first. The DOS Programs 
screen comes standard with only one 
button , labe led "Enter DOS. " (C li cking 
this drops you out of GeoWorks Pro to 
the DOS prompt .) You need to create 
buttons to run your favorite programs , 
but don't worry, it 's easy-see "Creat
ing a Button" a little later. 

If you create more buttons than will 
fit on the screen , paging arrows appear 
at the bottom of the screen. The paging 
arrows let you flip from one screenful of 
buttons to another. (If a paging arrow is 
greyed out , you 've already gone as far 
as you can in that direction.) 
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To run a DOS program or batch 
file ... 
0 Find the button you wish to use . 
Create one if you have to . If there are 
additional screens of buttons , 
click the Next and Prev arrows 
at the bottom of the screen to 
see the others. 
8 Click the button. (A dialog box may 
appear so that you can enter command 
line options ; more on this later in the 
chapter.) The screen clears whi le 
GeoWorks Pro shuts down-convenient
ly freeing up a lmost a ll of memory
and the DOS program starts. 
El When you exit the program, 
GeoWorks Pro is automatica lly started 
back up again , and you 're returned to 
the DOS Programs screen . Everything 
is exactly the way you left it. (If you 
get stuck at the DOS prompt yo u 'll 
have to type exit to return.) 

To exit to DOS temporarily ... 
0 Cli ck the Enter DOS button . 
GeoWorks Pro shuts down , leaving you 
at the DOS prompt. 
8 Since GeoWorks Pro is completely 
shut down and removed from memory, 

The DOS Programs screen. Each 
button in the middle runs a DOS 
program or batch file (0). (The 
screen only comes with one built
in button-the Enter DOS button 
at the upper left corner.) When 
you want to return to the 
Welcome screen, click Exit ((i)). 
The two paging arrows are at the 
bottom (Cl)). 



you can run any p rog ram o r pe rfo rm any 
command you like w itho ut GeoWo rks 
Pro getting in the way. 
8 Whe n you 're fini shed , type exit 
and press [Return!. This s ta rts GeoWo rks 
Pro b ack up aga in and re turn s you to 
the DOS Programs screen . 

CREATING A BUTTON 

It 's easy to c rea te a custo m butto n 
fo r any DOS p rogram o r batch fil e. 
Bu t, before you begin , yo u sh o uld 
make su re yo u ' re fa miliar w ith th e 
concepts and tec hniq ues presente d in 
the "Bas ic Tools a nd Ski ll s " chapte r. 

To create a new button ... 
0 Ch oose Crea te New Butto n fro m the 
Optio ns me nu . A fil e selec to r a p pea rs , 
asking you to selec t a DOS fil e fo r the 
new butto n . (Onl y .COM, .EXE, and 
.BAT fil es a ppea r. ) 

6 Selec t th e fil e a nd cli ck Use This 
Fi le. The fil e selec to r goes away and is 
re p lace d by the Bu tto n Settings dia log 
box. 
8 Cha nge th e button 's se ttings as 
des ire d. 

Blitton Settings 

File f'or Blitton 

AUTDEXECJJAT 

aaanpe F~ f 

..---- ----Command line Options--------. 
+ Ho Commend Line Options 
v A.sic for Options Each Time 

Specify Options tlow 

f.li)i.iol)..~) 

(Left) This dialog box is 
what you use to select a 
DOS program for the new 
button. Keep in mind that 
this DOS program's name 
might not be what you 
expect-if you wanted to 
select "WordPerfect," for 
example, you'd actually 
select the file wp . exe, 

the actual DOS program. 

6.3 

Button Appearance Th e Butto n 
Appearance a rea shows th e picture o n 
the face o f th e butto n a lo ng w ith th e 
tex t tha t appea rs und e rneath. Cha nge 
the tex t in th e n o rmal ma nne r, and 
choose a diffe re nt picture by clicking 
Cha nge Picture. Bo th o f these a re fo r 
you r be nefit o nly , so you ca n p ut 
w h ateve r yo u wa nt he re. Go w ild. 
DOS File for Button Cli ck thi s if you 
wa nt to change w h ich p rogram sta rts 
w he n yo u cl ick the butto n . 
Command Line Options Ma ny DOS 
p rog rams acce pt o ptio ns- calle d "com
mand line optio ns"- th at change w h a t 
th ey d o. For examp le, wh e n us ing the 
DOS CHKDSK command you ca n add 
o p tio ns such as "/ f" to fi x e rrors and 
"/v" to d ispl ay the n ame o f each fil e as 
it goes . Yo u can hand le these o ptio ns 
three diffe rent ways: 

The Change Picture dialog box. 
Scroll the list until you find the 
picture you want, then click to 
select it . Click OK when done. 
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•No Command Line Options: Runs the 
program without any command line 
options. 

•Ask for Options Each Time: Each time 
you run the program you'll be asked 
to enter some command line options. 

• Specify Options Now: Choose this 
when the options are always the same . 
Enter them here and be done with it. 

0 Click OK. The dialog box closes and 
the new button appears on the screen. 

CHANGING AND DELETING BUTTONS 

Once you have created a button, 
you can change its settings or delete it 
at any time. 

To change a button's settings ... 
0 Choose Change Button Settings from 
the Options menu . A dialog box 
appears, listing all the buttons by 
name . 

8 In the list , click to select the name 
of the button you wish to change. 
Click Change Settings. The Button Set
tings dialog box appears, showing the 
settings for the button. 
8 Change the button's settings in the 
dialog box as desired. (See "Creating a 
Button, " earlier in this chapter, for an 
explanation of the settings.) 
0 Click OK. The dialog box closes and 
the button appears with its new set
tings . 
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To delete a button ... 
0 Choose Delete Button from the 
Options menu . A dialog box appears, 
listing all the buttons by name . 
8 Click to selec t the name of the but
ton you want to delete. 

8 With the button name se lected , click 
Delete Button. The dialog box closes 
and the button is gone . 

CREATING AND EDITING BATCH 
FILES 

A batch file is a sequence of DOS 
commands contained in a text file 
(check the DOS User's Refe re nce for 
information) . You can eas ily create and 
edit them in the DOS Programs screen . 

To create a new batch file ... 
0 Choose Create Batch File from the 
Options menu. A file selector appears, 
asking you to name the batch fil e. 



f) Type a name for the batch file, up 
to eight characters in length. Only 
characters va lid for DOS file names are 
accepted. Since it 's a batch file , a 
". BAT" is automatically tacked on at 
the end of the name. 
8 Click Create . The Batch File Text 
dialog box appears. 

8etch fie Tub 

0 Use this dialog box to enter the 
contents of the batch file. 
0 When you finish editing, click Save 
to save your work. 

To edit an existing batch file ... 
0 Chose Edit Batch File from the 
Options menu. A file selector appears, 
asking you to se lect the batch fil e you 
want to change. Choose the file and 
click Edit File. The Batch File Text 
dialog box appears. 
f) Edit the text in the Batch File Text 
dialog box the same way you 'd edit 
text in , say, the Notepad . 
8 When you finish editing, click Save 
to update the batch file on your disk . 

The Batch File Text dialog 
box. Basically the same thing 
as the Notepad, this is 
where you enter (and edit) 
the contents of your new 
batch file. 
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THE GE 0 W 0 R KS "EXTRAS" 

In addition to the regular applications, 

fonts, and clip art, GeoWorks Pro 

comes \\Tith a collection of "freebie" 

programs. Some are quite useful and oth

ers are just for your amusement. The most 

useful of them is Screen Dumper, \Vhich is 

handy for taking a "snapshot" of your 

GeoWorks Pro windows. 1~his utility-and 

all the other "extra" sofuvare-can 

be found in the World directory, in 

a directory called "Extras." 



SCREEN DUMPER 

Screen Dumper is an application you 
use to take a "picture" of a GeoWorks Pro 
screen. It captures the image and saves it 
as a file you can import into another 
program, such as GeoDraw (or Aldus 
PageMaker, or any of the other page 
layout programs available for PC or Mac
intosh computers- we used this utility to 
produce this book) . Screen Dumper lets 
you capture one window out of several 
open windows, if you wish- you don't 
have to capture the whole screen. And it 
can save images in several popular for
mats: Raw Bitmap, Postscript , Encapsu
lated Postscript, PC-Paintbrush ("PCX"), 
and TIFF. 

A couple of important points before 
you begin: Screen Dumper is one of the 
only GeoWorks Pro programs that 's 
truly modal. This means that while 
you're issuing commands to capture a 
screen, all other applications are com
pletely frozen (unresponsive). This may 
be disconcerting the first time you use 
Screen Dumper, but you' ll soon get 
used to it . 
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Also, when capturing Postscript-for
mat (or EPS-format) files , Screen Dumper 
doesn't include a screen image along 
with the Postscript commands. While the 
image prints normally, most other pro
grams (PageMaker, etc.) will show you a 
gray box (with a name in it) in lieu of 
the image . 

SETTING UP THE SCREEN DUMPER The Screen 
Dumper window does nothing more 
than allow you to set the Screen 
Dumper options. The first thing you 
shou ld do is use the file selector (see 
"Basic Tools and Skills" for more about 
file selectors) to tell Screen Dumper 
where you want it to put the dump 
files. Change the Base Name if you 
want each file to be named something 
more specific than "DUMP." But leave 
the percent sign (%) at the end of what
ever name you type-Screen Dumper 
substitutes the dump number for the 
percent sign , upping the number by one 
for each dump. (The first capture will 
be saved as DUMPOO, the second as 
DUMPOl , and so on.) Use the annotation 
feature to keep a log of your screen 

The Screen Dumper window. You can 
capture screens even when this 
window isn't visible. Before you 
begin, change the Base Name (unless 
you want all your images to have file 
names beginning with uDUMP"). 
Also, use the file selector to pick the 
directory that will receive the dumps. 
Then, select the Format I or the image. 
(Don't forget to change the options 
for the format-che<k the Options 
menu.) When ready, click Banish if 
you want to make sure that Screen 
Dumper itself doesn't inadvertantly 
end up in your captured screens. 



captures, o r use Appe nd to add e ntries 
to the e nd o f th e curre nt log. 

BANISHING THE SCREEN DUMPER WINDOW To 
make th e Scree n Dumpe r w indow dis
appea r (so that you do n 't in adverte ntl y 
ca pture it in a screen dump), click 
Ba nish . To bring the Sc reen Dumpe r 
w indow bac k , press [gill + 0!] + ~' 
th en [ill. 

DISABLING THE CURSOR If you are ca pturing 
an image that has a blinking cursor (like 
a dialog box with a text fi e ld o r a page 
in a wo rd processing document) , you 
can do two things : le t the cursor contin
ue blinking, w hich means you may o r 
may not get the cursor in your image, 
de pending o n how you time the sc reen 
dump; o r disab le the blinking cursor, in 
which case it sto ps b linking and appea rs 
in the image. To disable the blinking 
cursor, choose Disable Blinking Cursor 
fro m the Options menu. To restore the 
blinking cursor during screen captures, 
choose Enable Blinking Cursor Aga in . 
Ge oWorks Pro auto matica lly restarts 
w he n you do eithe r of these . 

SETTING POSTSCRIPT OPTIONS Wh e n you save 
a sc reen dump as a Pos tsc ript fil e , yo u 
have seve ra l o pti o ns fo r the size and 
o rie ntatio n o f the image, the colo r 
mo d e l, th e number of co pies o f eac h 
screen dump you w ant , and so forth . 
Choose Pos tsc ript fro m th e Optio ns 
me nu and ma ke your cho ices in th e 
Postscript dia log box. 

7.3 

Postscr·ipt 

Image Nam e This na me appea rs o n 
the bl ank box th at re presents th e 
Pos tSc ript im age w ithin d eskto p pub
lishing p rograms (s uch as PageMa ke r) . 
The name serves o nly to docume nt th e 
contents o f the screen ca pture fil e; it 
h as no e ffec t o n th e image itse lf, o r o n 
th e name o f th e fil e in whi ch th e 
image is placed . 
Color Choose th e colo r mod e l bes t 
suited for th e equipment you w ill use 
to print the images . Use RGB if you 
will be viewing the images o n a colo r 
m o nito r, w hile CMYK is b ette r for co lo r 
printe rs. Graysca le is bes t for bl ac k
a nd-white printe rs and m o nito rs. 
Note: Both RGB and CMYK use Postscript color extensions 
(the ucolorimage" operator). If your printer doesn't 
support this, choose Grayscale, or you'll get an error when 
you try to print the document. 

Number of Copies You ca n have the 
printe r make seve ral co pies o f each 
ca pture . This is mu ch , mu ch fas te r th an 
printing the image severa l times, but 
every tim e you print the fil e you ' ll ge t 
this many copies. 
Orientation Choose Portra it if yo u 
w ant th e image printed n o rmally. 
Choos ing Landsca pe makes the image 
print out sidew ays-useful for printing 
full sc reens , as this is closer to the 
aspect ra tio (w idth to he ight ra tio) of a 
mo nitor tha n the Po rtrait o ptio n. 
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Image Width, Image Height This is 
the size (in centimeters) of the image. 
Note that Image Width and Image Height 
are always relative to the image, not the 
page orientation. Your image will appear 
this size when you prin,t even if it has to 
be stretched to fit-there being no way 
to have Screen Dumper automatically 
size the Image Width and Image Height 
to match the image. 
Paper Size This is the size of the pa per 
on which you' ll print the image. The 
image will be centered within this space. 

SETTING TIFF OPTIONS When you choose the 
TIFF format to save your screen dumps, 
you can choose between color or gray
sca le images. Choose TIFF from the 
Options menu and make your choices 
in the TIFF dialog box. 

Dump Color As When capturing a 
color screen to a TIFF fi le, the colors 
can be placed in the file as-is, or con
verted to sixteen-leve l Graysca le. This 
option has no effect if you 're capturing 
a monochrome screen . 
Image Compression This option isn 't 
yet supported. 
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CAPTURING A SCREEN IMAGE Often, capturing 
an image involves going into Screen 
Dumper's "control mode. " This means 
that Screen Dumper completely takes 
control of your computer, and all you 
can do-until you leave control mode, at 
any rate-are screen dumping opera
tions. You can still move the pointer 
around the screen (you'll notice it no 
longer changes when it moves over dif
ferent things), but it returns to its original 
position when you leave control mode. 

You enter control mode when you 
press~ +!Shift) + ~· The computer 
immediately freezes so that you can 
dump the screen . Press !Esc ] when you 
want to exit from control mode and 
thaw your computer. 

To capture the entire screen ... 
0 Make sure that you 've set all the 
proper options-Base Name , Dump 
Number, Formats , et a l. 
8 Press (Shift] + [Prt sc) . Or, press~ + 
I Shift) + ~. This freezes everything 
temporarily and puts you into "control 
mode. " Press [£[] to capture the 
screen. 
8 If Annotation is on , a dialog box 
appears so that you can enter a 
description of what you just captured. 

To capture a single window ... 
0 Make sure that you 've set a ll the 
proper options-Base Name, Dump 
Number, Formats , etc. 
8 Press~ + !Shift) + ~. This freezes 
everything temporari ly and puts you 
into "control mode ." 
8 Position the pointer on the title bar 
of the window you w ish to capture . 



This is ve ry, very impo rtant. When 
you capture a windo w , Screen Dumper 
captures the window that is directly 
under the pointe r. But there 's a catch: In 
many cases, windows are built up from 
several little w indows that do n 't look like 
w indows-they' re essentially invisible. If 
you put the pointer on one of these, a ll 
you get is the little w indow. Putting the 
po inter on the big w indow's title bar 
gives you eve rything inside the window 
(little w indows and a ll) , and there fore 
avoids the problem . 

0 Press (ill to ca pture the windo w 
w itho ut th e p o inte r, o r press [BJ to 
capture both th e w indow and th e 
po inte r. 
0 If Anno tatio n is o n , a dialog box 
appea rs so th at yo u can ente r a 
desc riptio n . 

If your keyboa rd has the exte nde d 
fun cti o n keys, you can simpl y press 
§TI to ge t th e w indow by itself o r Ifill 
to get the w indow a nd po inte r, w itho ut 
ever e nte rin g contro l mode (meaning 
th at yo u a lso do n 't h ave to press I Esc I 
to exit contro l mo de ) . 

7.5 

To capture only a portion of the 
screen ... 

You don 't h ave to ca pture an entire 
window if a ll you need is a tiny po rtio n 
o f it. 
0 Ente r Screen Dumpe r co ntrol m o d e 
by press ing @!ill + I Shift I + ~. 
8 Pos iti o n the p o inte r a t the uppe r
left corne r o f the p o rtio n you w ish to 
ca pture . 
8 Hold down the le ft mo use butto n and 
drag a selectio n rectangle. Everything 
within this rectangle will be captured . 
(Re lease the mo use butto n w he n do n e .) 

0 Press [ill to ca pture eve rything o n 
the screen w ithin the ca pture rec tang le . 

Screen Dumper remembe rs the current 
selection rectangle, so you o nly need to 
ente r co ntrol mode and press m w hen 
you want to capture the same area aga in . 
(Press ffi to see the current selectio n 
rectangle .) 

To exit control mode ... 
Screen Dumper automatically p o ps 

you o ut o f control mode and "thaws " 
your computer aft e r you ca pture some 
thing (by pressing m o r [ill) . If you 
e nte r control mode and change your 
mind , you can escap e by press ing [EscJ. 
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NIMBUS FONT CONVERTER 

There are many different font formats 
out there. GeoWorks Pro uses a format 
based on a specific driver known as 
"Nimbus Q," which is designed to work 
with fonts produced by the URW type 
foundry in Germany. (The term "foundry" 
stems from long ago when fonts were 
minted from lead in an actual foundry.) 

If you happen to have other URW 
fonts that you want to use with 
GeoWorks Pro, you can run them through 
the Nimbus Font Converter. The font 
converter translates and copies URW 
fonts into GeoWorks Pro's internal font 
directory. It also adds some extra infor
mation to the file to improve the font 's 
performance. These fonts will then 
appear in the Fonts menu, and you 'll be 
able to use them in your documents the 
same way you 'd use any of the regular 
GeoWorks Pro fonts. 

To convert a font ... 
0 Start the Nimbus Font Converter. A 
file selector appears. 
f) Locate the directory containing the 
fonts you wou ld like to convert. Dou
ble-click to open it. You may have to 
move through several directories or 
even look on another disk to find the 
proper directory. 
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8 When you 've found the directory 
containing the fonts you 'd like to con
vert, click OK. At this point, you're not 
actually selecting the font files that 
you 're interested in , but merely select
ing the directory that contains them. 

0 Another dia log box appears with 
the fonts listed by their Nimbus font 
names instead of their DOS filenames. 
If there are severa l variations of one 
font in the directory (for example , a 
file containing Roman Book , one for 
Roman Italic , and another for Roman 
Bold) , a ll the file s will be liste d under 
one font name-Roman. 
9 Se lect the font name that you would 
like to convert. 
0 You can type in a new name for the 
font. This is the name that wi ll appear 
in the Fonts menu of GeoWrite or 
GeoDraw. As you type in a new name 
for the font , the name of the font in 
the list changes al so . This name change 
is used in GeoWorks Pro only-the 
name of the font in the original file is 
not changed. 



G Click Convert. The font you se lected 
is converted to PC/ GEOS format and its 
new name-if you typed one in-is 
added to the font me nu s of GeoDraw 
and GeoWrite. 
0 Click Done when the re are no more 
fonts that you want to convert . Choose 
Exit from the File menu to exit the 
Font Converter. 
0 At this point you 're asked to restart 
GeoWorks Pro so that the new fonts can 
take effect. Click Yes if you 'd like your 
changes to take effect immediately . (If 
you 're in no hurry to use the fonts you 
can choose o, in which case the new 
fonts will appear the next time you 
start GeoWorks Pro.) 

The Perf window. The little 
graphs along the top chart the 
current load on your computer. If 
the window is too big for your 
tastes, click Hide Controls at the 
bottom-this shrinks the window 
so that only the graphs are 
visible. (To see the controls 
again, simply click one of the 
graphs.) 

1.1 

PERF 

Perf is kind of like the pressure 
indicator on a steam pipe in that it 
tells you how "hot" GeoWorks Pro is 
getting-how much memory is in use , 
what percentage of the CPU's process
ing power is being used , how much is 
currently swapped out of memory , and 
other things "techies " might want to 
know. (If you have no idea what any 
of this means , relax-Perf is just for 
satisfying your curiosity, it 's not some
thing you ever need to run .) All these 
statistics are shown in small graphs 
that reflect changes by the second. For 
a discussion of what each graph 
mea ns, click Help at the bottom of the 
Perf window. 

CHOOSING GRAPH OPTIONS You have control 
over what statistics to display and how 
to display them. You can choose only a 
few statistics of interest , show a s ingle 
stati stic in th e corner of the screen, 
change graph colors, and show graphs 
with or without captions and values. 
You can even freeze graphs to preserve 
their values. 
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To hide the controls ... 
Select Hide Controls to hide every

thing but the graphs. This is a handy 
to view the graphs without having the 
whole dialog box open. To view the 
controls again, simply click on the 
graphs. 

To choose specific graphs to view ... 
In Performance Statistics , click on 

the statistics that you do not want to 
see and click Apply. Those graphs 
disappear from the window. To see 
them again , reselect them in Perfor
mance Statistics and click App ly. 

To see a single graph in the lower
left corner of the screen ... 

Choose Minimize from the Control 
menu to view the CPU graph in the 
lower left corner of the screen. To 
view another single graph, turn off all 
the graphs you do not want to see and 
select Minimize from the Control menu. 
You can drag the graph anywhere on 
the screen. To view the Perf dialog box 
again, double-click the graph. 

To customize graph colors ... 
Click the graph you would like to 

change and click Graph colors. From 
the palette, choose the desired color. 
You can keep the palette open until 
you have a color you like, then double
click the Control button to close it. 

To freeze values ... 
Click the Off button next to Perfor

mance Meters. The graphs stop chang
ing and the values freeze. Click On to 
resume activity. 

To set display options ... 
Each display consists of the graph, 

its caption, and a value . These are a ll 
visib le when you open the Perf dialog 
box. To hide any of them, click the 
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The 3D Font Demo and 
Bounce are two programs 
that demonstrate the 
multitasking (and in 3D Font 
Demo's case, the smooth font 
capabilities) inherent in 
GeoWorks Pro. 

7.8 

appropriate setting in Display options 
and click Apply. To view that part of 
the display again, select the setting in 
Display options and click Apply. 

3D FONT DEMO AND BOUNCE 

The 3D Font Demo shows a piece of 
text spinning around and around in 
three dimensional space . The name 
GeoWorks appears in the text field , but 
you can type any word you want into 
it. (Be sure to press !Return) when done 
typing .) You can resize the window as 
you wish. 

Bounce shows a bouncing diamond 
moving around a window. It bounces 
around and around and around. It's not 
very useful , but it is fun to watch. 

Its purpose-and that of 3D Font 
Demo, too-is to let you see GeoWorks 
Pro 's multitasking in action. Start the 
ball bouncing and the text spinning, 
and then notice how you can still do 
other things (like editing and printing) 
without seriously affecting their speed. 



T H E F I L E C A B I N E T 

When you enter the Intermediate 

Workspace, the File Cabinet 

document manager is the first 

thing you see. From there yo.u can 

open documents-yours and ours-as 

well as manage your files, directories, and 

disks. You do all these things vvith the 

simple point and click actions that you use 

elsevvhere in GeoWorks Pro---there's no 

need to remember any mystifying 

commands. (It's much like the Advanced 

Workspace's GeoManager in this vvay.) 



WHAT YOU SHOULD ALREADY KNOW 

Certain tasks you perform in the File 
Cabinet are common to all GeoWorks 
applications. This is the main reason 
you can go from one GeoWorks Pro 
application to another and feel imme
diately comfortable. These common 
tasks are not discussed in application 
chapters like this one, but they are 
described in the "Basic Tools and 
Skills" chapter. Here are some of these 
tasks. If you are not familiar with them 
already, go to the "Basic Tools" chapter 
and read about them there. 
•Opening and clos ing a document 
• Naming Files and directories 
•Entering and editing text 
• Saving a document 
• Using a file selector 
• Selecting file and directory icons 
•Directories and subdirectories 
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THE FILE CABINET WINDOW 

The File Cabinet window tells you 
much about the directory you're in and 
what it contains. Here are some of the 
items that give you that information: 
Information bar The information bar 
displays: 
• The directory pathname (See "Basic 

Tools and Skills " for more about path
names) 

•The number of files and directories 
currently appearing in the File Cabi
net window 

• The amount of disk space , in bytes 
(characters, that is), used by the file s 
shown and the amount of free disk 
space 

GeoWorks Pro file icons Each type of 
GeoWorks Pro document has a unique 
icon . The different icons help you 
quickly spot particular types of files. 
The names of the files appear below 
the icons . 

The File Cabinet. Each of the little pictures ("Icons") in 
the middle area represent files or directories-the icon 
itself identifies the type of file. Note that the names of 
the files can be as long as 32 characters, a big Improve
ment over normal DOS file names. Use the rows of 
buttons along the top and bottom of the screen to 
perform actions. (Most of the buttons will be dimmed 
until you select a file or directory.) 



DOS file icons Th o ugh you 'll rare ly 
see DOS fil es lis te d in a Fil e Cabin e t 
window, they a lso have th e ir own 
uniqu e ico n . 
Directory icons A fo lde r icon in the 
Fil e Ca bine t w indow re presents a 
direc to ry o n your disk drive. Beca use 
direc to ries a ppea r as pictures o f litt le 
fo lde rs, th e te rms "directo ry" and 
"fo lde r" a re o ft en used inte rchangea bl y 
( in mu ch the same way th a t "doc u 
me nt" and "fil e" a re). 
Floppy disk buttons Each fl o ppy disk 
drive in your compute r is re presented by 
a button o n the bottom edge o f the File 
Cabinet window. The le tte rs o n the but
to ns indica te w hich drives the butto ns 
re present . If, fo r example , you wa nt to 
see the contents o f the fl oppy disk in 
drive A, you click the disk button 
labeled "A." 

GETTING TO WORK 

Yo u sta rt work o n a docume nt s imply 
by op ening it. If you 're crea ting a docu
ment fro m scratch , you need to o pen a 
templ ate document (see "Wo rking With 
Templ ates," la te r in this ch apte r). 

To open a docume nt ... 
0 Open the directo ry that conta ins your 
document. (See "Ope ning Directo ries," 
late r, for mo re informatio n abo ut this.) 
8 Click to select the docum ent 's icon . 
The icon w ill high light to show you 
th at it 's se lec te d . 
8 With th e docume nt selec ted , click 
the Ope n button a t the to p o f th e Fil e 

Cabine t w indow. Th e 
docume nt opens up , 
and you can ge t to 
w o rk . 
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Yo u ca n a lso o p en the d ocume nt by 
do ub le -clicking the docum e nt icon 
( instead o f se lecting it a nd clicking 
Ope n). It does n 't ma tte r w hich me tho d 
yo u use. 

WORKING WITH TEMPLATES 

The docume nts th at yo u use in th e 
Inte rmediate Wo rks pace a re called tem 
plate doc um e nts-bas ica lly, bo ile r-pla te 
doc um e nts. Te mpl ates ma ke your wo rk 
easy beca use the fo rmatting in th em 
has already been do ne fo r you . So, to 
crea te a g rea t looking d ocume nt , a ll 
you have to d o is o pen a te mp late and 
add your own text-and eve n graphics, 
if you 'd lik e. 

Fo r example, a newslette r templ ate 
ho lds fo rmatting fo r columns, line spac
ing, pa ragraph inde nts, headings, fo nts, 
and so forth . To crea te your own news
le tte r, you s imply o pe n a template in 
the NEWSLTTR fo lde r, typ e in yo ur text, 
paste in any g raphics, the n name the 
newsle tter and save it. The te mplate 
itse lf re mains unchanged , ready to be 
used aga in , w hile your new document 
appea rs in the Fil e Cabine t. O th e r fo ld 
e rs (like BANNERS, CARDS, FORMS, 
SIGNS) also conta in useful templates. 

To ope n a template ... 
0 Click the template 's icon to se lect it. 
It w ill highlight to indica te th at you 've 
correctly selec te d it . 
8 Cli ck th e O p e n butto n a t the to p o f 
the windo w . A dia log box appea rs to 
te ll yo u tha t the fil e is ma rk e d as Read 
Only, meaning tha t you ca n 't change 
the template. 
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8 Since you' ll be saving the document 
with a name of your own-thus leaving 
the template unchanged-click OK. The 
dialog box goes away and the template 
opens up . 

OPENING DIRECTORIES 

When you want to perform file man
agement tasks like copying or moving 
files and directories, you begin by 
opening the directory that contains the 
items you want to work with . You can 
a lso open a directory to just view its 
contents. When you open a directory , 
its contents appear in a new window. 
The directory you are working with is 
called the current or active directory. 

To open the DOCUMENT directory ... 
The DOCUMENT directory is where 

you normally store all your GeoWorks 
Pro documents. Click the 
Documents button . This 
opens the directory and 
shows its contents in the 
window. 

To open a directory from its folder 
icon ... 

Double-click the icon of the directory 
you want to open, or select the icon and 

click Open Dir at the bot
tom of the File Cabinet 
window. The directory 
opens and its contents 
display in the window. 
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To open the parent directory ... 
Switch to the parent 

directory-that is , the 
directory that contains the 
current directory-by 
clicking the Close Dir 
button. 

You can continue clicking the Close 
Dir button to move up the directory 
structure (one level at a time) until you 
reach the DOCUMENT directory. When 
you get here, the button is dimmed to 
indicate that you can go no higher. If you 
want to manage files and directories that 
are not in the \GEOWORKS \OOCUMENT 
directory, use GeoManager in the 
Advanced Workspace . 

To open a directory on another 
disk ... 

If the other disk you want to open 
is a brand new floppy disk , you may 
need to format it before you try to 
open it. See "Formatting a Floppy 
Disk" later in this chapter. 
0 If you want to open a directory on a 
floppy disk , insert the disk in a floppy 
disk drive. 
8 Click the disk button that corresponds 
to that drive. If it 's a floppy that you put 

in the A drive, for exam
ple, click the Floppy but
ton labeled "A. " The File 
Cabinet window displays 
the root directory of the 
floppy disk or hard disk . 

8 You can now work with the contents 
of this disk in the normal way. 



CREATING A NEW DIRECTORY 

You can cre ate a ne w directo ry 
within any ope n direc to ry . The new 
directo ry is e mpty until yo u move o r 
copy ite ms into it. 

To create a new d irecto ry . .. 
0 Ope n the direc to ry you wa nt to 
contain the new directo ry. (I f yo u need 
to move back up the directo ry stru cture 
to do this, use the Close Dir butto n .) 

8 Click Crea te Dir at the 
bo tto m o f the Fil e Ca bine t 
window. A di a log box 
appea rs as king you to 
name the new directo ry. 

8 Type the name of the new directo ry. 
Use standard DOS fil ename conve n
tio ns- e ight lette rs, with an optiona l 
three le tte r extensio n . Fo r instance, 
MYFOLDER . ONE. 

0 Click Crea te . The new directory 
appea rs in the curre nt directory window. 

RENAMING A FILE OR DIRECTORY 

The name tha t you g ive a dire cto ry 
o r fil e is no t necessa rily pe rmane nt . 
You ca n change it a t any time us ing 
the Re name button . 

To re name an ite m .. . 
0 Select the item you want to rename. 
You can select more than one if you like 
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(see "Se lecting" in the "Bas ic Tools and 
Skills" chapte r for more information) . 

8 Cli ck Re name at th e 
top o f the File Cabine t 
w indow. A dia log box 
appea rs. 

8 Ente r the ne w name in the box . 

(The MW nmne must be In the format fl..OtAME.EXf) 

0 Click Rename to apply the new 
name. If anothe r fil e already has this 
name, a dialog box asks you to type a 
diffe re nt name . If you 've selected sever
al items, you ge t a di alog box for each 
item. Click Next to leave the name of 
the current ite m unchanged and go on 
to the next. Click Ca ncel to close the 
dialog box without re naming the rest o f 
the se lected fil es . 

MOVING AND COPYING FILES AND 
DIRECTORIES 

The easiest way to move o r copy a fil e 
or directory is to drag it to its destination 
(us ing the right mouse button) . Dragging 
an item to a directory on the same disk 
moves the item to that directo ry, while 
dragging it to anothe r disk copies the 
item. You can also copy and move by 
using the Copy and Move buttons. 

When yo u move o r cop y more than 
one ite m, a dialog box appea rs showing 
you the progress of the operation . If 
you want to halt the who le process , 
click Stop. The operation stops afte r 
finishing with the current fil e. 
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The directory you copy or move 
items from is sometimes called the 
source directory, and the directory you 
copy or move them to is ca lled the 
destination directory. If the destina
tion directory a lready contains an item 
with the same name, yo u 're asked if 
you want to replace the existing item. 

To move an item using the Move 
button ... 
0 Select the item (or items) you want 
to move. 
8 Click the Move button at the top of 

the File Cabinet window . 
A file selector appears 
asking you for the desti
nation directory. 

f) In the file se lector, find and select the 
destination directory. Only the directories 
within the current directory are shown
files in the directory aren 't listed. If the 
list is empty then there are no folders in 
the current directory. (For more about 
file se lectors , look in the "Basic Tools 
and Skills" chapter of this book.) 
0 Cli ck Move to move the items. 
When you move more than one item , a 
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dialog box appears showing you the 
progress of the operation. If you want 
to halt the move operation, click Stop 
(the operation wi ll stop after finishing 
with the current file). 

To copy an item using the Copy 
buttons ... 
0 Select the item (or items) you want 
to copy. 
8 Click the Copy button at the top of 

the Fi le Cabinet window. 
A file se lector appears 
asking you for the desti
nation directory. 

f) In the file se lector, find and select the 
destination directory. Only the directories 
within the current directory are shown
files in the directory are not listed. If the 
list is empty then there are no folders in 
the current directory. 
0 Click Copy to copy the files into the 
directory . When you copy more than 
one item, a dialog box appears showing 
you the progress of the operation. If 
you want to halt the copy operation, 
click Stop (the ope ration wi ll stop after 
finishing with the current file). 

To move a file, position the 
pointer over it and click the left 
mouse button and hold it down. 
This "picks up" the file. Actually 
drag the file to the place you 
want it to be. Your options range 
from putting it in another 
directory to copying it to a file, or 
even dropping it in the wastebas
ket (lo delete it from your disk). 
It may seem a little odd at first 
to be dropping files on buttons 
(you can achieve the same results 
by clicking the Move and Copy 
buttons, or the Delete button), 
but this way is faster and easier. 



To move or copy an item by drag
ging ... 
0 Select the item or items you want to 
move or copy. 
8 Position the pointer over one of the 
selected items then press and hold down 
the right mouse button. The pointer 
changes to indicate whether you are 
dragging a single item or several items. 
8 Drag the pointer over one of the 
following elements: 
•A folder icon. 
•The Close Dir button (if available) at 

the bottom of the File Cabinet win
dow-the items are moved to the 
parent directory , one level up in the 
directory hierarchy . 

0 Release the right mouse button. 
Dragging an item to a directory on 

the same disk moves the item to that 
directory , while dragging it to another 
disk copies the item. You can always 
force a move operation by holding down 
the lEI] key while dragging , or force a 
copy operation by holding down the 
@!ill key. 

DUPLICATING A FILE OR DIRECTORY 

You can make copies (exact in all but 
name) of both files and directories. For 
example , you may want to duplicate a 
document file before making extensive 
changes to it , in order to have a backup 
of the original. 

To duplicate an item ... 
0 Select the item (or items) you want 
to duplicate . 

f) Click the Duplicate 
button at the top of the 
File Cabinet window. A 
dialog box appears . 

• IMIN!ii! 

Dragging a single item ... 

• iMIN!ii 

vs. dragging several. 
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8 Type in a name for the duplicate
if you like-otherwise the copy is just 
named "Copy of (file or directory 
name) ." When you duplicate many 
items , you 're given a chance to change 
the name of each copy. Clicking Next 
skips the current item altogether. 
Clicking Cancel closes the dialog box 
without duplicating the remaining 
items . 
0 Click Duplicate. A duplicate of the 
selected item (or items) appears in the 
same directory as the original. If you're 
duplicating more than one item, the 
name of the next item appears in the 
dialog box and the whole process 
repeats. 

DELETING A FILE OR DIRECTORY 

There are times when you need to 
make room on your hard disk (or flop 
py disks for that matter) by deleting 
files or directories you no longer need. 
Deleting a file removes the file from 
your disk, so be careful to delete only 
those file s you know you won't need 
later. You cannot recover a deleted 
item using GeoWorks Pro. 

To delete an item ... 
0 Select the item (or items) you want 
to delete. 
f) Click Delete at the bottom of the 
File Cabinet window. A dialog box 
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appears, asking you to 
confirm the delete opera
tion. 
8 Click Yes to delete the 

item; click No to keep it and move on 
to the next (if you're deleting several). 
Click Cancel to close the dialog box 
without deleting additional items. 

If you delete more than one item , a 
dialog box may appear showing you 
the progress of the operation. If you 
want to halt the deletions, click Stop. 
The delete operation stops after the 
current file is deleted. 

GETTING INFORMATION ABOUT A 
FILE OR DIRECTORY 

Click the Get Info button to see 
information about a file, including its 
size and when you last worked on it. 
When you display information about a 
GeoWorks Pro application or document, 
you can also enter your own notes. 

To display information about a file 
or directory ... 
0 Select the item (or items) you 're 
interested in. 

0 Click Get Info at the 
top of the File Cabinet 
window. The Get Info 
dialog box appears. 

8 If the item is a GeoWorks Pro appli
cation or document, and it isn't Read
Only, you can enter and edit text in 
the User Notes box. Notes are saved 
a long with the file. 
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0 Click OK to save the notes and 
display information about the next 
item. Click Next to skip the current 
item and display information about the 
next item. Click Cancel to close the 
dialog box. 

FORMATTING A FLOPPY DISK 

An unformatted disk is like a library 
with no shelves-there 's nowhere to put 
the books. Before you can store any
thing on a disk , you must format it. 
When you format a disk , you 're essen
tially building the shelves (and labeling 
them) so the computer has an organized 
framework in which to store files and 
directories. 

To see if a disk has already been for
matted, insert it into a floppy disk drive 
and click the appropriate floppy disk 
drive button. If a dialog box appears 
telling you that the disk is unreadable, 
you know the disk needs formatting. 

To format a floppy disk ... 
0 Insert the floppy disk into one of 
the disk drives. 

0 Click Format at the 
top of the File Cabinet 
window. A dialog box 
appears. 



8 Click the radio button that ide ntifies 
which floppy disk drive has the disk. 
0 Click the option for the disk capacity 
you want. Your formatting options 
depend on the capacity of your floppy 
disk drive and the size of the disk you 
are formatting. 
0 Click OK. A dialog box appears 
requesting a name for the disk. 
0 Type a name for the disk , and click 
Format . The File Cabinet formats the 
disk according to the options you spec
ified. A message lets you know how 
the formatt ing is proceeding and when 
it is complete. 
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LEAVING FILE CABINET (AND THE 
INTERMEDIATE WORKSPACE) 

You can leave the File Cabinet (and 
the Intermediate Workspace) at any time 
by either retu rning to the Welcome 
screen or exiting to DOS . Always exit to 
DOS before turning off your computer. 

GeoWorks Pro also remembers what 
yo u were doing when yo u exited. This 
way , when you come back , no matter 
how lo ng you've been gone or what 
you 've done in the meantime , every
thing is just as you left it. The current 
d irectory is the same. The same docu
ments are open. 

To leave File Cabinet and return to 
the Welcome screen ... 
0 Click the Express b utton. 
8 On the Express menu , click Welcome. 
The File Cabinet window goes away and 
the Welcome screen appears. 
Note: You may also press [ill to return to the Welcome 

screen without using the Express menu. 

To leave File Cabinet and return to 
DOS . . . 
0 Click the Exit button at the top of 

the File Cabinet window. 
A dialog box appears 
asking you to confirm that 
you want to exit to DOS . 

8 Click Yes. File Cabinet exits and the 
DOS prompt appears. At this point it 's 
OK to turn your computer off or run a 
DOS program. 
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G E 0 c 0 M 

GeoComm makes telecommunication 
with other computers, information 

services, and bulletin board systems 
straightf otward and efficient. And it 
also gives you po-werful tools for 
processing the information you 
send and receive. You can capture 

your session in a DOS text file. 
Compose messages off-line. Send 

and receive files using the XMODEM 
protocol. Even create scripts to 

automate your 
. 

session. 

M 



THE GEOCOMM WINDOW 

When you 're on-line (connected to 
another computer) , anything you type 
into the GeoComm window is sent to 
the other computer. And , likewise, 
anything sent to you from the other 
computer appears in the window. It's 
just like having a regular phone con
versation- except that both sides of 
the conversation appear in a window. 

GeoComm's cursor looks and acts 
differently than the text cursor you see 
in other GeoWorks applications (like 
GeoWrite) . First of all , GeoComm's cur
sor looks like a little box instead of a 
thin vertica l bar. When the box is solid, 
the GeoComm window is active, and 
whatever you type is sent to the other 
computer you are communicating with. 
When the box is hollow, the GeoComm 
window is inactive. The window will 
still receive data from another computer, 
but you cannot type anything until you 
make the window active (by clicking in 
the GeoComm window). 
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To change the size of the window ... 
In addition to using the resize borders 

to make the window larger or smaller, 
you can specifically set the number of 
lines and columns in the window: 
0 Choose Window Size from the View 
menu . The Window Size dialog box 
appears, displaying the current number 
of lines and columns. 
f) Adjust the number of Window Lines 
by clicking the arrow buttons or typing 
a new number. 

8 Adjust the number of Window 
Columns. 
0 Click Apply . The GeoComm window 
immediately changes to the new size. 
0 Click Close. 

You can have up to 80 columns and 
24 lines. On some computer screens, this 
size would make the GeoComm window 

The Geo(omm window has a 
uniquely·shaped cursor, a square 
instead of a line. When the 
window is active, the cursor is 
black. But when the window is 
Inactive-meaning that you can 
still receive information but you 
cannot type-the cursor turns 
into a hollow white square. 



bigger than the e ntire screen . In these 
cases , GeoComm allows only the number 
of lines that wil l fit on the scree n. 

To make the text large or small ... 
Choose Large Font o r Small Font 

from th e View me nu . The window 
redraws with the approp riate font size. 
GeoComm automatically c hanges ( if 
need be) the number of lines and 
co lumns so th e GeoComm window 
co mpl e te ly fits on the screen. 

SETTING PARAMETERS 

Before you do anything , ad jus t your 
protocol, te rminal, and modem settings 
using the commands in the Options 
menu . All the settings on your computer 
must match the o the r one 's exactl y, or 
yo u may no t be able to communicate . 

PROTOCOL SETTINGS Whe n you first start 
GeoComm , a dialog box appears asking 
you to choose the protocol settings for 
your mod e m. The se ttings you first see 
a re default settings-they match those 
in the modem section of the Prefer
e nces application . To change these 

Protocol 

Modem Portz 'V Com1 • · .. ·· Com3 .... · l:om4 

Baud Rates 1200 • 2400 v 4800 v 9600 v 19200 

7 $ 8 
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default protocol settings-and prevent 
GeoComm from asking for them each 
time-change the corresponding settings 
in the modem section of Preferences . Of 
course , you can still change the protocol 
settings temporarily using the Protocol 
dialog box. 
Modem Port Should correspond to the 
seria l port where your mode m is 
plugged in. 
Baud Rate The baud rate is the speed 
at which data is transmitted between 
your computer and the remote system. 
Data Bits , Parity, and Stop Bits These 
sett ings d e fine exactly how data is 
formatted for transfe r between two 
computers. Data Bits defines how many 
bits (in the stream of data) co nta in 
mea ningful information . Parity is used 
for error-checking during transmission . 
Stop Bits are the one or two bits which 
indicate the end of a character in the 
s tream of data. 
Handshake Choosing Software (XON/ 
XOFF) allows GeoComm to monitor the 
flow of data from the remote system, 
pausing and restarting the remote com
puter if necessary . If you turn this 
option off, you risk losing portions of 
incoming data . 

To set protocol settings ... 
0 Choose Protocol from the Options 
menu. The Protocol window appears. 
8 Change the options in the window. 
8 Click Apply when you finish , and 
click Close to close the window. 
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TERMINAL SETTINGS GeoComm can emulate 
(act like) many popular models of 
dumb terminals . (A dumb terminal is 
essentially a computer with very little 
computing power-basically just a 
screen and a keyboard, that can 't run 
programs the way a PC can.) 

Terminal Type GeoComm can emulate 
a variety of terminals: TTY, VT52, VTlOO, 
WYSESO, ANSI, IBM3101, and TVI950. 
Normally you use a standard TTY ("tele
type") terminal setting. When you con
nect to a system that expects a particular 
type of terminal, select the appropriate 
entry from the list. 
Duplex The Duplex setting controls 
the way data flows between computers. 
Full duplex is analogous to a two-way 
street: data can flow in both directions 
at the same time. Similarly , half duplex 
is like a one-way street: data can only 
flow in one direction at a time. There 's 
an easy way to tell which setting you 
should choose: type something. If what 
you type appears twice on the screen, 
select Fu ll duplex. If they don ' t appear 
at all, try Half duplex . 
Wrap Lines at Edge This option con
trols how GeoComm deals with lines of 
text that are too long to fit in the win
dow. With this option on , a long line is 
split into severa l shorter lines that fit 
within the window. When the option is 
off, long lines abruptly end at the win
dow's edge. (If you 're capturing the 
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text to a DOS file, the entire long line 
is captured correctly , even if it doesn 't 
display correctly in the window.) 
Auto Linefeed This option replaces 
each incoming carriage return with a 
carriage return and a linefeed. If each 
new line displayed on your screen 
overwrites previous lines , turn on Auto 
Linefeed; o n the other hand , if all the 
lines are double spaced, turn it off. 

To set terminal settings ... 
0 Choose Terminal from the Options 
menu. The Terminal dialog box appears. 
8 Change the options in the dialog box . 
8 Click OK when you finish. The dialog 
box disappears . 

MODEM SETTINGS In order to communicate 
with other computer over a phone line, 
you must have a modem attached to 
your computer. The Modem settings 
will only work with Hayes-compatible 
modems. If your modem is not Hayes 
compatible, check the modem's manual 
for information on adjusting the 
modem 's operation. 

Phone Type Set the phone type to agree 
with the type of service (tone or pulse) 
on your telephone line. 
Modem Speaker You can use your 
modem's b uilt-in speaker to eavesdrop 
on the telephone line activity. Choose 
one of the settings: 



•On Until Connect keeps the speaker 
on while dialing and waiting for the 
other modem to answer, but turns it 
off when a connection is made. 

•On Unless Dialing turns the speaker 
on only while waiting for the other 
modem to answer. 

•Always On keeps the speaker on at 
all times. 

•Always Off keeps the speaker com
pletely off. 

Speaker Volume This setting controls 
the volume of your modem's speaker. 

To change the modem settings ... 
0 Choose Modem from the Options 
menu . The Modem dialog box appears. 
f) Change the options in the dialog box. 
8 Click OK when you finish. The dia
log box disa ppears . 

STARTING AND ENDING 
COMMUNICATIONS 

Once you've set the GeoComm param
eters for your computer, you're ready to 
begin communications. Before you can 
send or receive anything, though , you 
must establish a connection with another 
computer by calling it. This is usually just 
a matter of using GeoComm to dial the 
phone number of the other computer. 

To dial a number ... 
0 Choose Quick Dial from the Dial 
menu . The Quick Dial dialog box 
appears. 
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f) Type the phone number you wish 
to dial. 
8 Click Dial. GeoComm dials the 
number. 
Note: Place a <omma anywhere In the number where you 
want a brief pause in the dialing sequen<e. For example, if 
you need to dial an amss <ode for an outside line, type it 
as part of the number: 9,SSS-1212. 

To hang up the phone ... 
0 If you're logged onto the other 
computer, log off of the computer in 
the normal way. 
8 Choose Hang Up from the Dial 
menu . A dialog box appears, asking 
you if you're sure you want to break 
the connection. If you click Yes, the 
modem hangs up the phone line , clos
ing the connection. 

WORKING ON-LINE 

When you are not connected to 
another computer, you are off-line. 
Similarly, when you have established 
communications with a computer and 
are exchanging information, you are 
on-line with that computer. Once on
line, anything you type in the Geo
Comm window is sent to the other 
computer. Likewise , anything the other 
computer sends to you also appears in 
the window-it looks like someone 
else is typing with your keyboard . 

SENDING PREPARED TEXT Sending prepared 
text is like having GeoComm automati
cally type something for you. In fact, if 
you were to watch from the other com
puter, it would look like an extremely 
fast typist was typing your text. Since 
neither computer checks for transmis
sion errors, though, you run the risk of 
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losing characters here and there-which 
is fine if you're sending short messages , 
but very bad if you 're sending some
thing important like a database file. To 
send important files , use XMODEM 
(discussed later in this chapter). 

Here are three different ways to send 
prepared text: 
•If you like working with your mes
sages-composing, revising , re-revis
ing , and so on-before you send 
them, you can compose them off-line 
in the Message window. This is espe
cially useful for sending short elec
tronic mail messages .When you 're 
done , GeoComm automatically types 
in the message for you. 

•Any text you paste from the clipboard 
is automatically typed into the window. 
So, you can copy a paragraph or two 
from GeoWrite to the clipboard, and 
then paste them into the GeoComm 
window, thus sending them to the 
other computer. You can quick copy 
text into the GeoComm window and 
have that type out too. 

• GeoComm can also type in the contents 
of DOS text files (like those you create 
with the Notepad). This method works 
well for short files without special con
trol characters in them. In other words, 
it 's a very bad idea to send GeoWorks 
Pro documents (those produced by 
GeoWorks applications) this way. 

To compose a message off-line ... 
0 Choose Message from the Edit 
menu. The Message window appears. 
This basically looks and works like a 
little Notepad window. 

GEOCOMM 9.6 

8 Type the message you wish to send. 
You can edit the message using basic 
text editing procedures. 
8 Click Send. The message is automati
cally typed into the GeoComm window
and therefore to the other computer. 
Compose and send other messages if you 
want. When you're finished, click Close . 

To send the contents of the clip
board ... 
0 From the other applications (or 
GeoComm), cut or copy the text you 
wish to send. 
8 Switch back to GeoComm with the 
Express menu (unless, of course, you're 
already there). 
8 Choose Paste from the Edit menu to 
send the contents of the clipboard to 
the other computer. 

To send a DOS text file ... 
0 Choose Type From Text File from 
the File menu. A file selector appears. 
8 Locate and select the DOS file you 
want to send. 
8 If the remote computer requires 
linefeeds after every carriage return , 
make sure the Strip Linefeeds from 
Text option is off (most do not) . 

8 Click Type . A status window 
appears, showing you the name of the 
file currently being transmitted. If you 
want to stop the transfer at any time , 
click Cancel in the status window. 



SCROLLING THROUGH DATA When the Geo
Comm window fills with text , it scrolls 
upward. The top line of text goes out the 
top, and any incoming lines of text come 
in at the bottom. As the lines of text go 
out the top of the window they are 
stored in something called the "scroll
back buffer. " You can view this holding 
area by scrolling the window down with 
the vertical scroll bar. There 's room in 
the buffer for about 175 lines of text , but 
when it fills up it removes the oldest 
lines-in other words, it always contains 
the most recent 175 lines of text . 

You can save the scroll-back buffer 
into a DOS text file if you want to 
keep it. For more information , see 
"Capturing Text" later in this chapter. 

SAVING INFORMATION 

You can save anything that appears 
in the GeoComm window. If you want 
to save only a little bit of text , you can 
select it and copy it to the clipboard. Or, 
if you want to save what you see on the 
screen and what 's included in the scroll 
back buffer (discussed earlier in this 
section) use the Save Buffer command. 
Otherwise , if you know that you just 
want to save everything that appears in 
the GeoComm window from now on, try 
the Capture to Text File command. 

To copy text to the clipboard ... 
0 With the mouse, select the text you 
wish to copy. 
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8 Choose Copy from the Edit menu. 
The selected text is copied to the clip
board. You can then paste this scrap 
into another application-just like you 'd 
paste anything else from the clipboard. 

To save the current screen and 
scroll-back buffer to a file ... 
0 Choose Save Buffer from the File 
menu . A file selector appears. 
8 Locate the directory where you want 
to save the file . 
8 Enter a name for the file. This name 
should be in DOS format-one to eight 
characters, optionally followed by a 
period and an extension of up to three 
more characters. 
0 Choose Screen Only if you want to 
save the current screen, or Scroll-Back 
Buffer if you would like to save only 
what has scrolled off the top of the 
screen. Choose Scroll-Back Buffer and 
Screen if you would like to save both. 

0 Click OK to save the screen to the 
DOS file. 

GEOCOMM 



To capture text to a file ... 
If you know ahead of time that you 

want to store data as you receive it, 
you can route it directly into a text file 
as it comes in. 
0 Choose Capture to Text File from 
the File menu . A file selector appears. 
8 Locate the directory in which you 
want to save the file . 
t) Enter a name for the file (in DOS 
format). 
8 Turn on End Lines With CR/ LF if 
your want the file to have linefeeds 
after every carriage return. You nor
mally leave this option off. 

0 Click Capture. The Capture Status 
window appears. This window stays up 
in front of the GeoComm window for 
as long as you're collecting text-but 
you can still do work in the GeoComm 
window. Anything that appears in the 
GeoComm window is recorded on disk. 

0 Click Done in the Capture Status win
dow when you want to stop capturing 
data. The capture file is closed, and the 
dialog box goes away. 
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SENDING AND RECEIVING FILES 
USING XMODEM 

Earlier in this chapter, you learned 
how to send short messages and even 
DOS text files by having GeoComm type 
them in for you. But this method is not a 
reliable way to send important files
those where every character must be 
transmitted correctly. This is where 
XMODEM comes in . XMODEM works 
differently from the earlier methods-it 
sends (or receives) the information in 
small pieces , making sure that each 
piece is received correctly before send
ing the next one. If any piece is received 
with something wrong (perhaps because 
of a noisy phone line) then the piece is 
transmitted aga in . And again, until it is 
received perfectly. Almost all file trans
fers via XMODEM are error-free . Both 
computers must be using XMODEM for 
the fil e transfer to work . 

To send a file with XMODEM ... 
0 Prepare the remote syste m to receive 
an XMODEM file . You usually do this by 
manu ally sending a message to the other 
compute r that says something like , "I'm 
about to send an XMODEM fil e." Be 
sure to specify whether you are sending 
a text or a binary file. (If you 're sending 
GeoWorks documents, use binary.) 
When the person on the o ther side gets 
your message , it 's up to them to prepare 
their computer to receive the file . 

8 Choose Send XMODEM from the 
File menu. A file selector appears. 
t) Locate and select the file you want 
to send. 



0 Choose lK Bloc ks if the re mote 
compute r accommod ates lK Blocks 
a nd if yo u 've got a pre tty good pho ne 
co nnecti o n to th e o th e r compute r. 
Othe rw ise (or if yo u 're no t s ure) 
choose 128 Bytes. 

II 

Select file to send: 

ii? I c.(IRftl DISK) 

\GEOWORKS\OOCll"IEltT 

0 Click Send . The Send Statu s w indow 
appea rs , showing you the numbe r of 
e rrors encounte red during the send . 
While it 's no rma l to ge t a couple of 
e rro rs during the opera tion , ge tting a lo t 
o f e rro rs in a little bit of time p robably 
indica tes that the re 's a p roble m w ith the 
line . If you wa nt to stop sending the fil e 
at any time, click Ca nce l. 

Sendln9 MYFl.£.00 
Paclceta senti 1 o 

Packet Errora. I 
Timeouts. 0 

To receive a file with XMODEM ... 
Yo u rece ive fil es in mu ch th e sa me 

way as yo u send the m. 
0 Le t the re mo te compute r know th at 
yo u 're read y to rece ive a fil e us ing 
XMO DEM. GeoComm d oesn 't d o thi s 
fo r you-you must manually type in a 
message. 
f) Choose Receive XMODEM fro m the 
File me nu . A fil e se lecto r appea rs . 
8 Loca te the directory whe re you 
w ant to save the fil e. 
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0 Ente r a name fo r the fil e , in DOS 
fo rmat. 
0 Choose the Text o ptio n if you are 
rece iving a DOS text fil e. Se lec t the 
Bina ry o ptio n if yo u a re rece iving a 
bina ry fil e (such as a GeoWo rks d o cu
me nt o r appli ca ti o n fil e) . 
Q Choose CRC if the re mote sys te m 
ca n accommoda te CRC (Cycli c Redun 
d ancy Chec k). Choose Checksum if the 
re mote sys te m d oesn 't a llow CRC. CRC 
is a mo re sophistica ted e rro r-checking 
protoco l th a n Checksum , a ltho ugh 
e ithe r sho uld res ult in e rro r-free fil e 
transfe rs . If you 're n o t s ure w hi ch to 
use, choose Checks um . 

@ Click Receive. The Receive Status 
w indow appears , showing the numbe r of 
e rro rs encountered during the ope ratio n . 
Expect to get a couple of errors , but if 
you seem to be encounte ring an awful 
lot o f them (especia lly if you get them 
all right away) it may indica te a proble m 
with the line. If you wa nt to stop receiv
ing the fil e, click Cancel in the Rece ive 
Status w indow (if the button becomes 
disa bled (grey) , then the fil e transfe r 
ca n 't be inte rrupted at this po int) . 
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SHOWING LINE STATUS 

Naturally, any sort of connection 
between two computers is not going to 
be perfect-transmission errors are 
bound to occur. The Show Line Status 
feature of GeoComm allows you to 
monitor those errors and decide if 
what you're sending is making it to the 
other computer, and vice versa. Usua lly 
it 's all right for a few line errors (like 
10) to occur. You should start to worry 
when you see hundreds of errors (and 
hang up the phone and try again if you 
see thousands). 

To show line status ... 
Choose Show Line Status from the 

Options menu. The Show Line Status 
window appears . This window moni
tors errors o n the serial line , updating 
its disp lay each time a read , write, 
frame, or parity error is encountered . 

To reset line status counters ... 
Click Reset Counters in the Show 

Line Status window. The four error 
counters re.set to zero. 

USING SCRIPTS 

Through the use of GeoComm scripts, 
you can automate many aspects of your 
communications tasks. For example , 
scripts are great for automatically log
ging on to an information service. Geo
Comm comes with several sample 
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scripts that are ready to use . Use these , 
or create your own using GeoComm's 
scripting language . 

To run a script ... 
0 Choose Scripts from the Dia l menu. 
The Scripts dialog box appea rs. 
f) Locate and select the script you 
would like to run. 

E) Click Run. The Script Display win
dow appears , showing the progress of 
the script. You can stop a script at any 
time by clicking Stop in the Script 
Display window. 

To create a script ... 
0 Use the Notepad desk tool or any 
other DOS text file editor to create a file 
containing your script. For a description 
of scripting commands, see "The Script
ing Language, " later in this chapter. 
f) Save the file with a name that ends 
with .MAC. "MYSCRIPT.MAC ," for 
example. 
E) Place this script file in the 
GEOWORKS \ GEOCOMM directory . 
Once it 's there , you can run the new 
script from the Scripts dialog box. 



THE SCRIPTING LANGUAGE Scripts resembl e 
simple prog rams- a nd in fac t yo u ca n 
use th e m to "prog ra m" GeoComm to 
p e rfo rm commo n tas ks fo r yo u , such as 
logging o n to an in fo rmat io n serv ice . 

In GeoComm 's sc riptin g lang uage , 
yo u must e nte r a ll th e comm ands in 
uppe r case . 

In the descriptions th at fo llow , words 
e nclosed in angle brackets ("<>") are 
words that you re pl ace with your ow n 
(minus the brackets) . 

:<label> 
Any lin e beginning w ith a co lo n is 

treated as a labe l (a lth o ug h the co lon 
isn 't ac tu a ll y p a rt of th e labe l). Use the 
GOTO command to jump to a label 
lin e. Labels ca n be in uppe r o r lower 
case, but yo u mus t be co ns istent-if 
you have a label d efin ed as ": GoHere '', 
you must re fe r to it exactl y the same 
way in GOTO statements ("GOTO 
GoHe re "). He re 's a sampl e labe l lin e: 

: Bran c hToMe 

:ABORT 
GeoComm will GOTO thi s spec ial 

labe l if th e user clicks Stop in the Script 
Disp lay w indow. The word "ABORT" 
mu st be a ll uppercase . If th e re 's no 
labe l, th e script s impl y s tops. 

: ABORT 

BELL 
Thi s command makes a beep sound 

to a le rt th e user. 
BELL 

CLEAR 
This comm and clears th e Script 

Display w ind ow. For Example: 
CLEAR 

COMM <baud-databits-parity-stop
bits-duplex> 

This command se ts the communica
tion se ttings . For more de ta iled infor-
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m ation , re fe r to "Setting Pa rame te rs " 
ea rli e r in this chapter. 

With the COMM command you have 
th ese settin gs ava ilable to you: 

baud 300, 1200 , 2400, 4800, 
9600, 19200 

data bits 5, 6, 7, 8 
parity N, 0, E, M, S 
stop bits 1, 1.5 , 2 
duplex HALF, FULL 

For example, if yo u 're using a 2400 
baud line with e ight d ata bits, no parity , 
and one stop bit , you wo uld put this 
command in your script (put das hes 
between settings) : 

COMM 24 00-8-N-1-FULL 

DIAL <number> 
This dia ls the number given using 

to ne or pulse dia ling (see the TONE and 
PULSE commands late r in this section). 

To make your script dial a 9 to con
nect you to an o utside line, and then dial 
555-1 212 , you would put the following 
command in your script: 

DIAL " 9 , 555 - 1 21 2 " 

END 
This sto ps the script, re turning control 

to the user (but doesn 't jump to the 
:ABORT label). 

GOTO <label> 
This ca uses GeoComm to jump to 

the line s tarting w ith ":<labe l> ". Be 
sure to leave off the starting colon . 

GOTO BranchToMe 

MATCH <text> GOTO <label> 
PROMPT <number> 

Th e MATCH and PROMPT commands 
work togethe r to make GeoComm per
form some action based on text received 
from the other computer. 

First, the MATCH command makes 
GeoComm look for <text> in the text 
tha t is transmitted by the other com-
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puter. You can specify many MATCH 
commands but after them all, you must 
include a PROMPT command. 

The text for the MATCH commands 
must be entered in quotes ("). 

Use the PROMPT command to make 
sure GeoComm doesn't wait too long for 
text from the other computer. The 
PROMPT command causes GeoComm to 
wait a certain amount of time for the 
remote computer to satisfy one of 
MATCH commands. If a match is found 
within the specified time, GeoComm 
jumps to the given labe l. On the other 
hand, if no match is found in time , Geo
Comm "fall s through " and runs the com
mand following the PROMPT command. 
The time in the PROMPT command is 
given in sixtieths of a second. For exam
ple, to make GeoComm wait for up to 
sixty seconds (3600 sixtieths of a sec
ond) while waiting for the other com
puter to either ask for a password or say 
that no login is possible, you could put 
the following lines in your script: 

MATCH "Password?" GOTO DoPass 
MATCH "System down" GOTO Down 
PROMPT 3600 
PRINT "No response" 

PAUSE <number> 
Causes GeoComm to pause for a cer

tain amount of time before continuing 
with the script. The <number> must be in 
units of sixtieths of a second. If you omit 
the number, GeoComm pauses for one 
second. For example, to make GeoComm 
pause for one minute (60 seconds), you 
would use this command: 

PAUSE 3600 

PORT <port> 
Makes GeoComm use the given COM 

port to communicate with the other 
computer. If your modem is connected 
to COM port 2, for example, you would 
use this command: 

PORT 2 
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PRINT <text> 
This command displays the <text> in 

the Script Display window. The text is 
not sent to the other computer. If you 
want the next thing you print in the 
Script Display window to start on the 
next line , you should end the line with 
",CR" (for carriage return) . For example, 
to make your script show the message 
"Sending password ... " when it transmits 
a password , you would put the follow
ing command in your script: 

PRINT "Sending 
Password ... ", CR , CR 

TONE 
PULSE 

These commands cause GeoComm to 
use tone or pulse dialing when it dial s 
a phone number. Otherwise, GeoComm 
uses what you've set in your Modem 
settings: 

PULSE 

SEND <text> 
This command sends the <text> to 

the remote sys tem . You can add a 
",CR" to the end if you want a carriage 
return sent after the text. For example, 
to send the word "password" followed 
by a (Return ! to the other computer, you 
would put the following line in the 
script: 

SEND "password ", CR 

TERM <terminal type> 
This command makes GeoComm 

emulate a certain type of terminal. The 
<terminal type> must be one of these : 
TTY, VT52, VTlOO, WYSESO, ANSI , 
IBM3101, TVI950 . For example, to make 
GeoComm emulate a standard TTY 
terminal, you would put this command 
in your script: 

TERM TTY 



G E 0 D E 

GeoDex combines a card file with a 

phone auto-dialer. It's ideal for keeping 

track of friends, relatives, and business 

contacts. Browsing, listing, and free

form search capabilities make 

/~ ·· finding a name, address, or phone 
; . 

C : number quick and easy. GeoDex can 
: Rh;,''}''."'° ' 
·~u 

·· also print lists of names and phone 

x 

numbers, or mailing labels if you W"ant. 

And for those W"ith modems, GeoDex W"ill 

dial your phone for you. 



THE GEODEX WINDOW 

GeoDex, on screen, resembles an 
office card file, and like an office card 
file you add names, addresses , and 
phone numbers directly to the cards
one card for each person. Once you 've 
filled in your cards, you can view each 
card individually, or look at all the 
names in the Browse View. 

Move through your cards one at a 
time with the Next and Previous but
tons, or click one of the letter tabs to 
jump right to the names that start with 
that letter. Click the dial button and 
GeoDex automatically dials the phone 
number that appears on the current 
address card (provided you have a 
modem, of course) . 

John Mur-tnik 
2 338 Pebbles (i) 
Ber-keley. CR 94190 

(2) :& 1IHOME 11789-9009 

~ 

GEODEX 

The GeoDex window, which resembles a common office 
card file. The "card" fills most of the window ((i)); 
this is where you enter the name, address, and phone 
numbers. Click the Phone Number arrows to view the 
seven different types of phone numbers ((i)). Or dick 
the Next and Previous arrows (0)) to flip forward and 
backward through the cards. 
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ADDING CARDS 

You add names and other bits of 
information to your GeoDex address 
book by adding cards, just like you 
wou ld in a real card file-you put the 
information right on the card. 

To add a card ... 
0 Click New. A blank card appears. 
8 In the index field, type the person's 
last name, then the 
first name, separat
ed by a comma
Murtnik, John 
for example. 

The cards are sorted by the index 
field. By entering something other than 
names in the index field, you can order 
the cards differently. For example, you 
can use area codes or zip codes as 
indexes. 
8 When you're satisfied with the name 
as it is, press !Return). The name is auto
matically copied down to the address 
field, but now with the first name first 
and the last name last. Press I Return I 
again to move to the next line. 
0 Type the address , pressing !Return) at 
the end of each line. You may enter 
the address in any format you wish. 
You may a lso make addresses as many 
lines as you like; n 

1 
e c o . E 

the address area 
automatically 
scrolls if you 
need more room. 
0 When you're finished typing the 
address, press ~. The text cursor 
moves into the telephone number area. 
Click the two arrow buttons to select the 
type of telephone number-home, busi
ness, fax, or car- or create your own 
type. To do so, click the down arrow 



until you come to 
a blank phone 
type . Click in the 
type field and 
e nte r your own. 

9 You may e nter more than o ne te le
phone numbe r. Ju st click th e a rrows 
aga in to select an o th e r type of number. 

He re are some guide lines for e nter
ing phone numbe rs: 
• Omit the a rea code fo r loca l numbe rs. 
• For lo ng distance ca lls, include the 1 

and th e area cod e. For example: 
1-415 -555-1 2 12. 

•If th e numbe r needs a spec ia l dialing 
sequ e nce-to access a lo ng dista nce 
serv ice, for instance-be sure to e nte r 
this seq ue nce before the regular num
ber. For example: 10288-1-202-
555-1212. 

•Place a comma anyw he re in the num
ber where you wa nt a brief pause in 
the dialing sequence . This is ac tu a lly 
a modem fea ture; no t all mo d ems 
support it and different models d e lay 
for diffe re nt amounts of tim e. Check 
your mode m owne r's manual for 
more informatio n about this fea ture. 

•If there is a specia l number-such as 
an access cod e fo r a n outside line
that yo u a lways dial before each 
numbe r, yo u ca n enter it in front of 
every numbe r. For insta nce , if you 
a lways dial a 9 before dia ling the 
phone numbe r, you co uld type it as 
pa rt of the numbe r, like this: 9 , 5 5 5-
1212. 
He re the access code is sepa rated 
from th e numbe r by a comma. This 
no t only makes the number more 
read able , but a lso pa uses the dialing 
brie fl y to g ive yo ur pho ne sys te m 
time to respond to the access code. 
You could leave both the access code 
and the comma off of the phone 
number and instead e nter them in the 
Prefix box on the Dialing Options 

To create a new category of 
phone number ... 

Click the down arrow ... 

... Until you find a blank 
category ... 

... Then dick in the box and 
type. 

10.3 

window. This is the best choice if yo u 
must dial the access code before all 
your phone numbe rs. (It 's also much 
easier to cha nge la te r, s ince you don 't 
need to change each number.) 

• To make the phone numbe rs easier to 
read , se parate the pa rts of the number 
w ith dashes ("-") o r spaces. You can 
also use pa re ntheses . For example: 
1 ( 415 ) 5 5 5 -1 2 12. These extra 
characte rs will no t affect dia ling. 

FLIPPING THROUGH CARDS 

You flip through cards in the GeoDex 
address book in much the same way that 
you flip through cards in an office card 
file. The cards in GeoDex are ordered 
alphabe tically by their indexes (the top 
field on the card) . 

To flip through ca rd s ... 
Click the Next a rrow to flip to the 

following ca rd or click the Prev io us 
arrow to flip to the pre
ceding card. On th e 
keyboard , press I Pg Up I to 
flip to the following 
card , and press I Pg On) to 
flip to the previous card. 

Flipping pas t the last card takes you to 
the first , and vice-versa. 

To flip direc tly to a le tt e r ... 
In Card View, click the index tab with 

the letter you wish to see. The first card 
sto red unde r that letter 

~ 
appears. If there are no 
cards stored under that le t
ter, GeoDex shows a blank 
card. If you double-click an 

index tab, GeoDex switches to the Both 
View before flipping to that letter. 
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MAKING CHANGES 

Changing a card is just a matter of 
flipping to the card and editing the 
text. You can also delete a card com
pletely. In either operation, if you 
change your mind, GeoDex comes with 
an Undo feature that restores the card 
to its original form . 

To change the information on a 
card ... 
0 Flip to the card you wish to change. 
See "Flipping Through Cards ," earlier 
in this chapter, for information about 
finding a particular card. 
8 Change the name and address the 
way you would change any text-select 
it with the mouse and replace it with 
the new text. 
8 Change the phone number the same 
way you normally change text, by 
selecting the number and retyping it. 
(You may need to click the phone 
number arrows to bring up the number 
you want to change.) 

To undo a change ... 
Choose Undo from the Edit menu. The 

card reverts back to its original form. 

To delete a card .. . 
0 Flip to the card you wish to delete. 
8 Choose Delete from the Edit menu . 
The card is removed from the address 
book. 

To undo a deletion ... 
Choose Undo from the Edit menu. 

The card is restored to the address 
book. 
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DIALING 

For GeoDex to dial your telephone, 
you must have a Hayes compatible 
modem on the same line as your phone 
(see your modem's documentation) and 
you also need to use the Preference Desk 
Tool to set your modem's parameters 
(see "Preferences" in this guide) . 

There are two ways to dial your 
telephone using GeoDex. The first is to 
find the person 's card , then click the 
Dial button on the card . However, if 
you frequently dial certain numbers, 
you may pre fer using GeoDex's Quick 
Dial command. With this method , you 
don 't have to actually find the person 's 
card-just click the Quick Dial button . 
GeoDex then gives you a list of the 
most frequently dialed numbers and a 
list of the most recently dialed num
bers . Pick a number from one of the 
lists and click it. GeoDex automatically 
dials the number. 

Before you dial a number from within 
GeoDex, make sure that your telephone 
is not off the hook-otherwise your 
modem may not be able to dial the 
number correctly. 

To dial a number on the current 
card ... 
0 Make sure that your telephone is 
properly hung up. 
8 Click the small arrows to scroll to 
the appropriate phone number. 
8 Click Dial. The Dialing dialog box 
appears, telling you that GeoDex is 
starting to dial the phone number. If 

ey .. CR 94190 

1789-9009 



yo ur mo de m has a bui lt-in spea ke r, 
you ' ll hea r th e dia l-to ne, th e num ber 
b e ing di a le d , and the rin g ing s igna l. 
0 As soon as the modem fini shes dia ling 
the number, pick up the te le pho ne hand
set and cl ick Talk in the dialog box. This 
resets th e modem before it ca n give its 
dea fe ning connect to ne . If you don 't 
click Talk quickly eno ugh, th e pe rson 
answering w ill no t be ab le to hear you 
speaking, but he will hea r your mode rn . 

To Quic k Di a l a num be r .. . 
0 Make sure th a t yo ur te le ph o ne is 
p ro pe rl y hung up . 

8 Click th e Quick Dia l 
butto n . 
8 A di a log box appea rs 

,,_ ...... ,.. · i w ith two se ts o f numbe rs, 

th ose most o ft e n d ia led and th ose most 
recently di a led . Click th e butto n show
ing the name and numbe r yo u wish to 
dia l. The Dia ling di alog box appea rs , 
and you hea r th e mode rn di a l the num 
be r. 
0 As soon as the mode rn finishes dialing 
the number, pick up the te lepho ne hand
set and click Talk in the dialog box. This 
resets the modem before it can give its 
lo ud connect tone. 

The two speed-dial lis ts are continu al
ly updated . For exa mple, as you click o n 
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a numbe r in the Frequently Called lis t, 
the numbe r may move up the list 
beca use it is gradu a lly becoming the 
most frequ ent ly ca ll ed numbe r. It a lso 
moves to the to p of the Recently Called 
list, s ince it is, by definiti o n , the last 
number ca lled . 

SETTING THE DIALING OPTIONS GeoDex ca n 
auto ma ti ca ll y add spec ia l numbe rs to 
th e fro nt o f eve ry numbe r di a le d . Yo u 
e nte r th ese spec ia l numbe rs in th e 
Dia ling Optio ns dia log bo x . 

19 Area Code: {1-4151 I 

Pre fi x If your pho ne syste m re quires 
that yo u pre fi x a ll your pho ne numbe rs 
w ith a s pecia l access cod e, yo u ca n 
have GeoDex a uto matica lly dia l this 
pre fi x fo r you . Fo r examp le, ass um e 
th at yo ur ph o ne syste m re quires th a t 
yo u di al 9 before eve ry pho ne numbe r, 
and th at you 've e nte red "9 ,". If the 
address card shows 555-121 2 as th e 
numbe r, GeoDex ac tually di a ls 
9,55 5-1212. 

The Quick Dial window. The 
column of buttons on the left 
shows the numbers you dial most 
often, while the column on the 
right shows the last ten numbers 
you've dialed. 
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Area Code GeoDex can turn every 
phone number it dials into a long
distance number, which is handy if 
take your computer outside of the local 
area code but still want to dial the 
local numbers you have on file. For 
example, suppose you live in the 415 
area code and take your computer with 
you on long trips. If you wa nt to dial 
a ll your local numbers but don 't want 
to change every number to have an 
area code , enter "1-415-" (you should 
enter the initial 1 as well as the area 
code) in the Dialing Options dialog 
box. If the address card shows 
555-1212 as the number, GeoDex dials 
1-415-555-1212 . . 

Note that GeoDex enters this area 
code before every number it dials, so 
turn the option off if you're dialing 
numbers that already contain an area 
code . 

The Area Code field accepts long
distance codes up to ten characters long, 
allowing you to use it fo r international 
calls. 

To set a dialing option .. . 
0 Choose Dialing Options from the 
Options menu. The Dialing Options 
dialog box appears . 
8 Turn the option on by clicking the 
check box next to the option. 
8 In the box, enter the numbers 
Geo Dex should dial. 
0 Close the Dialing Options dia log 
box by double-clicking the Control 
button. 
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To temporarily turn off a dialing 
option ... 

Click in the check box to turn the 
option off. For example, to stop GeoDex 
from placing a prefix in front of every 
number, click (to turn off) the check box 
next to Prefix . 

BROWSING 

You can v iew your address book as a 
list of names , instead of as a collection 
of cards . This li st is called the Browse 
View, and it shows only names and 
phone numbers . 

To switch betwe en the Card View 
and the Browse View . .. 

If you 're in the Card View, choose 
Browse View from the View menu. If 
you 're in the Browse View, choose 
Card View. 



To see a p e rso n 's ph o n e numb er ... 
0 Scroll the browse lis t until you find 
the p e rson 's name. 
8 Select the name by clicking it. A 
pho ne numbe r appea rs in the phone 
numbe r box . 
E) Click the up and down a rrows to 
see the diffe re nt numbe rs. 

To di a l a ph o n e numb e r ... 
Click the Dia l button . 

SEARCHING 

With GeoDex 's search feature, you 
te ll GeoDex what tex t you want to 
find, and GeoDex finds cards contain
ing that text for yo u . You can have 
GeoDex search for pa rt of a word, a 
whole word , or ma ny words. Whatever 
yo u search fo r, GeoDex looks fo r the 
text in a ll th e pa rts o f th e ca rd-in th e 
index fi e ld , n ame , address , or th e 
pho ne numbe r areas . This means that 
you could search for "M u ," and 
GeoDex would find names like 
Murtnik , Mulling , and Munster, and 
a lso people w ho lived o n Mulberry 
Avenue o r in Mudville. 

A search starts in the Both view. 
Type the text you want to find 
into the Search For area and dick 
Lookup. Not the right card? Click 
Find Next (which has replaced the 
Lookup button). 
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If thi s is too broad a search , you ca n 
limit the sea rch to the index fi e lds. 
Because these fi e lds n o rmally conta in 
just the pe rson 's name, this is e ffective
ly a name-onl y sea rch. With this type 
o f search , th o ug h , GeoDex looks o nly 
for precise ma tch es. If you ente r "murt
nik" in th e Search For field, GeoDex 
won 't conside r cards containing 
"Murtnik" to match-it 's looking for a 
"murtnik" beginning w ith a small "m ." 

To sea rc h fo r a p a rti c ul a r ca rd ... 
0 Switch to the Both view by choos
ing Both from th e View me nu . 
8 In the Sea rch Fo r fi e ld , type the tex t 
you wish to find. 
E) If yo u wish to limit your search to 
Index fi e ld o nly , turn o n the Confine 
Search to Index o ptio n . 
0 Click Lookup. The first ca rd co n
ta ining the text is sh own , and the 
Lookup butto n changes to read Find 
Next. 
0 Click Find Next to find the next 
card th at a lso conta ins the text. 

To clear th e searc h c rit e ria ... 
Click the Clear butto n . The Sea rch 

For fi e ld clears and the Confine Sea rch 
to Index o ptio n turns off. 
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PRINTING 

GeoDex gives you three different 
ways to print all the cards on file 
(there 's no way to print 
Print All prints the names, addresses, 
and the phone numbers from all the 
cards. 
Print Phones prints two columns of 
names and phone numbers. 
Print Labels prints names and addresses 
in a format suitable for mailing labels. 
The Label Size option lists the different 
sizes that you can print. 

LINKING TO GEOPLANNER 

GeoDex can search the GeoPlanner 
calendar for scheduled events containing 
a particular name or bit of text. If, for 
example, you were looking at the card 
for John Murtnik, and you wanted to 
find the time of your next meeting with 
him, GeoDex could scan the GeoPlanner 
calendar for events containing the name 
"John Murtnik." 

GeoDex expects the text for which 
you're searching to match the text in 
the GeoPlanner calendar exactly. If you 
search for "John Murtnik," you won't 
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When you want to search 
for a name in GeoPlanner, 
simply select the text you 
want to find ((.i)) and click 
the GeoPlanner button ((D). 
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get events containing the name "john 
murtnik. " For this reason, you should 
be consistent in the way that you enter 
names into both GeoDex and 
GeoPlanner (or omit the first letter 
from the search criteria). 

To find a calendar item for the per
son on the current card ... 
0 Make sure that GeoPlanner is started. 
8 Select the text. This text could be 
the person 's name , part of the address , 
or just some odd bit of text. 
8 Click the GeoPlanner button. The 
GeoPlanner window comes up , and the 
first event containing the selected text 
is shown in the Event window . If you 
want to find the next event also con
taining the name, click Find Next in 
the Search dialog box. 
0 Click Cancel in the Search dialog 
box when you're done searching. 
0 When you finish looking at the cal
endar, return to GeoDex by clicking 
anywhere inside the GeoDex window, 
or by choosing GeoDex from the 
Express menu. 

As an example , suppose you 're 
looking at John Murtnik 's card and you 
want to find your next scheduled meet
ing with him. Select the last name, 
"Murtnik ," and click the GeoPlanner 
button. The GeoPlanner window comes 
up, and your next meeting with 
"Murtnik" is highlighted. 



G E 0 D R A w 

GeoDravv lets you dravv full
color charts, graphs, and other 
pictures that you make out of 
regular shapes-that is, squares, 
circles, ovals, polygons, even text. 
Rotate, group, stretch, and color each 
element. And vvhile GeoDravv isn't the best 
choice for painting things like the Mona 
Lisa (an actual painting program is best for 
that), you can import a picture of the Mona 
Lisa created with a painting program-or 
any clip art, for that matter. And with 
GeoWorks Pro's printing power, your 

dravving prints exactly as it appears 
· ... ~~ on the screen (and in color, too, if 

you have a Postscript-compatible 
. color printer). 



WHAT Y--OU MUST ALREADY KNOW 

Certain tasks you perform in 
GeoDraw are common to all GeoWorks 
applications. This is the main reason 
you can go from one GeoWorks appli
cation to another and feel immediately 
comfortable. Here are some of these 
tasks. If you are not familiar with them 
already, go to the "Basic Tools" chapter 
and read about them there. 
•Opening and closing a document 
•Entering and editing text 
•Formatting text 
•Pas ting text and graphics from the 

clipboard 
•Saving a document 
•Printing 
•Correcting the aspect ratio 
•Working with multiple documents 

GEODRAW 11.2 

THE GEODRAW WINDOW 

The GeoDraw window is your elec
tronic easel. It includes a drawing area 
and a tool box with tools for drawing , 
moving , and reshaping objects. The 
dotted margin lines around the edge of 
the drawing area indicate the printable 
area of the page (for most printers). If 
a part of your drawing falls outside of 
this line , it 'll more than likely be 
chopped off when you print. 

MOVING AND CLOSING THE TOOL BOX You can 
move or hide the tool box when you 
want an unobscured view of your 
drawing. The tool box is a window like 
any other window in GeoWorks Pro , 
and you move and close it the same 
way (see the "Basic Skills and Tools " 
chapter). To reopen the tool box , 
choose Show Tool Box from the 
Options menu. The tool box reappears 
exactly where it was positioned when 
you closed it. 

The Tool Box 

Arrow Pointer 

Text Tool 

Line Tool 

Connected Line Tool 

The GeoDraw window. The large 
white space is your drawing area 
(the dotted line around the edge 
of it indicates the printable area). 
The tool box floats above the 
drawing area ((i)). If you don't 
like where it is, move it by 
dragging its title bar. 

Rotation Pointer 

Rectangle Tool 

Circle Tool 

Polygon Tool 



ZOOMING IN AND OUT The View me nu le ts 
you change the magnifica tion of the 
p age w ithin the w indow. It does no t 
affec t the w indow itse lf. As you create 
your image, expe rim e nt by choos ing 
diffe re nt magnifica tio n levels fro m th e 
View menu to find the one th at 's 
appropriate for w hat you 're doi ng . For 
example, w he n you wa nt to precisely 
a lign two objects, it 's eas ie r if you 
magnify the view . Whe n you wa nt an 
overview of the e ntire layout of the 
image, a reduced view is be tte r. To 
re turn a docume nt to its no rm al size, 
choose Actua l Size fro m the View 
me nu . 

SETTING THE DOCUMENT SIZE 

The size of a new document is auto 
matically set at 8 1/2 x 11 inches, the 
s ize of a regular piece of pape r. You can 
use the Page Setup command to change 
the page size and o rie ntatio n, w hich 
changes the size and shape of the draw
ing area in the GeoDraw window. 

To set the page size and orienta
tion ... 
0 Choose Page Setup fro m the File 
menu . The Page Setup dialog box 
a ppears. 
f) Click the radio button to change the 
page orientation. The Portrait setting 
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orients the page vertically; the Landscape 
setting orients the page ho rizontally. 
E) Choose a Page Size from the list, or 
adjust the Width and Height to make a 
custom-sized page. 
0 Click OK to apply th e se ttings and 
close th e dia log box. 

CREATING OBJECTS 

In Geo Draw , an image is composed 
of o ne o r mo re objects. An object is 
simply a piece o f text, a shape (such as 
a rectangle or a po lygon) , o r impo rted 
artwork (l ike clip a rt o r a Q uattro Pro 
cha rt). To make all but the most basic 
pictures , you combine a number of 
objects . Each object ca n be selected , 
edited , and manipula ted se parate ly from 
other objects in the p ictu re , a lthough 
you ca n fuse objects togethe r so they 
be have as one (see the sectio n , "Fusing 
and De fu s ing Objects ," in this chapte r. ) 

You crea te objects us ing the text 
and drawing tools in th e tool box. Two 
additio nal too ls-the Arrow Po inte r 
and Ro ta te Po inter-are used fo r 
se lec ting and manipul ating objec ts afte r 
th ey 're d raw n. As yo u d raw , don 't 
worry if a n object is not exactly the 
right shape o r a littl e o ut of pos itio n . 
Yo u ca n eas ily move a nd resha pe it
or eve n de le te it and try aga in . You 
ca n a lso flip an o bject (even a text 
o bject! ) o r rotate it to any ang le you 
wa nt . These techniques a re describe d 
in "Mov in g a nd Reshaping Objects ," 
late r in this cha pte r. 

Whe n you c reate an object , it 
appea rs in the currently selec ted colo r, 
patte rn , and style. You can change any 
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of these properties after the object is 
created. You can also edit text and 
change its font, size, and style. 

After you create an object, four han
dles appear around the object and one 
handle, called the move handle, 
appears in its center. Use the handles 
to drag, rotate , and reshape the object 
(see "Moving and Reshaping Objects " 
later in this chapter). 

On the left, the 
object. On the 
right, the object 
after you've 
selected it. 

ABOUT OVERLAPPING OBJECTS If you draw one 
object on top of another, the object on 
top may hide part or all of the object 
underneath. Often this is exactly the 
effect that you want . The objects are 
said to be stacked when they overlap 
like this. You can move an object 
towards the top or bottom of a stack 
by using the Arrange menu commands. 
This is covered in "Arranging Objects 
Within a Stack ," later in the chapter. 

Some overlapped 
objects. The text 
is on top of the 
oval, and they're 
both on top of the 
rectangle. 

SELECTING A TOOL The Arrow Pointer tool is 
automatically selected when you first 
enter GeoDraw. You use it to select, 
move , and resize objects . When you 
want to create and manipulate objects, 
first select the appropriate tool from 
the tool box by clicking on it (the 
selected tool highlights). 
•If you select one of the drawing tools , 

the pointer changes to crosshairs when 
you move it over the drawing area . The 
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The different 
pointers ... 

Arrow 

Cross hairs 

Rotate 

I-Beam 
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center of the crosshairs shows where 
the shape will begin as you draw. 

•If you select the Text tool, the pointer 
changes to an I-beam when you move 
it over the drawing area. The I-beam 
shows where the text cursor will appear 
when you click the mouse button. 

•If you select the Rotate Pointer, the 
pointer shape changes to a curved 
pointer. The Rotate Pointer works like 
the Arrow Pointer, except that you 
can also use it to rotate objects 
(though not stretch them) . 

A tool remains selected after you have 
finished the object , so that you 're ready 
if you want to make another one . 

DRAWING LINES The tool box has two tools 
for drawing lines . With the Line tool, 
you can draw a single continuous line 
in any direction. With the Connected 
Line tool, you can draw any number of 
connected lines to create a simple geo
metric outline or even , with a bit of 
patience , a smoother outline that 
resembles a freehand drawing . The 
technique for the latter is the same as 
for the former-the line segments in 
the smooth outline are just very small. 
The smaller, the smoother. 

When you draw a line, it appears with 
a standard color, pattern, width, and style 
(solid or dashed) . You can change any of 
these in the Line Properties dialog box 
described in "Changing Colors, Patterns , 
and Lines" in this chapter. 

To draw a line ... 
0 Select the Line tool in the tool box. 
f) Position the center of the crosshairs 
where you want the line to begin . 
8 Hold down the mouse button and 
drag until the crosshairs are centered 
over the point where you want the 
line to end. Then release the mouse 
button. As you drag, a dotted line 



follow s th e crosshairs. Whe n yo u 
re lease th e mouse butto n , the line is 
drawn and its handles appea r. 

.-+ 
,,, · 

To draw connected lines ... 
0 Select the Connected Line too l in 
th e tool box. 
8 Positio n the cente r o f the crossh airs 
w he re yo u wa nt th e lin e to beg in , a nd 
click to ancho r this po int. 
8 Move the crossha irs to w he re you 
wa nt the first segment o f the connected 
line to end (you d o n 't have to ho ld 
d own the mouse butto n w ith this tool) . 
Then click aga in to an cho r the segment. 
0 Co ntinu e positioning the crosshairs 
and clicking to crea te as many segments 
as you wa nt. Whe n you 've drawn as 
many segme nts as you want , do uble 
click to fini sh the connecte d line, o r 
click o n th e Co nnected Line too l. Yo u 
ca n a lso press the l"'ES£1 key (or the right 
m o use butto n) to end the last line. 

• 
+ 

• 

• • 
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DRAWING CIRCLES The Circle tool draws 
circles and ovals tha t initially have the 
standa rd fill and outline (which you can 
change with the Area Pro pe rties dialog 
box described in "Changing Colo rs, 
Patte rns , and Lines" in this chapter) . 

To draw a circle ... 
0 Selec t the Circle tool in the tool box. 
8 Pos itio n the cross ha irs w he re you 
wa nt the c ircle to beg in. 
8 Hold d o wn the m o use butto n and 
drag diagonally in any direc tio n until 
th e circle (or oval) is th e s ize you 
wa nt . Re lease th e mo use butto n . 

As you drag, a do tted o utlin e indi
ca tes the circle 's size. Yo u ca n adju s t 
the size until you re lease th e mo use 
butto n . The dotted o utline appea rs as 
e ithe r a circle o r a rectang le , de pe nding 
o n w he the r you ch oose the Drag as 
Rectangle o r the Drag as Outline o ptio n 
fro m the Optio ns me nu . (Fo r mo re 
informatio n , see "Making GeoDraw 
Wo rk Faste r" late r in this chapte r. ) 

+ 

DRAWING RECTANGLES Th e Rectang le tool 
draw s fill e d rec tan g les a nd squ a res . A 
rectangle or square initia lly comes 
w ith the standa rd fill a nd o utlin e, but 
you can ch ange this w ith the Area 
Properties dialog box (d escribe d in 
"Changing Colors, Pa tte rns, and Lines " 
la te r in this chapte r) . 
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To draw a rectangle ... 
0 Se lect the Rectangle tool in the tool 
box . 
8 Positio n the crossha irs w h e re you 
wa nt the rectangle to begin . 
8 Ho ld d own the mo use button and 
drag in any directio n until the rectangle 
(or square) is the size you wa nt. (As you 
drag , a do tte d o utline indica tes the rect
angle 's size .) Re lease the mo use butto n . 

DRAWING POLYGONS The Po lygon tool a llows 
you to crea te objects with irregul ar 
shapes and three o r mo re sides . With 
this tool, you draw a se ries o f connected 
line segments and le t GeoDraw close 
them into a solid sha pe. The shape is 
auto matica ll y fi ll ed with a so li d pattern , 
w hi ch you can change with the Area 
Pro pe rties dialog box (descri bed in the 
"Chang ing Colors , Patte rns , and Styles" 
secti on in this chapter.) 

To draw a polygon ... 
0 Se lect the Po lygon too l in the too l 
box. 
8 Positi o n the cross ha irs w he re yo u 
want the firs t line o f the p o lygon to 
beg in , and click to ancho r thi s p o int. 
8 Move the cross ha irs to w he re you 
want this first segme nt o f the p o lygon 
line to end . Th e n click aga in to anch or 
th e segme nt. 
0 Co ntinu e positi oning the crossha irs 
and clicking to crea te as many seg
me nts as you wa nt. At the e nd of the 
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n ext-to- last segment , double-click to 
fini sh the polygon . GeoDraw co nnects 
this last p o int to the starting p o int to 
compl e te the sh ape . The p o lygon is 
the n fill e d in and its handles appear. 

You can also fini sh a p o lygon by 
press ing the ~ key o r the rig ht 
mo use butto n (o r click the Po lygon 
tool aga in). 

TYPING TEXT The Text tool le ts yo u crea te 
a s imple ca pti o n o r fill the p age w ith 
many p a ragraphs o f text. In GeoDraw, 
a block o f tex t acts like any o bject. It 
ca n be moved , res ha ped , ro ta ted , and 
flipp e d , w hi ch le ts you crea te spec ia l 
e ffec ts. For exampl e, you ca n s tre tch 
and skew a text bloc k by fu s ing it w ith 
itse lf-turning it into a "s hap e "- and 
then dragging its handl es. See "Fusing 
and Defu sing" la te r in this chapte r. 

Text appears in the curre ntly selected 
font , s ize , style , and justificatio n. Yo u can 
change these attributes and even add 
color and halfto nes to text as described 



in "Changing Colo rs, Patte rns , and Styles" 
in th is cha pte r. Text is fu ll y ed itab le and 
can be cut , copied , and pasted in the 
normal manne r. 

To type tex t .. . 
0 Se lec t the Text too l in th e too l box . 
The po inte r changes to an I-bea m . 
8 Pos itio n the I-bea m w he re yo u wa nt 
th e firs t cha racte r to begin . 
8 De fin e the w idth o f th e b lock o f text 
by dragging the I-bea m to th e right , as 
yo u might drag th e Rectang le too l. 
0 Re lease the m o use and begin typ
ing . As yo u type , th e text w ra ps w ithin 
the tex t ob jec t , w hi ch auto matica ll y 
exp a nds d ow nwa rd to acco mm oda te 
th e new lines. Yo u ca n crea te a text 
o bjec t w ith a standa rd three- inch w idth 
by jus t cli cking. 

Whe n you finish typing , the Text tool 
re mains se lected . Yo u can crea te add i
ti o na l text o bjects o r se lect a nothe r too l. 

To create a text box, select the Text tool and drag a box ... 

Then, type. 
, ........... .... ... .... .... .... .... ....... ..... 1····· ····· ········ ····· ··· ······· 

10nce upon a ~ · .................................................................. .......... ~ 

As your text reaches the right edge of the text box, the box 
grows downward to accomodate another line. 

r0·~·~~· -~·p~·~· · ·~··i~·~·· · ·· ·· · ·· · ·· · ·1 

~ere was a little line l 
of text that sat inside l 
~J.~!.~.~ --~?..~ ....................................... ...I 
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SELECTING OBJECTS 

Afte r yo u c re ate a n o bjec t, yo u ca n 
a lte r it in many ways. But before yo u 
change an o bject , yo u mu s t select it 
us ing e ithe r the Arrow p o inte r o r Ro ta 
tio n po inte r too ls. Yo u se lec t o bjects in 
GeoDraw the sa me way yo u se lec t 
icons in th e Fil e Ca bine t o r Geo Ma nag
e r, by cl icking the m w ith th e mo use. If 
yo u se lec t mo re th a n o ne o bj e ct a nd 
ma ke a ch ange, the cha nge app lies to 

a ll th e se lec ted ob jec ts. 

To select an object by clicking ... 
0 Se lect the Arrow po inte r o r the 
Ro tatio n p o inte r. 
8 Pos iti o n th e po inte r ove r th e o bjec t. 
Any p a rt w ill d o ( it d oes n ' t need to be 
ove r th e ce nte r) , as lo ng as the p a rt 
isn 't ove rl appe d b y an o th e r o bjec t. 
8 Click . 

To select objects by dragging ... 
0 Se lect th e Arrow p o inte r o r th e 
Ro tatio n p o inte r. 
8 Vis ua li ze a box surrounding the 
gro up of ob jec ts yo u wa nt to se lec t . 
The n p os iti o n th e po inte r a t the "co r
ne r" o f th is imag in a ry box . 
8 Ho ld d own the mo use butto n a nd 
drag diagonall y until the d o tted "rub
be r ba nd " rec tangle surrou nds a ll th e 
o bjec ts yo u want to se lec t. Re lease the 
mo use butto n . As yo u se lec t an o bjec t , 
its handl es appea r. If you missed a n 
o bjec t , try aga in . 

: a • • ~ 
! .Ovals &•Squares• : 
· .................................................................................................................. ·~ 
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To add objects to a selection ... 
Hold down~ as you select addi

tional objects. You can also deselect 
objects in a selected group by holding 
down ~ and clicking the selected 
objects. Other objects in the group 
remain selected. 

To select every object in the docu
ment ... 

Choose Select All from the Edit menu. 
Every object is instantly selected. 

SELECTING CHARACTERS WITHIN A TEXT OBJECT 
When you want to edit or modify 
selected characters within a text object , 
use the Text tool to select the charac
ters you want to change. The selection 
appears highlighted. (See the "Basic 
Tools and Skills" chapter to read more 
about selecting text.) 

To move or reshape a text object or 
make the same change to all its charac
ters, select the text as an object-that is , 
use the Arrow or Rotation pointer tools . 
For example , you wou ld use this tech
nique when you want to change a ll the 
characters in a block to the same font. 

-

..... ................ .......................... ! 

pon a time, ~ 

1here was a 1 ittle 1 ine ~ 
bf text that sat inside a ! 

~-~!~~---~?..~ ............. ............ .. ....................... .J 
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MOVING OBJECTS 

In GeoDraw, you can move objects by 
dragging them using the right mouse 
button-the same way you move files in 
GeoManager. You can also use the left 
mouse button to move a selected object 
if you drag the object's "move" handle 
(the center handle) . To speed up moving 
objects, select the Drag as Outline option 
on the Options menu . This option is 
discussed in "Making GeoDraw Work 
Faster" later in this chapter. 

To drag one or more objects using 
the left mouse button ... 
0 Select the objects you want to drag. 
8 Position the pointer over the center 
"move" handle of one of the selected 
objects. 
8 Press the left mouse button and drag 
the object- or objects-to the new 
position. Release the mouse button. 

To drag one or more objects using 
the right mouse button ... 
0 Position the pointer on the object 
(or on any one of the objects if multi
ple objects are selected) . The pointer 
need not be over the object 's center 
handle. 
8 Press the right mouse button and 
drag the object- or objects-to the new 
position. Release the mouse button. 



NUDGING OBJECTS You can precisely position 
an object by moving it one pixel at a 
time with the Nudge command on the 
Modify menu . Pixels are the small screen 
dots that form the character image. 

To move an object slightly by nudg
ing ... 
0 Se lect o ne or more objects. 
f) Choose Nudge fro m the Modify 
me nu . The Nudge cascad e me nu 
appears. 
f) Choose the direc tion in which yo u 
want to nudge the se lecti o n . After th e 
object moves, the udge me nu disap
pea rs- so, if you plan to do mo re than 
one nudge , you sh o uld pin the menu 
before choos ing o ne of the directions . 

ROTATING OBJECTS 

The Ro tate 45° Right and Ro ta te 45° 
Left commands o n the Modify me nu le t 
you ro ta te an o bjec t precisely 45° 
clockwise or co unter-clockwise. On 
the o th e r hand , th e Rotation pointer 
le ts yo u ro tate a n ob ject freehand to 
any position . An object a lways ro ta tes 
aro und its cente r po int. 

Keep in mind th a t text charac ters 
ca nno t be edite d when th e text object 
has been rotated . To edit tex t charac
te rs , first rotate the ob jec t back to its 
o riginal orientation. 

Also , if se lect seve ral objec ts and 
rotate the m , they won 't rotate as a 
single unit ; that is, each piece will s tay 
in the same place and rotate about its 
center point . If you want to rotate all 
the pieces as a single unit , fuse them 
first. 
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To rotate objects 45° ... 
0 Select one or more objects. 
f) To rotate 45° clockwise , choose 
Rota te 45° Right from the Modify menu. 
To rotate 45° counter-clockwise , choose 
Rotate 45° Left from the Modify me nu . 
Each object in the se lection rotates 45° 
around its own cente r po int . 

• 

To rotate an object freehand ... 
0 Se lec t the Ro tate po inte r in the too l 
box. 
f) Click the object you want to rotate. 
The object se lec ts and its handles 
a ppear. 
f) Position th e Rota tio n p o inte r ove r 
o ne of the co rne r handl es. 
0 Ho ld d own the mo use button and 
drag clockwise o r counter-clockwise to 
rotate the object to the pos iti on yo u 
wa nt it . As yo u drag , the o utline shows 
how the object wo uld appear if yo u 
released the mouse button. 

I •• " 

\ .... ·· 

0 Release the mouse button. The 
object appea rs in its rotated pos iti o n . 

GEODRAW 



FLIPPING OBJECTS 

You can flip an object on its hori
zontal or vertical axis using the Flip 
Horizontal and Flip Vertical commands 
on the Modify menu. Text characters 
cannot be edited when the text object 
has been flipped (to edit text charac
te rs , first flip the object back to its 
original orientation). 

To flip an object on an axis ... 
0 Select one or more objects. 
f) Choose Flip Horizontal from the 
Modify menu to flip the object along 
its horisontal ax is . Or, to flip it along 
the vertical axis, choose Flip Vertical. 

Flipping horizontally. 

RESHAPING OBJECTS 

You can change the s ize and shape 
of an object by stretching it vertically 
or horizontally-or both directions at 
the same time . Stretching an object 
distorts the object's shape. 
Note: Reshaping a text object changes the line width, but 
does not affect the shape of the characters. The line width 
determines how words wrap within a text object. 

To stretch an object ... 
0 Select the Arrow pointer. 
f) Click the object you want to select. 
The object 's handles appear. 
8 To stretch an object vertically, posi
tion the pointer on one of the handles 
on the top or bottom edge and drag. To 
stretch an object horizontally, position 
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the pointer on one of the handles on 
the left or right edge and drag. To 
stretch the object both vertically and 
horizontally, position the pointer on 
any corner handle and drag. Until you 
release the mouse button , you can con
tinue adjusting the shape. An outline 
shows the size as you stretch. When 
you release the mouse button, the 
object appears in the stretched shape. 

., ....... , ......................... . 

MAKING GEODRAW WORK FASTER 

As you move or reshape an object, a 
dotted outline appears around it showing 
the size and location of the object as you 
manipulate it (it appears when you draw 
the object, also). This outline of the 
object 's shape allows you to place it 
exactly where you want it-aligned with 
another object, for example . If you don 't 
need to see the exact boundary of 
objects for precise placement, however, 
you can speed up moving and reshaping 
objects with the Drag as Rectangle option 
on the Options menu . With this option 
selected, a rectangle appears around a 
selected object no matter what its shape. 

Dragging as Outline ... . .. vs. Drag as Rectangle 



COPYING AND PASTING 

Copying and pasting produces an 
exact replica of an object and makes it 
easy to create an image that contains 
many identical parts. After you paste , 
you can drag , rotate , or flip the object to 
position it where you want it. With text, 
you can also copy selected characters 
and paste the m into another text object, 
or paste them in as a new object. 
Objects can be copied and pasted with in 
one document or between different 
documents . (Copying and Pasting is 
discussed more thoroughly in the "Basic 
Tools and Skill " chapter.) 

To insert text in an existing text 
object ... 

Choose the Text tool from the tool 
box. Position the I-beam at the point in 
the text object where you want to 
insert the text. Click to place the text 
cursor. Then choose Paste from the 
Edit menu . 

To paste text as a new text object ... 
Choose the Pointer tool from the tool 

box (not the Text tool). Then choose 
Paste from the Edit menu. The pasted 
text appears in a new text object in the 
cente r of the screen . Or, se lect the Text 
tool and position the I-beam in an empty 
part of the screen . Click . This opens up 
a new, empty text object. Choose Paste 
from the Edit menu. 
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CUTTING AND DELETING 

There are two ways to remove 
se lected objects or text characters
cutting and deleting. Cutting removes 
the se lection to the clipboard so that 
you can paste it in another document . 
Deleting permanently removes the 
selection without saving it to the clip
board. Do not delete an object you 
intend to paste somewhere else. 

To cut or delete objects, select them 
and choose the Cut or Delete command 
from the Edit menu . 

CHANGING COLORS, PATTERNS, 
AND STYLES 

GeoDraw has a palette of 16 colors 
and 16 patterns that you can apply to 
lines, object o utlines, and the area 
inside filled objects (rectangles , circles, 
and polygons). You can also apply color 
and halftones to text as described in 
"Changing Text Color and Halftone" 
later in this chapter. To work with colors 
you must have a color monitor, either 
EGA or VGA. To print a document in 
color you need a Postscript compatible 
color printer and the appropriate printer 
driver installed. If you are working with 
a color monitor and a black and wh ite 
printer, colors will print o ut as different 
shades of gray. 

You use three properties boxes for 
changing colors, patterns , and styles- an 
Area Properties box, a Line Properties 
box, and a Text Properties box. Open a 
properties box by choosing its command 
from the Modify menu. You can leave it 
open to make repeated changes to an 
object until you are happy with its 
appearance, or to change other objects . 
If the properties box is covering up an 

GEODRAW 



object, move it around the screen by 
dragging its title bar. Close a Properties 
box by double-clicking on its Control 
button. On other words, property boxes 
are little windows, and can be moved 
and closed in the normal way.) 

CHANGING LINE PROPERTIES The Line Proper
ties box lets you change the color, 
pattern, width and style of both lines 
and object outlines (the outline of a 
filled object is treated as a line and can 
have a different color and pattern than 
the object's interior). If no object is 
selected, the changes you make will 
affect the next object you create. 

To change an object's line 
properties ... 
0 Select the object (or objects). If you 
do not select an object before you 
change the line color or pattern settings, 
the change will be applied to the next 
object you draw. 
8 Choose Line Properties from the 
Modify menu to open the Line Proper
ties box. 

8 Click the different buttons to 
change the settings. Each time you 
click a setting, the selected objects 
reflect the change. 

If you have a monochrome monitor, 
your only color choices are black and 
white. 

Before changing the Line 
Properties ... 
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... and after. 
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FILLING AN OBJECT WITH A COLOR OR PATTERN The 
Area Properties box lets you change the 
color or pattern of the area within a 
filled object. A filled object is any object 
created with the Rectangle, Circle, or 
Polygon tools. A closed shape created 
with the Line or Connected Line tool 
cannot be filled with a color or pattern. 

You can set the area color or pattern 
for existing objects (or for the next 
object you draw) with settings in the 
Area Properties dialog box. Patterns 
can be either solid or see-through. 
With a see-through pattern , the "holes " 
in the pattern are actually clear and 
allow you to see through to objects in 
the background.In a solid pattern , the 
"holes " are actually opaque, so that 
you can't see through the object. 

To change the fill color or pattern ... 
0 Select the object (or objects). If you 
do not select an object first, any changes 
you make in the properties box apply to 
the next object you draw. 
8 Choose Area Properties from the 
Modify menu to open the Area Proper
ties box. 

8 Click to select the Color or Pattern 
you want to apply to the object (or 
objects) you 've selected. You can click 
both a color and a pattern setting. Each 
time you click a setting , the selected 
objects reflect the change. 

Objects can be filled with 
solid color ... 

...or a see-through pattern. 



CHANGING TEXT COLOR AND HALFTONE The Text 
Properties box le ts you change text 
colo r and set a da rk , medium , o r light 
halfto ne fo r text. A halftone is a lighte r 
shade of the colo r yo u have selected . 
GeoDraw creates the illus io n of shades 
by turning off some of the pixe ls (the 
small dots th at fo rm the cha racte r 
image). For this reason , ha lftones look 
best o n larger fo nt s izes and bo ldface 
cha racte rs that have mo re pixe ls . You 
ca n change the colo r o r halftone of text 
yo u've already typed (or th e next text 
yo u type) by clicking the se ttings you 
wa nt in the Text Prope rties box . 

Each o f the ha lfto ne se ttings is a 
pe rce ntage o f the full co ncentra ti o n o f 
the se lec te d colo r: 

Setting Concentration 
Solid 100% 
Dark 75 % 
Medium 50% 
Light 25 % 

To apply text color or halftones ... 
0 Se lect the text you wa nt to change. 
Yo u ca n select specifi c characte rs or an 
entire text object . If yo u d o not se lect 
text before yo u change colo r o r ha lftone 
settings , the change will be applied to 
the next characte rs you type. 
fJ Choose Text Pro pe rties fro m the 
Modi fy me nu (or the Text me nu) to 
ope n the Text Prope rties box . 

Halftone: 

Color: 

8 Cli ck to select the Text Colo r yo u 
wa nt . To change the Halftone setting, 
click the radio butto n for the se tting 
you wa nt. Each time you click a setting, 
the se lec ted objects re fl ect the change. 
You ca n lea ve the Prope rties box ope n 

(Right) A block 
of text with a 
medium half
tone. 
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to try diffe rent se ttings until you get the 
effec t you wa nt o r to change additio nal 
o bjects. Do uble-c li ck the control button 
to close the Prope rties box. 

• 

• 

EDITING TEXT 

In GeoDraw, text is full y editabl e. 
You ca n copy, pas te, o r d e le te text 
us ing the sa me p rocedures you use to 
e dit draw o bjects. For ins tru ctions o n 
co pying, pas ting, a nd d e le ting, see the 
re leva nt sec ti o ns ea rlie r in this chapte r. 

In additi on to the s tanda rd editing 
techniques, yo u ca n mo dify text by 
changing the text font , size, and style, 
as desc ribed in the "Bas ic Tools a nd 
Skill s " chapte r. Yo u can a lso change 
justifica tio n , as describe d be low. 

CHANGING TEXT JUSTIFICATION The Justifica tion 
command le ts you set how the left and 
right edges of text a re aligned with the 
bo rders of the text object. You can 
choose from fo ur justifica tion settings. 
Left Ju stification aligns the le ft text edges 
and leaves the right edges "ragged "-that 
is , uneven. Right Justifica tion aligns the 
right text edges and leaves the left edges 
ragged . Cente r Justifica tion cente rs text 
be tween the le ft and right borders of the 
text object. Full Justificatio n spreads 
each line of text out so that both the left 
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and right text edges are aligned with the 
borders of the text object (except that 
last line of the paragraph, which is left 
justified). 

You can change the justification 
setting for selected paragraphs within a 
text object, or for the entire text object. 

To change text justification ... 
0 With the text tool, position the 
cursor in the paragraph , or select the 
paragraphs you want to change . To 
change a ll text in an object, use the 
pointer tool to select the object (or 
objects). 
f) Choose Justification from the Text 
menu . 
8 Choose the justification setting you 
want. 

Left ... 

Right ... 

Center ... 

And Full 
Justification. 

'bnce upon a time, there was a little 
paragraph of text that oat inside a little box. 
It could shift around ~side this little box, 

.fack and for th. 

• 

• 

• Once upon a time, there was a liu!:' 
paragraph of text~ sat inside a little box. 

It could shift around inside this little box, 
back and for m. • 

• 

• 

Once upon a time, there was a little 
paragraph of text tha.t..sat inside a Httle box. 
It could shift arounainside this little box, 

back and forth. 

• 

• 

'bnce upon a time, there was a litt!:' 
paragraph of text tha~sat inside a little box. 
It could shift around inside this little box, 

.fack and for th. • 
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Moving the top 
object down ... 

... one level ... 

... at a time. 
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ARRANGING OBJECTS WITHIN A 
STACK 

Several overlapping objects are 
call ed a stack . Use the Arrange menu 
commands to move an object to the 
front or to the back of the stack to get 
the effect you want. 

To bring an object to the front or 
send it to the back ... 
0 Select the object. 
f) If you want to bring the object to 
the front , choose Bring to Front from 
the Arrange me nu. To se nd it to the 
back, choose Send to Back from the 
Arrange menu. 

To move an object one level at a 
time ... 
0 Select the object. 
f) If you want to move the object back 
into the stack, choose Move Backward 
from the Arrange menu . The se lected 
object moves one level towards the 
back of the stack. 

If, on the other hand, you want to 
bring the object forward, choose Move 
Forward from the Arrange menu. This 
moves the se lected object up one level 
towards the front of the stack. 
8 Repeat these commands again and 
again until the object is where you 
want it in the stack. 

FUSING AND DEFUSING OBJECTS 

Fusing objects makes them a single 
object-they are , in effect, fused into 
one. This feature is useful when you 
have created a drawing (a house, for 
instance) out of several separate shapes. 
By fusing them into one, you can copy, 
reshape , or resize the house as one 



object. This is much easie r than trying to 
work w ith each part of the house sepa
rately. The fuse fea ture also gives you a 
way to stretch and disto rt a block of text. 

To fuse objects ... 
0 Se lect all the o bjec ts you wa nt to 
fu se-it 's important that they a ll be 
se lec ted a t the sa me time . Yo u ca n 
e ithe r drag a do tte d se lec tio n rectangle 
around the m , o r h o ld dow n @!ill and 
cli ck the m each indi vidua ll y . 

f) Choose Fuse Objects from the Edit 
me nu . The se para te o bjects fu se into a 
single object , w ith a s ing le se t o f han
dles . 

8 You ca n drag one o f th e handles to 
resize the newly fu sed o bjec t. While 
the o bjects are fu sed , howeve r, yo u 
can 't change the line, area, o r text 
prope rti es (yo u 'll have to de fu se the 
o bjec t firs t) . 
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To defuse an object ... 
0 Se lect the object. It must be an 
o bject tha t was previo us ly fu sed . 
f) Choose Defuse Object fro m the Edit 
menu . The object is split into its compo 
nent objects. If you 've sized or rotated 
the fu sed o bject , the component obje cts 
w ill be returned to the ir o rig inal s ize 
and o rie ntatio n . 

To stretch text ... 
0 Use the Arrow p o inte r tool-not the 
Text tool-to se lect the text block yo u 
wish to stretch . 
f) Choose Fuse Objects from the Edit 
me nu . The text is fused to itself, meaning 
that it becomes a "shape ," instead of a 
text block . 

"rext ;as • 
111.nade ~ be • 
distorted. • • 

8 Grab a ny o f the s ide handles and 
drag. The text disto rts as you drag . 

rr-ex-i""·w-as···· 
~nade to be 
!distorted. 

i i 
'· · ····· · · · ·· ·· · ·· · · · · · ·· ······ · · ·········· · ·· · · ··· · ···~ 

• • • 
Text was 
-made~ be · 
distorted. 
• • 

Yo u ca nnot edit the text w hile it is 
fu sed (s ince it is no longe r a text 
block). Defu se text when you wa nt to 
e dit it. The distorted text will re turn to 
be ing a te xt block in its original size 
a nd form. 
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IMPORTING IMAGES FROM DOS 
APPLICATIONS 

You can import images stored in other 
file formats with the Import command 
on the File menu. An imported image is 
treated as a single object in GeoDraw 
and you resize , reshape, cut, copy, and 
paste it as you wou ld any GeoDraw 
object. You can import several file for
mats , including one-bit TIFF, 16-color 
PCX. , and EPS charts from Quattro Pro. 

To import an image ... 
0 Choose Import from the File menu. 
The Import file se lector dialog box 
shows the files and directories in the 
current directory. 
0 Click TIFF, PCX, or Quattro Pro EPS 
to see a list of the files of that type 
contained in the current directory . 
8 Select the file you want to import . 
0 To preview the image before 
importing the file, click View. You can 
use the scroll bars to scroll the image 
in the dialog box. 

0 When you are ready to import a 
file , click Import. Or, to close the 
Import dialog box without importing , 
click Cancel. When you click Import, 
the Import dialog box closes and the 
image appears in the document win
dow. If the image is large , it may take 
several minutes for the image to be 
imported. 
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G E 0 M A N A G E R 

Geo Manager lets you perform all your file 

and disk Illanagement tasks without 

having to remember a single cryptic DOS 

command. GeoManager shows files as 

icons (the "computerese" term for those 

small symbolic pictures that you see all 

over GeoWorks Pro). Instead of typing 

commands, you use these icons to open 

files and perform management tasks. 

Whenever you want to do something vvith 

a file (like opening, moving, or copying it) 

silllply select the icon and 

choose a command from one of 

GeoManager's menus. Easy. 



WHAT YOU MUST ALREADY KNOW 

Certain tasks you perform in Geo
Manager are common to all GeoWorks 
applications. This is the main reason 
you can go from one GeoWorks Pro 
application to another and feel imme
diately comfortable. These common 
tasks are not discussed in chapters 
such as this , but they are described in 
the "Basic Tools and Skills" chapter. 
Here are some of these tasks. If you 
are not familiar with them already, go 
to the "Basic Tools" chapter and read 
about them there. 
•Opening and closing a document 
•Using windows 
•Naming files and directories 
•Entering and editing text 
•Saving a document 
•Using a file selector 
•Selecting file and directory icons 
•Directories and subdirectories 
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QUATTRO 

Letter to Chris 

THE GEOMANAGER WINDOW 

The GeoManager window tells you 
much about the directory you're in and 
what it contains. Here are some of the 
items that give you that information: 
Information bar The information bar 
displays : 
•The directory pathname (see "Basic 

Tools and Skills" for more about path
names). 

•The number of files and directories 
currently appearing in the File Cabinet 
window. 

•The amount of disk space , in bytes 
(characters), used by the files shown 
and the amount of free disk space. 

GeoWorks Pro file icons Each type of 
GeoWorks Pro document has a unique 
icon. The different icons help you quick
ly spot particular types of files . The name 
of the files appear below the icons. 
DOS file icons You rarely see DOS file 
icons in the same directory as GeoWorks 
Pro file icons. If the DOS file is a pro
gram or batch file , you can double-click 

Printer Verificat ... 

The GeoManager window. The i<ons in the 
middle represent the files and directories 
on your hard disk ((.i)). You <an move a 
file from one directory to another by 
dragging it with the mouse. To delete a 
file or a directory, drag it down to the 
wastebasket ( (i) ). GeoManager <omes 
with some handy short<uts I or <ommon 
operations: di<k the WORLD and DOCU· 
MENT buttons (Ci)) to immediately view 
those directories, or di<k the disk drive 
buttons to view directories on those disks 
(Ci)). You <an also di<k the full-sized and 
overlapping window buttons to <hange the 
number of directories visible on the meen 
al one time ((4)). 



the file icon to run it. (You don 't need 
to go back to the DOS Programs screen 
to run it.) 
Directory icons Folder icons in the File 
Cabinet window represents directories on 
your disk drives. Because directories 
appear as pictures of little folders, the 
terms "directory" and "folder" are often 
used interchangeably (in much the same 
way as "document" and "file " are). 
Disk drive buttons Every disk drive 
available on your computer is represent
ed by a button on the bottom edge of 
the GeoManager window. A floppy disk 
button appears for each floppy disk 
drive attached to your computer and a 
hard disk button appears for each hard 
disk. Additional buttons appear if you 
have a RAM disk, ROM disk , or other 
type of disk device (such as a network 
device) attached to your computer. 

LAUNCHING A DOS PROGRAM OR 
BATCH FILE 

You can start a DOS program or 
batch file directly from GeoManager. 
The GeoManager window temporarily 
closes and the DOS program or batch 
file appears . When you quit the DOS 
program, or the batch file finishes , the 
GeoManager window reopens automat
ically. The window appears exactly as 
it looked before it closed . 

To start a DOS program or batch 
file ... 
0 Open the directory that contains 
the DOS program or batch file you 
want to launch. 

8 Double-click the file 's 
icon , or select the file and 
choose Open from the File 
menu . 
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The GeoManager window temporarily 
closes and the DOS program or batch 
file launches. When you quit the DOS 
program or batch file , you see a mes
sage that lets you return to GeoWorks 
Pro or go directly to DOS . When you 
return to GeoWorks Pro, you 'll find 
everything just as you left it. 

OPENING DIRECTORIES 

Directories appear as folder icons in 
GeoManager. To open a directory , dou
ble-click a folder or se lect the folder 
and choose Open from the File menu. 
The directory opens and its contents 
display in a window. (Its name is also 
added to the list of directories on the 
the Window menu .) The directory you 
are working with is ca lled the current 
or active directory, and its name is 
selected on the Window menu. If the 
directory is already open , but not 
active, choose its name from the Win
dow menu , or click on its window to 
make it active (more abo ut overlapping 
w indows in a mome nt). 

OPENING THE WORLD AND DOCUMENT DIRECTORIES 
GeoWorks Pro has two main directories : 
WORLD and DOCUMENT. The WORLD 
directory contains applications (programs 
you can run), and the DOCUMENT direc
tory contains documents (data files creat
ed with applications) . 
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To open the WORLD or DOCUMENT 
directory ... 

Click either the WORLD directory 
button or the DOCUMENT directory but
ton at the bottom of the GeoManager 
window. The WORLD or DOCUMENT 
directory opens and its contents display 
in the window. 

OPENING A PARENT DIRECTORY You can display 
successive parent directories by clicking 
the Parent Directory button on the 
directory window. A parent directory is 
a directory containing another directory. 
The current parent directory, then, is 
the one containing the file s and folders 
that now appear in GeoManager. When 
you move up as far as the root directo
ry , the Parent Directory button dims to 
indicate there are no higher directory 
levels to view. 

To open the parent directory ... 
Click the Parent Directory button at 

the upper-left corner of the 
window. The parent directo
ry appears, becoming the 
current directory. 

OPENING A DIRECTORY ON ANOTHER DISK You can 
display directories on another disk by 
clicking the appropriate drive button . 

To open a directory on another 
disk ... 
0 If the other disk is a floppy disk , 
insert the floppy in a floppy disk drive. 
8 Click the Drive button for the flop
py disk , hard disk, or device you want 
to view. 
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The Full-Sized and Over· 
lapping buttons. 

With overlapping windows, 
GeoManager can show 
several directories side·by
side within the window 
(above). You can move these 
windows around, scroll them 
up and down, make them 
different sizes-everything 
that you can normally do with 
windows. For comparison, 
take a look at the normal, 
full-sized GeoManager 
window (below). Only one 
directory is visible. 
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GeoManager displays the root directo
ry of the disk, which is then the current 
directory. Use GeoManager in the nor
mal manner to work with the files and 
directories on the disk. 

CHOOSING FULL-SIZED AND OVERLAPPING WINDOWS 
Initially, you view directories one at a 
time in the GeoManager window. Each 
directory you open fills the window, 
covering up any directory that previ
ously appeared there. There is a way, 
however, to view many directories 
simultaneously as smaller, overlapping 
windows. You can then move and 
resize these windows to your liking 
(much as you can move and resize 
application windows in the Advanced 
Workspace). It 's also easier to move 
files when you have overlapping win
dows. (See "Moving and Copying Files 
and Directories " later in this chapter.) 

To view directories as overlapping 
windows ... 

Click the Overlapping button , or 
choose Overlapping from the Window 
menu . 



To view directories as full-sized 
windows again ... 

Click the Full-Sized button or choose 
Fu ll-Sized from the Window menu . Alter
natively, click the Maximize button on 
any of the overlapping windows. 

COMPRESSING THE DIRECTORY DISPLAY If you get 
tired of scrolling around directories with 
lots of files and directories in them , turn 
o n the Compress Display option. This 
moves the file and directory icons closer 
together, so that more of them can fit in 
a window. 

To turn the Compress Display 
option on or off ... 

Choose Compress Display from the 
View menu . 

(Above) This is how 
GeoManager 
normally shows the 
contents of a 
directory. When you 
turn on Compress 
Display (below), you 
get a lot more files 
in the same amount 
of space. 

CHANGING THE ACTIVE DIRECTORY 

Only one directory can be the current, 
or active , directory at a time. If you have 
more than one directory open , you can 
activate a different directory by choosing 
the directory 's pathname from the Win
dow menu. If you are viewing directories 
as overlapping windows it 's even easier: 
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Click in the window of the directory you 
want to activate. 

To activate another directory ... 
Choose the directory pathname from 

the Window menu . If you are using the 
Overlapping view, you can a lso click 
the directory window you want to 
make active. 

CREATING A NEW DIRECTORY 

You can create a new directory fo lder 
in any open directory. The new directory 
folder is empty until you move or copy 
items into it . 

To create a new directory ... 
0 Open the directory in which you 
want to place the new directory. If the 
directory is already open, make it active. 
f) Choose Create Directory from the 
Fi le menu . A dialog box appears asking 
you to name the new directory . 
8 Type the name for the directory . 
Use standard DOS filename conven
tions-eight letters, with an optiona l 
three-letter extension. For instance , 
MYFOLDER . ONE. 
0 Click Create. A new directory appears 
in the current directory. 
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RENAMING A FILE OR DIRECTORY 

The name that you give a directory 
or file is not necessarily permanent. 
You can change it at any time using 
the Rename button . 

To rename an item ... 
0 Select the item (or items) you want 
to rename. 
8 Choose Rename from the File menu . 
A dialog box appears. 
8 Enter the new name in the box. 

0 Click Rename to apply the new name. 
If a file with the same name already 
exists, a dialog box asks you to type a 
different name . 

If you 've selected several items , you 
get a separate dialog box for each item. 
Click Next to leave the name of the cur
rent item unchanged and go on to the 
next. Click Cancel to close the dialog 
box without renaming the remaining 
selected files. 

MOVING AND COPYING FILES AND 
DIRECTORIES 

The easiest way to move or copy a 
file or directory is to drag it to its desti
nation (using the right mouse button). 
Dragging an item to a directory on the 
same disk moves the item to that direc
tory, while dragging it to another disk 
copies the item. But you can always 
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{Right) It's easy to drag a 
file or directory. First, select 
the file. Then, position the 
pointer on the selected file 
and hold down the mouse 
button. The pointer changes 
to show that you've upicked 
up" the file (above). Now 
simply drag the pointer lo 
the proper place. This 
technique also works when 
you select several files 
(below). Note the slightly 
different poiinter. 
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force a move operation by holding 
down the [ED key during the drag 
operation, or force a copy operation by 
holding down the§ key. You can 
also copy and move by using the Copy 
and Move commands on the File menu . 

The directory you copy or move 
items from is often called the source 
directory, and the directory you copy 
or move them to is called the destina
tion directory. If the destination direc
tory already contains an item with the 
same name , you 're asked if you want 
to replace the existing item (unless you 
have turned off the Confirm Replace 
option in the Options men u). For more 
information about the confirmation 
options , see "Changing GeoManager 
Options ," later in this chapter. 

When you move or copy more than 
one item, a dialog box appears showing 
you the progress of the operation. If you 
want to halt the move or copy operation, 
click Stop . The operation stops after 
finishing with the current file. 

To move or copy an item by drag
ging ... 
0 Select the item or items you want to 
move or copy. 
8 Position the pointer over one of the 
selected items and hold down the right 
mouse button. The pointer changes to 
indicate whether you are dragging a 
single item or several items. 

~ 
~ 

My Schedule • IM@i@& 

• IM@i@& 

New drawi1 

New drawi1 



8 Drag the p o inte r a nd p os itio n it 
ove r o ne o f the fo llow ing (acco rding to 
w he re yo u wa n t to mo ve o r cop y the 
ite ms) : 
• A fo ld e r icon in a directo ry w indow. 

Th e ite ms a re p lace d in th at direc to ry. 
• Any a rea o f a d irecto ry w ind ow, but 

not over a fo lde r icon . The ite ms a re 
p laced in the directo ry corres p onding 
to the w indow. 

• The Parent Directory butto n o n a d irec
to ry window. The ite ms are moved to 
the parent directo ry, o ne leve l up in the 
directo ry hie rarchy. 

• Ove r o ne o f the disk drive butto ns at 
the bo ttom of the GeoManager window. 
The items are copied to the root direc
to ry of the disk currently in that drive. 

0 Re lease th e right m o use butto n . 

To move an item using the Move 
command . .. 
0 Se lect the ite m (or ite ms) you wa nt 
to move . 
8 Choose Move fro m the Fi le men u . A 
fil e se lecto r appea rs. Use it to find and 
o p e n th e des tinati o n directo ry. 
8 Click Move to mo ve the fi les in to 
the directo ry . 
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To copy an item using the Copy 
command ... 
0 Se lect the ite m (or items) yo u wa n t 
to co py. 
8 Choose Co p y fro m the Fi le me n u . A 
fi le selecto r appea rs. Use it to find th e 
d es tination directo ry. 
8 Click Cop y to copy the fil es into th e 
direc to ry. 

DUPLICATING A FILE OR DIRECTORY 

Yo u can make copies (exact in all but 
name) of both fil es and d irectories. Fo r 
example, yo u may w ant to duplica te a 
d ocument fi le be fore making exte nsive 
changes to it , in o rde r to have a backup 
copy o f the origi nal. 

To duplicate an item ... 
0 Se lect th e ite m (or items) you w ant 
to dup lica te. 
8 Choose D up licate fro m the Fi le 
me nu . A dia log box a ppea rs . 
8 Type in a name for the d u p lica te
if yo u li ke- o the rwise the co py is jus t 

When you pick up a file or directory, you can drag it to 
several different ploces, like: 

•The Parent Directory button-moves it to the parent 
directory (you don't need to dick the button.) 

•Another Folder-moves it into the other folder 

•Another Window-moves it to the directory represented 
by that window 

•The Disk Drive buttons-copies it to the disk on which 
you drop the file 

•The WORLD and DIRECTORY buttons-moves it to one of 
these GeoWorks Pro directories 

•The Wastebasket-deletes it 
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named "Copy of (file or directory 
name)." 

When you duplicate many items , 
you 're given a chance to change the 
name of each copy. Clicking Next skips 
the current item altogether. Cli cking 
Cancel closes the dialog box without 
duplicating the remaining items. 
0 Click Duplicate. A duplicate of the 
selected item (or items) appears in the 
same directory as the original. 
0 If you're duplicating more than one 
item, the name of the next item appears 
in the dialog box and the whole process 
repeats. 

DELETING A FILE OR DIRECTORY 

There are times when you need to 
make room on your hard disk (or flop
py disks, for that matter) by deleting 
files or directories you no longer need . 
Deleting a file removes the file from 
your disk, so be carefu l to delete only 
those files you know you won't need 
later. You cannot recover a deleted 
item using GeoWorks Pro. 

To delete an item by dragging it to 
the Wastebasket ... 
0 Select the item (or items) you want 
to delete. 
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f) Position the pointer over the select
ed item (or one of the items , if several 

items are selected). Hold 
down the right mouse but
ton and drag the item to the 
wastebasket. 

If the Confirm De lete option is 
turned on, a dialog box appears asking 
you to confirm each deletion. Click Yes 
to delete the item; click No to leave it 
untouched and move on to the next (if 
you're deleting several). Click Cancel 
to close the dialog box without delet
ing the additional items . 

To delete an item using the Delete 
command ... 
0 Select the item (or items) you want 
to delete. 
f) Choose Delete from the File menu. 

CHANGING DOS FILE ATTRIBUTES 

There are four DOS fi le attributes 
that limit the kinds of operations you 
can perform on a file or directory: 
Read-Only (R), Hidden (H), System (S) , 
and Archive (A). 

An item can have one or more file 
attributes. Fi le attributes appear in the 
directory window when you select the 
Names and Details option on the View 
menu. The file attributes appear in the 
last column of the listing. 

The most useful attribute, and the 
only one you may ever want to change, 
is the Read-Only attribute. When the 
Read-Only attribute is set, it adds a level 
of protection to the file that prevents the 
file from being changed or deleted easi
ly. For example, if there are certain 
documents that you wanted to take 
extra pains to safeguard, setting the 
Read-Only attribute is a good way to 



protect them . (The template documents 
that came with GeoWorks Pro have the 
Read-Only attribute set, w hich is w hy a 
dialog box a pp ears when you open 
them explaining that you can 't change 
the contents o f the document. ) 

The Archive, Hidden , a nd System 
attributes are used by DOS and DOS 
utilities . They a re n o t very useful to 
GeoWorks Pro applica tio ns. Refe r to 
your DOS refe re nce m anu al fo r more 
info rmation o n th ese a ttributes. 

To change file attributes ... 
0 Selec t th e item (o r ite ms) w hose 
attributes you want to cha nge . 
8 Choose Attributes from the File 
me nu . The Change Attributes dialog box 
appears. Click to select the attributes 
you want to ass ign . Click to deselect 
any already selected attributes to turn 
them off. 

E) Click Change to apply th e att ri butes 
you 've selec te d . Cli ck Next to skip the 
curre nt ite m and go o n to th e next o ne 
(if you se lec te d mo re than one item) . 
Click Cancel to close th e dia log box 
with out making any furth e r changes. 
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GETTING INFORMATION ABOUT A 
FILE OR DIRECTORY 

Certain info rmation about a file (or 
directo ry)-including its size, file attri
butes , and when you last worked on it
is available to you at a moment's notice . 
When you display information about a 
GeoWorks Pro appl ication or document , 
you can also ente r your own notes about 
the item . These notes are saved along 
with the item. 

To display information about an 
item ... 
0 Se lec t the ite m (or item s) and 
choose Ge t Info fro m the File me nu . 
The Get Info dia log box a ppears. 

ltemes .., .... to Dlrlll 
Paths Cl(llllO llllUE) \&EOWClllCS\DOC 

Attrlbutna A 
Lest Hodlflcetioni Rit2 PM 01115192 

Fie Sizes 2.352 
lif09 Fie T..- OM Fie 

Creaton GeoWrtte 
....... 1.2 4-4 

8 If the item is a GeoWorks Pro appli
ca tio n o r docume nt and is n 't Read-Only 
(the Read-Only a ttribute is no t set) you 
can e nte r (and e dit) text in the User 

o tes box. Notes a re saved a lo ng w ith 
the fil e; use the m to describe the fil e's 
conte nts. 
E) Click OK to save the n o tes and dis
play information abo ut th e next item . If 
yo u se lec te d mo re than one, click Next 
to skip this ite m and see the next . 
0 When you 're fini shed , click Cance l 
to close the dialo g box . 
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VIEWING FILES AND DIRECTORIES 
AS A LIST 

You can choose to view the contents 
of a directory as an alphabetized word 
list rather than as icons. Of the three 
options for switching between icons 
and lists, the highlighted option is the 
one currently in effect for the current 
directory. 

To change the current viewing 
option ... 
0 Open the directory you want to 
change . 
8 Choose the option you want from 
the View menu. Your choices are: 
Names Only Shows the contents of the 
directory as a list of very small icons 
with the name on the right (instead of 
below). This view is especially useful if 
you have a lot of files in a directory 
and want to see as many as possible 
without scrolling. 

~-Ililliiii~;Jl-~d-. .,$ •• 
IE1 About Newsletters 
IE1 Blank 2-Column Nwslttr 
IE1 Blank 3-Co lumn Nwslttr 

111§1 
fil Dl ,L "' .1. 

Names and Details Also shows the 
contents of the directory as a list of 
small icons but with the name, size, 
modification date , and attributes to the 
right of the icons. Each file attribute is 
represented by a single letter: Read
Only (R), Hidden (H), System (S), and 
Archive (A). For more information 
about file attributes , see "Changing 
DOS File Attributes" earlier in this 
chapter. 
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The modification date for a directory 
is simply the date you created the 
directory . 
Icons The standard option. Shows the 
contents of the directory as file or 
directory icons, with the name below 
the icon. 

About Newsletters Blank 2-Co lumn ... 

ORDERING ITEMS Within any directory, you 
can change the sorting criteria used to 
display the files and subdirectories . 
Subdirectories always appear before 
files, though , no matter how you sort 
the contents of a directory. 

To change how files are sorted ... 
0 Activate the directory you want to 
change (that is, make it the current 
directory). 
f) Choose Sort By from the View menu . 
A cascade menu appears . 
8 Choose the arrangement you want 
from the cascade menu . Your options 
are: 
Name Arranges the contents of the 
current directory alphabetically by 
name. 
Date and Time Arranges the contents 
of the current directory by the date and 
time the files were last modified , with 
the most recent first . 
Size Arranges the contents of the cur
rent directory by size, beginning with 
the largest file. 



USING THE DIRECTORY TREE 

One of the best ways to see the 
directory structure of a disk is to view 
the organization as an upside down 
"directory tree. " It 's upside down 
because the root directory of the disk 
is at the top of the tree . Directories 
directly under the root directory form 
the main branches, their subdirectories 
branch off from there , and so on . 
Using the Tree menu , you can see this 
structure on your computer screen. 

You control how much of the direc
tory tree is displayed by expanding or 
collapsing the branches (directories) of 
the tree . Expanding a directory displays 
its subdirectories ; co llaps ing a directory 
hides them . A plus sign indicates that a 
directory can be expanded. A minus 
sign indicates that a directory is already 
expanded. 

The Tree window does not show the 
files within a directory. You can , howev
er, view a directory 's files by double
clicking the directory name . You can 
also perform all directory management 
tasks (such as creating, copying, or 

El \ 
(±) ARTWORK 

DOS 
El GEO'w'ORKS 

El DOCUMENT 
BANNERS 

:=~~ 
CARDS 
CLIP ART 
FORMS 
LETTERS 
NE'w'SLTTR 
PAPER 
POSTERS 
PRESENT 
QUATTRO 
RESUMES 
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moving directories) from within the Tree 
window. You can click the directory 
name to select it , then choose the com
mand you want from the File menu . Or 
just drag (with the right mouse button) a 
directory from the Tree window to move 
or copy it into another directory. 

To open the Tree window ... 
To display the contents of the cur

rent drive , choose Show Tree Window 
from the Tree menu . The tree for the 
current drive appears. 

To expand all directories in the 
tree ... 

Choose Expand All from the Tree 
menu . Thi s shows every directory 
within every other directory on the 
current drive. 

To expand the next directory 
level... 
• Click the plus ( +) sign 

next to the directory you 
want to expand. Or .. . 

• Click to select the name 

+ ARTWORK 
DOS 

~EOWORKS 

of the directory you want to expand 
(do not click the plus or minus sign) 
and choose Expand One Level from the 
Tree menu. 

To expand all directories within a 
branch ... 
0 Click to select the name (±) ARTWORK 

of the directory you want Dos 
(±)RllJE. to expand (do not click the -1' 

plus or minus sign). 
8 Choose Expand Branch from the 
Tree menu . This shows you every 
directory within every other directory 
inside of the selected one. 
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To collapse all directories within a 
branch ... 
•Click the minus sign 

next to the directory 
you want to collapse . 
Or ... 

(±) ARTWORK 
DOS 

E! GEO'w'ORKS 
3 DOCUMEN 

•Click the name of the directory you 
want to collapse (not the plus or 
minus sign) and choose Collapse 
Branch from the Tree menu. 

To display the directory tree for 
another disk ... 
0 Choose Drive from the Tree menu. 
A cascade menu appears listing the 
drives connected to your computer. 
8 Click the drive you want to display. 
The Tree window changes to show the 
contents of the selected drive. 

To return to the regular GeoManag
er window ... 
•Choose Close from the Window menu. 

This closes down the Tree window 
and shows you one of the other open 
directories . (More specifically, it shows 
you the directory that is listed under
neath the Directory Tree entry on the 
Window menu.) 

• Choose the name of one of the open 
directories from the Window menu. 
This makes this directory the current 
one (effectively hiding the Tree window 
behind it), but leaves-no pun intend
ed-the Tree window available should 
you want to return to it . (You 'd return 
to it by selecting Directory Tree from 
the Window menu.) 
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SHOWING HIDDEN FILES 

Files with their Hidden or System 
attribute set do not automatically 
appear in GeoManager. To see these 
files , and have them included in the 
file size count at the top of the win
dow, you must first turn on the Show 
Hidden Files option on. When the 
Show Hidden Files option is turned 
off, these files disappear again . 

To turn the Show Hidden Files 
option on or off ... 

Choose Show Hidden Files from the 
View menu . The first time you do this, 
it turns the option on. The second 
time, it turns the option off. And so on . 

MANAGING DISKS 

The Disk menu lets you perform the 
fo llowing disk management tasks : 
•Copy a disk 's contents onto another 

disk 
• Format a disk so that it can be used 
•Rename a disk 
•Rescan any drives needed to update 

the contents of the open directories 
The disk name can be from 1 to 11 

characters long , in uppercase letters 
(lowercase letters are converted to 
uppercase) . You can use both numbers 
and letters in the name , as shown in 
the fo llowing example: 

LETTERS 12 

FORMATTING A FLOPPY DISK An unformatted 
disk is like a library with no shelves
there 's nowhere to put the books. Before 
you can store anything on a disk , then , 
you must format it. When you format a 



disk , yo u build the she lves (and even 
labe l them, metaphorica lly spea king) so 
the computer has an o rganized frame
wo rk in which to store information . 

To see if a disk has already been for
matted , insert it into a fl o ppy disk drive 
and click the appropriate fl o ppy disk 
drive button . If a dialog box appears 
te lling you that the disk is unreadable, 
you know the disk needs fo rmatting . 

To format a floppy disk ... 
0 Inse rt the flopp y disk into o ne o f 
the di sk drives. 
8 Choose Fo rmat Disk fro m th e Disk 
me nu . 
E) Click the drive that conta ins th e 
fl o ppy disk. 
0 Click the o ption for the disk ca pac ity 
you want. 

0 Click OK. A dialog box appears 
requ esting a name for the disk. Type a 
name for the disk (1 to 11 cha racte rs 
long), and click Fo rmat. GeoManager 
fo rmats the disk according to the o ptio ns 
you specified . A message le ts yo u know 
how the fo rmatting is p roceeding and 
w he n it is complete. 

COPYING A FLOPPY DISK The Co py Disk com
mand o n the Disk me nu le ts you crea te 
an exact duplicate of a fl o ppy disk. Th e 
original disk is call ed th e source disk 
and the duplicate disk is ca ll ed the 
d estination disk. Because GeoManage r 
makes an exact duplica te o f the source 
disk , the destination disk mu st be the 
same size as the source disk. This 
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mea ns you ca nnot duplica te a 3 .5 inch 
disk o nto a 5.25 inch disk , or vice 
ve rsa. Also note that , during a disk 
co py, GeoManager writes o ve r all fil es 
that a re o n th e destin atio n disk. Be 
absolute ly sure yo ur d estin atio n disk 
conta ins no thing you w ant to keep. 

To copy a floppy disk ... 
0 If yo u have n 't do n e so a lread y, la be l 
the so urce and des tin a tio n disks so you 
do n 't in ad ve rte ntly confuse the m . 
8 Choose Copy Disk fro m the Disk 
me nu . A di alog b ox a ppea rs . 
E) Cli ck to se lec t the source drive and 
the des tin atio n drive. If yo u have o nly 
o ne drive, drive A a ppea rs as bo th the 
so urce and des tinatio n drive . (You ca n 
do it w ith o nly o ne disk drive, th o ug h 
you ' ll have to constantly p o p disks in 
and o ut o f the fl o ppy disk drive .) 

Select so1.rce and destination for disk copua 

Source: v A: ~ 
Destlnetlonl · ... • Al • Ba 

0 Cli ck Co py. 
0 GeoManager te lls yo u whe never you 
need to inse rt a ne w di sk . Fo llo w th e 
instru ctio ns o n th e sc reen . 

RENAMING A DISK You can eas ily change the 
name of a floppy disk . Yo u named the 
disk , remember, whe n you formatted it 
(see "Fo rmatting a Flo ppy Disk ," earlie r). 

To rename a disk ... 
0 Choose Re name Disk fro m the Dis k 
me nu . A dialog box a ppea rs. 
8 Cli ck to se lect th e drive that conta ins 
the disk you want to rename . 
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8 In the "To" area, type a new name 
for the disk. 
0 Click Rename to rename the disk. 

RESCANNING It's possible for a directory 
display to become out of date. This 
can happen in two different situations: 
• You 're working with a floppy disk, 

and you eject it from your floppy disk 
drive and have a friend add a file to 
it. When you stick it back in the drive , 
the GeoManager window doesn't 
show the new file 

• You're using a network drive (on, say, 
a Novell network) and somebody e lse 
adds or removes files from it. These 
changes don 't appear in the GeoMan
ager window. 

In both these situations, GeoManager 
doesn 't know that the contents of the 
disk in question have changed, so it 
doesn 't update the window. Fortunate
ly, it 's easy to remedy the situation: All 
you need to do is rescan the drive . 

To rescan ... 
Choose Rescan Drives from the Disk 

menu. GeoManager rereads the contents 
of all displayed disks (that is , disks 
whose directories appear in the Window 
menu), updating any directory windows 
if necessary. 
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CLOSING DIRECTORIES 

A directory remains open until you 
specifically close it. If you open many 
directories, you should periodically 
close the o nes you aren't using. This 
frees additional computer memory. 

If you close the only open directory , 
the GeoManager window will then be 
empty and b lack. At this point you 
shou ld click one of the drive buttons 
(or the WORLD and DOCUMENTS but
tons) a long the bottom of the window 
to open a new directory. 

To close the current directory ... 
Choose Close from the Window menu. 

The window of the current directory 
closes. If you are viewing directories as 
overlapping windows, you cou ld do this 
by simply double-clicking the Control 
button of the overlapping window you 
wish to close. 

To close all open directories ... 
Choose Close All from the Window 

menu. All the directory windows close , 
leaving the GeoManager window black. 

CHANGING GEOMANAGER OPTIONS 

Here are some options you can turn 
on (or off) to customize GeoManager 
to your liking. Once you 're satisfied 
with your settings, save them so that 
they will apply the next time you start 
GeoManager. 

When options are turned on, they 
are selected in the menu. When a con
firmation option is deselected (turned 



ofD, no confirmation message appears 
when you perform the action. 

Remember, when you delete or 
replace a file, you cannot undo the 
operation if you change your mind. We 
suggest you leave confirmation options 
on unless you 're very experienced with 
the system. Most of them warn you of 
actions that cannot be undone . 

Confirm Delete When on, this option 
displays a confirmation message before 
you delete a file . 
Confirm Read-Only When on, this 
option displays a confirmation message 
before you delete a Read-Only file . For 
more information about Read-Only files , 
see "Changing DOS File Attributes ," earli
er in this chapter. Otherwise , the Read
Only file is deleted without comment. 
Confirm Replace When on, this dis
plays a confirmation message before 
you copy or move a file to a directory 
that already contains another file with 
the same name . When this option is 
off, you risk unknowingly overwriting 
files in the destination directory . 
Minimize on Run When on, this option 
causes GeoManager to shrink to an icon 
when you run another GeoWorks Pro 
application . With this option off, the 
GeoManager window remains open 
when you run another GeoWorks Pro 
application. 
Ask Before Returning to PC/GEOS This 
only applies when you run a DOS pro
gram from GeoManager. When this is on, 
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you have to press r when you exit from 
this DOS program before GeoWorks Pro 
will start up again. (At this point, you 
can alternatively choose to return to 
DOS , instead of starting GeoWorks Pro.) 

To turn an option on or off ... 
Choose the option from the Options 

menu. If the option is currently on , 
choosing it turns it off. And vice versa. 

To save the current options and 
make them permanent ... 

Choose Save Options from the 
Options menu. 

EXITING GEOMANAGER 

The Exit command closes GeoMan
ager. Normally you never exit Geo
Manager, but if you are running sever
a l additional applications and notice 
that your system is running slowly , 
you can exit GeoManager to free up 
some memory on your computer. 

To close GeoManager ... 
Choose Exit from the File menu. The 

GeoManager application closes. 
If another GeoWorks Pro application 

is currently open, you see the open 
application when you close GeoManager. 
If no other GeoWorks Pro applications 
are open, you are returned to the Wel
come screen. 

To restart Geo Manager ... 
0 Choose Startup on the Express 
menu of any application. A cascade 
menu appears. 
f) From the cascade menu , choose 
GeoManager. The GeoManager applica
tion restarts. 
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G E 0 p L A N N E 

GeoPlanner gives you both a yearly 

calendar and an appointlllent book in 

R 

one povverful application. Vievv this year's 

calendar and then svvitch to next year's

or last year' s-W"ith one click of 

the mouse button. Schedule 

appointments or meetings, and 

have GeoPlanner automatically remind 

you about the important ones. You can 

even schedule recurring events, like 

birthdays or vveekly meetings. 



THE GEOPLANNER WINDOW 

The GeoPlanner window is actually 
two windows-the Calendar window on 
the left and the Event window on the 
right. You use the Calendar window to 
pick the day you want to work with, 
while you use the Event window to 
look at and change the events sched
uled on that day. 

In GeoPlanner, something you 
schedule- such as an appointment or a 
meeting-is called an event. To see 
what you 've scheduled, or to schedule 
an event on a particular day, select a 
day in the Calendar window by clicking 
it. Likewise, if you want to see a series 
of days , select them by dragging. The 
scheduled events immediately appear in 
the Event window. 

You can a lso move through the days 
one at a time. Simply click the Previous 

Day and Next Day but
tons above the Event 
window. 
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CHANGING DAYS WITH THE 
CALENDAR WINDOW 

The Calendar window, as you might 
expect, shows the calendar for a given 
year. It normally shows one month at a 
time , although you can make it show 
several months at once if you desire. 

Today 's date is always marked with 
a heavy outline. Any days you select 
are also highlighted with their own 
color. The little triangles denote days 
that have events scheduled on them. 

To see a particular month while in 
Single Month view ... 

Click the scroll bars on the Calendar 
view window until you reach the desired 
month. 

To view different years ... 
Change the Year field at the top of 

the GeoPlanner window, either by 
clicking the up or down arrows or by 

The GeoPlanner window. On 
the left is the Calendar 
window ((i)) and on the 
right is the Event window 
((i)), which shows all the 
events scheduled on the days 
selected in the Calendar 
window. In this picture it 
shows events for December 
17 through 31. At the upper 
right are the Previous Day 
and Next Day buttons. (Ci)) 



typing a new year. You can enter any 
year from 1900 to 9999 (AD, of course). 
The Calendar window immediately 
changes to show the calendar for that 
year. Note that doing this doesn 't 
change the selected day. You may not 
be able to see that day in the window 
any more , but it 's still selected. 

You can tell by looking at the date 
above the Event window, which still 
shows the selected day-as does the 
Event window itself. The date and 
Event window will both change when 
you actually click a new day. 

To see several months at a time in 
the Calendar window ... 

Choose Full Year from the View 
menu. The Calendar window immediate
ly changes to show as many months as 
will fit . Use the scroll bars to see the 
remaining months. 

When you want to see one month at a 
time again, choose Single Month from the 
View menu. (This is the normal view.) 

WORKING WITH EVENTS 

You can use GeoPlanner as an elec
tronic date book for tracking events in 
your daily schedule. You can also use 
it to automatically remind you when 
it's time for important appointments. 

A very useful feature of GeoPlanner is 
its ability to schedule events that happen 
at regular intervals, like weekly meetings 
or anniversaries. This feature is described 
in "Working With Repeating Events, " later 
in this chapter. 
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SCHEDULING EVENTS Scheduling events is 
simply a matter of selecting the appropri
ate day , entering the time of the event 
and then typing a brief description . 

In the description portion of an 
event, you can paste text that 's been 
copied from other applications. The 
reverse is also true : you can copy text 
from GeoPlanner to pas te into other 
appl\cations , such as GeoWrite. 

To schedule an event ... 
0 In the Calendar window, click the 
square of the desired day. The day 's 
events appear in the Event window . 
Check the date above the Event win
dow to make sure that you clicked the 
correct day. 
8 Choose New Event from the Edit 
menu. A blank event appears in the 
Event window, with its time selected. 

Don 't de-select the time (by, say, click
ing somewhere else in the event). 
E) Type the time of the appointment or 
event ( replacing the selected time). For 
example, type 10 : 43arn. If the event 
has no particular starting time, press 
I Backspace I to delete the existing time 
and leave the time area blank. 
Note: If you omit the "am" or "pm" when you type the 
time, GeoPlanner tries to guess which one you mean. If it 
doesn't guess correctly, change the time manually. 

0 Press ~. GeoPlanner quickly verifies 
that you typed the time correctly and the 
cursor moves into the description portion 
of the event line . 
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0 Type a description of the event. You 
may fill as many lines as you like . 

(:) That's it. GeoPlanner automatically 
records the event as soon as you do 
something else-such as selecting a 
different day or starting a new event. 

To change an event ... 
Change the event the way that you'd 

change any regular text , by selecting 
text with the mouse and re-typing. 

If you make a mistake while chang
ing an event, choose Undo from the 
Edit menu to restore the event to its 
original form. (Note that you cannot 
undo after you change or delete anoth
er event or after you change the day 
displayed in the Event window.) 

To remove an event. .. 
0 Click anywhere in the text of the 
event to select it. GeoPlanner draws a 
box around the event to show that it 
has been selected. 
f) Choose Delete Event from the Edit 
menu. The event is removed from the 
window. 

You can change your mind and 
restore a deleted event by choosing 
Undo from the Edit menu. Act quickly, 
though: you cannot restore the event 
after you change the day displayed in 
the Event window, or after you change 
or delete another event. 
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VIEWING EVENTS The Event window shows 
the events scheduled for a particular day 
or group of days. GeoPlanner provides 
several shortcuts for quickly viewing the 
scheduled events of one day, the entire 
week, or the entire month. 

To view a day's event ... 
In the Calendar window, simply 

click the day. The day's events appear 
in the Event window. 

To view the next or previous day's 
events ... 

Click the Next Day button to view 
the day following the currently selected 

day. The Event window 
changes to show the day . 
Or, click the Previous 
Day button. The events 

scheduled for that day appear in the 
Event window. 

To view events for a range of days ... 
In the Calendar window, drag the 

mouse to select the days you wish to 
view. The events 

~.r-1·~ scheduled fo'. those 
days appear m the 
Event window . 

The Next Day and Previous Day 
buttons move you forward and back
ward by the same number of days that 
you 've selected. For example, if you 
select four days and click Next Day, 
GeoPlanner selects the following four 
days. 

To quickly view today's events (or 
this week's, or this weekend's) ... 

Choose Today from the Quick menu . 
The Event window shows the events 
scheduled for today. Similarly, you can 
use the Quick menu to view the events 
for this week, this weekend, or this 
month. 



SETTING THE ALARM 

GeoPlanne r has an ala rm yo u can 
se t to re mind you that it 's tim e fo r an 
impo rtant appo intment . Wh e n th e 
a la rm goes o ff , your compute r bee ps 
and a dia logue box a ppea rs , showing 
th e d esc riptio n for th e event . And best 
o f a ll , like a be ds ide clock th e 
GeoPla nn e r ala rm co mes with a s nooze 
butto n. 

Alarms no rmally go o ff a t the time 
o f the event , but you ca n se t the m to 
go o ff a few minutes ea rly to g ive yo u 
some time to pre pa re . 

To turn an alarm on or off ... 
If th e re is no thing in th e d escriptio n 

p o rti o n o f an event , type something 
the re-the eve nt ca n 't be bl ank . Click 
the b e ll icon next to the particula r 
eve nt. The be ll darke ns, indi ca ting that 
the a la rm is se t. To turn th e ala rm off , 
s impl y click th e be ll aga in . 

An o the r way to turn it o n o r o ff is 
w ith th e Alarm Settings dialog box , 
which you ca n bring up by choos ing 
Al a rm Settings fro m the Edit menu . 

To stop the alarm once it's gone 
off ... 

Click O ff in th e dialog box to turn 
o ff th e a la rm a nd make the box go 
away . Or, click Snooze to turn the 
a la rm off te mpo ra ril y-like press ing 
the Snooze butto n o n a beds ide a la rm 
clock . Afte r fiv e minutes the a la rm 
goes o ff aga in. 

To make the alarm go off earlier ... 
0 Choose Ala rm Settings fro m the Edit 
me nu. The a larm settings box appears. 
8 Change the Time. This is no rmally 
se t to th e time of the eve nt. Ente r the 
time th at you wish the al a rm to go off. 
For example , if you we re se tting the 
alarm for a 10:00 am appointme nt and 
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you wa nte d fi ve minutes to ge t ready, 
yo u 'd ente r 9 : 55 am. 

8 Click O K. The dialog box goes away . 
Yo u ca n se t a ll a la rms to go o ff 

ea rly as p a rt o f th e ir s tanda rd ope ra
ti o n . See "Custo mizing GeoPla nner" 
la te r in thi s chapte r, for m o re infor ma
ti o n a bo ut this . 

WORKING WITH REPEATING EVENTS 

With Geo Planne r, you d o n 't need to 
record regul arl y re peating eve nts o n 
eac h da te th ey occur-you need o nly 
e nte r it o n ce . For insta nce , if h ave you 
h ave a s taff meeting eve ry Tu esday a t 
9:30 am , o r you need to pi ck up your 
childre n from school ea rl y o n th e firs t 
Thursd ay of each mo nth , you 'd e nte r 
th e eve nts o nce and GeoPlanne r would 
auto mati call y re pea t the events o n 
future dates. 

GeoPlanner can o nl y ha ndl e th ose 
eve nts th at re peat at regul ar inte rva ls. It 
couldn 't handle , say , a meeting th at 
ha ppens in J anu ary, Se ptem be r, a nd 
Novembe r. O n the o th e r hand , he re are 
some exa mples o f re peating events it 
could handle: 
• Every J a nu ary 5th until 1995 
• Every Monday and We dnesday this yea r 
• Eve ry second Friday o f the m onth 
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Such events are marked with a large 
R in the Event window to indicate that 
they repeat . The Repeating Events dia
log box shows them a ll together. 

Here 's what the different parts of 
the dialog box do: 
Frequency This is the event's cycle, 
how often it repeats . The event can 
happen each week, once a month , or 
once a year. 
Specify by Monthly and yearly events 
can be listed one of two ways: by 
date-January 7th- or by the day of 
the week- the second Friday. The 
choices you make here and in 
Frequency determine which of the 
fo llowing fields you can change. 
Select Days For a weekly eve nt , use 
these settings to choose the days of the 
week that the event occurs. Note that 
you can choose more than one day if 
you like. 
Month For a yearly event, use this 
setting to choose the month in which 
the event occurs. 
Day of Month For monthly or yearly 
events scheduled by date , use this 
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sett ing to choose the day of the month 
on which the event occurs. If it always 
occurs on the last day of the month , 
click Last . 
Day of Week For monthly or yearly 
events scheduled by day of week, use 
this setting to choose the day. For 
instance, if you always get paid on the 
second Monday of the month, you 
would choose Second and Monday . 
Time Time of day that the event hap
pens. Leave it blank if the event has no 
scheduled time , as wou ld be the case if 
this event were part of a "to do" li st. 
Description of event This is the same 
as the description portion of a regular 
event. 
Range of dates: This shows the date of 
the first occurrence of the event and the 
date of the last. If the event continues 
on indefinitely, click Forever. 

SCHEDULING REPEATING EVENTS You use the 
Repeating Events command to create, 
edit, and remove all repeating events. 

The Repeating Event s dialog box. 
Some of the options are dimmed (that 
is, grayed out and unavailable) 
depending on the Type of Event. 



To schedule a repeating event. .. 
0 Choose Re pea ting Eve nts fro m the 
Utilities me nu . The Re pea ting Events 
di alog box appea rs . 

1--·~ St. Patrlclc's Dag 
lndepelMlence Day 
Labor Day 

8 Click New. A dialog box w ith a 
va ri e ty o f se ttings a ppea rs . 
8 Set th e diffe rent o ptio ns. See 
"Se tting Some Common Eve nts ," la te r 
in this chapter, fo r seve ral exa mples o f 
sch edul ing differe nt re pea ting eve nts . 
8 Click O K to sche dul e the new eve nt . 
0 Cli ck Close to make the Re pea ting 
Events dia log box go away . 

To change a repeating event ... 
0 Choose Re pea ting Eve nts from th e 
Utiliti es me nu . The Re pea ting Eve nts 
di a log box appea rs. 
8 Cli ck to select the eve nt you wa nt 
to change and the n click Cha nge . The 
se ttings di a log box appea rs . 
8 Change the informatio n in the dialog 
box . 
8 Click O K w he n yo u fini sh . 
0 Choose a no ther event to change , o r 
cli ck Close. 

There 's ano the r way to change a 
re p ea ting event , but it has a majo r 
s ide-effec t: as we sa id ea rli e r, the 
re p ea ting e ve nt shows up in th e Event 
w indow like any o the r e vent when you 
view th e des igna ted day. And , like any 
o the r no rma l event , yo u ca n cha nge it 
the re . If yo u d o this , tho ugh , it 
becomes a no rmal-that is, no n-rep ea t
ing-event ; it 's co mpl e te ly cut o ff fro m 
the o rig ina l re peating event. 

This means that if you change the 
origina l eve nt la ter on ( the prope r way , 
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w ith the Re pea ting Eve nt dialog ue box) 
this pa rti cul a r event won 't change. 
Yo u ' ll have to change it manu a ll y. 

To remove a repeating event entire
ly from the calendar ... 
0 Choose Repea ting Eve nts fro m the 
Utiliti es me nu . The Repea ting Eve nts 
di a log box appears . 
8 Se lect the pa rticula r event yo u wa nt 
to re move . 
8 Cli ck De lete. The eve nt is re moved 
from the w indow . 

EXAMPLES OF SOME COMMON EVENTS He re a re a 
co upl e exampl es o f how to sc hedule 
some re pea ting events . 

To schedule an event that occurs 
weekly ... 

Suppose th a t yo u meet w ith yo ur 
e mp loye es e ve ry Wed ne sd ay at 3:30 
pm . 
0 Begin a new re pea ting eve nt by 
choosi ng Re pea ting Eve nts fro m the 
Utilities me nu. 
8 Click the Weekl y butto n in th e 
Re pea ting Eve nt di a log box. 
8 Whe re it says Se lec t Days , click th e 
d ay o r d ays whe n the eve nt occurs. In 
th is case , click Wednesd ay , s ince yo ur 
meeting is eve ry Wednesday afte rnoon . 
If yo u make a mi stake , cli ck the butto n 
aga in to turn it off a nd choose an o th er. 
8 In th e Time of Eve nt box , e nte r the 
time of the event : 

3 : 3 0pm 
0 In the Eve nt box , type a brie f 
desc ripti o n of the event : 

meeti ng wi th employees 
9 If the eve nt sta rts o n a particular 
d ate and continues th rough to ano the r 
d ate , ente r those two d ates into the 
Repea t From and To boxes. O n th e 
o the r hand , if the event goes o n indefi
nite ly, cli ck Foreve r. Since the latte r is 
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the case with your employee meetings, 
you click Forever. 
8 Click OK to enter the event. 

To schedule an event that occurs on 
a certain date each month ... 

Suppose that you a lways pay your 
rent on the 5th of the month . 
0 Begin a new re peat ing event by 
choos ing Repea ting Events from th e 
Utilities menu . 
8 Cli ck the Monthly button. 
8 Because you always pay on a cer
tain date , instead of a certain day of 
the week , click Date in the Specify By 
fi e ld . 
0 Choose the particular date by chang
ing the Date in the Day of Month field. 
In this case , change the Date to 5, since 
you pay on the 5th of the month. 
0 In the Time box, enter the time of 
the event. For this example, leave the 
Time box empty. 
0 In the Event box , type a brief 
description of the event: 

Pay rent 
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8 If the event starts on a particular 
date and continues through to another 
date , enter those two dates into the 
Repeat From and To boxes . If the 
event goes on indefinitely , click 
Forever. Since you pay rent indefinite
ly, you click Forever. 
0 Click OK to enter the event . 

To schedule an event that occurs on 
a particular day each year ... 

Suppose you want to mark 
Thanksgiving-which always happens 
on the fourth Thursday of November
in GeoP lanner. 
0 Begin a new repeating event by 
choos ing Repeating Events from the 
Utilities menu. 
8 Click the Yearly button . 
8 Because Thanksgiving always fa lls 
on a Thursday , click Day of Week in 
the Specify By field. 
0 Change the Month fie ld to November. 
0 Choose the particular day by changing 
the Day of Week. In this case, change it 
to Fourth and Thursday, since 
Thanksgiving always falls on the fo urth 
Thursday of the month . 
0 Leave the Time box empty. 
8 In the Event box, type a brief descrip
tion of the event. For this event, enter 

Thanksgiving 
e If the event starts on a particular 
date and continues through to another 
date , enter those two dates into the 
Repeat From and To boxes . On the 
other hand , if the event goes on indefi
nitely , click Forever. For this example, 
you click Forever. 
0 Click OK to enter the event. 



SEARCHING 

GeoPlanner lets you search for 
events that contain a certain bit of text ; 
for example, you could find all the 
events containing the word "Murtnik ." 

GeoPlanner looks for the text in the 
event description. You can search for 
part of a word , a whole word , or many 
words . This means that you could search 
for "Mu ," and GeoPlanner would find 
appointments with Murtnik, Mullin, and 
Munster. 

However, GeoPlanner is case-sensi
tive. If you search for "murtnik" (lower
case "m"), GeoPlanner won 't consider 
events containing "Murtnik" (uppercase 
"M") to match-it expects both of the 
words to match exactly. 

To search for an event containing 
some text ... 
0 Choose Search from the Uti lities 
menu. The Search dialog box appears. 
8 In the Search For field , type the text 
you want to find. 
8 Click Start Search . The first event 
containing the text appears selected in 
the event window. 

0 Click Find Next to find the next 
event that also contains the text. 

GeoPlanner starts the search with the 
selected day and continues on through 
the list of future events. If it can 't find 
the text in any of those events, it asks 
you if you want to search through past 
events, too. When there are no more 
past or future events that contain the 
Search For text, a dialog box appears 
telling you that the search is complete . 

PRINTING 

You can use GeoPlanner to print 
your scheduled events or to print 
monthly or yearly calendars. 

GeoPlanner prints according to the 
selected days in the calendar window. 
For example , to print a calendar for 
February, first select a day in February 
from the Calendar window. It 's not 
enough just to have the month showing 
in the Calendar window-you must 
actually select a specific day in the 
month . Then choose Print from the File 
menu and choose Month. The Will Print 
box says "February ." 
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In addition to the usua l printing 
options , GeoPlanner has some options 
of its own: 
Event Window Prints what 's in the 
event window-the events on the 
selected day, in other words. 
Month Prints a calendar for the month . 
Year Prints a ca lendar for the entire 
se lected year. No events are printed. 
Include Events For a monthly calendar, 
this prints the events as well. 
Will Print Shows what day , days , 
month , or year will be printed. Use this 
to double-check that you 've selected the 
right day. 
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CHANGING VIEWS 

You control the Calendar and Event 
windows with the View menu . 

To select a view ... 
Choose the desired view from the 

View menu. There are three different 
views: 
Calendar Only This view closes every
thing but the Calendar window. Because 
the Event window is closed, you cannot 
view the events themselves , nor can you 
change them or add to them. The 
reminder feature , however, continues to 
work for events that are already recorded. 

Events Only This view closes every
thing but the Event window. You can 
still view, change, and delete events, 
but without the Calendar window you 
can only change the day shown via the 
Next Day and Previous Day buttons. 
Both This is the standard view. It 
shows both the Calendar window and 
the Event window together. 
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(Below) In the Calendar Only 
view, the Calendar window 
expands to fill the entire 
GeoDex window. Likewise, 
when you choose Events 
Only, the Events window fills 
the entire window. 
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CUSTOMIZING GEOPLANNER 

You can customize some of the dif
ferent features of GeoPlanner, includ
ing the way that it presents events in 
the Event window and the number of 
minutes that alarms go off ahead of the 
actual event. Once you've chosen new 
options, you should save your prefer
ences so that they still apply the next 
time you start GeoPlanner. 

To set your preferences ... 
0 Choose Change Preferences from 
the Options menu. The preferences 
dialog box appears . 
8 Set the different options: 
Day Template When you turn on Day 
Template , the Event window provides a 
template of regular events (usually 
spaced at half-hour intervals), even if no 
events are actually scheduled. When Day 
Template is off, only scheduled events 
show; the window is otherwise blank. 
Show Empty Days When you select a 
range of days in the Calendar window, 
the Event window shows all the events 
scheduled on all of the days. Normally 
it lists only those days that actually 
have events scheduled. With this 
option turned on, the Event window 

The GeoDex Preferences window. 



lists every day in the range , even those 
days containing no scheduled events. 
Start Time, End Time, and Interval 
These three options control the Day 
Template . Start Time and End Time 
determine the range of the template
normally 8 AM to 6 PM. The Interval 
controls the amount of time between 
template entries, and is set to half an 
hour by default. This means that the 
day is marked off into half-hour 
blocks-8:00 , 8:30, 9:00, 9:30, and so 
on. You can change this interva l to 
anything from five minutes to sixty 
minutes. 
Reminder Precedes Event These set
tings change how far ahead of the events 
the alarms normally go off. While the 
settings are initially se t to zero-meaning 
that alarms go off at the time of the 
events-you can alter them to make the 
alarms go off minutes , hours , and even 
days before. The new settings takes 
effect for all events you enter from then 
on. Note that this is only the default 
alarm time. You can set the actua l time 
of the alarm when you turn it on. 
Startup As You can control which of 
the two windows are open when you 
first start GeoP lanner. You can choose 
to have just the Calendar window 
open, just the Events window , or both. 
Automatically Show Today's Date 
on Start-Up When this option is on, 
GeoPlanner will show you toda y's 
events when you start it. Alternatively, 
when the option is off it shows you the 
day you were looking at when you last 
used GeoDex. 
At Midnight, Automatically Switch 
to New Day Norma lly on, this option 
determines what happens if you leave 
GeoPlanner running overnight. "On" 
means that it wi ll change days auto
matically at midnight, while "off" 
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means that you have to adjust the ca l
endar window manually. (This option 
only matters if you leave GeoPlanner 
running overnight.) 
8 When yo u're satisfied with your 
settings, click OK. 

To save your preferences ... 
Choose Save Preferences from the 

Options menu. 
GeoPlanner doesn 't associate the 

preferences settings with any particular 
document. When you save your prefer
ences, they stay in effect even if you 
work with a different GeoPlanner doc
ument. 

LINKING TO GEODEX 

GeoPlanner can sea rch the GeoDex 
address book for cards containing a 
particular name or bit of text. For 
example, say you are scheduled to 
meet with John Murtnik and you want 
to call him to confirm the meeting. You 
can have GeoPlanner search GeoDex 
for the card with the name "Murtnik " 
on it. When yo u find it , you can use 
the phone numbers on it to call him . 

GeoPlanner expects the text that 
you 're searching for to match the text in 
the GeoDex address book exactly. If you 
search for "John Murtnik ," you won 't 
get cards containing the name "john 
murtnik, " or even "Murtnik, John ." For 
this reason, you should be consistent in 
the way that you enter names into both 
GeoPlanner and GeoDex. 
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To find the address card for a name 
in the Events window ... 
0 Make sure that the GeoDex applica
tion is started. 
f) Select the person's last name , or some 
other bit of text that you wish to locate. 
8 Choose GeoDex Lookup from the 
Utilities menu. The GeoDex window 
appears and shows the first card con
taining the selected text. 

If you want to find the next GeoDex 
card also containing the text, switch to 
GeoDex's Search view (choose Both 
View from the View menu) and click 
Find Next. 
0 When you finish looking at the 
address book , return to GeoPlanner by 
choosing GeoPlanner from the Express 
menu or by clicking anywhere inside 
the GeoPlanner window. 

As an example, take the earlier case 
where you are scheduled to meet with 
John Murtnik and you want to call him 
to confirm the meeting. Select the last 
name, "Murtnik ," and choose GeoDex 
Lookup from the Utilities menu. The 
GeoDex window appears with the card 
for Murtnik displayed . All you need to 
do is scroll to the correct phone num
ber and click the Dial button . 
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G E 0 w R T 

GeoWrite can do letters, sales reports, 

papers, and lots of other things. 

So can a lot of other wrord pro

cessors, but GeoWrite does 

them in style. It gives you the full benefit 

of the outline fonts built into Geo Works 

Pro, wrhich tneans that your text is smooth 

and easy to read-both on the 

E 

screen and on paper. And you can 

include pictures that you copy from 

GeoDrawr or the Scrapbook. With 

GeoWrite's advanced features, 

it's even easy to create a 

three-column newrsletter! 



WHAT IS A WORD PROCESSOR? 

First drafts are rare ly perfect. You'll 
always want to change them. In a letter, 
you may find a misspelled word here 
and there, or just a couple of typos. A 
lengthy report, however, may require a 
complete reorganization. Either way, 
with a typewriter, this means retyping 
the whole thing-a tremendous waste of 
time . But word processors make 
changes like this easy . 

With a word processor you actually 
type your text on a video screen (and 
not directly onto the page) where you 
can easily change it again and again 
(and again and again) before a single 
word is committed to paper. Want to 
change "feline" to "cat"? Just delete 
"feline" and type "cat, " or "dog, " or 
whatever you want. A word processor 
automatically shifts the following text to 
fill the empty space , or to give you room 
for new text. Pick up a whole paragraph 
to move it somewhere else , and the rest 
of the page shifts up to fill the vacancy. 
You need not settle for flawed docu
ments , as it 's so easy to fix them. When 
you 're satisfied with the document you 
see on the screen, print it. 

You can also save your work-so that 
you can retrieve your text tomorrow, or 
even a year later and continue working 
on it. Open an old document, update it, 
and save your changes as a new docu
ment. You now have two slightly differ
ent versions of the same document, both 
of which you can open and edit at any 
time. Save as many versions of a docu
ment as you like. 
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Most importantly, a word processor 
like GeoWrite is designed to make the 
process of writing easier. But like any 
tool, you 'll need to get used to using it . 
To that end, read through the "Getting 
Started" section of this manual if you 're 
new to the world of word processing , 
paying close attention to the bit about 
GeoWrite . There 's also some important 
information in the "Basic Tools and 
Skills" chapter-and of course , this 
chapter. 

HINTS FOR WORKING WITH A 
WORD PROCESSOR 

•Do not press I Return I at the end of every 
line-word wrapping automatically 
shifts text to the next line for you . 
Press I Return) only at the end of a para
graph , or when you absolutely have to 
have certain text start on a new line , 
say for a heading. 

•Remember, only one space after a 
sentence , not two. With typewriters , 
you always needed two , since the 
monospaced typeface-Courier-creat
ed very even , regular columns of text, 
and the only way to create the extra 
break at the end of a sentence was to 
add two spaces . While GeoWrite 
comes with URW Mono, a variation of 
Courier, most of the other fonts are 
proportional, meaning that the differ
ent letters have different widths ("m " 
is much wider than "i," and so forth) . 
Since the lines of text don 't form even 
columns , you only need a single 
space after a sentence to create a 
separation. 



•Use tabs instead of spaces to create 
tables. In a monospaced font , like on 
a typewriter, the word "bill " followed 
by ten spaces takes the same amount 
of room that the word "when" (and 
ten spaces) does . Not true for propor
tional fonts. The letter "b " is slightly 
slimmer then the letter "w ," "i" slim
mer than "e ," and so on. The refore , 
"bill " followed by ten spaces takes less 
room than "when" and ten spaces. 
The rule , then : tables made with 
spaces won 't line up ; those made with 
tabs will. (See "Creating a Table " in 
this chapter.) 

•Don 't use spaces to align text in the 
center or on the right edge of the 
page. Use the center tab (or center 
the whole paragraph) and the right 
align tab. (See "Setting Tabs " in this 
chapter.) 

•Avoid using spaces to indent the first 
line of a paragraph. Use a tab . Or, 
better yet , use the indentation mark 
on the ruler-that way, GeoWrite will 
automatically indent your paragraphs 
for you. (See "Changing Margins" in 
this chapter.) 

•In the days of the typewriter, you had 
only two ways to emphasize a partic
ular word: You underlined it or you 
made it all capital letters. Fine for 
typewritten pages , but why use capi
tals and underlines when you can 
choose boldface , italics , or even 
entirely different fonts to make a 
word stand out? Unless you 're typing 
a manuscript for submission to an 
editor, try to avoid underlines and 
words in capital letters. 

•Words with all capitals, however, are 
useful for logos , titles , and headings. 
But for these, you often use large font 
sizes which need their own special 
treatment. If the letters are big, make 
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sure you adjust the spacing between 
characters , so the line doesn 't look 
"spacey. " (See "Changing the 
Character Spacing.") 

•With GeoWrite , you can use special 
characters that you rarely , if ever, see 
on a typewriter. For a break in a sen
tence , use an em dash (-) instead of 
a pair of hyphens (--). Hyphens are 
usually used only to a break up a 
word. Or, use bullet points ( • ) to set 
apart items in a list. To see how to 
type these and other special charac
ters, turn to the Appendix . 

WHAT YOU SHOULD ALREADY KNOW 

Certain tasks you perform in 
GeoWrite are common to all GeoWorks 
applications. This is the main reason 
you can go from one GeoWorks appli
cation to another and feel immediately 
comfortable. These common tasks are 
not discussed in application chapters 
like this one, but they are described in 
the "Basic Tools and Skills" chapter. 
Here are some of these tasks. If you 
are not familiar with them already , go 
to the "Basic Tools " chapter and read 
about them there . 
•Opening and closing a document 
• Entering and editing text 
•Formatting text: Fonts , Sizes , Styles 
• Cutting and pasting text or graphics 
• Saving a document 
•Printing 
• Using the View menu to zoom in and out 
•Correcting the aspect ratio 
• Using the Window menu to work with 

multiple documents 
•Reverting 
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THE GEOWRITE WINDOW 

The GeoWrite window gives you an 
accurate, page-by-page view of your 
document. 

THE RULER The ruler is the centerpiece of 
GeoWrite's window . It indicates the 
width of the text area and allows you 
to set the position of tabs , margins , 
and indents . It contains justification 
and line spacing settings, page buttons , 
and movable margin and tab markers. 
Normally , these show you the margins , 
tabs , justification , etc. for the current 
paragraph-that is , the one with the 
text cursor in it. When you se lect a 
range of text , however, the ruler turns 
gray and shows only those settings that 
are common to all the se lected para
graphs. 

I Sweetwater, CA 99001 

I (111) 555-2n2 

Celia del Turo 
501 Argonaut Lane 
Sweetwater, CA 99001 

February 5, 1992 

Dear Ce lia, 

THE HEADER, BODY, AND FOOTER Each page of 
the document contains three areas 
where you can place text: the header, 
body, and footer. The text in the body 
of the document appears on only one 
page , but text in the header and footer 
areas is repeated on all the pages. This 
lets you have page numbers and graph
ics (like a logo or other design element) 

appear on each page. 
The header area is 

I.: :········ ···· ······ ···· ····· ········~.=: __ :;:_~-~················ ··················T :J visible at the top of the 
::"

0

::::::: page, though normally 
the window is adjusted 
so that you can 't see it. 

The three work areas on eath page, from 
top to bottom: the header, the page body, 
and the footer. 

You can see it by simply 
scrolling the window to 
the top . Similarly , to see 
the footer area at the 
bottom of the page, 
scroll the window down 
to the bottom. For the 
complete story on head-

I am very pleased with the quality of your work for the Coriander: Three Decades 

The GeoWrite window. Notice that the 
document really is uwhat-you-see-is
what-you-get" (WYSIWIG). The header is 
suolled off the window at the moment (as 
is the footer). The Ruler is just below the 
menu bar, and is itself split into two 
halves. The upper half resembles an actual 
ruler-giving rise to the name-and 
inditates the margins and tab stops 
turrently in effed. The lower half shows 
you the page number, line spacing, and 
paragraph justifitation. 

of Se · ne cl to me 
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ers and footers, see "Adding a Header 
and Footer. " 

MOVING BETWEEN THE PAGES OF A DOCUMENT You 
can move through the pages of your 
document in several ways. To move 
backward or forward one page at a 
time , use the Page arrows on the ruler. 
To jump to a specific page, however, 
it's easier to choose Go To from the 
Window menu. Pages you have already 

FORMATTING TEXT 

worked on appear 
in the Window 
menu. To go to 
one of these , just 
choose the page 
in the menu. 

One powerful feature of GeoWrite is 
that it allows you to experiment with 
many different styles of text. When you 
want to try something, first select the 
text, then choose different fonts, font 
sizes , or special styles (such as bold , 
italic , and underline). You can also 
color text , lighten it with a halftone (or 
a pattern of very small dots-but more 
on this elsewhere), or adjust the char
acter spacing for titles or headlines . 
Make changes until you find a look 
you like. 

You do most of your text formatting 
with the Fonts, Sizes , and Styles menus. 
But those menus , because they 're com
mon to many GeoWorks Pro applica
tions , are only discussed at length in the 
"Basic Tools and Skills" chapter of this 
book. There is , however, a formatting 
trick that is only discussed here: namely 
character spacing, which is often 
known as kerning. 

14.S 

CHANGING THE CHARACTER SPACING (KERNING) 
When you change the character spacing 
of a word, you change the amount of 
space between the characters-particu
larly useful for titles, headings, logos, 
and fine print. For example , if you used 
the word "World" in a title, you 'd notice 
that the "W" and the following "o " 
seem a little farther apart than, say, the 
"l" and the "d ." This happens because 
of the shapes of the two letters. By 
changing the characters ' spacing, you 
could bring the "o" in closer to the "W, " 
and achieve a better result. 

What's altered, like in other formatting 
commands , depends on what you select. 
Change the spacing of two characters, or 
a whole page. The default spacing is 
zero , but you can set spacing from -150 
up to 500. This number isn't an absolute 
measurement; rather, it is a degree of 
spacing that is based on the width of the 
character-so, a "w " with spacing of 150 
moves farther than an "i" with the same 
spacing. A negative number compresses 
text and causes the characters to overlap. 

Washington B~ 

Washington Bar 

Washington Bar 
Three different examples of character spacing. At top, each 
letter is spaced at +SO. In the middle, the spacing is zero, or 
standard. In the bottom example, each letter (especially the first 
"a" in Washington) is kerned to fit well with the one next to it. 
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To change character spacing ... 
0 Select the text you want to change. 
If you select one character, the spacing 
before the character is changed, while 
the space after remains unchanged. 
f) Choose Character Spacing from the 
Sizes menu . The Character Spacing 
dialog box appears. 
8 Click the up or down arrows to 
change the spacing, or type a new 
number. Increasing the number moves 
the characters apart, while decreasing 
number brings them closer together. 

0 Click Apply to see the effect of your 
changes. 
0 When you're satisfied, click Close to 
make the dialog box go away (though 
you can leave it open if you prefer
just click in the GeoWrite window to 
continue working). 

SETTING TABS 

You set tabs by dragging the type of 
tab you want from the collection of 
sample tabs (called the tab well) and 
positioning it on the ruler. You clear 
tabs by dragging them off the ruler in 
any direction. You have a choice of 
four types of tab : Left tabs align text 
on the left. Right tab aligns text on the 
right . Center tab centers text at the tab 
location . Decimal tab aligns text 
around a decimal point. 
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(Below) To place a 
tab, just drag a tab 
from the "well" on 
the lower ruler and 
position it on the 
upper ruler. 
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To set and clear tabs ... 
0 If necessary, choose Show Ruler 
Bottom from the Options menu so that 
the tab markers are visible. 
f) Position the text cursor in the para
graph for which you are setting tabs, 
or select multiple paragraphs. 
8 Drag a tab marker to the location 
you want on the ruler. Release the 
mouse button to set the tab. To move a 
tab, drag it to a new position on the 
ruler. To clear a tab , drag it off the ruler 
in any direction. 
0 Continue dragging tabs from the tab 
well to set as many tabs as you want. 

To copy a tab ... 
0 Create the first tab. 
f) Hold down the @Iill key and drag the 
tab to a new position on the ruler. The 
original tab stays in place . The copy is 
the same type of tab and contains the 
same formatting as the original tab . 

CHANGING THE DEFAULT TABS When you haven 't 
set any tab stops on the ruler, GeoWrite 
sets default tab stops every inch. These 
default tab stops are marked by tiny 
vertical arrows on the ruler. 

To change the default tabs ... 
0 Choose Default Tabs from the 
Paragraph menu . 
f) Click one of the four standard dis
tances on the cascade menu : Centimeter, 
Half Inch, One Inch, or None. 



FORMATTING TABS 

In addition to setting and clearing 
tabs from the ruler, you can format 
tabs. Your tab formatting options 
include using different types of leaders 
and applying vertical lines . You can 
format any tab you add from the tab 
well, but not GeoWrite 's de fault tabs . 

USING TAB LEADERS Tab leaders automatically 
insert a line or a row of dots between 
the text and the leader tab. For example , 
leading dots are often used to fill in the 
space between a table of contents entry 
and its page number, as the following 
example shows. You cannot add a leader 
to one of GeoWrite 's default tabs . 

To set tab leaders ... 
0 Click the tab on the upper half of 
the ruler. A small arrow appears beside 
it indicating that it is selected. 
f) Choose Tab Attributes from the 
Paragraph menu (or simply double
click the tab on the upper half of the 
ruler). 
8 Select either Dot or Line from the 
Tab Leader option. (The options are 
dimmed when no tab is selected.) The 
leader is associated with the currently 
selected tab . 
0 Change the Tab Type if necessary . 
9 Click Apply. 

The Tab Attributes 
dialog box, which 
you use to change 
the formatting of 
selected tabs. 
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You can keep the Tab Attributes 
dialog box open and move between 
the GeoWrite document and the dialog 
box until you like the tab leaders . You 
can also keep the dialog box open and 
click different tabs on the ruler. 

DRAWING VERTICAL LINES WITH A TAB With tab 
lines, you can use tabs to draw vertical 
lines-called rules-to make tables and 
columns. You cannot add a vertical line 
to one of GeoWrite 's default tabs . 

To draw tab lines ... 
0 Click to select a tab on the ruler. 
The arrow indicates which tab you are 
formatting . 
f) Choose Tab Attributes from the 
Paragraph menu. 
8 Click the Tab Lines option and click 
Apply. A line appears next to the tab on 
the ruler to show that a line will be 
drawn at the position of this tab, and 
the Tab Lines options become available. 
0 Click the arrows next to Tab Line 
Width to set the width of the lines 
(from 1 to 3 points). 
9 Click the arrows to change the Tab 
Line Spacing value from 1 to 3 points . 
This moves the tab line to the left, to 
create a bit of space between the line 
and the text at the tab . 
0 Click Apply to see the tab line in your 
document. The tab is now formatted to 

insert a vertical line in 
your document. Using this 
tab on several continuous 
lines creates a long solid 
vertical line. 
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CHANGING MARGINS 

Use the margin markers on the ruler 
to increase the left and right margins. 
Notice that the left margin marker is 
split into upper and lower halves. The 
top half allows you to indent the first 
line of a paragraph without affecting 
the paragraph's other lines . By moving 
the upper half, you can create either a 
normal paragraph indent or a special 
hanging indent-where the first line of 
a paragraph starts to the left of the rest 
of the paragraph. See "To create a 
hanging indent. .. " in this section. By 
contrast, the lower half of the margin 
marker determines the left edge of the 
paragraph-the left margin. 

To change paragraph margins ... 
The simplest way to change the mar

gins for the entire document is to choose 
Page Setup from the File menu (where 
you can enter the size of both margins) 
There, you can also have GeoWrite alter
nate left and right margins-where the 
left margin setting is actually the left 
margin setting on left (even) pages, but 
it's the right margin setting on right 
(odd) pages (think about it). To change 
individual paragraph margins, though, 
adjust the margin markers on the ruler. 
0 Select the desired paragraph by 
clicking in it to place the text cursor, 
or select multiple paragraphs that you 
want to change. 
f) Hold down I Shift I and drag the left 
marker to a new position on the ruler 
(by holding down the Shift key, you 
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drag both the upper and 
lower halves of the mark
er together). Or, to set the 
right margin, simply drag 
the right margin marker. 
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To indent the first line only ... 
0 Click to position the text cursor in 
the paragraph to be indented. Or, 
select multiple paragraphs. 
f) Drag the left indent marker (the 
upper halO to the correct position on 
the ruler. Be sure not to hold down 
I Shift I as you do this, since this will 
move both the upper and lower halves. 

To create a hanging indent ... 
0 Select the paragraph(s) you want to 
align with a hanging indent. 
f) Drag the left margin marker Clower 
halO to the right. Leave the first line 
indent marker (the upper ha lf) in 
place. 

CENTERING AND JUSTIFYING TEXT 

In GeoWrite, lines of text can be 
justified (aligned) any of four ways: 
flush to the left margin (left justified), 
flush to the right margin (right justi
fied) , evenly centered between the 
margins (centered), and flush to both 
the left and the right margins (fully 
justified). The alignment you choose 
affects the entire paragraph. 



To center or justify text ... 
0 If necessary, choose Show Rul e r 
Bo ttom o n the Optio ns me nu to displ ay 
th e lower p o rti o n o f the rul e r. 
f) Positio n the text cursor in the pa ra
graph yo u wa nt to justify, o r se lec t 
multiple pa ragraphs. 
8 Click a justificatio n icon o n the rule r. 

SETTING PARAGRAPH SPACING 

In typesetting te rms , the w hite space 
between lines is ca lled leading (p ro
no unced "ledding, " no t "leeding, " since 
the te rm d ates back to the d ays w he n 
printe rs used strips of lead to space 
lines of text on the press). GeoWrite 
le ts you change the leading se p arate ly 
fo r above, be low , and within a para 
graph . You a lso have a cho ice of using 
automati c o r ma nu al leading. Auto matic 
makes the line he ight a multiple of the 
s ize of the largest characte r o n the line. 
You e nte r the multiple-2 fo r d o ubl e
spacing, 3 for triple -spacing, and so 
forth. With manu al leading you have 
more control-yo u e nte r a speci fi c 
leading measureme nt , usually in po ints . 
Precise manu al leading adju stme nts are 
handy w he n lay ing o ut a newsle tter o r 
pamphl e t , whe re aes the tics and cop yfit 
ting a re important. Howeve r, if yo u a re 
just typing a le tte r o r me mo , it may be 
best to use the simpler auto matic line 
spacing (see "Changing Line Sp acing" 
in this sectio n) . 

GeoWrite displ ays measureme nts in 
most di alog boxes in in ches by defa ult . 
But in the Paragraph Spacing dia log 
box , the de fault measure me nt is po ints. 
Yo u can also e nte r va lue s in othe r 
units by using the correct abbrev iation : 
in (inch), pi (pica), cm (centimete r), 
mm (millime ter), ci (Cicero), or e p 
(European point). 

The four kinds 
justification ... 

~ 
Left 

~ 
Center 

~ 
Right 

~ 
Fully Justified 

... And the three types 
of line spacing 

~ 
Single 

E!l 
One-and-a-Half 

[!2J 
Double 
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CHANGING LINE SPACING (AUTOMATIC LEADING) The 
s implest way to change the space 
be twee n lines is to adjust line spac ing 
from the rule r. This is best if yo u a re 
typing a le tte r or me mo and do n o t 
need the precise control that custo m 
leading gives you . Choose a se tting
s ingle , do ubl e, o r o ne -and-a-ha lf sp ac
ing-by clicking the appropria te sp ac
ing symbo l o n the rule r. 

To change the line spacing with the 
ruler ... 
0 If necessa ry, choose Show Rul e r 
Bo tto m o n the Optio ns me nu to see 
the line sp ac ing o ptions . 
8 Cli ck th e text curso r in the p ara
graph to be s paced o r select multiple 
pa ragra phs . 
8 Click one of the three line-spaci ng 
icons o n the rul e r. For mo re informa
ti o n see "Setting Paragraph Spac ing. " 

To set custom line spacing ... 
0 Positi o n the text cursor in the pa ra
g raph yo u want to change , o r se lec t 
multiple parag raphs. 
8 Choose Paragra ph Sp acing from the 
Paragraph me nu. Note tha t unde r 
Leading you have two cho ices: 
Auto matic and Manual. 
8 Selec t Automati c Lea ding. 
0 Click the a rrows o r type a va lue . A 
numbe r like 3 in the Line Spa c ing b ox 
gives yo u tripl e -sp ac ing . The no rma l 
line spacin g (as de te rmined by the 
la rgest cha racte r s ize o n the line) is 
multiplie d by this number; so , 1 is 
single -spacing, 2 is do uble-spac ing, 
and so fo rth. Yo u ca n a lso e nte r a fra c
tio nal va lue . 
9 Click Apply to see the result o f your 
change. 
0 Click Close . 
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CHANGING LEADING MANUALLY For precise 
control over line spacing, use manual 
leading. 

To manually set the leading ... 
0 Place the text cursor in the para
graph you want to change or select 
multiple paragraphs. 
8 Choose Paragraph Spacing from the 
Paragraph menu and select Manual 
Leading. The Manual option lets you 
enter a specific value rather than a 
multiple of the normal line spacing . 
8 Click the arrows or type a new 
val ue in the Manua l Leading box. 
0 Click Apply to see the result of 
your change . 
0 Click Close. 

CHANGING THE SPACING BEFORE AND AFTER A 
PARAGRAPH Often, to set a paragraph 
(like a heading) off from the text 
around it, you 'll want to add some 
white space above and below. You 
cou ld simply add extra lines before 
and after the paragraph, but unfortu
nately these lines have a set height 
(the height of the text) thus giving you 
little control over exactly how much 
space yo u get. Here's a better way. 
With the Paragraph Spacing dialog box, 
you can add a specific amour of space 
before (and after) the paragraph, to 
separate it from the others around it. 

The Paragraph Spacing dialog 
box lets you change the 
spacing between lines (the 
"leading") as well as the 
spacing between individual 
paragraphs. 
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To change the spacing above or 
below a paragraph ... 
0 With your pargraphs selected, 
choose Paragraph Spacing from the 
Paragraph menu. The Paragraph 
Spacing dialog box appears. 
8 Click the arrows or type a va lue for 
Space on Top , or Space On Bottom. 
8 Click Apply to see the results of 
your changes. Make more adjustments 
or click Close to close the dialog box. 

USING STYLES 

You will often spend a good deal of 
time getting a paragraph to look just the 
way you want. Elaborate formatting, 
like choosing point sizes and styles, 
setting custom leading, creating special 
indents, setting tabs, and so forth, can 
be time-consuming for one paragraph
never mind the time it takes to repeat 
the process for other paragraphs . In 
GeoWrite, however, you can apply the 
formatting from one paragraph to 
another in a couple of easy strokes. 
This is accomplished with a GeoWrite 
style. A style is all the character and 
ruler settings such as font, size, style , 
and indentation , that you have applied 
to text. To use a style, you store the 
style for one paragraph and apply it (by 
recalling the style) to another. 

To store a style ... 
0 Format text with the font, size, 
style, and ruler settings that you want. 
8 With the text cursor anywhere in 
the paragraph, choose Store Style from 
the Edit menu. 

To recall a style ... 
0 Click to position the text cursor in 
the paragraph to which you want apply 
the style (or se lect several paragraphs). 



8 Choose Recall Style from the Edit 
menu . GeoWrite applies the setti ngs of 
the last style you stored to the current 
paragraph. It 's just as though you man
ually se t the font , size, and character 
sty les. 

CREATING BORDERS FOR TEXT 

GeoWrite lets you add borders to 
paragraphs for emphasis and design. For 
a quick border, you have three choices: 
one line , two line , and shadow (with an 
adjustable imaginary light source). For 
more control though , GeoWrite 's Custom 
Border command all ows you to change 
the three basic border types . Borders 
can also be colored and halftoned, and 
when combined with paragraph color, 
you have a seemingly endless range of 
design possibilities. 

To add a standard border to text ... 
0 Position the text cursor in the para
graph you wa nt to border, or select 
many paragraphs . 
8 Choose Border from the Paragra ph 
menu . A cascade menu appears. 
Choose a border from the casca de 
menu: One Line , Two Line , or Shadow 
Top Left. 

I 'Jthe m.a.tin.g pattern of the native 
"£luge nheld 11 bird is one of obscure 
ritual and many lou.d noises, 
particularly by the male when he 
finds a suitable fem.a.le . 

To remove a harder ... 
0 Position the text cursor in the para
graph from which you want to remove 
all the borders, or select several para
graphs. 

(Left) A two-line 
border applied to 
a paragragh. 
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8 Choose Border from the Paragraph 
menu. 
8 Choose None. 

CUSTOMIZING BORDERS Choosing Custom 
Borders lets you refine the three stan
dard borders. For example , yo u may 
want a thick line that appears on ly 
above and be low the text , not on a ll 
four sides. Or, if you have a double
line border, you may want to change 
the spacing between the lines. 

To apply a color or halftone to the 
border, see "Using Color in GeoWrite." 

To customize a border ... 
0 Choose Border from the Paragraph 
menu . Then choose Custom Border from 
the cascade menu that appears. 

Custom Bor·der 

Left t:l Top • Right Bottom Drew ...._. Lines 

Border Spacing (pcmts)I 

Bottom Left Bottom llielht 

8 In the Custom Border dialog box , 
choose a Border type: Normal, 
Shadow, or Double Line . 
8 Turn on the Draw Inner Lines option 
if you want a line drawn between bor
dered paragraphs. (Normally, a group 
of paragraphs that have exactly the 
sa me borders aren 't separated by 
lines-instead they 're enclosed in one 
big box .) 
0 Click to deselect any sides that you 
do not want bordered. 
0 Click the arrows if you want to adjust 
Border Width, Border Spacing, Shadow 
Width , or the Width Between Lines of a 
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two-line border. If you select the 
Shadow border, choose the corner from 
which the shadow is cast (the Shadow 
Anchor). 
9 Click Apply to see the results. 
0 Make final adjustments to the border 
settings and click Close when you finish. 

CREATING A TABLE 

You can use tab lines in conjunction 
with a border to build tables in your 
documents. 

To create a table ... 
0 Set tabs on the ruler where you 
want each column of text to begin. 
Use decimal tabs where appropriate 
for numeric data. 
8 Add a tab anywhere you want a verti 
cal line drawn between columns of data. 
8 Double-click the tab to open the Tab 
Attributes dialog box and turn Tab Lines 
on. Set Tab Line Width and Tab Line 
Spacing as desired and click Apply. 

0 Click Close when you have tab lines 
you are happy with. 
0 Enter data in the columns of the 
table. Be sure to use the ~ key (not 
I Spacebar]) to create columns on a new 
line. Tabs you formatted with tab lines 
make vertical lines between columns . 
To change the width of a column , sim
ply adjust the appropriate tabs (be sure 
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to select all the lines in the table before 
adjusting the tab, so that all the lines 
are adjusted the same way). 
9 Select the entire table and choose 
Border from the Paragraph menu. Choose 
a border from the cascade menu that 
appears, or create a custom border for 
the table. 

Curren~ To dollus rxom dollus 

Australia. .7450 1.342.3 
Colombia .001731 577.78 
Greece .005508 181.55 
Japan .007985 12.6.83 
Thailal_I .03965 2.5.2.2. 

.A. 

A sample table, showing the use of decimal tabs, tab lines, and 
paragraph barders. 

USING COLOR IN GEOWRITE 

GeoWrite offers you the ability to 
add color to your documents . You can 
choose from a palette of 16 colors and 
apply the colors to text, paragraph 
backgrounds, or borders. You can view 
these colors on an EGA or VGA moni
tor, although you must have a color 
PostScript-compatible printer to actual
ly print in color. (If you don't have 
such a printer, you 'II sti ll see shades of 
grey, much like watching a color tele
vision program on a b lack and white 
television set.) 

ABOUT COLOR ON A MONOCHROME SYSTEM On a 
monochrome monitor the colors on the 
color palette appear as patterns. Use 
them to apply shades of gray to text, 
paragraph backgrounds, or borders. If 
you have a Postscript-compatible color 



printer, the actual color (corresponding 
to the pattern on a monochrome moni
tor) prints, even though it 's grey on your 
screen. With regular single-color printers 
you just get the shades of gray. 

The Halftone controls simply change 
the color intensity (of text, paragraph 
backgrounds , and borders) on both color 
and monochrome monitors. Halftones 
print on both color and black-and-white 
printers. See "About Halftones" later in 
this section. 

COLORING TEXT, PARAGRAPHS, AND BORDERS 
Whether you choose a color for text , a 
paragraph background , or a border, a 
dialog box presents the co lor controls 
in the same way . 

To use color ... 
0 Select text or position the text cur
sor in the paragraph containing the 
border or background you want to 
color, then choose the appropriate 
color command. 
•Text Choose Text Color from the Styles 

menu 
•Paragraph background Choose 

Paragraph Color from the Paragraph 
menu 

•A border Choose Border from the 
Paragraph menu , then choose Border 
Color from the cascade menu . Tab lines 
within a border are also colored when 
you color the surrounding border 

The Text Color dialog box, which is typical of the three ucolor" dialog boxes. You can choose 
a color by clicking one of the color buttons ( (i) ), or by dialing in a specific intensities of red, 
green, and blue, the three primary colors that form all the other colors. ( (i)) 
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In addition to the preset 16 colors, 
you can vary the concentration of red, 
green , and blue to create custom colors. 
f) Click to select the color of your 
choice . 
E) To create a custom color, use the 
arrows to vary the amount of Red, 
Green , or Blue from 0 to 255. 
0 To lighten the concentration of 
color, change the Halftone setting to 
Light (15%), Medium (25%) , or Dark 
(50%). (See "About Halftones ," later.) 
0 Click Apply to see the change. 
9 When satisfied , click Close. 

CREATING WHITE-ON-BLACK TEXT You can add 
the sharp look of white type against a 
black background with the Paragraph 
Color option. 

To create white-on-black text ... 
0 Select the text you want to change . 
f) Choose Text Color from the Styles 
menu. 
E) Click White on the color palette and 
click Apply. The selected text "disap
pears" (becomes white on white) until 
you add color to the paragraph back
ground . 
0 Choose Paragraph Color from the 
Paragraph menu. 
0 Click the black square (or other 
color square) on the color palette . 
9 Click Apply . The white type that 
you selected or any that you now type 
becomes visible against the dark back
ground. 
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ABOUT HALFTONES GeoWrite provides four 
halftone settings that you can apply to 
text, borders, and backgrounds. 
Halftones change the concentration of a 
color by reducing the number of pix
els-dots on the screen-that display 
the color, forming a pattern of very tiny 
dots. Newspapers use halftones when 
they reproduce photographs; if you 
look at a photo with a magnifying 
glass, you'll see that the "colors" (well, 
shades of grey) are actually made from 
patterns of little black dots. It's the 
same way with GeoWrite . On the print
ed page, the ink is screened according 
to these percentages (with solid color 
being 100%, and white-no color
being 0%): 

Setting 
Solid 
Dark 

Percentage 
100% 
75% 

Medium 50% 
Light 25% 
Halftones work with both color and 
monochrome systems . 

To apply halftones ... 
0 Select the text, or merely click to 
place the text cursor in a paragraph if 
you want to apply a halftone to its 
border or background. 

SOLID 
DAR.K 
.IV.l.E.D IU._lVl 

GEOWRITE 

(left) The four 
flavors of halfto11es. 
The lighter the 
shade, the farther 
apart the dots are 
that make up each 
letter. 
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f) Choose 
•Text Color from the Styles menu (for 

text). 
•Paragraph Color from the Paragraph 

menu (for the background color of 
the paragraph). 

•Border from the Paragraph menu and 
then Border Color (to color the para
graph's border). 

8 Choose a color from the dialog box 
that appears. 
0 Select a Halftone setting: Solid, 
Light, Medium, or Dark. 
0 Click Apply to see the change. 
0 When you 're finished , click Close. 

INSERTING GRAPHICS 

Graphic elements that you create in 
GeoDraw (or scraps collected in a 
scrapbook) can be copied to the clip
board, then pasted directly into your 
GeoWrite documents. The graphic 
appears in your document at the cur
rent insertion point, and the line lead
ing automatically increases to accom
modate the graphic, unless you have 

'~ I .om very pluHd with th.! ~ity ~~!your work ford 
Co~ndtr, Three Doc.des of Suvico oxposition. In fact, Chris Dixon mant 
kl me eulior this woek that 

chosen manual leading (in which case 
the leading stays the same and the 
graphic spills over to other lines) . 
These graphics then behave much like 
text. Move it forward on a line by 
inserting spaces in front of it (using the 
I Spacebar )), or move it to the next line 
by inserting a line before it (by press
ing !Return)). You can double-click to 



select it as you would a word, and use 
the Cut, Copy, and Paste commands to 
relocate or duplicate it. 

HIDING GRAPHICS Complex graphics take a 
long time to draw on the screen and 
consume a lot of your computer's valu
able memory . If your document con
tains detailed graphics , you can make 
scrolling and screen drawing go faster 
and conserve memory by turning off 
the Draw Graphics option (in the 
Options menu). This replaces each 
graphic with a simple rectangular 
place holder. To see the actual graphic 
again , turn the Draw Graphics option 
back on. 

ADDING A HEADER AND FOOTER 

GeoWrite automatically creates areas 
for headers and footers on every page of 
your document. Choose a page-any 
page-and type text or place graphics in 
the footer or header area (or both). 
Whatever you place there appears on all 
pages of the document. Well , there are a 
couple of exceptions . If you turn the 
Title Page option on (see "Creating a 
Title Page" later in this chapter) the 
header and footer are suppressed on the 
first page of your document-useful for 
cover pages. The other exception arises 
if you've selected Alternate Left and Right 
Margins in Page Setup . In this case, the 
document has alternating headers and 
footers (one for the odd-numbered pages 
and one for the even-numbered pages) . 
Therefore , you must make changes on 
both an even- and odd-numbered page 
to have the changes appear on both left 
and right pages . 
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Headers and footers physically occu
py the area between the margin of the 
document and the printing edge of the 
paper (this is usually 1/4 inch or 18 
points in from the real edge of the 
paper). With a standard margin of one 
inch and a printing margin of 1/ 4 inch, 
the default header or footer is 3/ 4 of an 
inch high. Since you cannot easily 
adjust the printing edge of the paper 
(this is often permanently set), you 
adjust the height of the header or footer 
by changing the Top or Bottom Margin 
settings in the Page Setup dialog box. 

Edit a header or footer just as you 
would text in the body of the document. 

All of the ruler and text controls are 
available and operate in the same way 
in the header and footer areas as they 
do in the body area of the page . For 
example, you can center text in a head
er by selecting the text and clicking the 
center justification icon on the ruler. 

To resize a header or footer ... 
0 Choose Page Setup from the File 
menu. The Page Setup dialog box 
appears . 
8 To make the header area larger, 
increase the top margin. The header 
automatically expands to fill the area 
between the top margin and the print
ing edge of the paper. To make the 
header area smaller, decrease the top 
margin. In the same way, increase and 
decrease the size of the bottom margin 
to change the size of the footer. 
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To remove a header or footer ... 
0 Choose Page Setup from the File 
menu. The Page Setup dialog box 
appears. 
8 To remove the header area, decrease 
the top margin to the lowest possible 
setting-0.25 inch (18 pt)-which leaves 
no room for the header area. Similarly, 
to remove the footer area, decrease the 
bottom margin to the lowest possible 
setting (0.25 inch or 18 pt). 
8 Click OK. If the header or footer 
area contains text, the text reappears 
when you open the header or footer 
area back up. 

CREATING A TITLE PAGE 

You can add a special page to your 
document that does not have any header 
or footer information. This is useful if 
you are printing a report with a header 
and footer but you don't want them to 
appear on the cover page . With the Title 
Page option on, GeoWrite starts the 
header and footer (and page numbering) 
on the second page of the document. 

To create a title page ... 
0 Choose Page Setup from the File 
menu 
f) Select Yes for Title Page and click 
OK. The first page of your document 
becomes the title page, while the second 
page becomes page one. The header and 
footer areas disappear from the title 
page and the page indicator on the ruler 
reads "Page: TP"-indicating that you are 
now on the title page . 

To go to the title page ... 
Click the left arrow beside the page 

indicator on the ruler until the page 
indicator reads "Page: TP" and you see 
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the title page. Or, choose Go To 
Beginning from the Window menu . 

To remove a title page ... 
0 Choose Page Setup from the File menu 
and select No for the Title Page option. 
f) Click OK. 

INSERTING THE PAGE NUMBER Like everything 
else in the header or footer, Page num
bers placed there appear on every page 
of the document. GeoWrite keeps track 
of all the pages in your document , 
renumbering when you remove pages , 
and automatically numbering new ones. 
If you have a title page , page number
ing skips the title page and starts on 
page one. 

To insert automatic page numbers ... 
0 Click the text cursor in either the 
header or footer. 
f) Choose the font , size, and style that 
you want from the appropriate menus . 
If you want to center the page number, 
click the center justification icon on the 
ruler. Or, if there is other tex t in the 
header or footer, use a center tab to 
place the number rather than centering 
the whole line. 
8 Type a prefix if you wish , such as a 
dash or the word "Page " followed by a 
space. 
0 Choose Insert Page Number from 
the Edit menu . The page number 
appears at the text cursor and updates 
automatically on each page. 

····················l'a~··ir·i············· 



ADDING PAGE BREAKS 

As you add text and gra phics to a 
document , GeoWrite automatica lly crea tes 
new pages (o r columns) to accommodate 
your text. Beca use GeoWrite gives you a 
page-by-page view of a document , you 
ca n eas ily see whe re these pages and 
columns begin . When you see a brea k 
that does not naturally occur in the right 
place (like before a new chapte r) you 
can add a page (or column) break by 
choosing the Insert Page Break command 
fro m the Edit menu . 

To insert a page break ... 
0 Positio n the text curso r w he re you 
wa nt the page o r column b rea k to occur. 
f) Choose Inse rt Page Brea k fro m th e 
Edit me nu . 

You ca n also press [9:ill [Return I to 
inse rt a page brea k . 

To delete a page break ... 
0 Pos ition the text cursor at the to p of 
the page o r column that you started with 
a ha rd p age break . 
f) Press I Backspace I to de le te the inserted 
p age break. Text re fl ows auto matica lly 
between the columns o r pages . 

For exampl e, if you inse rt a p age 
brea k so th at a p arag raph sta rts a t th e 
to p o f the n ext p age, the n la te r change 
your mind , p os itio n th e text curso r 
befo re the first wo rd o f th at p a ragraph 
and press I Backspace J to back up and 
de le te the page break. 

A GeoWrite document 
with three columns. 
Only the first one has 
text in it, so the other 
two are grayed out. 
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WORKING WITH COLUMNS 

GeoWrite allo ws you to create ne ws
le tte r, book , o r brochure layouts by 
arrang ing text in two , three , or four 
evenly spaced columns pe r page. On 
the screen, the a rea o f each column is 
o utlin ed with a dotted line, and empty 
columns are colo red grey. Through the 
Page Setup dialog b ox, you ca n add 
ve rtica l rules o f va rying widths to sepa
rate them, and you can control the 
width of columns by chang ing the spac
ing be twee n columns. 

To create multiple columns ... 
0 Ch oose Page Setup fro m th e Fil e 
me nu . 
f) Se lec t o ne o f th e Co lumns cho ices: 
2, 3, o r 4 co lumns. Wh e n yo u choose 
to have mo re than o n e column , the 
Spac ing and Rul e Width co ntro ls 
become se lecta ble. 
E) Ch ange the spac ing be tween the 
co lumns by adju sting th e Spac ing con
tro l. Click th e a rrows o r type a new 
va lu e fro m 0.175 inch to 1 in ch . 
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0 Adjust the Rule Widths setting to add 
a vertical rule between the columns. 
The width can vary from 1 point to 9 
points (0.175 of an inch). To delete the 
rule, set the Rule Width to zero. 
0 Click OK to apply the changes to 
your document. 

To add column breaks ... 
0 To start text at the top of a new 
column, position the text cursor where 
you want the text to break. 
8 Choose Insert Page Break from the 
Edit menu (or press @!ill IReturnJ). The 
text cursor moves to the top of the 
next column. 

To delete column breaks ... 
0 Position the text cursor at the top 
of the column following the inserted 
column break. For example, if you 
have a column break before a heading 
and change your mind, position the 
text cursor before the first word of the 
heading. 
f) Press ~[ B-a-c-ks_p_a-ce~J to back up and delete 

the column break. The heading and text 
automatically flow back into the available 
space in the previous column. 

GEOWRITE 

Use the Options 
menus to tailor 
GeoWrite to 
your liking. 
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CUSTOMIZING GEOWRITE 

The Options menu gives you several 
commands that let you tailor GeoWrite 
to your liking. They are: 
Draw Graphics Turn this Option off to 
have GeoWrite replace complicated 
graphics with temporary rectangular 
placeholders-for faster scrolling and 
minimal memory use. Turn it on to 
actually see your graphics. 
Align Ruler With Page When this 
option is on, it aligns the ruler to the 
edge of the paper. Otherwise, when 
off the ruler aligns to the left margin. 
Snap to Ruler Marks Use this option to 
make tab alignment easier. When on, 
any tab you move or add will snap 
exactly to one of the 1/ 8 inch marks on 
the ruler. When off, you can move or 
add tabs to spots in between the 1/ 8 
inch marks-giving you finer placement, 
but less accuracy. 
Show Ruler Top When on, the top 
portion of the ruler-showing the "tick" 
marks that give the ruler its name, as 
well as the tab stops-is visible in the 
GeoWrite window. When off, the top of 
the ruler is hidden. 
Show Ruler Bottom When on, the 
bottom portion of the ruler is visible, 
showing you the Page indicator, the 
tab well, and the justification and line 
spacing indicators. When off, the bot
tom of the ruler is hidden . 
Show Horizontal Scroll Bar Shows or 
hides the horizontal scroll bar. 



Show Vertical Scroll Bar Shows o r 
hides th e ve rtica l scroll ba r. 
Show All Choose this to turn o n a ll o f 
the above four items (Show Rul e r Top , 
Show Ruler Bo ttom, Show Horizontal 
Scroll Bar, and Show Vertical Scroll Bar). 
Hide All Choose this to turn o ff th e 
four ite ms (Show Rule r To p , Rul e r 
Bo tto m , Show Ho rizontal Scro ll Bar, 
and Show Vertical Scroll Bar). 
Measurement Units Gives you a cas
cad e me nu fro m w hich you ca n choose 
the units tha t appea r o n the rule r: 
English , Metric, o r the Sys te m De fault . 
Spell Checker Options See "Checking 
the Spe lling in Your Doc ume nts." 
Save Options Choose this to save the 
curre nt se ttin gs in th e Optio ns me nu. 
That way, the next time you start 
GeoWrite (no matte r w hat d ocume nt 
you m ay be o pening) these se ttings 
will automatically take effec t . 

CHECKING THE SPELLING IN YOUR 
DOCUMENTS 

The GeoWrite spelling checker checks 
the spe lling of words in your docume nt 
by looking them up in two e lectronic 
dictiona ries . The first , the system dictio
nary, is a pe rmanent , 100,000-word 
American English dictionary. The sec
ond , the user dic tionary, is empty until 
you add your own special words. When 
the spe lling checker finds a word in 
your docume nt that 's no t in e ither of 
these dictionaries , it fl ags the word as 
"unknown" and stops to allow you to 
correct it . 

A spe lling check begins when you 
sele ct Check Spelling from the Edit 
menu . This brings up the Check 
Spelling dialog box, the "control room" 
for the spelling checke r. It 's from here 
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that you steer the spe lling checker 
th rough your docume nt , co rrect 
unknown words as they po p up , and 
edit your user dictionary. When the 
spe lling checke r stops for a w ord no t in 
a dictionary, you can e ithe r add it to 
th e use r dictio nary o r skip it. If you add 
it to the user dictionary, it is ign o re d in 
future spe lling checks. Pe rsonal names 
like Murtnik and Munste r, if used fre
que ntly, are good candidates fo r the 
user dictio nary. 

A spe lling checker has two impo rtant 
limitatio ns . It can 't te ll if you 're us ing a 
correc tly spelle d word incorrec tly- fo r 
example, "yo ur" whe n "you 're" is actu
a lly right for the sente nce. Nor can it 
ide ntify a wo rd that is miss pe lled if the 
misspe lling is a lso a word . It won 't 
ca tch a case w here you mistype 
"found" as "fund ," s ince the latte r is 
indeed a word . 

CHOOSING A STARTING POINT Be fore you 
check yo ur docume nt , you must te ll 
the spe lling checke r w he re to start and 
how far in th e docume nt to go. The 
spe lling checke r all ows you to check 
three diffe rent po rtio ns o f yo ur docu
m e nt : 
Note:You can change your starting point even after you've 
started a spelling check. Just click at a new place in your 
document, and then click one of the three start buttons 
again. 

To check a single word or section 
of text ... 
0 Double-click a word , triple-click a 
paragraph , or drag the po inte r to select 
a range of text. (Don 't worry abo ut only 
selecting part o f a word-the spe lling 
checker still checks the e ntire word .) 
8 Choose Check Spe lling from th e 
Edit me nu o r press [ill. 
8 Click Check Selec tio n in the Check 
Spe lling dia lo g box. The spe lling 
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ch ecke r checks o nly the word you 've 
selecte d. 

To check from the text cursor to 
the end of the document ... 

This o ptio n is g rea t for continuing a 
chec k a ft e r yo u've s to ppe d to do some 
majo r re pa irs in th e middle o f your 
docume nt. 
0 Click somew he re in the docume nt 
to pos iti o n the text curso r, b u t do n 't 
actu all y se lect a nything. 
8 Choose Check Sp e lling fro m the 
Edit me nu o r press [BJ . 
8 Cli ck Chec k to End o f Docume nt. 

To check the whole document ... 
0 Make sure that no text is se lec te d . 
8 Choose Check Sp e lling fro m the 
Edit me nu o r press ffi. 
8 Cli ck Check Entire Docume nt . 

TAKING CARE OF UNKNOWN WORDS Whe n th e 
sp e lling checker finds a wo rd in yo ur 
docume nt th at 's no t in e ithe r o f the 
di cti o na ries, it d oes seve ra l things . It 
highli ghts th e wo rd in the docume nt 
(yo u may need to move the Check 
Sp e lling di alog box to see th e wo rd); it 
pl aces the word in th e b ox lab e led 

Check Spelling 

Replacement Text 

"Unknown Wo rd"; and it gives you 
several ways to fix the word : 
• To igno re the word and move o n , 

cli ck Skip . Th is te lls the sp e lling 
checke r that the word is sp e lle d cor

Unknown Word 
rec tly but you 
do n 't wa nt it 
added to the 
user di cti o 
na ry. The next 
time it finds 

this wo rd , the spe lling checke r s to ps 
aga in . Click Skip All to ign o re o the r 
occurre nces o f the word until the 
Chec k Spe lling d ia log box closes 
(usua ll y w he n the check is com ple te) . 
Turn off the "Reset Skipped Words 
Li st Whe n Sp e lling Chec k Compl e te " 
o pti o n to have th e sp e lling checke r 
continu e to igno re this word in o the r 
docume nts . 

• To repl ace the word with another word , 
type the correct word in the Rep lacement 

Text box . 
.----Replacement Text-

Ir ores I 
Click Replace 
to re place 
this instance 
only, or 
Replace All 

to re place every occurrence of th e mis
spe ll ed word in the document. 

The Check Spelling dialog box, the 0 control room" for the spelling che<ker. On the bottom row, click any of the three 0 start" buttons to begin checking your document 
((i)). The Unknown Word box shows the flagged word ((.i)). Next to it is the Replacement Text box, where you type in the corrected word ((j)). The Suggestions 
List on the right lists words that are similar to the Unknown Word ((i)). 
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Shortcut: Select the Unknown Word and Quick Copy it to 
the Replacement Text box. 

•To have the spelling checke r suggest a 
re placement , click Suggest Spellings. 
The sp e lling checker then searches its 
dictionaries to find words similar to 

the unknown 
word . The 
spelling 
checker dis
plays its find-

ings in the Spelling Suggestio ns box . 
Use the scroll bar to move through the 
list. If th e correc t word isn 't lis ted, you 
ca n click Suggest from User Dictionary 
to have the spelling checker look for 
possible replacements in the user dic
tionary. 

If you find the correct word in 
the list , se lec t it. The word ap p ears in 
th e Rep lacement Text box , w h ere you 
can change it if you like. When you 
are sa tisfied wi th the Repl acement 
Word , click Replace (or click Replace 
All if you wa nt to replace a ll occur
re nces of the misspe ll ed word). 
Shortcut: Double-dick a word in the Suggestions list to 
have it automatically replace the unknown word. 

• To add the word to the user dictio
nary, click (not suprisingly) Add to 
Use r Dictionary. With the word 
recorded in the user dictionary , the 
spelling checker does not stop if it 
e ncounte rs the word again , in this or 
any other documents. 

EDITING THE USER DICTIONARY The system dic
tionary supplied with GeoWrite contains 
over 100 ,000 words , a lot when you 
consider the number of unique words in 
the typ ical business le tter or report , but 
a relative drop in the bucket compared 
to the numbe r of words in the English 
language itself. The Oxford English 
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Dictio nary, by comparison , lis ts over 
half a million . 

This is where the user dictionary 
comes in . When the spelling checker 
flags words that you think should be in 
a dictionary , but aren 't , simply click the 
button labeled "Add to User Dictionary" 
and the word is added . From that point 
o n , the spe lling checker will not flag 
the word aga in , even if it 's used in 
o the r GeoWrite docume nts. 

You can add and re move specific 
words from the use r diction ary a t any 
time by clicking the Edit User 
Dictionary button . 

To add a word to the User 
Dictionary ... 
0 Making sure that no text is selected , 
ch oose Check Spelling from th e Edit 
me n LI Or press (£[] . 
8 Click Edit User Dictionary. 
E> Type the word in the New Word field 
and make sure it 's spe lled correctly. 
0 Click Add New Word. Since it 's now 
p art of the diction ary, the sp e lling 
ch ecke r won't stop for it in subsequent 
spell checks. 

To remove a word from the User 
Dictionary ... 
0 Choose Check Spelling from the 
Edit me nu or press (£[]. 
8 Click Edit User Dictionary . 
E> Select the word in the Words in 
User Dictionary list and click Delete 
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Selected Word. The word is removed 
from the dictionary, and the spelling 
checker stops for it in subsequent 
spell checks. 

CUSTOMIZING THE SPELLING CHECKER The 
spelling checker is not entirely set in its 
ways-you have some say in how it 
goes about its business of checking your 
documents. For instance , when it finds 
an unknown word, it usually waits for 
you to click Suggest Spellings before it 
looks up possible replacements . By 
changing one of the options, you can 
avoid a step by having the spelling 
checker look up replacement words 
automatica lly- without waiting for you 
to click the Suggest Spelling button. 

To change the Spelling Checker 
options ... 
0 Choose Spell Checker Options from 
the Options menu . A cascade menu 
with three check boxes appears. Turn 
the settings on or off as you like: 

Automatically Suggest Spellings With 
this option on, the spelling checker auto
matically looks for suggested spellings 
when it finds an unknown word. With 
the option off, you must click Suggest 
Spellings to see suggestions . Note that 
when on , this option can slow you down 
significantly if you 're working on a slow 
computer. 
Automatically Start Checking 
Selections Normally this option is on. 
When you select some text and choose 
Check Spelling, the spelling checker 
automatically begins checking the selec
tion rather than waiting for you to click 
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the Check Selection button. But when 
you turn this option off, you must click 
the button before it will check. 
Reset Skipped Words List When Spell 
Check Complete When you click Skip 
All, the spelling checker skips every 
occurrence of the misspelled word. With 
this option on, the spelling checker only 
skips the word until the spell check is 
complete . After that, the word is once 
again fair game, and the checker flags 
the word when it finds it. 

With the option off, the spelling 
checker keeps on skipping the word 
until you close GeoWrite or shut down 
GeoWorks Pro . It a lso skips the word 
when you check the spelling of other 
documents (that is, if the documents 
are open within the same GeoWrite). 
f) When finished , click anywhere out
side the cascade menu to close it. 

TRANSFERRING FILES BETWEEN 
GEOWRITE AND OTHER WORD 
PROCESSORS 

Although most word processors seem 
pretty much the same, the internal for
matting of their documents is not. This 
means you can't take a document creat
ed with one word processor and simply 
open it in another. GeoWrite can't open 
documents created by other word pro
cessors, and they in turn can't open 
documents created by GeoWrite. 

But, if you want to transfer the text in 
one document from another word pro
cessor to GeoWrite, or vice versa, there 
is a way. Most word processors , page 
layout programs, and even some spread
sheets can save a document as a simple 
DOS text file, and load information from 
such files . Text files (also known as 
ASCII-American Standard Code for 



Information Interchange-files) contain 
all the letters, numbers, and some of the 
special characters of a document, but 
not the formatting information. They 
contain no italics , boldface, extra fonts, 
paragraph spacing, colors, or any of the 
other things that add pizzazz to 
GeoWrite documents. 

To bring a text file into GeoWrite ... 
Remember that when you import a 

text file into GeoWrite, it comes in with 
almost no formatting at all. You can, 
however, add italics, boldface, and 
other flashy things to your document 
once it's been imported. 
0 Open a GeoWrite file, or select New 
from the File menu to create a new 
document. 
8 Click to place the text cursor where 
you'd like to insert the imported text, or 
select text you would like the imported 
text to replace. Keep in mind that the 
imported text takes on the same style as 
the text at the insertion point. 
8 Select Insert From Text File from 
the File menu. A file selector dialog 
box appears. 
0 Find the file you want to import, 
changing directories if necessary , and 
double-click the name of the file. The 
contents of the file are placed in your 
document at the current insertion point. 
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To save a GeoWrite documents as a 
text file ... 

You can save any GeoWrite docu
ment as a text file . Again , this text file 
won't look the same as the original , 
since it 'll lose most of its formatting 
(one exception: tabs are kept , although 
the tab stops are not) . But you will be 
able to import this text file into other 
word processors . 

Also note that the file won 't be 
saved with carriage returns at the end 
of each line . You 'll only find carriage 
returns in the text file where you 
specifically pressed I Return I in the 
GeoWrite document -that is , at the 
end of paragraphs . 
0 Open a GeoWrite document. 
8 Select Save as Text File. A file 
selector appears. 
8 Type in a DOS filename. Since your 
document is being saved as a regular 
DOS text file-not as a GeoWorks doc
ument-you must give the document a 
legitimate DOS filename (for the defini
tive word on DOS file names, see your 
DOS manual). 
0 Click Save. GeoWrite saves a separate 
text version of your document, leaving 
your actual document unaffected. 

The Save as Text File dialog box. Choose a directory and enter 
the name for the text file. Note that the name needs to be a 
standard DOS file name. 

GEO WRITE 
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T H E N 0 TEP AD 

The Notepad is a simple text editor, 

vvhich makes it ideal for quickly jotting 

down notes that don't require the full font 

and formatting povver of GeoWrite. And, 

since it works specifically with DOS text 

(ASCII) files, it's also great for creating 

and editing DOS files, like 

AUTOEXEC.BAT. 



THE NOTEPAD WINDOW 

While at first glance the Notepad 
window may resemble GeoWrite 's, it 's 
really much more sparse. There is no 
ruler underneath the menu bar, since 
the kind of formatting control-justifi
cation, adjustable tabs, line spacing, 
etc.-found on the ruler isn't found in 
the Notepad. In fact, there's simply a 
large area where you can type , and the 
menu bar. 

Pancake Scuffle: 

1 egg 
1 /2 cup flour 
1/2 cup milk 
1 tbsp butter, melted 
dash o' sugar 

- Beat egg 

USING THE NOTEPAD 

The Notepad is easy to use . You 
create, type in, edit, and save Notepad 
files the same way you do in any other 
GeoWorks application. See the "Basic 
Tools and Skills" chapter for informa
tion on both working with files and 
editing text. 

Although the Notepad may seem a 
lot like GeoWrite , keep in mind that 
there are differences between the two , 
as shown in the table below. 

CHANGING THE TEXT SIZE Although the 
Notepad doesn't give you the kind of 
text size control that you find in 
GeoWrite-where you can make one 
word larger or smaller than the sur
rounding words-the Notepad does let 
you make all the text in the window 
larger (and easier to see) or smaller 
(so that more fits on the screen). 

- Mix flour, milk, melted butter and sugar in 
To change the text size ... 

Choose the size you want from the 
Sizes menu. You'll see all the text in 
the window change to the size you 
chose. Keep in mind, though , that this 
only changes the text in the window. 
The text size information isn 't saved as 
part of the file , and the file prints at 10 

the egg mixture 

When you start the Notepad, it auto
matically opens the file NOTES .TXT. If 
the file doesn't exist in the 
DOCUMENT directory, the Notepad 
creates it there for you . 

THE NOTEPAD 

THE NOTEPAD VS. GEOWRITE 

Notepad GeoWrite 
Can open DOS FILES GEOWRITE FILES 
Files open at once ONLY ONE MANY 
Document safeguarding No YES 
Indents, spacing, etc. No YES 
Fonts and text sizing No YES 
PAGINATION No YES 
MAXIMUM FILE SIZE 10,000 CHARS UNLIMITED 
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point no matte r w ha t size the text is o n 
the screen . Also, the s ize se tting stays 
in effect even w hen you close the cur
re nt fil e and o pe n a new o ne . 

1 egg 
1 /2 cup flour 
1/2 cup milk 
1 tbsp butter, melted 

OPENING, CLOSING, AND SAVING 
NOTEPAD FILES 

With the Note p ad , yo u ca n o nly 
have one fil e ope n a t a time. So, you 
must close the curre nt fil e before you 
ca n o pe n a new one. (Or, yo u ca n sta rt 
Note pad a second time. ) 

Follow the DOS naming conve ntions 
(e ight cha racte rs , o ptiona lly fo llowed 
by a pe ri od and three mo re cha racte rs) 
w hen you save a Notep ad fil e, as it is a 
standard DOS text fil e and no t a 
GeoWorks d ocume nt. Also, s ince it o nly 
wo rks w ith DOS fil es , the Note pad 
does no t suppo rt d ocume nt safeguard
ing. This mea ns tha t yo u need to be 
sure to save the fil e w heneve r you 
make important changes . 
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P R E F E R E N C E S 

The Preferences application helps _ 

you tailor GeoWorks Pro to vvork with 

your particular computer systenl. Use it to 

adjust various hardware options like 

printer and modem settings, and software 

options like size of the font used in menus 

and dialog boxes. 



THE PREFERENCES WINDOW 

When you start the Preferences appli
cation, the Preferences window appears. 
The window is filled with buttons that 
you click to change different groups of 
options. Here 's a list of the Preferences 
buttons and what they do. 
Look and Feel Changes the size of the 
text in menus and dialog boxes, and 
how often GeoWorks Pro automatically 
safeguards open documents. 
Date and Time Changes the computer's 
internal date and time settings. 
Background Changes the picture that 
fills the workspace background. 
Sound Changes the GeoWorks Pro 
sound setting. (Keep in mind that when 
the sound is off, GeoPlanner's alarms 
are silenced.) 
Printer Changes the brand of printer 
you 're using and the port to which it 's 
connected. 
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Computer Changes the type of addi
tional memory present in your comput
er and other hardware options . 
Video Changes the type of video moni
tor you're using and the screen saving 
interval. 
International Changes the standard 
currency symbol, decimal point, quota
tion mark, long date, short date, and 
time formats. 
Keyboard Changes the type of key
board you're using, or the way that the 
GeoWork Pro responds to your key
board . 
Mouse Changes the brand of mouse 
you 're using, its responsiveness, and 
how quickly you have to click to do a 
double-click. 
Modem Changes the port, speed, and 
protocol options for your modem. 
PC/GEOS Internal GeoWorks Pro 
options (not normally changed). 

The Preferences window. 
Click the large buttons to 
change different groups 
of options. 



CHANGING THE LOOK AND FEEL 

You can increase the size of the 
system text to make it easier to read . 
System text appears in menus , menu 
bars , window title bars, and dialog 
boxes. You can also change how often 
applications safeguard open documents 
by saving temporary copies of them. (If 
your computer shuts down when your 
in the middle of something, your last 
safeguarded version of the document 
wi ll come up when you restart.) 
GeoWorks Pro must restart for the 
changes to go into effect. 

.-----f...t Size------. r---'""IRla 

1-llfzeofthe..,..textlat 
'*Smell ~ lllfV8 

s.nipre text In alllctecf feint .... 

To change the size of the system 
text ... 
0 In the Preferences window, cl ick 
Look & Feel. The Look & Feel dialog 
box appears . 
8 Choose sma ll , medium, or large 
GeoWorks Pro system text. Underneath 
the settings is some sample system text, 
so you ca n see how each of the choices 
look. Your new setting , though , won't 
take effect until GeoWorks Pro shuts 
down and starts up again. 
8 Click OK, or click Reset to leave the 
options unchanged. 
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To change document safeguarding ... 
0 In the Preferences window, click 
Look & Feel. The Look & Feel dialog 
box appears . 
8 Turn the Document Safeguard fea
ture on or off by clicking On or Off. 
8 Set the interval between safeguards 
by entering a new Time in minutes . 
0 Click OK, or click Reset to leave the 
options unchanged . 

To bypass the Welcome Screen ... 
0 Click Look & Feel. The Look & Feel 
dialog box appears. 
8 Choose where you 'd like to end up 
when you start GeoWorks Pro : the DOS 
Programs screen, the Intermediate 
Workspace , the Advanced Workspace , 
or the Welcome screen (the standard 
setting) . 
8 Click OK. 

To control overstrike mode ... 
Choose Via insert key if you want to be 
able to toggle between overstrike and 
insert mode while in GeoWorks Pro. 
Click Always disabled if you want to 
always use insert mode (standard). 

CHANGING DATE AND TIME 

Your computer has a built-in clock 
that tracks both the date and time , which 
you can change with the Date & Time 
dialog box. New date and time settings 
take effect immediately. 

To change the date and time ... 
0 Click Date & Time. The dialog box 
appears. 
8 Change the date. You may enter the 
date in one of two ways: 5 / 25 / 90 , or 
10 / 29 / 1990. 
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8 Change the time. Enter the new time 
in 12-hour format, and enter am or pm 
along with the time: 10: 2 5 am 
0 Click OK to update the built-in clock, 
or click Reset to leave the date and time 
unchanged. 
If you change the fonnat of the date cnl line in the lntemationd section of 
~you llllSf ent8' dates cnl tines in those formats. 

CHANGING THE WORKSPACE BACK
GROUND 

You can fill the Advanced Workspace 
background-the grey area behind all 
the windows-with a picture. GeoWorks 
Pro comes with several different back
ground pictures , or you can create your 
own. Any change to the background 
takes effect immediately. 

To change the workspace 
background ... 
0 In the Preferences window, click 
Background. The Background dialog 
box appears. 
8 Select the name of the background 
picture that you want from the Back
grounds Available list. 
8 Select the way you want to place the 
background on the screen: 
•Place graphic in upper-left of 
screen The left edge of the picture is 
placed against the upper left edge of 
the screen. 

•Place graphic in center of screen 
The picture is centered on the screen. 
If it is smaller than the screen, then 
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the surrounding area is filled with the 
regular solid background. 

•Tile graphic to fill screen The picture 
is repeated across and down the screen, 
covering the entire screen the way tiles 
cover a wall. 

0 Click Apply to make the current 
picture your workspace background. 
The background immediately changes. 
(To see the results , it helps to first 
minimize all the application windows, 
including GeoManager. ) 
0 If you don 't like the background pic
ture , choose another and click Apply. 
Q Click Close when you finish. 

ADDING COLOR TO BACKGROUND IMAGES You can 
add some color to your black-and-white 
background images by clicking one of 
the color squares. 

To change the color of your back
ground ... 
0 In the Preferences window, click 
Background. The Background dialog 
box appears. 
8 Click one of the Background Color 
buttons to select the desired color for 
the background. This option will not 



appea r if yo u ha ve a bl ac k a nd white 
mo nito r. 
E) Cli ck Apply. The backgro und 
changes co lo r. 

This se tting o nly affects bl ack-a nd 
w hite backg round images (o r the s tan
da rd so lid bac kground) . Th e co lor bl ack 
is re placed w ith the chose n co lo r, giv ing 
yo u , fo r exa mple , a red -a nd -w hite 
image . Or a blue-a nd-w hite image. 

CREATING A BACKGROUND IN GEODRAW An ything 
th a t yo u ca n c rea te in GeoDra w ca n 
become an Ad va nced Wo rksp ace bac k
g round image. And we mea n anyth ing. 
Yo u ca n inc lude tex t, co lo red sha p es , 
TIFF (Tag Inte rchange Fil e Fo rm at) and 
PCX (PC Pa intbru sh) images-a nythin g 
that yo u ca n do in GeoDra w. 

To create a background picture 
using Geo Draw ... 
0 Create a pi cture in GeoD raw . 
8 Se lect a ll o f the o bj ects in the picture . 
Yo u ca n drag to se lect the objec ts , o r 
ho ld down the Contro l key and select 
the m individually , or-eas ies t o f all
choose Se lect All from th e Edit menu . 
E) Choose Co py fro m the Edit me nu . 
This co pies the picture to the clipboa rd. 
0 Sw itch to Prefe re nces a nd c li ck 
Bac kgro un d. Th e Backgro und d ia log 
box appea rs. 
0 Click Get Background From Clipboa rd. 
A dialog box appea rs asking yo u to e nte r 
a fil e name. 

Using GeoDraw to create a background •.. 

0 

(:) Ente r a n ame and click OK . This 
co pi es th e picture fro m the clipboard 
to th e ne w fil e, and a lso imme diate ly 
displ ays it as th e ba ckground . Th e fil e 
na me a ppea rs in the Bac kg rounds 
Ava il a bl e li s t, so yo u ca n se lec t thi s 
pi cture aga in a t a la te r d a te . 

CONTROLLING THE SOUND 

Yo u ca n turn GeoWo rks Pro's sounds 
o n o r o ff by clicking Sound . The setting 
he re affects sounds throug ho ut GeoWo rks 
Pro, and this ca n lead to some unexpect
ed conseq ue nces- fo r instance , turning 
o ff the sound also silences GeoPlanne r's 
ala rms . Your new sound setting takes 
e ffect immediate ly. 

~ The sounds produced by appllc11ttons for errors, lllllrms, mid oU--
I ~ reasons Cllf'I be turned on and off. 

Sound 

Shlft+Uel =e "----=~;..:.;1= • ....,.........,, 
Qf!lete Del 
ll.e!ect .. 
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Sound. • On v Off 

To turn all GeoWorks Pro sound on 
or off ... 
0 Cli ck So und in the Pre fe re nces win
d ow. The Sound di a log box appea rs. 
8 Cli c k O n o r Off. 
E) Click O K. 

Get lleckground from Clipboenl_" 
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CHANGING PRINTERS 

Before you can print anything, you 
need to tell GeoWorks Pro what printer 
you have and what communication port 
it's connected to. Of course, you must 
install at least one printer before you 
can print anything. After that , though , 
you can install as many as you like . 
Any changes you make take effect 
immediately upon closing the Printer 
dialog box. You can test your printer by 
clicking Test. 

To install a new printer ... 
0 In the Preferences window, click 
Printer. The Printer dialog box appears. 
8 Click Install New. A second dialog box 
appears. (See picture below.) 
8 From the Printer list , click to select 
the brand name of the printer you wish 
to install. Scroll the list to see all the 
choices. (A quick way to find a printer 
is to type the first letter of the printer 
name.) 
0 From the Port list , click to select the 
communication port you 've connected 
the printer to. Each port corresponds to 
a socket at the back of the computer
although not all computers have a 
socket for every port in the Port list. 

As a rule of thumb , most parallel 
printers plug into LPTl , while most 
serial printers plug into COMl. (No 
guarantees, though .) 
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0 If you've chosen one of the serial ports 
from the Port list (COMl, COM2, COM3, 
or COM4), click Serial Port Options to 
configure the serial port to match the 
settings of your printer. Unfortunately, 
they have to match exactly. If you're not 
sure what the settings should be, consult 
your printer's documentation. 

0 Normally the Printer Name box con
tains the brand name of the printer and 
the port it's connected to. This is the text 
that shows up when you use the Print 
command of an application . You can 
change this text to anything you like . 

For example, you could change the 
Printer Name to a more descriptive one 
like "Speed of Light Laser Printer" or 
"Creaky Old Dot Matrix Printer. " 
G Click OK. The dialog box closes, leav
ing you at the Printer dialog box again . 
0 Click Close to close this dialog box. 

The second dialog box that 
appears when you click Install 
New or Edit in the Printer 
dialog box (the first dialog 
box). 



To change a printer's configuration ... 
Eve n aft e r insta lling a printe r, yo u 

ca n change the brand of printe r, the 
communica ti on po rt it 's co nnecte d to , 
and the ass igned Printe r Na me. 
0 In the Pre fe rences w ind ow , c lick 
Printe r. The Printe r di a log box appea rs . 
8 From th e Printe rs Insta ll ed li s t , click 
the name o f the printe r yo u w ish to 
configure and the n click Edit . A second 
di alog box appea rs. (See the pi cture a t 
the bo tto m o f the pre vio us page .) 
8 Change one or more of the three 
ite ms in the dialog box-the brand o f 
printe r, the communica tio n po rt , and 
the ass igned Printe r Na me. 
0 Click OK w hen you 're fini shed . The 
dialog box closes and the Printe r dialog 
box shows again . If you 've cha nged the 
Printe r Na me, the new name shows in 
the Insta ll ed Printe r lis t. 
0 Click Close to close the Printe r di a
log box. 

To delete a printer from the list of 
printers ... 
0 In the Pre fe rences w indow , click 
Printer. The Printe r dialog box appea rs . 
8 From the Printers Insta lled list , click 
the name of the printe r you w ish to 
de le te from the list. 
8 Click De le te . A dia log box appea rs 
as king you if yo u want to de le te the 
printe r. If you still want to , cli ck OK to 
ac tu a lly de le te it . 
0 The printe r is re moved from the lis t 
o f Insta ll e d Printe rs. 
0 Click Close to close the Printe r dia
log box . 

To print a test page on a printer ... 
0 In the Prefere nces w indow, click 
Printer. The Printer dia log box appears . 
8 From the Printers Installed list , click 
to se le ct the name of the printe r o n 
which you want to print the tes t page . 
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8 Click Test. The selected printer should 
immediately begin printing a test page . If 
nothing happens or gibbe rish prints out, 
you should check the printer's switches and 
pe rhaps change its configuration (see 
above) , For persistent problems, check the 
Customer Service/ Troubleshooting Guide. 
0 Click Close to close the Printe r dialog 
box w he n you 're do ne. 

CHANGING COMPUTER OPTIONS 

Compute r o ptions le t you tell 
GeoWo rks Pro what me mory configura
tion your syste m has. Use this prefe rence 
w hen you change the kind o r amount of 
me mory in your computer. You can also 
correct the settings you entered during 
se tup if they are wrong . If you know 
what you a re d o ing , you can change the 
inte rrupt levels o f the serial and parallel 
po rts, as well. GeoWorks Pro must restart 
for the changes to go into effect . 

To change your memory settings ... 
0 Click Compute r in the Prefe re nces 
w indow . The Compute r dialog box 
appears. 
8 Choose the types of additional mem
ory that you have installed in your 
computer: 
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•None No memory beyond 640K is 
installed. 

•Expanded memory (LIM EMS) If 
you added memory to an original PC 
or XT, you probably added expanded 
memory . 

•XMS/HIMEM.SYS If you have a file 
called HIMEM .SYS, QEMM.SYS, OR 
EMM 386.SYS, you have managed 
extended memory. 

•Extended If you have an AT (286), 386, 
or 486 machine, you probably have 
extended memory. (Of course, you may 
also have expanded memory.) 

You may select more than one of the 
options . If you don 't know which types 
you have , you can select all three. 
t) Click OK when you finish, or click 
Reset to leave the options unchanged. 

To change the interrupt levels of 
the serial and parallel ports ... 
0 Click Computer in the Preferences 
window. The Computer dia log box 
appears . 
f) Change the interrupt levels of the 
various serial and parallel ports . You 
shou ldn 't change these settings unless 
you 're very familiar with the inside 
workings of the PC. 
t) Click OK when you finish, or click 
Reset to leave the options unchanged. 

CHANGING VIDEO OPTIONS 

Use the Video preferences to tell 
GeoWorks what video adapter you are 
using, when you change adapters. You 
could use setup newvideo to do this , 
but its generally easier to use 
Preferences-though it can turn into a 
"catch 22" situation in some cases. To wit: 
your new adapter must be installed before 
you change your video settings, but if 

PREFERENCES 16.8 

you do, it 's possible that you won't be 
able to start GeoWorks Pro, since the as
yet unchanged video settings don 't 
match. Fortunately, you 're only likely to 
encounter this problem if you 're changing 
from a more powerful adapter (say, VGA) 
to a less powerful one (CGA). In these 
cases, use Setup. 

The video setting also controls the 
"screen blanking ." When you leave an 
image at the same place on your screen 
for a long time , there 's a possibility the 
image may become permanently burned 
into the screen-that is, you see a ghost 
outline of the picture even when the 
video screen is completely turned off. 
You can have GeoWorks Pro blank the 
screen automatically when the computer 
is idle. When you move the mouse or 
press a key , it turns the picture back on. 
In addition to turning this feature on 
and off, you can set how long GeoWorks 
Pro waits before blanking the picture. 

To configure GeoWorks Pro for a 
new video adapter . .. 
0 Click Video in the Preferences win
dow. The Video dialog box appears. 
f) Click Change. 
t) Select the appropriate adapter from 
the Change Video Type list. Click OK 
when you finish. 
0 Click OK. The dialog box disappears. 

GeoWorks Pro must be restarted for 
the changes to take effect . For this 



reason, you shou ld install the new 
video adapter before changing the 
Video preferences (see the note at the 
beginning of this section) . If GeoWorks 
Pro fails to work after you 've insta lled 
the new adapter, use setup newvideo 
to change your video settings. 

To turn automatic screen blanking 
on or off ... 
0 Click Video in the Preferences win
dow . The Video dialog box appears. 
8 Turn the Screen Blanking setting On to 
have GeoWorks Pro automatica lly b lank 
the screen after you leave your computer 
alone for a period of time . Turn Screen 
Blanking Off to keep GeoWorks Pro from 
blanking the screen. 
8 In the Time box, enter the length of 
time in minutes your computer must be 
idle before GeoWorks Pro blanks the 
screen. 
8 Click OK when you 're finished , or 
Reset to leave the options unchanged. 

The International dialog box. 
Choose one of the categories on 
the left and click Edit. A second 
dialog box will appear that lets 
you change that particular format. 

The screen blanking option takes effect 
immediately . 

CUSTOMIZING GEOWORKS PRO FOR 
OTHER COUNTRIES 

You can change the standard currency 
symbol, decimal point, quotation mark , 
long date , short date , and time formats 
to conform to those used outside the 
USA. Any changes you make in the Inter
national dialog box are reflected in the 
Example field . GeoWorks Pro must 
restart for changes to go into effect. 

CURRENCY FORMAT With GeoWorks Pro 's 
Currency formatting options, you can 
change the appearance of currency 
values for international currencie . 

To change curren cy formatting . . . 
0 Click International. The International 
dialog box appears. 
8 Double-click Currency, or click Cur
rency and then click Edit. The dialog 
box for currency formatting appears. 
8 Change the format by clicking the 
arrows. You have these options: 

. -?rt. · t .... these optiona to change ..... tme end date~ 
~"':' .""t. •r; f1Wft18ts. curnnc\I end number formats. end ......,. c1eteu1t 

,, , . ce..ctera. 
..m....... ' 
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•Symbol & Negative Placement 
Changes the placement of the currency 
symbol and negative sign. 

•Space around symbol Sets the dis
tance between the symbol and value . 

•Symbol Sets a different currency sym
bol. Type in any symbol. 

•Leading zero Turns leading zeroes 
on and off. 

•Decimal Digits Sets the standard 
number of decimal places. 

0 When you finish changing your set
tings, click OK. The dialog box disap
pears. 

NUMBER FORMAT AND MEASUREMENT UNITS You 
have control over the way numbers are 
presented , as well as the standard mea
surement system (English or Metric) 
used in GeoWrite. 

To change number formatting ... 
0 Click International. The International 
dialog box appears. 
8 Double-click Number, or click Number 
and then click Edit. The dialog box for 
number formatting appears. 
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8 Change the format until the example 
on the lower left shows the formatting 
you want. You have these choices: 
• 1000 separator Changes the character 

used to separate thousands. The 
default is a comma (as in "1,000,000") . 

•Decimal separator Changes the 
decimal character. For example, some 
countries use a comma instead of a 
period for the decimal point (3,14 
instead of 3 .14) . 

•Decimal digits Changes the default 
precision (number of decimal places). 
Setting this to five yields a number 
like "3.14159," whereas setting it to 
two yields "3.14. " (This setting has no 
effect on the Calculator desk tool, 
which has its own setting.) 

•Leading zero Turns the leading zeroes 
on or off. Turning them on yields num
bers like "0.25", while turning them off 
gives you ". 25" instead. 

•List separator Type in a new list 
separator. This is the character that 
shows up as the delimiter in a series 
of numbers (for example, "1,2,3,4 ," 
where commas are the list separator). 

•Measurement system Use the arrow 
buttons to change the default mea
surement system to Metric or English. 

0 Click OK. The dialog box 
disappears. 

QUOTATION MARKS Documents have more of 
a professionally typeset look when you 
use "typographer 's " quotation marks 
instead of straight up-and-down "type
writer style" quotes (the " mark and ' 
mark). Typewriter quotes are more 
often used to indicate measurements in 
feet and inches (he's 61 3" tall) or min
utes and seconds of arc (as in N 38° 4' 
10"). 



To use typographer's quotes ... 
0 Click International. The International 
dialog box appears. 
8 Double-click Quotation marks , or 
click Quotation marks and then click 
Edit. The dialog box for quotation 
marks appears. 
8 Edit the choices shown. 
8 Click OK. The dialog box 
disappears. 

......... -a, ....... 
flrat ......... ............... 

flrat ......... ................. 
Exmnplei •123• •456• 

LONG DATE FORMAT The Long date format 
shows the weekday (Sunday, for 
instance) in addition to the month , 
year, and day. As you alter the format , 
the example date shown changes to 
reflect the settings. 

To change the long date format ... 
0 Click International. The International 
dialog box appears. 
8 Double-click Long date , or click 
Long date marks and then click Edit . 
The dialog box for long dates appears . 
8 Change the weekday, month , day , 
and year formats by clicking the 
arrows. 

The Long Date 
Format, Short Date 
Format, and Time 
Format dialog boxes 
all work pretty much 
the same way. You 
can change both the 
format and position 
of each component, 
and also pick the 
character inserted 
between them. 
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The second and third fields can both 
contain either the year, month , or day . 
This is so you can choose to have the 
day first followed by the month (as is 
common in Europe) , or vice versa. You 
can also type new separator characters 
in the small fields between the week
day , month, day , and year fields. 

SHORT DATE FORMAT The Short Date shows 
just the month , day, and year, and is 
used in windows where space is limited . 
As you alter the format, the sample date 
shown changes to reflect the settings. 

To change the short date format ... 
0 Click International . The International 
dialog box appears. 
8 Double-click Short date, or click 
Short date and then click Edit. The 
dialog box for short dates appears. 
8 Change the month , day , and year 
formats by clicking the arrows. Type 
new separator characters in the small 
fields between the month , day, and 
year fields . 
8 Click OK. 
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TIME FORMAT You can choose both twelve 
and twenty-four hour formats. As you 
alter the format , the sample time shown 
changes to reflect the new settings. 

To change time formatting ... 
0 Click International. The International 
dialog box appears . 
f) Double-click Time, or click Time 
and then click Edit. The dialog box for 
time appears. 
8 Change the time formats using the 
arrow buttons. Type new separator 
characters in the small fields between 
the hour, minute , and second fields. 
0 Click close. 

CUSTOMIZING YOUR KEYBOARD 

GeoWorks Pro provides you w ith 
several options to adapt the keyboard 
to how you work. In addition, you can 
configure GeoWorks Pro to work w ith 
different foreign keyboards. GeoWorks 
Pro must restart for changes to go into 
effect. 

To change the way the keyboard 
works ... 
0 Click Keyboard. The Keyboard dialog 
box appears. 
8 Choose your options. They are: 
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•Keyboard Delay Changes how long 
you must hold down a key before it 
starts repeating. 

•Keyboard Repeat Rate Sets the 
speed at which the key repeats. 

•Right Alt key functions like Ctrl + Alt 
Makes pressing the right 0I] key the 
equivalent of pressing @Im + 0I] 
together. This could save you some 
keystrokes , depending on what you are 
doing. For example , to place a bullet in 
your document, you normally hold 
down @Im and 0I] and type "8." With 
this option on, you could get the same 
character by holding down only the 
right 0IJ and typing the "8." (But be 
careful-you could also do a @Im + ~ 
+ ~ reset by pressing only right ~ 
and~.) 

•Pressing Shift releases Caps Lock 
Turns off the Caps Lock every time 
you press I Shift J. If you learned to type 
on a typewriter and are new to using 
computers, this se tting may make the 
transition easier for you. On the other 
hand , if you 're accustomed to the way 
Caps Lock functions in DOS-that is , 
it stays on until you press I Caps Lock I 
again to turn it off- you may not want 
to turn this option on. 

•Exchange Ctrl and Caps lock keys 
Makes your @Im key behave like the 
I Caps Lock I key, and vice versa. This is 
handy because half the keyboard man
ufacturers seem to put I Caps Lock I above 
the I Shift I key and @Im below it , while 
the other half seem equally determined 
to put them in exactly the opposite 
arrangement-@@ above and ~I c-a-ps_L_o_c~k I 
below. Turn this on if your keyboard 
has keys that are opposite from the 
arrangement you like. 

8 Click OK when you have made your 
choices, or Reset to leave settings 
unchanged. 



To change the keyboard you are 
using ... 
0 Click Keyboard . The Keyboa rd dialog 
box appea rs . 
f) Scro ll th rough the Keyboard list and 
click on the keyboard you are us ing w ith 
GeoWorks Pro . If you a re us ing a U.S. 
keyboa rd , click U.S. Keyboard ; if you 're 
using a UK extended keyboa rd , click UK 
Extended Keyboard. And so on. 
E) Cli ck O K w he n yo u have made your 
cho ice , o r Reset to leave the se tting 
unchanged . 

CHANGING THE MOUSE 

Yo u ca n change th e speed at which 
the po inte r moves ac ross the screen 
and how fas t you must click to do a 
d o uble-click . Yo u ca n a lso change th e 
brand and mo d el of mo use th a t you use 
w ith GeoWo rks Pro , and set inte rrupt 
leve ls, if ne cessa ry . The new mouse 
res po ns iveness se tting takes e ffect 
immediate ly, but the o the r cha nges 
re quire yo u to res ta rt GeoWo rks Pro . 

To change mouse responsiveness ... 
0 In the Prefe re nces w indow, click the 
b utton labe led Mo use . The Mouse dialog 
box appea rs. 
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f) Choose a Do uble -Click Time , w hich 
controls how quickly you must click the 
mouse to d o a double-click. Fast means 
you must cli ck twice ve ry qui ckly for 
GeoWorks Pro to recognize a 
double-click ; Medium and Slow a llow 
you to click more slowly. Do uble-click 
the Test button to try o ut the setting; it 
fl ashes and bee ps w he n you 've clicked 
fas t e no ugh . 
E) Choose a Mo use Acce le ra tion . This 
changes how fa r th e po inte r moves 
w he n you quickly move the mouse. 

At the Slow setting , the po inter always 
moves the same distance as the mo use. 
At the Fast setting , however, the po inte r 
moves much fa rthe r whe n you move the 
mouse quickly (a lthough w hen you move 
it slowly, the po inte r moves o nly the 
same distance as the mo use). The refore , 
at the Fast setting, sho rt , quick mouse 
movements can take the pointe r all the 
way across the screen . 
0 Click OK when you finish, o r click 
Reset to leave the options unchanged . 
After changing Mouse Accele ration , move 
the mouse around to see how it feels. 

To change the mouse 
configuration ... 

When you re place yo ur mo use w ith a 
diffe re nt brand o r model, you need to 
change the Mo use Configuratio n settings 
as well. 
0 In the Preferences w indow, cli ck the 
button labe led Mouse. The Mo use dialog 
box appea rs . 
f) In th e Mouse Co nfiguratio n sectio n , 
click Change . Anothe r di a log box 
appea rs. 
E) Choose o ne o f the brands fro m the 
list o f brands. 
0 If you 're using a serial mo use , 
choose the Seri al Mouse Po rt to w hich it 
is connected . If it 's connecte d to COM3 
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or COM4, use the arrows to set the 
interrupt level. (See also "Setting the 
Mouse Interrupt Level" in this section.) 

0 Click OK when you 're finished. The 
dialog box closes , leaving you at the 
Mouse dialog box again . 
0 In the Mouse dialog box, click OK. 
You are then given some screens to test 
your mouse. 

SETTING THE MOUSE INTERRUPT LEVEL The Mouse 
Configuration dialog box has an Interrupt 
Level option. This option only applies to 
a few types of mouse devices, those that 
require a specific interrupt level. If you 
don't have one of these mice , don 't 
worry about it-the Interrupt Level 
option is grayed out. If you do have one 
of these mice, you should check the 
documentation that came with your 
mouse to make sure that the interrupt 
level setting is correct. 

To set your mouse's interrupt 
level... 
0 Click Mouse . The Mouse dialog box 
appears. 
f) In the Type of Mouse area, Click 
Change. The Change Mouse dialog box 
appears. 
E) Set the correct Interrupt Level. Your 
mouse's documentation should have 
more information regarding the correct 
interrupt level. 
0 Click OK. 
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CHANGING MODEM OPTIONS 

Before you can use your modem, you 
need to identify the communication port 
the modem is connected to and set the 
port 's Speed and Format options (see 
your modem manual for these) . The 
settings you make here are used as stan
dard settings by GeoComm, GeoDex, and 
other GeoWorks Pro applications that use 
a modem. New modem settings go into 
effect immediately. 

Also, if you can 't use tone dialing 
with your phone line , you can have the 
modem do pulse dialing instead. 

To change modem options ... 
0 Click Modem . The Modem dialog 
box appears . 

f) Choose which serial port has the 
modem plugged into it-usually COMl, 
unless you have a serial mouse, in 
which case it 's usually COM2 . Make 
sure it isn 't the same one you plugged 
a serial mouse into. 
8 Click the Speed and Format Options 
button to change the transmission 
speed (Baud rate) , parity, stop bits, and 
protocol. A second dialog box appears . 
0 Change the options for your modem. 
Click OK when you're finished. The 
dialog box closes, leaving you at the 
Modem dialog box again. 



0 If yo ur pho ne ca n 't handle tone 
dia ling , set the Dial Type to Pulse. 
0 Click OK , o r click Reset to leave th e 
optio ns un changed. 

Part Options fora Hu Hodem 

Baud Rates 300 600 1200 <+ 400 4800 9600 v 19200 

PerHua v £ven v Odd Spece v Merk • Hone 

Word Length! v 5 v 6 

Stop llltaz ~1 ·-·· 1.5 2 

............. !.J ~· 11 Sottu.-e (XOtt/)(Off) LI ttone 
H61·d11.1are liMU."hakll)f) Optionu. 

CHANGING INTERNAL OPTIONS 

The PC/ GEOS button lets yo u 
cha nge inte rna l o ptio ns. You sh o uld 
not change any GeoWorks Pro inte rna l 
o ptio ns unless directed to d o so by an 
authorized custo mer se rvice tec hnic ian . 
Incorrec tly changing any o f these 
optio ns ca n seriou sly d egrade th e per
formance o f GeoWorks Pro and p oss ibl y 
even preve nt it fr o m working at all. 
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THE QUATTRO PRO VIEWER 

The VieW"er lets you look at (but not 

change) Quattro Pro SE and Lotus 1-2-3 

spreadsheets W"ithout ever leaving 

GeoWorks Pro. Just double-click a 

spreadsheet file in GeoManager, and 

the spreadsheet shoW"s up in a regular 

W"indoW". From there, you can copy it out 

to the clipboard, and paste it into reports 

or presentations created in GeoWrite (or 

any GeoWorks application). The satne is 

true for charts and graphs 

created in Quattro Pro SE. 



WHAT THE VIEWER DOES 

The idea behind the Viewer is very 
simple: It gives you an easy way to inte
grate Quattro Pro spreadsheets and charts 
into your GeoWorks Pro documents. To 
this end, it acts like a window- you can 
look at your spreadsheets and charts, but 
you can't edit them. (You need to use 
Quattro Pro to actually change them.) You 
can, however, copy whatever you're look
ing at onto the clipboard, and from there 
paste them into GeoWorks applications. 

The Viewer can show you a maxi
mum of (ap proximately) 26 columns 
by 60 rows of the spreadsheet, the 
actual maximum depending on both 
the complexity of the formatting and 
your page size. Practically speaking, 
26 by 60 is a fairly good-sized spread
sheet, so you shouldn't have a prob
lem viewing most spreadsheets in their 
e ntirety (but if you do have a problem , 
see "A Few Ways to Deal With Large 
Spreadsheets," later.) 

In addition to viewing spreadsheets, 
you can also view Quattro Pro 's Encap
sulated Postscript (EPS) chart files. Be 
careful, though: Quattro Pro doesn 't 
automatically save charts in EPS format. 
You must "print" the chart to an EPS 
file, a simple procedure that ensures 
that all your chart information-data , 
labels, and annotation-is retained in 
the file. (See "Charts and the Viewer" 
later in this chapter.) 
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INSTALLING QUATTRO PRO SE 

Before you use the Viewer, you 
should (if you haven't already done so) 
install Quattro Pro SE on your hard 
disk. To make using Quattro Pro SE 
easier, install Quattro Pro in the QPRO 
directory on the same drive as the 
GEOWORKS directory, make sure that 
you answer "yes" when the Quattro Pro 
installation utility asks you if you want 
to add Quattro Pro to your DOS search 
path. This makes it easy for the Viewer 
to find and run Quattro Pro . If you 
insta ll Quattro Pro in a different directo
ry , or on a different disk , you'll have to 
tell the Viewer where to find it the first 
time you try to open a spreadsheet. 
(See the beginning of the section 
"Changing or Creating Spreadsheets.") 

To install Quattro Pro , use the Quat
tro Pro SE Install program and fo llow 
the instructions it gives you (see the 
"Getting Started" chapter of this manual 
for more about the installing Quattro 
Pro SE) . The recommended answers to 
some of the questions that the Quattro 
Pro SE installation program will ask are 

QUATTRO PRO INSTALLATION ANSWERS 

Question Answer 
Source Drive As appropriate 
Quattro Pro Directory C:\QPRO 
Monitor Type As appropriate 
Edit AUTOEXEC.BAT Yes · (very important) 
Printer Manufacturer As appropriate 
Printer Model As appropriate 
Printer Mode As appropriate 
Graph Quality Draft 
Bitstream Character Set As appropriate 
Fonts to Build None 

'we mommend that you let the INSTALL program add Quattro Pro SE's 

directory to your path statement. This lets GeoWorks' Viewer easily 
locate the Quattro Pro SE program for launching. 



shown in the tab le o n the previo us 
p age. 

INSTALLING THE MOUSE FOR QUATTRO PRO As you 
use GeoWorks applications like GeoWrite 
and GeoDraw, you 'll become accustomed 
to using a mouse fo r much of your work. 
You can also use a mo use in Quattro Pro 
fo r many of its commands, but the mo use 
is not automatica lly ava ilab le to you 
the re the way it is in GeoWo rks Pro. If 
you want to use a mouse, and you start 
Quattro Pro SE and find that your mo use 
is not ava ilable (in other words , no thing 
happens when you move it) see 
"Installing Your Mouse" in Appendix A of 
the Quattro Pro SE manual. 

VIEWING A SPREADSHEET OR 
CHART 

Viewing spreadsheets and cha rts is 
what the Viewer is a ll a bo ut . It le ts yo u 
o p e n severa l Q uattro Pro and Lotu s 
1-2-3 fil e typ es : 
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.WQl-Quattro Pro SE o r 2.0 spread
sheet fil es 
.EPS-Quattro Pro SE o r 2.0 cha rt fil es 
(in EPS o r s lide EPS fo rmat) 
.WKl-Lo tu s 1-2-3 fil es 

To view a spreadsheet or chart by 
starting the Viewer application .. . 
0 Start the Viewer applica tion by double
clicking its icon in the WORLD directory. 

The Viewer window appears 
~~~'fit, and a fil e selector pops up 

OuatfroProVl•w.r asking YOU tO ChOOSe a 
spreadsheet or chart . 

8 From the Docume nt Form ats box, 
click to se lect th e kind o f fil e you wa nt 
to o p en. O nly fil es o f tha t typ e w ill 
show in the fil e lis t . ( If no fil es appear, 
th e n the re a re n 't any o f th ose typ es o f 
fil es in the current directo ry.) 
8 From the fil e lis t , selec t the ac tu a l 
fil e you wa nt to view (change disk 
d rives and direc tories as need ed) . 
0 Click O p en . A d ocume nt w ind ow 
o p e ns showing the spread sheet (or 
cha rt). 

When you start the Viewer 
application by double-dicking 
the Viewer icon in GeoManager 
(and not by double·dicking, 
say, a spreadsheet document), 
the Viewer first asks you to 
identify the type of docu
ment-as well as the document 
itself-that you want to open. 
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To view a spreadsheet from within 
the Viewer ... 
0 While in the Viewer, choose View 
from the File menu. A file selector 
appears. 
8 Select the kind of file from the 
Document Formats box. 
8 Click to se lect the file you want to 
view from the file list, changing disks 
or directories if necessary. 
0 Click Open . 

To view a spreadsheet or chart by 
opening its file in Geo Manager ... 
0 In GeoManager, open the directory 
that contains the spreadsheet or chart 
file you want to open. Take a look at 
the file's three-letter extension and make 
sure that it's one of the supported file 
types listed at the start of this section. 

BALANCE.'w'Q1 

8 Double-click the file's 
icon. The Viewer starts and 
automatically opens the file 
for viewing . 

VIEWING ANOTHER PART OF A SPREADSHEET The 
Viewer is limited in the number of rows 
and columns it can show you-approxi
mately 26 columns by 60 rows. These 
numbers depend both on the complexity 
of the formatting and your page size . 
Fortunately, you can pick which 26 by 60 
region of the spreadsheet you wish to 

With this dialog box, you can change the part of the spreadsheet that you view. 
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view. You do this by letting the Viewer 
know the starting cell. This then becomes 
the upper-left corner of the 26 by 60 
viewing area. 

Note: There Is a way to view spreadsheets with an unlimit· 
ed number of columns (though not a way to view one with 
a lot of rows). See "A Few Ways to Deal with Large 
Spreadsheets" in this chapter. 

To set the starting cell ... 
0 Choose Spreadsheet Range from the 
Options menu. 
8 Click the option "Display as much as 
possible , given the current page size ." 
8 Type the starting cell for the 26 by 
60 page. This cell becomes the upper
left corner of the spreadsheet in the 
Viewer window. For example , if you 
want to have the Viewer start at col
umn C and row 30 , type in C30 . The 
Viewer would then show the 60 rows 
below this cell and the 26 cells to the 
right . (Remember, the 26 by 60 figure 
is approximate-the actual size is 
determined by the complexity of the 
spreadsheet.) 

To specify a specific range of cells ... 
You can further limit the number of 

cells that the Viewer shows by calling 
out not only the upper-left cell , but 
also the lower-right cell as well. 
0 Choose Spreadsheet Range from the 
Options menu. 
8 Click "Display a block of cells. " 
8 Type the upper-left and lower-right 
limits of the range of cells (for example , 
C30 and L60). The Viewer displays only 
the cells that are contained in that block 
of cells. Keep in mind, though, that the 
26 column by 60 row maximum size still 
applies . 



VIEWING MULTIPLE SPREADSHEETS You ca n view 
multipl e spreadsheets and charts in the 
same way th at you work w ith multiple 
docum e nts in o the r GeoWo rks a pplica
tio ns, like GeoWrite. To view a second 
doc ume nt , s imply o pe n it for viewing 
w itho ut clos ing the first o ne. (C hoose 
View fro m th e File menu , as describe d 
ea rli e r. ) 

CHANGING OR CREATING 
SPREADSHEETS 

The Viewer is fo r viewing your 
spreadsheets , not working o n them . If 
you wa nt to work o n o ne- say , to 
change some fo rmulas- you must launch 
Quattro Pro SE . The Viewer gives you 
severa l ways to do this . The method you 
choose depends o n w he ther you want 
Quattro Pro to crea te a new fil e o r o pen 
an existing o ne. 

If you do not add Quatt ro Pro to your 
DOS search path , the first time you launch 
it the Viewer asks you to loca te the Quat
tro Pro p rogram. Yo u'll only have to do 
this once , as the Viewer remembers where 
the Quatt ro program is . 

To create a new spreadsheet ... 
0 In the View e r, choose New fro m th e 
File m e nu . A fil e se lecto r a ppea rs. 
8 Use th e fil e selecto r to choose the 
directo ry w he re you wa nt Qu attro Pro 
to save the spread sheet wh e n you 're 
d o ne with it . 
E) Typ e in a name fo r your new fil e 
and click Create . 
0 A dia log box appea rs askin g yo u if 
you rea ll y wa nt to launch Qu attro Pro . 

Note: If you don't want to see this dialog box when you 
launch Quattro Pro from the Viewer, use the Advanced 
Options command in the Options menu to turn it off (see 
"Customizing the Viewer" later in this chapter. 
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0 Click OK. GeoWo rks Pro shuts down 
and Quattro Pro SE launches , o pe ning a 
new e mpty spreads heet w ith the g iven 
name . When you exit Qua tt ro Pro SE 
la te r, yo u re turn to the Viewer. Choose 
View fro m th e File me nu to take a look 
at the fil e you just worked w ith . 

To edit the spreadsheet you're cur
rently viewing ... 
0 Choose Edit Spreadsheet fr o m the 
Window me nu . A d ia log b ox ap pea rs 
as king yo u if yo u wa nt to launch 
Qu a tt ro Pro SE. 

Note: If you don't want to see this dialog box when you 
launch Quattro Pro from the Viewer, use the Advanced 
Options command in the Options menu lo turn it off. 

8 Click OK. GeoWo rks Pro shuts d own 
a nd Qu att ro Pro SE launch es , auto mati
ca lly o pe ning th e same spreadsheet 
you we re viewing. Wh e n you exit 
Qu a ttro Pro SE la te r, you 're re turn e d to 
the Vie w e r. No tice tha t you are s till 
viewing the spreadsheet , and th at it 
has auto matica ll y changed to re fl ec t 
th e work you did in Quattro Pro . 

To launch Quattro Pro and open an 
existing spreadsheet without first 
viewing it ... 
0 In the View er, choose Open from 
th e File menu . A fil e selector appe ars. 
8 From the Docume nt Formats box, 
click to selec t the kind o f fil e you want 

THE QUATTRO PRO VIEWER 



to open. Only files of that type wi ll 
show up in the file list. (If no files 
appear, then there aren't any files of 
that type in the current directory.) 
8 Select the file you want and click 
Open. Quattro Pro SE then launches 
and opens the selected spreadsheet. 

When you exit Quattro Pro SE, you 
return to the Viewer. You can then use 
the View menu to take a look at the 
spreadsheet. 

COPYING SPREADSHEETS TO OTHER 
APPLICATIONS 

Anything in the Viewer window can 
be copied to the clipboard and subse
quently pasted into other GeoWorks 
applications. 

SELECTING AND COPYING Before you can copy 
something to the clipboard, you must 
select it. This is as true in the Viewer 
as it is in GeoWrite, GeoDraw, or any 
other GeoWorks application. 

To select the entire view ... 
Choose Select All from the Edit 

menu or click the Select All button in 
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the upper-left corner of the document 
window . The entire view is selected. 
Keep in mind that if the spreadsheet is 

large , the Viewer will only 
show a 26 column by 60 
row portion of it-and it is 
this portion that you are 
selecting. 

To select a line of a spreadsheet ... 
Triple-dick anywhere in the line of text 

you want to select , or-even easier-dick 
its row number on the left. To 
select several lines, triple-dick 
on the first line you want to 
select and drag to select the 
others. 

To copy selected text to the clip
board ... 

With the text selected, choose Copy 
from the Edit menu . 

PLACING A SPREADSHEET INTO GEODRAW OR 
GEOWRITE When you copy spreadsheet 
text to the clipboard, it 's copied with 
tabs separating the columns. If you 
then paste the text into GeoWrite, the 
tabs automatically show up on the 
ruler. At that point you can change the 
tab stops and edit the text to your lik
ing. If, however, you paste the text 
into GeoDraw, it becomes a text object 
that you can edit, rotate, stretch, and 
resize-but you can 't adjust the tabs. 
This can only be done from GeoWrite. 

Note: If you have borders in your spreadsheet and intend to 
copy it into a GeoWrite or GeoDraw document, always set 
the page size (see u A Few Ways to Deal With Large 
Spreadsheets") to match that of your GeoWrite or GeoDraw 
document. 



A FEW WAYS TO DEAL WITH LARGE 
SPREADSHEETS 

The Viewer's column limit is related 
to the number of tabs stops it can 
define. Each column of the spreadsheet 
requires one tab stop . So, three columns, 
three tab stops. GeoWorks Pro limits the 
number of tab stops in a block of text to 
25 , hence the 26 column limitation (the 
leftmost column plus 25 other columns 
gives you 26 columns, Q.E.D.). Because 
each vertical border in the spreadsheet 
requires an extra tab stop, turning off 
the spreadsheet's borders is an easy way 
to make more room for a large spread
sheet. 

There is also a way to view an 
unlimited number of columns in a 
spreadsheet: Make all the columns the 
same width, thus completely e liminating 
the need for tab stops. But you can 't 
have any borders or varying column 
widths if you choose this format. (Keep 
in mind that just because you can view 
an unlimited amount of columns, it 
doesn 't mean that you can view an 
unlimited amount of spreadsheet-the 
number of rows is sti ll limited.) 

To remove the borders from the 
spreadsheet view ... 
0 Choose Cell Borders from the 
Options menu. A cascade menu with 
two options appears. 
8 Choose None. The borders in the 
spreadsheet disappear. You can bring 
them back by choosing As In File (also 
under Cell Borders in the Options menu). 
These changes affect only your view of 
the file , not the actua l Quattro Pro 
spreadsheet file. 

To change to fixed-width columns ... 
0 Choose Column Widths from the 
Options menu. A dialog box appears. 
8 Click Fixed Column Widths. 

17.7 

8 Click one of the Default Tab Spacing 
choices. Remember, a ll the columns in 
the spreadsheet w ill become this width. 
If a column contains text that does not fit 
within the new width , the end of the text 
is cut off. And if a cell contains a number 
that doesn 't fit , the Viewer replaces the 
number with asterisks (*). 

0 Click Ok. 

To change the page size ... 
The Viewer on ly shows you , at 

most , the number of spreadsheet cells 
that fit on a s ingle Viewer page. So , 
one way to see more of a spreadsheet 
is to simply choose a larger page size. 

Change the page size by choosing 
Page Size from the Options menu , then 
choose the desired size . If you intend to 
paste your spreadsheet into a GeoWrite 
or GeoDraw document, always se t the 
Viewer's Page Size to match that of the 
final document . 

To change the font size for the 
entire spreadsheet ... 

Another way to fit more cells into the 
Viewer page is to make the spreadsheet 
font size smaller. The sma ller the text is, 
the more you can fit on the page . Choose 
one of the font sizes from the Sizes 
menu , or, to set a special size , choose 
Custom Sizes instead. (You can also set a 
custom size by clicking the Font Size 
button in the tool box. ) 

Any change you make affects the font 
size of the entire document. The Viewer 
automatically adjusts everything-font , 
column width , and row height-to 
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match. If you want to change the size of 
individual letters or words, copy and 
paste the spreadsheet into GeoDraw or 
GeoWrite and make the changes there. 

To change the font for the entire 
spreads he et ... 

Choose a font from the Fonts menu , 
or choose More Fonts if you've installed 
additional fonts. 

SOME IMPORTANT NOTES ABOUT 
SPREADSHEET BORDERS 

The Viewer uses a combination of 
tab lines and paragraph borders to 
match the borders in the original 
spreadsheet. But there are some differ
ences. Here are some hints for produc
ing the best borders: 
• All border lines (including thick , thin, 

double lines , etc.) in a Quattro Pro file 
appear as single width lines in the 
Viewer. However, you can change the 
border styles once you copy the 
spreadsheet into GeoWrite. 

•The Viewer uses a paragraph border 
(similar to GeoWrite 's paragraph bor
ders) to create horizontal lines. Because 
a paragraph border applies to a whole 
row, not individual cells, horizontal 
lines in the Viewer always stretch the 
entire length of the row, whether or not 
they originally did in your spreadsheet. 

•The Viewer uses a combination of tab 
lines and paragraph borders to create 
vertica l lines. Because the Viewer is 
limited by the number of tabs it can 
show, you can turn the borders off to 
see more of a spreadsheet. (See "A 
Few Ways to Deal With Large Spread
sheets" earlier in this chapter.) 
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CHARTS AND THE VIEWER 

The Viewer can open up Quattro 
chart files, providing you created them 
in Encapsulated Postscript (EPS) format. 
You do this by printing the chart to a 
Postscript printer, but capturing the 
result in a file before it can be printed. 
Not only isn 't it as complex as it sounds, 
but you don 't even have to actua lly have 
a Postscript printer to do this. (Though 
you do have to make sure that Quattro 
Pro thinks you have one; see "If All Your 
Charts Turn Blue" later in this section.) 

Note: The Viewer is designed to only view EPS chart files 
produced by Quattro Pro, not EPS files produced by other 
graphics programs. 

To print a chart to an EPS file ... 
0 In Quattro Pro , create a chart from 
your spreadsheet data. See Chapter 12 
and 13 of the Quattro Pro SE manual 
for more about creating charts (graphs) . 
8 Choose Graph Print from the Print 
menu . A cascade me nu appears. 
E) Choose Write Graph File from the 
cascade menu . Another cascade menu 
appears. 
0 Choose EPS file (don't worry if you 
don 't have a PostScript printer-you 
don 't really need one). A dialog box 
appears. Click on the pathname (which 
probably reads C: \ GEOWORKS \DOCU
MENT \ * .EPS, or something s imilar). 
The pathname reappears in a dialog 
box without the * .EPS part. 
0 Type a name for the chart using 
standard DOS file-naming conventions. 
Leave off the ".EPS" part ; Quattro auto
matically adds it to the end. So, if you 
enter "mychart " it would create a file 
named MYCHART.EPS . 

Note: If your chart has the same name as the spreadsheet 
(except for the .EPS part) you can use the Viewer's View 
Matching Spreadsheet and View Matching Chart commands. 
For example, if your spreadsheet is named MYDATA.WQl, 
name your chart MYDATA.EPS. 



0 Once you 've typed a name, press 
[Return). A dialog box appears that says 
"Now Printing." 

SIZING A CHART Charts are not resizeable 
within the Viewer. Instead , you should 
copy the chart to either GeoDraw (see 
"Pasting a Chart into GeoDraw or 
GeoWrite," later) or a scrapbook docu
ment. There is an advantage to copying a 
chart to a scrapbook: you can propor
tionally scale it using the View at % 
feature. Proportional scaling keeps the 
chart's horizontal and vertica l dimensions 
the same in relationship to each other
one is not stretched more than the other. 
This prevents the chart from becoming 
distorted as you make it larger or smaller. 

FITTING A CHART IN THE VIEWER WINDOW If you 
want to view an entire chart within a 
window , choose the Fit in Window 
command from the Options menu. This 
shrinks or magnifies the chart, so that 
it exactly fills the window. Note that 
the chart is sti ll the same size-it just 
appears bigger or smaller within the 
window. To see the chart at its actua l 
size, choose Fit in Window a second 
time to turn the option off. 
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PASTING A CHART INTO GEODRAW OR GEOWRITE 
When you copy a chart to the clipboard, 
the entire chart is copied as a single 
GeoDraw object. You can then paste this 
object into both GeoWrite and GeoDraw. 
In GeoWrite, it behaves just like any 
other picture you might paste in-it 
becomes part of the text. In GeoDraw, it 
is pasted as a single object, meaning 
that you can 't then defuse it and change 
the component pieces (although you 
can rotate it and size it the way you do 
other objects). 

If you plan to eventually print the 
chart on a PostScript printer (from 
GeoWrite or GeoDraw) , choose the 
Postscript Printer option from the 
Options menu . If you 're going to print 
the chart on a dot-matrix printer, choose 
Non-PostScript Printer. 

To copy a chart to the clipboard ... 
Make sure that the chart 's window is 

active (that is, not behind another win
dow) . Choose Copy from the Edit menu. 

IF ALL YOUR CHARTS TURN BLUE You may find 
that your colorfu l charts turn black 
and blue when you look at them in th e 
Viewer. The problem is that , unl ess 
you 've made Quattro Pro 's default 
printer a PostScript printer, it doesn 't 
correctly identify all of the chart's 
colors when it creates the EPS file . 
Fortunately, you don 't need to actua ll y 
have a Postscript printer in order to 
make one your default. 

(In the following steps , we assume 
you 're using the mouse to choose 
menu items . If, however, you want to 
use the keyboard, you 'll need to do 
things a little differently. See "Using 
the Keyboard" in Chapter 1 of the 
Quattro Pro SE manual for more about 
using the keyboard.) 
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To cure the (black and) blues ... 
0 Choose Hardware from the Options 
menu (in Quattro Pro SE) , and then 
choose Printers. 
8 Choose 2nd Printer. 
8 Choose Type of Printer. 
0 Choose Postscript. 
0 Choose Normal . 
0 Look up a little bit and Click Printers 
(the same Printers you clicked earlier). 
8 Choose Default Printer. 
0 Choose 2nd Printer. 
0 Click on the Options menu again. 
~ Click Update. You 're done. 

USING THE TOOL BOX 

The floating tool box gives you a 
quick way to give common commands
its buttons correspond to commands in 
the Viewer's menus. Clicking one of 
them is exactly the same as pulling down 

one of the menus and selecting the cor
responding command. 

If the tool box gets in your way, close 
it by double-clicking its control button. 
Bring the tool box back by choosing 
Tool Box from the Options menus . 

There are six commands on the tool 
box: 

Edit Spreadsheet Click this 
button to launch Quattro Pro 
and have it automatically 
open the spreadsheet that 

you 're viewing. The button does the 
same thing as the Edit Spreadsheet 
command in the Window menu. If 
you 're viewing a chart, you can click 
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this button to launch Quattro Pro and 
open the spreadsheet that corresponds 
to the chart . (See "View Matching 
Spreadsheet.") 

View Matching Spreadsheet 
This button is dimmed unless 
you 're viewing a chart. Click it 
to see the spreadsheet that 

corresponds to the chart. For instance , if 
you 're viewing a chart named FORE
CAST.EPS and you click this button, the 
Viewer looks for the file FORECAST.WQl 
and opens it for viewing. Both files must 
be in the same directory for this to work. 
This button corresponds to the View 
Matching Spreadsheet command in the 
Window menu . 

View Matching Chart This is 
much like the View Spread
sheet button except that it 
works in reverse : The Viewer 

looks for the chart associated with a 
spreadsheet. Again, the spreadsheet and 
the chart need to be in the same direc
tory. This button corresponds to the 
View Matching Chart command in the 
Window menu. 

Set Spreadsheet Range Click 
this button to set the starting 
cell or range of cells in the 
view. See "Viewing Another 

Part of a Spreadsheet" in this chapter 
for more about the starting cell and 
range. 

Set Font This brings up the 
More Fonts dialog box. 
Choose a font and click 
Apply-the font changes to 

the new font throughout the entire 
spreadsheet. 

Set Font Size Click this but
ton to bring up the Custom 
Size dialog box. This changes 
the font s ize for the entire 

spreadsheet. The Viewer adjusts the 
column widths and row heights to 
accommodate the new font size . 



CUSTOMIZING THE VIEWER 

The Viewer allows you to customize 
some of the things it usually does auto 
matically. Fo r instance , to save time you 
can te ll the Viewer to not display certain 
w arnings . You can also change the pro
g ram that the Viewer launches w hen 
you choose e ithe r the Edit Spreadsheet, 
New, o r Open commands . Be ca reful , 
though-unless you really know what 
you're doing, it 's best to leave these 
o ptions alone. 

TURNING THE VIEWER'S WARNINGS ON AND OFF 
The Viewer o ft e n warns yo u w he n it 's 
going to do some thing th a t you may 
n o t expect. Great if you 're new to the 
Viewer-wa rnings ca n save you from 
unexpected results-but aft e r a w hil e 
yo u may no t want to see th em a ny
mo re. o rmally, a ll o f the Viewe r's 
wa rnings a re o n . Here's how to turn 
the m o ff (a nd back o n , if you change 
your mind). 

The Advanced Options 
dialog box. By setting the 
different options here, you 
can keep the Viewer from 
issuing certain warning 
messages. You can also 
change the kind of files it 
creates, and the program 
that it runs. 

To turn the View er's w arnings on 
and off ... 
0 Choose Advanced Optio ns fro m the 
Options me nu . The Adva nced Options 
dia log box appears. 
8 Turn the "Confi rm befo re " o ptio ns 
on o r off b y clicking the appropriate 
check boxes. These o ptio ns cont ro l the 
confirmati o n d ia log boxes tha t appea r 
w he n you d o the ac tio ns shown . Turn
ing th e o ptio ns off suppresses th e 
dia log boxes. 
8 Also click the "Warn w he n spread
sheet" optio ns to turn th em o n and off. 
Like the "Confirm before" o ptio ns, these 
contro l the warning dia log boxes that 
appea r whenever something ha ppe ns 
that affects accuracy of the view-for 
exa mpl e, a wa rning appears if yo u 
change the fo nt size to 72 po ints, caus
ing part o f your spreadsheet to be te m
pora rily los t from the view. If you turn 
an option off, the associated warning 
never appears. 
0 Click OK to acce pt the changes and 
close the Advanced O ptio ns dialog box. 
To re ject your changes, click Ca ncel. 

i8 too complex to uiew using prQPOrtional column widths 
is too complex to uiew full height 

l}bas eel borders drawn and is copied to clipboard 
r Quattro Pro SE Configuration--------. 
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CHANGING YOUR QUATTRO PRO CONFIGURATION 
This option is for power users only. If 
you h ave anothe r spreadsheet program 
you want the Viewer to launch , or you 
want to launch Quattro Pro SE with 
specific options every time , this is how 
you do it . 

Note: If you choose to use a spreadsheet program other 
than Quattro Pro, keep in mind that the Viewer only 
imports spreadsheets and charts saved in the formats 
shown in the Supported File Types list earlier in this 
chapter. 

To launch a program other than 
Quattro Pro SE ... 
0 Choose Advanced Options from the 
Options me nu . The Advanced Options 
dia log box appears. 
0 In the Program text box, type the 
complete pathname for the program, 
including the drive le tter and name of 
the program file (the fil e extension is 
optional). For instance, say you installed 
Lotus 1-2-3 in the LOTUS directory of 
drive C. To have the viewer launch Lotus 
1-2-3 instead of Quattro Pro SE, you'd 
type C: \LOTUS\ 123.EXE in the program 
field . Then, whenever you choose ew, 
Open, etc., the Viewer launches Lotus 
1-2-3 instead of Q uattro Pro. 
E) Cli ck OK to accept your changes o r 
Cancel to reject them. 

To launch the spreadsheet program 
with specific options ... 

Some DOS programs all ow you to 
add command line options when you 
launch them so that the program does 
someth ing more than just launch. For 
instance , by typing a document name 
after the program's name (at the DOS 
prompt) many DOS programs wi ll 
launch the program and automatically 
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o pen the document. The Viewer can 
automatica lly tack o n extra options to 
the end of its usual command line when 
it launches the spreadsheet program . 
0 Choose Advanced Options from the 
Options menu. 
0 Typ e the options in the Arguments 
box. (To find out about specific options, 
see your program's documentation.) 
E) Click OK to accept your ch anges or 
Cancel to reject them . 

To change the file extension that 
the Viewer looks for when you View 
the Matching Spreadsheet ... 

If you mainly use the Viewer to look 
at Lotus 1-2-3 files , and you 'd like to 
use the View Matching Spreadsheet 
command, you can have the Viewer 
look for the filename extension ".WKl " 
instead of the usual ".WQl " (used for 
Quattro Pro SE files). 
0 Choose Adva nced Options from the 
Options menu. 
0 Change the three letter document 
extension . If you mainly use the Viewer 
to look at Lotus 1-2-3 files, change the 
Document filename extension to 
". WKl ", which is how Lotus 1-2-3 
names its spreadsheets. Otherwise , for 
Quattro Pro SE files , leave it as ".WQl". 
E) Cli ck OK to accept your changes or 
Cancel to reject them . 

SAVING YOUR OPTIONS You ca n have the 
Viewer remember your custom optio ns 
so that they apply the next time you 
sta rt the Viewer. Choose Save Advanced 
Options from the Optio ns menu. 
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The Scrapbook application, like its real 

"World counterpart, is a place to store 

scraps-bits of images and information, 

stuff you "Want to keep together in 

~ one convenient place. Use it to 

~ store logos, letterheads, or any-

thing you use again and again-things you 

want to collect in one place so you can to 

get at them quickly. Scraps are stored in 

docu111ents called (not surprisingly) 

scrapbooks. When you "Want to use 

something you've stored, simply 

open the scrapbook, flip to the 

page, and copy the item out. 



THE SCRAPBOOK WINDOW 

The contents of the current scrapbook 
page appear in the viewing window. 
(When you open an empty scrapbook, 
the viewing window is empty.) To flip to 
other scrapbook pages, use the Next and 
Previous buttons-they move you for
ward and backward one page at a time. 
Or use the Go to Page button to jump 
straight to a specific page. 

When you start the Scrapbook appli 
cation , it normally opens a document 
called "Default Scrapbook" so you can 
start work right away . If there is no 
Default Scrapbook document in the 
DOCUMENT directory, then the 
Scrapbook application automatically 
creates one. 

WORKING WITH SCRAPS 

To add a page to the Scrapbook, 
simply cut or copy text or graphics 
from one document and paste them 
into the Scrapbook; whatever you paste 
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becomes a new page in the Scrapbook 
document. When you want to use 
something you 've saved, open the 
Scrapbook, flip to a page, and cut or 
copy whatever you want to another 
document. 

See the "Basic Tools and Skills " 
chapter for more about cutting and 
pasting. 

To flip through pages of a scrap
book ... 

Click the Next button to flip forward a 
page , and click the Previous button to 
flip backward. If you 're on the last page , 
clicking Next flips you around to the 
first. Likewise, if you're on the first page, 
clicking Previous flips you to the last. 

To flip to a specific scrapbook 
page ... 
0 Click the Go to Page button. The 
Go to Page dialog box appears. Inside 
the dialog box is a list of all the pages 
in the Scrapbook. 
f) Find the page you want and click to 
se lect it. 
8 With the page selec ted, click View 
Page. The Scrapbook window flips to 
that page. 

You can also double-click a page in 
the list to select and view that page in 
one step. If you want, leave the dialog 
box open while you work in the 
Scrapbook-just move it so it doesn 't 
cover the viewing window. Or click 
Close to make the dialog box go away . 



To add something to a scrapbook ... 
0 Within an application, copy (or cut) 
something-anything-to the clipboard 
in the normal manner. 
f) Switch to the Scrapbook applica
tion. If Scrapbook is not a lready run
ning, start it now. 
e If you want to place the contents of 
the clipboard on a particular page, flip 
to that page and choose Paste from the 
Edit menu. A new page is inserted in 
front of the current page , and the con
tents of the clipboard are pasted into it. 

If, on the other hand , you want to 
place the contents of the clipboard on 
a new page at the end of the 
Scrapbook , choose Paste at End from 
the Edit menu. 
0 In the Name field, type a descriptive 
name for what you 've placed on the 
scrapbook page. This makes it much 
easier to find the scrap later, as this 
name appears in the list of pages when 
you click the Go to Page button. 

If you don't name your scrap, 
then it will be called 
uunnamed Graphic" (above) 
which isn't very helpful when 
you want to find your scrap a 
year from now. Type a more 
descriptive name into the 
0 name" field. (below) 
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To cut or copy from a scrapbook to 
another application ... 
0 Flip to the scrapbook page with the 
scrap yo u wish to cut or copy. 
f) Choose Cut or Copy from the Edit 
menu. The Copy command copies the 
contents of the page to the clipboard , 
leaving the scrapbook page intact. The 
Cut command a lso puts a copy of th e 
scrap on the clipboard , but completely 
removes the scrapbook page in the 
process. 
8 Switch to th e applicat ion (GeoWrite 
or GeoDraw, for instance). 
0 If you 're inserting the clipboard 's 
contents into a GeoWrite document (or 
GeoDraw text block) click to put the 
insertion point at the place you wish to 
paste the scrap. You normally don 't 
need to do this when pasting graphics 
into GeoDraw, since the scrap is auto
matically pasted in the center of the 
screen. 
0 Choose Paste from the Edit menu to 
actua lly paste in the scrap. 

To remove a page ... 
0 Flip to the page you want to delete. 
f) Choose Delete from the Edit menu . 
The page and its scrap are removed 
from the Scrapbook document. The 
Delete command works much like the 
Cut command , except for one impor
tant difference: when yo u delete a 
page , its contents are not placed on 
the clipboard. 

If you accidenta ll y remove a page 
yo u wanted to keep , you can get it 
back by choosing Revert from the File 
menu. Use the Revert command with 
care though; it undoes all work yo u 've 
done since you last saved the docu
ment. 
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To name or rename the contents of 
a page ... 
0 Flip to the page with the scrap you 
want to name. 
f) In the Name field, type text that 
describes the contents of the page. You 
may type up to 32 characters, including 
spaces and punctuation. If there is 
a lready a name for the page , and you 'd 
like to change it , edit it like you wo uld 
any other text in GeoWorks Pro. 

SCALING IMAGES WITH THE 
SCRAPBOOK 

Scaling means sizing an image so that 
its horizontal and vertical proportions 
are maintained-useful with logos and 
artwork that you don't want distorted 
when you size them. With the scrapbook 
you can view a scrap at various scaling 
percentages, much like you 'd view 
something under a magnifying glass-the 
object looks bigger, but it doesn 't actual
ly become bigger. Then, if you want to 
copy the scaled image, use the Copy at 
View % command. If, however, you want 
to copy the image to the clipboard at its 
normal size , use the Copy command. 

To view a scaled image ... 
0 Flip to the scrapbook page contain
ing the scrap. Use the Go To button , or 
the Next and Previous buttons. 
8 Select a percentage from the View 
menu, or choose Custom View if you 
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want to specify your own . The 
Scrapbook limits your images to 
sizes under 11 inches square. 

e If you want to view other scraps at 
this scale, just flip to the other pages. 
The Scrapbook application shows you 
every image at that scale (until yo u 
change it, of course) . 

To copy a scaled image to the clip
board ... 
0 Flip to the image you want copy , 
and change the image 's scale with the 
View menu as described earlier. 
8 Choose Copy at View % from the 
Edit menu. The image is copied to the 
clipboard at the size you were viewing 
it. That is , if you're viewing an image 
at 50 percent, and you use the Copy at 
View % command to copy it, the copy 
(on the clipboard) is half as big as the 
original. 



SCRAPBOOK TRICKS 

Here are some more advanced 
things you ca n do wi th the Scrapbook 
application: 

To make another document the 
Default Scrapbook ... 
0 Exit Scrapbook. 
8 Switch to GeoManager. 
8 In the DOCUMENT directory, rename 
the Defaul t Scrapbook to something e lse. 
0 Also in the DOCUMENT di rectory, 
fi nd the Scrapbook document you want 
to be the defau lt and rename it to 
"Defau lt Scrapbook" (spell and capital
ize the name exactly as it is here) . The 
next time you start the Scrapbook 
app li cation , this new Defa ul t Scrapbook 
automatica lly opens. 

To keep more than one Scrapbook 
open at a time ... 

Whi le the Scrapbook application 
o nl y lets yo u have one document open 
at a time, there 's nothing to prevent 
you from having several Scrapbook 
app lications ru nning at the same 
time-each with a different scrapbook 
open. J ust open each scrapbook doc u
ment by dou b le-clicking its fi le icon. 

\GEOWORKS\DOCUMEHT\QURTTRO 

It's simple to import pictures ond 
charts into the Scrapbook (0). Click 
the choice for the type of image 
you're importing, then select the file 
from the file selector (8). If you 
want to double check your choice 
before importing it, click View (8). 
Satisfied? Click Import. (0) 

18.S 

To cut or copy between two 
Scrapbooks ... 
0 Open the two scrapbooks by dou
ble-clicking their file icons . 
8 In one of the Scrapbooks, flip to a 
page you want to cut or copy, and cut 
or copy the contents of the page to the 
clipboard as usual. 
8 In the other Scrapbook , flip to 
where you want to p aste the contents , 
then paste as usual. 

IMPORTING IMAGES FROM OTHER 
DOS APPLICATIONS 

The Scrapbook applicatio n can 
import-that is , bring into a 
scrapbook-TIFF, PCX, or Quattro Pro 
EPS images. 

To import a image into a 
s crapbook ... 
0 Open the scrapbook in which you 
want to p lace the image, and flip to 
the page where you want the image 
placed. Re me mbe r, th e scrap is placed 
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on a new page in front of the current 
page. 
f) Choose Import from the File menu. 
A file selector appears. 
8 Click on the type of file (TIFF, PCX, 
or Quattro Pro EPS) you intend to 
import. The file selector only shows 
you files of that type. 
0 Find the file you want to import
changing disks and directories if you 
need to-and click on its name. 
0 If you want to glimpse the file 
before you import it, click the View 
button. The image appears in the View 
window. 
9 With the file selected, click Import. 
The image is imported and placed on 
the current page. (You may need to 
wait a few seconds while this 
happens.) 
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This computer version of Solitaire plays 

just like the game you know and love. But 

in this version you tnove the cards on the 

screen, instead of on your kitchen table, 

and the computer does all the shuffling 

and dealing for you. Be careful 

though, it's surprisingly ,_,.. .. ... \. , ..... 
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PLAYING THE GAME 

You drag cards to move them from 
stack to stack, and you click on face
down cards to flip them over. (If you're 
a little unsure about how to drag and 
click, turn to the "Basic Tools and 
Skills" chapter in this manual.) 

To move a card ... 
Click on the card and drag it to its 

new location. 

To flip over a face-down card ... 
Click the card. If it 's in one of the 

seven lower stacks, a single card will 
flip. If you click the deck , either one 
or three cards will flip-depending 
how you set your options. See 
"Changing the Number of Cards 
Drawn" later. 

To start playing ... 
Begin playing by dragging a card or 

clicking a card to turn it over. The 
game starts as soon as you move or 
flip your first card. 
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To start a new game ... 
Choose Re-Deal from the Game menu. 

To cheat ... 
If you make a move and then change 

your mind, choose Undo from the Game 
menu. 

SETTING A DIFFICULTY LEVEL 

Solitaire lets you choose from three 
levels of play: Beginner, Intermediate , 
and Advanced. 
Beginner At the Beginner level, when 
you click a card, Solitaire helps you 
decide where to place it by highlighting 
possible destinations (unless the Full 
Card Dragging option is on). At this 
level , it 's also legal to move cards from 
the four top stacks to the seven lower 
stacks. You can also split sequences
move , say , only the last three face-up 
cards in a stack of six. 

GeoWorks Solitaire looks-and plays
just like the version you play at home. Use 
the pointer to pick a card and move it to 
another pile. Drag the card from the lower 
stacks to the upper four stacks. When 
you've pulled off all the cards, you've 
won. (Be sure to choose the Beginner level 
of play if you've never played before
when you dick a card, it shows you the 
different places you can move the card.) 



Intermediate Yo u lose bo th the desti
na tion he lp a nd th e ab ility to move 
ca rds fro m th e to p four s tacks to the 
lower seven-o n ce ca rds a re in the to p 
four s tacks , they stay the re . But you 
ca n still sp lit seq ue nces . 
Advanced No he lp . o mov ing ca rds 
off the to p four s ta cks . No splitting o f 
seq ue nces . 

To change the level of difficulty ... 
0 From th e Options me nu se lec t Level 
of Pl ay . 
8 From th e e nsuin g cascad e me nu , 
choose Beginner, Inte rme di ate , o r 
Ad va nced. 

CHANGING THE SCORING 

Solita ire ca n be scored in diffe re nt 
ways . Choose fro m Sta nda rd , Vegas , 
and No Scoring. 

STANDARD SCORING With standard scoring, 
you lose po ints for time yo u spe nd 
deciding to take actio n , and when you 
start through the disca rd deck aga in . You 
ga in points fo r each successfu l move . 

VEGAS SCORING In Vegas scoring , your 
ga me sta rts w hen you re -dea l. Yo u start 
o ut 52 points in th e ho le, and for each 
re-deal yo u p ay with anothe r 52 points. 
Yo u the n get five (pos itive) p o ints for 
each card tha t you move to one of the 
four uppe r stacks . Your goal is to work 
your way to a p os itive score . Points are 
cumulative from game to game . In addi
tion , you 're limited in how many times 
you ca n go through the discard deck: 
once , when you pl ay o ne-card draw; 
three times, with three-ca rd draw . 

If you ... 
Let ten seconds goes by 

To change scoring ... 
From the Options me nu se lec t 

Sco ring . Three ch o ices appea r, 
Sta ndard , Vegas , and No Scoring . 
Choose o ne . 

CHANGING THE NUMBER OF CARDS 
DRAWN 

You ca n draw e ithe r o ne o r three 
ca rds a t a time fro m the disca rd stack. 
The cho ice yo u make affects how many 
passes through the disca rd deck you ge t 
whe n pl ay ing with Vegas scoring (see 
"Chang ing Sco ring Options" ea rlie r). 

To change the number of cards 
drawn ... 

Choose Draw How Many Cards? fro m 
the Options me nu. From the en suing 
cascade me nu , choose o ne o r three . 

STANDARD SCORING 

You get ... 
·1 point 

Move a card to one of the four upper stacks +10 

Flip a card in one of the lower seven stacks 
Pull a card out of the discard deck 
Start through discard deck again (one-card draw) 

Start through discard deck again (three-card draw) 

+S 
+S 

· 10 for the first four times, 
and ·20, ·30, etc., each time 

thereafter 

·30 first two times, ·60, -90, 
etc., each time thereafter 

VEGAS SCORING 

If you ... You get ... 
Re-deal ·52 points 

Move card to an upper stack +S 
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SETTING OTHER OPTIONS 

You have four other options in 
Solitaire. You can change any of these 
by choosing them from the Options 
menu: 
Change Card Backs Gives you a dialog 
box from which you choose the artwork 
o n the backs of the cards. 
Outline Dragging When on, you see 
only see a card's outline as you drag it . 
Full Card Dragging Shows the full card 
as you drag it. The game moves a little 
slower with this option on. Use Outline 
Dragging to speed things up. Also, with 
Full Card Dragging on, you don 't get 
any destination help when playing at 
the beginner level. 
Fade on Deal When on, cards fade in 
as they are dealt . With this setting off, 
cards appear immediately . This option 
also slows things down (not good if 
you're playing a timed game). 
Timed Game Standard setting that 
times your game and deducts a point 
when you take more than ten seconds 
to ac t. Time is displayed in the lower 
left of the screen . With this setting 
turned off, no points are deducted. 
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T E T R 

As games go, Tetris is easy to learn, hard 

to master, and unfailingly addictive. To 

- play, simply rotate shapes as they 
, , • > fall dovvn a vvell, trying to make 

them land in neatly filled rovvs. Simple/ 

Completely filled rows disappear, giving 

you room to vvork-and room is 

s 

vvhat you need, for vvhen the 

pieces stack up to the top of the 

vvell, it's Game Over! 



PLAYING THE GAME 

The basic playing area is called the 
well. Differently-shaped blocks fa ll down 
the well , slowly at first, then faster as 
you advance to higher ski ll levels. As the 
pieces fall, you can rotate them counter
clockwise and move them left or right. 
The idea is to fit them neatly into rows 
at the bottom. When you complete a 
row-that is , fit the last piece so there 
aren 't any gaps in the row-it disap
pears, and the rows above shift down to 
fill the space. Once you 've lined the 
falling piece up correctly, yo u can make 
it drop immediately onto the pile , which 
speeds the pace of the game and earns 
you extra points . 

The longer you play, the more points 
you make. Your goal , of course, is to 
accumulate as many points as you can. 

To start a game of Tetris ... 
Choose Start New Game from the 

Game menu. The first piece will imme
diately start fa lling from the top of the 
we ll. 

MOVING THE PIECES IN TETRIS Tetris is easy to 
operate , since you only need to learn to 
use a few keys. The chart at the bottom 
of this page shows the keys that maneu
ver the pieces in both the one- and two
pla yer games. 

TETRIS 

In T etris, pieces fall down the 
uwell" 0 and land on the pile 
below (.i). When you com· 
pletely fill a row, it disappears 
and the pile shrinks by one 
row. Easy, right? 
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PAUSING THE GAME If you 're in the middle 
of a game and you need to stop for a 
second (say, to answer the phone), 
simply choose Pause Game from the 
Game menu. While Tetris is paused 
none of the pieces move. When you 're 
ready to go back to playing , choose 
Continue Game from the Game menu. 
The game will pick up again as though 
you 'd never left. The Pause Game fea
ture is a lso a great way to stop and 
calm your panic when the pile of 
pieces gets large and the pace really 
picks up . (Of course, you can 't see 
anything in the well while the game is 
paused, since that wo uld certainly give 
you an unfair advantage!) 



SCORING 

Scoring in Terris is pretty simple: the 
more challenging the play , the more 
points you get. But for those of you 
who just have to know, here are some 
of the scoring rules. 
• Every time a piece lands on the pile 

you get a certain number of points 
(which goes up as the game level 
increases) . 

• When you drop a piece by pressing 
[Spacebar), you get extra points. The 
farther it drops , the more points you 
get. 

• You get 1 ,000 points when you clear 
fo ur rows at once. 

•However, you score fewer points 
when you 're playing with the Preview 
Pieces option on. 

The seven different 
types of Tetris pieces. 

TWO-PLAYER TETRIS 

In two-player Tetris, like in the single
player version, you try to rack up as 
many points as you can-it 's just that 
your opponent is simultaneously doing 
the same thing. Each of you has your 
own well and your own (different) series 
of fa lling blocks-it's like playing two 
single-player games side-by-side. 

Here 's the tricky part: There are 
actually two ways for the two-player 
game to end: 
•Both players ' piles reach the top of 

their respective wells . 
•One player's pile reaches the top and 

the other player has more points . 
(The one with more points wins, of 
course.) 
If you like , you can have the left

and right- player games interact. For 
example, if you set the Penalize 
Opponent option , then every time you 
clear a row, a new row gets added to 
the bottom of your opponent 's well. 

To start a game of two-player 
Tetris ... 
0 Select Two Players from the Options 
menu . You should also set any of the 
other options while you're at it (see 
the next section for a complete list). 
f) Choose Start New Game from the 
Game menu. 

MANEUVERING THE TETRIS PIECES 

One Player USE ANY OF THE THREE KEY COMBINATIONS 

Two Player L E F T PLAYER RIGHT PLAYER 

Move left [Q) 0 I [B 
Move ri_g_ht (8 [I] 0 
Rotate counter-clockwise @ IBJ [[) ON KEYPAD 

Drop piece jspacebar) Q [±]OR~ 
Increase difficulty OJ (Ml") ffiJ [!) 

20.3 TETRIS 



SETTING THE TETRIS OPTIONS 

Tetris comes with many options
found in the Options menu-to test 
your mastery of the game. 
Two Players Pits you against a 
"friend ," as each of you try to get the 
most points while playing with side-by
side wells. 
Preview Pieces Your crystal ball. With 
this option turned on you see the next 
piece that will drop before it actually 
appears in the well . As you might 
expect, this option takes some of the 
challenge out of the game , and you get 
less points. 
Players Get Identical Pieces In two
player Tetris , this option is one way to 
keep everything fair. (Sort of.) When 
it 's turned on, both players get the 
same falling pieces in the same order. 
Set Left Player's Game Level/Set 
Right Player's Game Level You can 
set different starting game levels for 
each player. If you and your opponent 

Rotate the pieces as they fall so that they fit snugly into the pile below. 
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aren't evenly matched, this is a great 
way to set a handicap. 
Set Starting Lines Tetris starts your 
game with some lines partially filled at 
the bottom. This makes the game excit
ing from the moment it starts. 
Penalize Opponent This option 
makes two-player Tetris just plain 
nasty. There even are several ways to 
penalize an opponent: 
•Never: Each player plays a normal , 

friendly Tetris game . 
•Every Other Line Filled: Here things 

become a little less friendly . Every 
other time you clear a row , an extra , 
partially filled row is added on your 
opponent 's side. (And vice versa, of 
course.) 

•Every Line Filled: Each row you clear 
adds another row to your opponent 's 
side. 

•Multiple Lines Filled Only: For 
advanced players . You need to clear 
two lines to penalize your opponent 
one line ; clear three lines to add two ; 
and four lines to add three . 

Show High Scores Choose this to see 
a list of the top ten scores . 
Reset Games Won In the two-player 
version, Tetris keeps a running total of 
the games each player has won. 
Choose this option to set the tally to 
zero . 
Save Options If you 're satisfied with the 
options you 've set and would like Tetris 
to keep them in effect , select Save 
Options . The next time you start Tetris, 
the current options will be in effect. 



GEOWORKS PRO IN THE REAL WORLD 

In the early days of personal computing, 

you didn't have llluch choice. Your PC 

was made by IBM and you used MS-DOS, 

which ran only one program at a time. But 

today, there are hundreds of choices. 

More brands of dot-matrix printers than 

you can count. (And laser printers, too.) 

MS-DOS is still around, but there are 

challengers like DR-DOS. And you can run 

many DOS programs at once and svvitch 

alllong them. You can even exchange files 

vvith others over 

-- a Local Area 

Network. 

With GeoWorks Pro and MS-DOS S.O or DR DOS 6.0, you 
can easily run a lot of DOS programs at the same time. 



GeoWorks has kept up with the 
changes, letting you take full advan
tage of the software and hardware 
choices that now exist. For example: 
•GeoWorks Pro supports Novell, LAN-

tastic, LANManager, and PC-NFS 3.5 
Local Area Networks . This means you 
can use network drives in the same 
way you use your local hard disk. 
You can even print to a network 
printer by redirecting your printer 
port. (See the manuals that came with 
your network for more about setting 
up network printers .) 

• You can print on Postscript printers
including Apple Laserwriters, QMS, 
and HP printers with Postscript car
tridges. You can also print to a 
Postscript file (which you can then 
import into programs that accept such 
files, like PageMaker). 

• GeoWorks Pro works wi th the task 
switchers (software that lets you 
switch between several active DOS 
programs) that come with MS-DOS 5.0 
and DR-DOS 6.0. GeoWorks Pro also 
works within Microsoft Windows. 

SWITCHING WITH THE MS-DOS 5.0 
DOSSHELL UTILITY 

GeoWorks Pro is compatible with the 
DOSSHELL utility, Microsoft 's task 
switcher for MS-DOS 5.0. Before you 
use it, though , there are a couple of 
things you should know: 
•The task switcher, DOSSHELL.COM, 

takes all of extended memory for 
itself, leaving none for GeoWorks Pro. 
It also takes up about 40K of regular 
memory, but it doesn 't affect your 
expanded memory at all. 

•When you switch from GeoWorks Pro 
into another DOS program (such as a 
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spreadsheet or word processor), 
everything that you were doing in 
GeoWorks Pro is put on hold . If 
you're in the middle of printing a 
document, it will stop printing. If you 
then try to print something from a 
DOS program, it will probably come 
out in the middle of the GeoWorks 
document. Because of this, you 
should completely finish printing 
(and saving) your documents before 
switching out of GeoWorks Pro. 

• GeoWorks Pro generally keeps a lot of 
files open. Normally this isn 't a prob
lem, but if you run other DOS pro
grams that also open lots of files , you 
might get an error that says you 've 
opened too many . Fortunately, this is 
easy to fix (see "Preparing Your Com
puter for DOS Program Switching,'' 
discussed a little later). 

To switch from GeoWorks Pro to 
another DOS program ... 

Make sure that you run DOSSHELL 
before you start GeoWorks Pro. Then , 
to switch to the DOSSHELL screen from 
GeoWorks Pro-from which you can 
transfer to any currently running DOS 
program or start a new one-press q + 
' . Note that while DOSSHELL gives you 
several keystrokes that you can use to 
switch applications, only q + ' works 
from within GeoWorks Pro . 

PREPARING YOUR COMPUTER FOR DOS PROGRAM 
SWITCHING Before you try to run 
GeoWorks Pro along with other DOS 
programs , you need to a lter your 
CONFIG.SYS file (found in the root 
directory of drive C) to make sure that 
your computer can handle the large 
number of files that will be open at the 
same time. 
Warning! Changing your CONFIG.SYS file is a very delicate 
business. If at any time you feel that have made an incor· 
rect change, don't hesitate to use the Revert command on 
the Fiie menu. 



To change your CONFIG.SYS file ... 
0 Sta rt GeoWo rks Pro. 
8 Sta rt the Note p ad d es k too l. A bl ank 
n o te book p age appea rs. 
8 Ope n yo ur CONFIG .SYS fil e by 
choos ing Ope n fro m the Fil e me nu. 
The CO NFIG.SYS fil e s ho uld be in the 
roo t direc to ry o f drive C. 
0 Look fo r the line th a t begins 

file s= 
Edit th e line to read 

f iles =lOO 
If th e re is no line like thi s in the fil e 
a lread y, add o ne (as s how n a b o ve) a t 
the e nd o f the fil e. 
0 Yo u s ho uld also add a line that 
a uto matica ll y insta lls SHARE.EXE: 

i n stall=c : \ do s \ s hare . exe 
/ f : 4 0 96 

(Of co urse , if SHARE.EXE isn 't fo und in 
the C: \DOS direc to ry, yo u need to 
change th e direc to ry na me acco rding
ly.) 
0 Save the changes yo u 've mad e and 
ex it GeoWorks Pro . 

files=lOO 
buffern=30 
SHELL=C:\OOS\COMMAHD.COM C:\DOS\ /p 
DEUICE=C:\DOS\HIMEM.SVS 
deuice=C:\MOUSE\MOUSE.SVS 
install=c:\dos\share.exe If :40961 

Use the Notepad (ar same 
other line editor, such as 
EDLIN) to edit your 
CONFIG.SYS file. Note that 
this only shows a sample 
file-this isn't everyone's 
ideal CONFIG.SYS file! 

G Resta rt yo ur compute r by press ing 
@!ill + ~ + ~. This puts the new 
CONFIG. SYS fil e into e ffect . 

SWITCHING WITH DR-DOS AND 
TASKMAX 

Tas kMAX, the DR-DOS 6 .0 prog ra m 
switche r, integra tes smoothly into 
GeoWo rks Pro , making it a lmost e ffort
less to switch be twee n GeoWo rks Pro 
a nd o th e r DOS prog rams. 

But you 'll need to wa tch o ut fo r a 
co uple o f things to make sure 
Tas kMAX wo rks prope rl y w ith 
GeoWo rks Pro-sp e cifica lly , you need 
to make sure th at your CONFIG .SYS 
fil e has the line 

files=120 
and that your compute r auto matica ll y 
s ta rts SHARE.EXE w he n yo u turn it o n . 
(Fo llow the p rocedure describe d in the 
previo us sectio n for ch ang ing your 
CO NFIG .SYS fil e.) 

SWITCHING BETWEEN APPLICATIONS Beca use 
Tas kMAX is integrate d w ith GeoWo rks 
Pro , it 's ve ry simple to sta rt DOS pro
g rams and switch be twee n the m . 

To start a DOS application from 
Geo Manager ... 

Yo u s tart DOS a pplica tio ns the sa me 
way you w ould if yo u w e re n 't running 
Tas kMAX-that is, by d o uble -clicking 
the ir icons. The o nly diffe re n ce is tha t, 
w ith Tas kMAX, GeoWo rks Pro d oesn 't 
have to shut down be fore running th e 
p rogram . Instead , b o th GeoWo rks Pro 
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and the DOS program run simultane
ously. 

Change to the proper directory and 
double-click the icon of the DOS pro
gram to start it. The screen will go 
black almost immediately, indicating 
that the program is starting. 

If, after double-clicking the icon a 
dialog box appears that says "shutting 
down PC/ GEOS, " you know that 
TaskMAX wasn 't started correctly. 
(Without TaskMAX, GeoWorks Pro must 
shut down before running a DOS pro
gram.) Exit GeoWorks Pro and follow 
the instructions in the DR-DOS User's 
Guide for starting TaskMAX. 

To switch to an active DOS program 
via the Express menu ... 

The names of all active (i.e., run
ning) DOS programs appear near the 
top of the Express menu. You can gen
era lly tell DOS program names from 
GeoWorks application names, since the 
DOS names are normally shown in all 
capital letters. 

0 Click the Express button to bring 
down the Express menu. 
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8 Click to select the name of the 
desired DOS program. The screen 
immediately goes black while TaskMAX 
switches to the program. In a few 
moments, the screen of the DOS pro
gram will appear, exactly the way you 
left it. 

To return to GeoWorks Pro ... 
You can use the TaskMAX dialog 

box to switch between different act ive 
DOS programs. 
0 Press @Iill + ~. This brings up the 
TaskMAX dialog box. 
8 Use the up and down arrow keys to 
move the cursor to the line that says 
"GeoWorks Pro. " 
Note: If the dialog box doesn't respond as you press the 

arrow keys, try this trick: press and release the left @Iill 

key, and then do the same with the right @Iill key. The 

control box should then function correctly. 

E) Press [Return!. In the now familiar 
pattern, the screen goes blank for a 
moment while GeoWorks Pro is 
restored . 

Of course, you could use almost this 
exact procedure to switch to any active 
DOS program. All you need to do is 
choose the name of the program from 
the TaskMAX dialog box and press 
I Return J. 

To shut down DOS programs ... 
The best way to shut down an active 

DOS program is to switch to the pro
gram (via the Express menu , as 
described earl ier) and shut it down in 
the normal way-the same way you 
would if you had run it from DOS 
instead of from GeoWorks Pro. Proba
bly the worst way to shut one down is 
to delete it using the TaskMAX dialog 
box (more on that later) . 



TASK SWITCHING FROM THE DOS PROGRAMS SCREEN 
GeoWo rks ' DOS Programs screen func
tio ns a lmost the sa me way w hethe r o r 
n o t you 're runnin g TaskMAX. The regu
la r DOS Programs sc reen (w itho ut 
TaskMAX, tha t is) is covere d e lsewhe re 
in this book . 

To start a DOS program ... 
Click the program 's butto n , the way 

you n o rmally would . Instead o f 
GeoWo rks Pro shutting dow n in th e 
no rmal way , however, th e screen goes 
b lank and th e DOS p rogra m loads. 
GeoWorks Pro is still running , in fac t , 
and ca n eas ily be reca ll ed w ith a cou
pl e of keys trokes (see be low). 

To switch to an already running 
program ... 
0 Click th e "Running Programs" but
to n at the botto m of the DOS Progra ms 

sc reen . A dia log box 
a ppears , showing a lis t o f 
a ll active DOS p rograms . 

f} Do u ble -click the na me of the 
des ire d progra m . The screen goes 
bl ack w hil e th e DOS p rogram is ac ti
va te d . 

To return to GeoWorks Pro from 
another DOS program ... 

Use th e TaskMAX di a log box to 
switch back to GeoWorks Pro. 
0 Press @!ill + ~. This brings up the 
TaskM AX dialog box . 
f} Use the up a nd d ow n arrow keys to 
move the cursor to th e line fo r 
GeoWo rk s Pro . 
8 Press !Return). The screen goes blank 
fo r a m ome nt w hil e GeoWorks Pro is 
res to re d . 

To shut down DOS applications ... 
0 Switch to the program (via the 
"Running Programs" butto n , d escribe d 
ea rli e r). 
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f} Shut th e program d own in the no r
mal way-the same w ay you w o uld if 
you had run it fro m DOS instead o f 
fro m GeoWo rks Pro. 
8 Afte r the p rog ram shuts d own , you 
m ay be re turn ed to GeoWorks Pro-o r 
you may be switched to an o the r ac tive 
DOS p rogram. Use th e p rocedure 
show n ea rlie r to switch back to 
GeoWorks Pro. 

THE TASKMAX DIALOG BOX Yo u can control 
TaskMAX directly using a specia l dia log 
box ava il able from the Express menu . 
While you can start DOS programs o r 
switch to them using this dialog box, this 
isn 't the easiest way to do this-double
clicking the fil es in GeoManager or 
choosing the ir names from the Express 
menu is actu ally much s imple r. The 
TaskMAX dialog box , however, is the 
o nly way to fo rcibly shut down a DOS 
p rogram w itho ut switching over to it . 

To bring up the TaskMAX dialog 
box ... 

Choose TaskMAX Co ntrol fro m the 
Ex press menu . The Tas kMAX dia log 
box a ppea rs . 

Per-task EMS limit (Kb\Jtes)z 

Free 5wap Space: 3552Kb 

CQpboa"d SUpporta , $i On 

The TaskMAX dialog box. The Active Tasks list ((i)) shows all the DOS pro· 
grams (other than GeoWorks Pro) that are currently running. 
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Active Tasks This list shows all the 
active DOS programs. The name shown 
is the name of the program's 
executable file (that is, the ". EXE " or 
". COM" file). If you start the DOS shell, 
COMMAND.COM, then the name 
"COMMAND " appears in this list. How
ever, if you switch over to the shell 
and run a program , the name of this 
program replaces the name 
"COMMAND " in the Active Tasks list. 
Add Click this to automaticall y start 
another COMMAND.COM DOS she ll , 
which you can then use to start anoth
er DOS program. 
Run Click here to switch to the se lect
ed program in the list. 
Delete This terminates the selected 
DOS program. This button is danger
o us-see the steps for shutting down 
DOS programs later in this section. 
Per-Task EMS Limit This shows the 
maximum amount of EMS memory 
available to each active DOS program . 
You can adjust the number. 
Free Swap Space The figure shown is 
the amount of disk space available for 
temporarily storing active DOS pro
grams. If this figure is too low, you 
may be unable to start additiona l pro
grams. 
Clipboard Support Turn this option 
on if you wa nt text that yo u 've cut or 
copied from a DOS program to replace 
the GeoWorks clipboard, thus making it 
available for you to paste into 
GeoWorks applications . Turn the option 
off if you want to ensure that 
GeoWorks Pro 's clipboard is left 
unchanged while you're using other 
DOS programs. (If the option is 
dimmed and unava ilable, it means that 
your version of TaskMAX doesn 't han
dle DOS cut and paste in a way that 
works with GeoWorks Pro.) 
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To start a DOS program ... 
0 Click Add. This starts the DOS shell , 
COMMAND.COM, and switches you 
into it . 
8 Run your DOS program from this 
DOS prompt the way you normally 
wou ld . Later, when you return to 
GeoWorks Pro , the TaskMAX dialog box 
will show you the name of this pro
gram, not COMMAND.COM, in the 
Active Tasks list. 

To switch to an active DOS 
program ... 

There are two ways to switch to an 
active program us ing the TaskMAX 
dialog box: 
•Click to se lect the name of the pro

gram from the li st of active DOS pro
grams. Then click Run . 

•Double-click the name of the program 
in the list of active tasks . 

In either case, the screen immediate
ly goes black while you switch . After a 
few moments, you 'll be back in the 
DOS program at exactly the same place 
you were before. 

To shut down an active DOS pro
gram ... 

The best way to shut down a DOS 
program is to first switch over to it , 
and then shut it down in the normal 
way. (You shut down WordPerfect , for 
example, by pressing t, although every 
DOS program is different .) The worst 
way, or at least the most potentially 
dangerous way, is to use the Delete 
button in the TaskMAX dialog box. 

The problem with this latter method 
is that the DOS program is abruptly 



shut down, without being given the 
opportunity to release any of its 
extended memory or flush out its file 
buffers. You run the risk, then, of cor
rupting your data files, or at least tying 
up some of your RAM until you turn 
your computer off. Not good. 

There are times, however, when the 
Delete button is the on ly way to shut 
down a job. Specifica lly , you must 
click Delete if you started the program 
using the i key in the regular TaskMAX 
dialog box (the one you get when you 
press q + ' from the DOS prompt , not 
the one described here that 's part of 
the Express menu) . You can shut down 
the DOS program in the normal man
ner, but you can 't get rid of the DOS 
shell except by clicking Delete. 

0 Select the name of the DOS pro
gram from the list of active programs. 
f) Click Delete. 
e If a warning appears , asking if you 
do, in fact, wish to forcibly shut down 
this program , you should probably 
click No . This warning only appears 
when you try to delete the kind of 
program described earlier (it probably 
has a llocated either extended memory 
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or temporary files). No warning, no 
problem. 

CUTTING AND PASTING FROM DOS APPLICATIONS 
DR-DOS comes with a way to cut, copy, 
and paste text from the screen into DOS 
applications, thus letting you copy some 
figures from , say , a Lotus 123 screen 
into your WordPerfect document. You 
can use this same feature to copy from a 
DOS program to a GeoWrite document, 
and vice versa. 

When you switch out of GeoWorks 
Pro , the contents of the GeoWorks clip
board are give n to TaskMAX so that 
they can be pasted into a DOS program 
later. And vice versa: When you swi tch 
back to GeoWorks Pro, TaskMAX takes 
any text that has been cut or copied 
and places it into the GeoWorks clip
board. 

While this process is automatic , you 
can turn it on or off. You might choose 
to turn it off if you had something 
important in the clipboard and you 
didn 't want to risk accidentally over
writing it. 

To turn the TaskMax clipboard sup
port on and off ... 
0 Choose TaskMAX Control from the 
Express menu . The TaskMAX dialog 
box appears. 
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8 The Clipboard Support option 
shows whether this feature is on or off. 
(If the option is dimmed and unavail
able, it means that your version of 
TaskMAX doesn 't handle DOS cut and 
paste in a way that works with 
GeoWorks Pro.) Change the setting by 
clicking the check box. 
8 Click Close to close the dialog box. 

RUNNING GEOWORKS PRO UNDER 
WINDOWS 3.0 

It is possible to run GeoWorks Pro 
from Windows in the 386 enhanced 
mode , but you must first set up a .PIF 
file and add GeoWorks Pro to the Non
Windows application group. 

To set up the .PIF file ... 
0 Run Windows. 
8 In the Program Manager window 
double-click the Main Group icon. 
8 Open the .PIF Editor. 
0 In the .PIF Editor, you need to 
change only the options shown in the 
"Windows PIF Options" table below. 
(Leave all the other PIF options alone). 
0 Select Save from the File menu and 
click the OK button to accept 
Kernel.pif as the filename. 
0 Close the .PIF Editor. 

To add GeoWorks Pro to the non
Windows applications group ... 
0 In the Program Manager window, 
choose New from the File menu . 
8 Click OK to accept "Program Item" 
as your selection. 
Note: If there is no Non·Windows Applications group icon, 

you need to create one. Consult your Windows manual to 
see how. 

8 In the Program Item Properties win
dow, type GeoWorks Pro in the 

Description box. This caption will 
appear under the icon in the Non
Windows Applications window. 
0 Press the Tab key to move to the 
Command Line box and type in "ker
nel.pif". 
0 Click the Change Icon button to 
display the Select Icon window and 
type in W3ICONS.DLL. 
/\ Move through the icons by clicking 
the View Next button until you see the 
World icon. 
0 Click OK. 
8 Click OK again to save and exit the 
Program Item Properties window. The 
newly created icon shou ld be 
displayed in the Non-Windows Appli
cations window. Double-click on the 
GeoWorks Pro icon to launch it. 

To switch out of GeoWorks Pro and 
into another DOS program ... 

All the task switching hotkeys, @Im 
+ ~'~+[~),and~+ IT§fil are 
active. Press any one of these keys to 
cycle to the next program. 

WINDOWS PIF OPTIONS 

Main .PIF Editor window Options 
Program Filename KERNEL.EXE 
Window Title GeoWorks Pro 
Start-up directory C: \ GEOWORKS 
Execution 

Advanced Options 
Display Options 

Other Options 

Exclusive 

Video Memory High 
Graphics (All other 
display options shou ld 
be deselected) 
Reserve Shortcut Keys 
~ + [Spacebar) , @D +[Enter) 

G E 0 W 0 R K S P R 0 I N T H E R E A L W 0 R L D 21.8 







S P E C I A L C H A R A C T E R S 

There are many special characters that 
you can use in GeoWorks Pro that you 
don't find on your average typewriter
or on your keyboard, for that matter. 
Foreign language accent tnarks, foreign 
currency symbols, and mathematical sym
bols, for example, that can make your 
documents more professional looking. 



To type a character shown on this list , simply press the key combination 
shown in the Keys column . (A plus sign ( +) means hold down the first set 
of keys while pressing the second; the word "then " means just the oppo
site-re lease the first set before typing the second .) These special characters 
print normally (that is, the way they look here), providing you don 't use the 
Text Only option when printing . 

ACCENTED LANGUAGE CHARACTERS 

Char Name Keys 

A uppercase A acute accent [ill 0IJ + e the n I Shift I + a 

A uppercase A dieresis accent [ill 0IJ + u then (Shift I + a 

A uppercase A grave accent [ill 0IJ + ' the n [Shift I + a 

A uppercase A circumflex accent [ill 0IJ + i then I Shift I + a 

A uppercase A tilde accent [ill 0IJ + n then [Shift I + a 

A uppercase A ring accent 

a lowercase a acute accent [ill 0IJ + e then a 

a lowercase a dieresis accent [ill 0IJ + u then a 

a lowercase a grave accent [ill 0IJ + ' th e n a 

a lowercase a circumfl ex accent [ill 0IJ + i then a 

a lowercase a tilde accent [ill 0IJ + n then a 

a lowercase a ring accent 

\: uppercase C cedill a accent 

<; lowercase c cedilla accent 

E uppercase E acute accent [ill 0IJ + e then (Shift I + e 

E uppercase E dieresis accent [ill 0IJ + u then [Shift I + e 

E uppercase E grave accent [ill 0IJ + ' then [ Shift I + e 

E uppercase E circumflex accent [ill 0IJ + i then [Shift I + e 

e lowercase e acute accent [ill 0IJ + e then e 

e lowercase e dieresis accent [ill 0IJ + u then e 

e lowercase e grave accent [ill 0IJ + ' then e 

e lowercase e circumflex accent [ill 0IJ + i then e 

uppercase I acute accent [ill 0IJ + e then I Shift I + i 

uppercase I dieresis accent [ill 0IJ + u then [Shift I + i 

uppercase I grave accent [ill 0IJ + - then [Shift I + i 

uppercase I circumflex accent [ill 0IJ + i then [Sh ift I + i 

lowercase i acute accent [ill 0IJ + e then i 
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Char Name Keys 

lowercase i die res is accent @!ill [E!D + u th e n i 

lowercase i grave acce nt @!ill [E!D + ' th e n i 

lowercase i circumfl ex accent @!ill [E!D + i the n i 

N uppe rcase N tilde accent @!ill [E!D + n th e n I Shift I + n 

fl lowercase n tilde acce nt @!ill [E!D + n then n 

6 uppe rcase 0 acute accent @!ill [E!D + e th e n I Shift I + 0 

6 uppe rcase 0 di e res is accent @!ill [E!D + u th e n I Shift) + o 

6 uppe rcase 0 g rave accent @!ill [E!D + ' th e n I Shift ) + o 

6 uppe rcase 0 circumflex accent @!ill [E!D + i th e n ! Shift) + o 

6 uppe rcase 0 tild e acce nt @!ill [E!D + n th e n I Shift ) + 0 

0 uppe rcase 0 s las h I Shift I @!ill [E!D + 0 

6 lowercase o ac ute accent @!ill [E!D + e th e n o 

b lowercase o die res is acce nt @!ill [E!D + u th e n o 

0 lowercase o g rave acce nt @!ill [E!D + ' th e n o 

6 lowe rcase o c ircumflex acce nt @!ill [E!D + i th e n o 

0 low e rcase o tilde acce nt @!ill [E!D + n the n o 

0 lowercase o slash @!ill [E!D + 0 

(J uppe rcase U acute acce nt @!ill [E!D + e th e n I Shift ) + u 

0 uppe rcase U die res is acce nt @!ill [E!D + u the n !shift I + u 

u uppe rcase U grave acce nt @!ill [E!D + ' th e n I Shift) + u 

0 uppe rcase U c ircumflex acce nt @!ill [E!D + i th e n I Shift) + u 

u lowe rcase u acute acce nt @!ill [E!D + e the n u 

i.i lowercase u die res is acce nt @!ill [E!D + u th en u 

u lowercase u grave accent @!ill [E!D + ' th en u 

0 lowercase u ci rcumfl ex acce nt @!ill [E!D + i th e n u 
y uppe rcase Y die res is accent @!ill [E!D + u then I Shift) + y 

y lowercase y die resis acce nt @!ill [E!D + u th en y 

£E uppe rcase AE diphth o ng I Shift ) @!ill [Eill + ' (apostrophe) 

~ lowe rcase ae diphtho ng @!ill [E!D + I (a postrophe) 

CE uppe rcase O E diphthong I Shift I @!ill [E!D + q 

ce lowercase oe diphtho ng @!ill [E!D + q 

do tless i I Shift I @!ill [E!D + i 

B German do ubl e s @!ill [E!D + s 
Q ordmasculine @!ill [Eill + 0 ( zero) 

ordf eminine (gill [E!D + 9 
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~POGRAPHICAL 
Char Name 

t dagger 

* double dagger 

§ sect ion 

9f paragraph 

® registered trademark 

© copyright 
TM trademark 

• bullet 

centered period 

0 lozenge 

PUNCTUATION 

Char Name 

question down 

exclamation down 

e llipsis 

non-breaking space 

soft hyphen 

en dash 

em dash 

typographer's open quotes 

typographer 's close quotes 

open single q uote 

close single quote 

double quote low 

single quote low 

opening gui llemot 

clos ing guillemot 

opening single guillemot 

closing single gui ll emot 
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Keys 

[ill~ +t 

[ill ~ + 7 

[ill ~ + 2 

(Shift] [ill~ + 0 (zero) 

Keys 

(Shift] [ill~+ I 

~ + I Spacebar ] 

[ill + - (hyphen) 

[ill ~ + - (hyphen) 

I Shift] [ill ~ + - (hyphen) 

[ill~ +[ 

[ill~+] 

[ill~ +\ 
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CURRENCY AND NUMERIC 

Char Name Keys 

¢ cent @!ill~ + 4 

£ pound sterling @!ill~ + 3 

¥ yen @!ill ~ + y 

0 general currency I Shift I @_fil) [Iill + 4 

f florin @!ill [Iill + f 

I fraction I Shift I @_fil) [Iill + 3 

degree I Shift I @_fil) [Iill + 8 

o/oo per thousand (Shift I @_fil) [Iill + 5 

MATHEMATICAL 

Not all the characters appear in every font. If your font doesn 't have a char
acter you need, use the URW SymbolPS fontinstead for that one character. 

Char Name Keys 

:I:- not equal @!ill [Iill + = 

approximately equal @!ill [Iill + x 
$ less than or equal @!ill [Iill + , (comma) 

~ greater than or equal @!ill [Iill + . (period) 

± plus/ minus I Shift I @_fil) [Iill + = 

division @!ill [Iill + I 

infinity @!ill [Iill + 5 

integral @!ill~ + b 

logical not @!ill~ + l 

'1 radical @!ill [Iill + v 

TI Pi I Shift I @_fil) [Iill + p 

7t pi @!ill [Iill + p 

~ Delta @!ill [Iill + j 

µ mu @!ill [Iill + m 

a partial differential @!ill [Iill + d 

Q Omega @!ill [Iill + z 

I Sigma @!ill [Iill + w 
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ACCENTS 

Char Name Keys 

acute @!ill @I) + e then I Spacebar J 

circumflex @!ill @I) + i then I Spacebar I 
grave @!ill @I) + ' then I Spacebar I 
dieresis @!ill @I) + u then I Spacebar J 

tilde @!ill @I) + n then I Spacebar I 
macron 

breve 

dot accent 

caron 

ring accent 

Hungarian umlaut 

ogonek 

cedilla 
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A 
abbreviations, for units of measure, 3.19 
accelerators (keyboard), 2.29 
accented characters, 3 .27, A.2 to A.3, A.6 
access codes, entering in GeoDex card files, 10.3 
activating windows, 3.8 
active area, 3.2 
active window, 3.8 
Address Book appliance, 4.3 
address card file, 4.3, See also GeoDex 
Advanced Workspace 

described, 1.6 
entering, 2.4 

alarm function. See GeoPlanner 
Aldus Pagemaker, capturing images for export to, 7 .2 
Alt-key combinations, 2.27, 3.15, 3.20 , 16.12 
appliances, 2.4, 4.1 to 4.5 

in Beginner Workspace, 1.4 
exiting, 4.2 
opening, 4.2 

applications , 3.6 
exiting , 2.28, 2.29, 3.31 , 3.36 
starting, 3.16, 3.29 to 3.30 
starting automatically, 2.9 
switching between, 2.18, 3.8, 3.16, 3.30 
See also extras 

Apply (dialog box option), 3.18 
appointment calendar. See GeoPlanner 
archive files, 12.8 to 12 .9 
area codes, using as indexes in card file , 10 .2 
arithmetic operations. See Calculator 
arrow keys 

menu selections with , 3 .15 
text cursor repositioning with , 3.24 

arrows , on box options, 3.18 to 3.19 
arrow-style pointer, 2.15 , 3.2, 11.3 
ASCII (DOS) files 

importing into GeoWrite , 14 .22 to 14 .23 
opening/ editing with Notepad , 15 .1, 15.3 

aspect ratio adjustments , 3.42 

B 
backgrounds, customizing, 16.4 to 16.5 
Backspace key, 1.3 , 2.11, 3 .24 
Banner appliance, 4.4 
BANNERS folder, 8.3 
batch files 

creating/ editing for DOS Program screen, 6 .4 to 6 .5 
starting from GeoManager, 12 .3 

Batch File Text dialog box, 6 .5 
.BAT filename extensions, 6 .5 
baud rate, 9.3 
Beginner Workspace 
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described , 1.4 
entering, 2.4 

blinking line cursor, 3.27 
body area, 2.10 
boldface type, 2.13, 3.41, 14.3 
borders, 14.11 to 14.12 

in spreadsheets, 17.6, 17.7 , 17.8 
boxes. See check boxes; dialog boxes 
Browse View, of GeoDex, 10.2 
bullets, 3.27 , 14.3, A.4 
buttons 

Close , 3.10 
Control , 2.29 , 3.7 
creating for DOS Programs screen, 6 .3 to 6.4 
default , 3.18 
in dialog boxes , 3.17 to 3.18 
"dimmed" versus lit up , 2.9 , 3 .12 
Express , 2.18 , 3.7 
for floppy disks , 8 .3 
how they work , 3. 4 to 3.5 
Maximize/ Restore, 3.7 
on the mouse , 2.6, 3 .3 
radio , 2.18 , 3 .1 8 

c 
Calculator, 4.3 , 5.1 to 5.2 

changing options , 5.3 to 5.4 
cutting and pasting , 5.3 
error indicator, 5.3 
operating, 5.2 
Reverse Polish Notation (RPN) , 5.4 
using the memory, 5.3 

ca lendar 
with Planner appliance , 4.4 
See also GeoPlanner 

Cancel (dialog box option), 3 .18 
canceling 

printing, 3.39 
Quick Copy/ Quick Move , 3.29 
See also exiting 

Cap Lock key, 16.12 
capturing 

"pictures" of screens , 7.1 to 7 .5 
screens within GeoComm, 9 .7 to 9 .8 

card games , Solitaire, 4.5, 19 .1 to 19.4 
cards 

adding to GeoDex card file , 10.2 to 10.3 
with Address Book appliance, 4 .3 
editing, 10.4 
flipping through , 10.3 

CARDS folder, 8.3 
carriage returns 

adding/ deleting for telecommunications, 9.4 
unnecessary at end of lines, 2.11, 14.2 

cascade menus, 3.13 , 3.15 



case sens itivity, o f sea rches , 10 .8, 13.9 , 13. 11 
ce nte ring of tex t, 14 .3, 14.8 to 14.9 

See also ju s tifying tex t 
centime te rs (c m), 3.19 , 14.9 
charac te r s pac ing, 14.5 to 14 .6 
cha rts , 17 .3 to 17 .5 , 17.8 to 17.10 
check boxes , 3. 18 
Checks um , 9.9 
choos ing. See selec tin g; sta rtin g 
c i (C iceros) , 3. 19, 14.9 
circles, drawing in GeoD raw , 11 .5 
c ircle / s las h -s tyle pointer, 3.2 , 3. 17 
c li cking the mo use buttons , 2.6, 2.13 , 2.14, 3.2, 3 .4, 3 .5 
Clipart 

browsing in , 2.20 
o pe ning , 2.19 

c lipboa rd , 2.20 
copy ing cha rts to , 17 .9 
copying to, 2.25 
copying to / from Calcul ato r, 5 .3 
re te nti o n/ e ras ure of images in , 2.25 
sav ing GeoCo mm communica tions to , 9.6 
text ha ndlin g w ith , 3.28 to 3.29 

Close button , 3. 10 
Close (d ia log box o ptio n ) , 3. 18 
Close (F il e me nu o ptio n), 3.36 
closing 

di a log boxes , 3 .18 
direc to ries, 3 .21, 12.1 4 
documents, 2.28 , 3 .32 , 3.36 
w indows, 3. 11 , 3.34 

cm (centimete rs) , 3. 19 , 14.9 
colla ps ing directories , 12.11 
Coll a te (P rint di alog box opti o n) , 3.36 to 3.37 
colo r 

for background images, 16 .4 to 16.5 
fi lli ng GeoD raw ob jec ts with , 11.12 to 11.1 3 
in GeoWrite documents , 14 .1 2 to 14. 14 

co lumn breaks , 14. 17 
co lumns 

in GeoWr ite docum ents , 14. 17 to 14. 18 
in spreadsheets, 17. 7 

COM1 / COM2 ports , 16 .6 
comma nd line op ti o ns, from DOS Programs sc reen , 6.3 

to 6.4 
commas, for pa us ing mo d e ms, 9.5, 10 .3 
compute r, turning o ff, 2.30 
CONFTG .SYS fi le, a nd task switching , 21 3 
confirma ti o n messages , 12.15 
Contro l button , 2.29 , 3.7 , 3.9 
Co nt ro l menu , 3.9 to 3.10 
contro l mode (of Sc reen Dumper) , 7 .4 
Copy (Ed it me nu o ptio n ) , 3.28 
copying 

e nlarged / re duce d images , 2.20 
fil es and directori es, 7 , 8.5 to 8 .7, 12.6 to 12 .8 
fl o ppy dis ks, 12.13 
and pas ting objects in GeoDraw , 11 .11 
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spread sheets, 17 .6 
tabs , 14.6 
to/ fro m clipboa rd , 2.20, 2.25 
See also cut a nd pas te o pe ra ti o ns 

copyri ght symbo l, 3.27, A.4 
Co rrec t fo r Aspect Ra tio (V iew me nu o ptio n) , 3.42 
CRC (Cyc li c Redunda ncy Check), 9.9 
crossha ir-s tyle po inter, 11.4 
Ctr! key 

combin at io ns w ith o th er keys, 3 .14, 16.12 
this manu al's depictions of, 1.3 

curre ncy for mats , 16.9 to 16. 10 
curre ncy symbo ls , A. 4 
curre nt paragraph , 2. 15 
curso r 

b linking line , 3.27 
disabling for screen dumps, 7 .2 
in GeoCo mm , 9 .2 
text-sty le, 2.10 
See also pointers 

curved a rrow-sty le p o inter, 2.23 , 11. 4 
customi zing 

bo rd e rs , 14. 11 to14. 12 
GeoMa nage r, 12 .14 to 12.15 
GeoWo rks Pro (Pre fe re nces), 16. 1 to 16.5 , 16.9 to 

16. 12 
GeoWrite , 14.18 to 14.19 
keyboards, 16 .1 2 to 16 .13 
modem , 16 .14 to 16. 15 
mo use , 16. 13 to 16. 14 
printe rs, 16.6 to 16.7 
spe lling chec ker, 14.22 
video ad ap te rs , 16.8 to 16.9 
Viewer, 17 .11 to 17 .12 

cut and pas te o pera ti o ns 
w ith Calcu la to r, 5 .3 
from clipboard , 3.28 to 3.29 
fro m GeoP la nne r, 13.3 
from Sc rapboo k , 2. 19 to 2 .26 , 18.2 , 18 .3 , 18.5 
See a lso copy ing 

Cut (Edit menu opti o n) , 3 .28 

D 
d a il y dia ry 

in Plann e r ap p lia nce, 4.4 
See a lso GeoP lanne r 

dashes (-) , in phone numbe rs, 10.3 
data bits , 9.3 
d a te 

fo rm attin g, 16. 11 
setting o n yo ur compute r, 16.3 to 16.4 

d a te boo k 
with Planne r a pplia nce, 4.4 
See also GeoPlanner 

dec ima ls 
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setting in Calculator, 5.3 to 5.4 
setting in GeoWrite, 14 .6, 14.12 

decimal tabs, 14.6, 14 .12 
default buttons , 3.18 
defusing objects in GeoDraw, 11 .6, 11.14 to 11.15 
Delete (Del) key , 2.11, 3.24 
deleting 

column breaks, 14.18 
files or directories , 8.7 to 8.8 , 12.8 
GeoDex file cards , 10.4 
GeoDraw objects, 11.11 
GeoPlanner repeating events, 13.7 
headers and footers, 14 .16 
page breaks, 14.17 
printers , 16.7 
Scrapbook pages , 18 .3 
text , 1.3, 2.11, 3.24, 3.26 
title pages , 14.16 
words from user dictionary, 14 .2 1 to 14.22 

destination directory , 8.6, 12.6 
dialing phone numbers. See GeoComm; GeoDex 
dialog boxes , 2.9, 3 .17 to 3 .19 

file selector, 2.16 
responding to, 3.19 to 3.20 

diamonds (radio buttons), 2.18, 3.18 
dictionaries , for spell checking, 14 .19 
"dimmed " versus lit up buttons , 2.9, 3.12 
direct manipulation , 3.3 
directories 

changing , 12.5 
closing, 3.21, 12 .14 
creating, 8.5, 12.5 
deleting, 8.7 to 8.8 
displaying as tree , 12.11 to 12 .12 
displaying in compressed mode , 12.5 
displaying number of, 8 .2, 12.2 
as file folders, 2.8, 8.3, 12.3 
for GeoWorks Pro, 2.3 
getting information about, 8.8, 12.9 
moving and copying, 8.5 to 8.7, 12 .6 to 12 .7 
naming or renaming , 3.6, 12 .6 
opening, 3.21 , 8.4, 12.3 to 12.4 
opening on other disks, 8.4 
parent, 2.8, 12.4 
selecting for file saves, 2.17 
viewing as list, 12.10 

Disable Blinking Cursor option, 7.3 
disk drives. See drives 
disks, managing in GeoManager, 12.12 to 12.14 
disk space, display of, 8 .2, 12.2 
DOCUMENT directory, 8.4, 12 .3 to 12 .4 
documents , 3.6 

closing, 2.28 , 3.32, 3.36 
icons for, 2 .7, 2.9 , 8.3 
naming, 2.16 , 3.6, 3.35 
opening, 3.31 to 3.32, 3.36, 8.3 
opening in GeoWrite , 2.10, 3.30 
opening in Scrapbook, 2.19 
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opening multiple , 3.33 
pagination of, 14.16 
pasting images into , 2.26 
printing, 2.27, 3.36 to 3.39 
safeguard feature for, 16 .3 
saving, 2.16, 2.28 , 3.34 to 3.35, 3.36 
sizing in GeoDraw, 11.3 
te mplates for, 1.7 
See also text 

DOS 
exiting to, 3.16 
exiting to GeoWorks Pro , 1.7 , 6.2 to 6.3 
naming files in , 3.6 
running from DOS Programs screen , 1.7 , 6.2 to 6.3 
running from GeoManager, 12 .3 
and task switching, 21 .1 to 21 .8 

DOS fil es 
changing attributes of, 12.8 to 12.9 
opening/ editing with Notepad , 15.1 , 15 .3 
saving GeoComm communications as, 9.7, 9.8 
telecommunicating via GeoComm, 9.6 to 9.7 

DOS Programs screen, 1.7 , 6 .1 to 6 .2 
creating/ deleting buttons for, 6 .3 to 6.4 
creating/ editing batch files, 6.4 to 6.5 
entering, 1.4, 2.4 
running DOS programs from , 6.2 to 6.3 

DOSSHELL utility , switching GeoWorks Pro with , 21.2 
dotted margin area, 11 .2 
double-clicking the mouse , 2.13, 3.5 
dragging the mouse , 2.12, 3.6 , 3 .12 to 3. 13 , 3.23 
drawing area, 2.21 , 11.2 
drawing. See GeoDraw 
drawing space, 2.23 
DR-DOS and TaskMAX e nvironment , 21.3 to 21.8 
drives 

buttons for, 12.3 
resca nning in GeoManager, 12 .14 
switching, 3.21 

DUMPOO files , 7.2 
duplex, 9.4 

E 
editing 

batch files , 6.5 
GeoDex file cards, 10.4 
GeoDraw text , 11.13 to 11.14 
GeoPlanner calendar events, 13.4 
GeoWrite text , 2.12 
with keyboard , 3.26 to 3.27 
spreadsheets, 17.5 

Edit menu, 3.28 to 3.29 
electronic date book . See GeoPlanner 
ellipsis ( ... ) 

in dialog boxes , 3.17 
key combination for, A.4 



e m d as hes , 14.3, A.4 
EMM 386.SYS fil e, 16 .8 
e mul atio n , 9 .4 
Ena ble Blinking Cursor o ptio n , 7.3 
e nl a rg ing 

images o r te xt , 2.20 , 3.4 1 to 3.42 
w indows , 3.7 

e nte ring 
DOS, 1. 7 
DOS Progra ms screen , 1.4 
th e Fil e Ca bin e t, 2.7 
Too lbox , 2.22 
wo rks paces , 1. 3 to 1.4, 2. 4 
See a lso o p e ning; s ta rtin g 

Ente r (Re turn ) key 
fo r d efa ult o ptio n , 3. 19, 3 .20 
unn ecessa ry a t e nd o f lines, 2. 11 , 14.2 

e p (E u ro p ea n po ints), 3. 19, 14 .9 
.EPS fil e na me exte ns io ns , 17.3 
EPS fil es 

impo rtin g into GeoDraw , 11.1 6 
impo rting into Scrapbook , 18.5 to 18 .6 
printing to , 17 .8 to 17.9 
v iewing fro m Viewer, 17.2 

e rror indicato r, fo r Ca lcul ato r, 5.3 
Europea n po ints (ep ) , 3. 19, 14. 9 
event ca le nda r 

w ith Planne r applia nce, 4 .4 
See a lso GeoPl anner 

Ex it (F il e me nu o ptio n), 3.36 
ex iting 

a pplia nces, 4 .2 
applica ti o ns , 2.28 , 2.29 , 3 .31, 3 .36 
to DOS, 3. 16, 6.2 
Fil e Ca bine t, 8.9 
GeoMa nage r, 12.1 5 
GeoWo rks Pro , 2 30 
menu s, 3. 15 
Quick Co p y/ Quick Move , 3.29 

Ex it to DOS (Express menu o pti o n), 3. 16 
exp ande d me mo ry , 16.8 
exp anding directo ri es , 12. 11 
Ex press b utto n , 2.1 8 , 3.7 
Ex press me nu , 3.7 

how to use, 2.18 , 3 .1 6 , 3 .30 
ex te ns io ns. See fil e na me exte ns io ns 
ex tras , 7. 1 

Nim b us Font Co nve rter, 7.6 to 7.7 
Perf, 7 .7 to 7.8 
Sc reen Dumpe r, 7. 1 to 7.5 
3D Font De mo , 7.8 

F 
F2 , re turn to Welco me screen , 1.4 , 3. 16 
F3, Ex it , 2.29 

i.S 

F5, Spe ll Checking , 14. 19 
fil e a ttributes , 12.8 to 12.9 , 12.10 
Fil e Ca bine t , 1. 5, 8 .1 to 8.2 

c rea ting d ocum e nts fro m , 3.3 1 
e nte rin g, 2.7 
ex iting , 8.9 
reca lling , 2. 18 

fil e icons, 3. 4 
Fil e me nus , in a ll GeoWo rks a pplica ti o ns, 3. 11 , 3.36 
fil e na me exte ns io ns, 3.6 

.BAT, 6 .5 

.EPS, 17.3 

.MAC, 9 .10 
s pec ify ing fo r Viewer lookups , 17 .12 
.WKl , 17 .3 
.WQl , 17 .3 

fil es 
d e le ting , 8.7 to 8 .8 
d is pl ay o f numbe r o f, 8.2 , 12.2 
getting in fo rma ti o n abo ut , 8.8 , 12.9 
as icons in GeoMa nage r, 12 .1 
impo rting in to GeoDraw , 11 .16 
impo rting to / fro m GeoWrite , 14.22 to 14.23 
moving and co py ing , 8. 5 to 8.7 , 12.6 to 12 .7 
na ming, 2. 16, 3.6 
read- o nl y, a rchive , sys te m a nd hidde n , 12.8 to 12.9, 

12. 12 
re naming, 8 .5 
te lecommunica ting . See GeoComm 
viewing as lis t, 12.10 
See a lso d ocume nts 

fil e se lecto r d ia log bo x , 2.1 6 to 2 .1 7 
fil e se lecto rs , 3 .20 to 3.2 1 

how to use , 3 .21 to 3.22 
fill ed o bj ects, 11 .12 
flipping GeoDraw o bjects , 11 .10 
fl o ppy disks 

b utto ns fo r, 8 .3, 12.3 
copying, 12.13 
fo rm a ttin g, 8 .8 to 8.9 , 12.1 2 to 12. 13 
re naming , 12. 13 to 12. 14 

fo lde r icons , 3.4 
fo lders 

as icons fo r directo ri es , 2.7, 8.3 , 12.3 
o pe ning , 2.8 

fo nts, 3.40 
chang ing, 2. 13 
choos ing a nd cha ng ing, 3 .40 to 3 .4 1 
con ve rting with Nimbus Fo nt Converte r, 7.6 to 7.7 
fo r GeoComm dis plays, 9 .3 
mo nos paced and p ropo rti o na l, 14.2 
in spread s heets, 17 .7 to 17.8 

Fonts me nus , 3 .40 to 3.41 
foo te rs a nd head e rs, 14.4, 14.15 to 14 .1 6 
fo re ign lang uage acce nt ma rks, 3. 27, A.2 to A. 3, A.6 
fo rma tting 

fl o ppy disks, 8.8 to 8. 9 , 12 .12 to 12 .13 
text in GeoWrite, 14. 5 to 14 .6 , 14. 8 to 14. 9 
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FORMS folder, 8.3 
full-size windows, 3.32, 3 .34, 12.4 to 12.5 
fusing and defusing objects in GeoDraw, 11.6 , 11.14 to 

11 .15 

G 
games 

Solitaire, 4.5, 19.1 to 19.4 
Tetris, 20.1 to 20 .4 

GeoComm, 9 .1 
communicating, 9.5 to 9.7, 9.8 to 9 .9 
main window, 9 .2 to 9.3 
protocol, terminal and modem settings, 9.3 to 9.5 
saving while communicating, 9 .7 to 9 .8 
showing status, 9.10 
using scripts, 9.10 to 9.12 

GeoDex, 10.1 to 10.2 
adding cards to , 10.2 to 10.3 
browsing/ searching through , 10.6 to 10.7 
dialing phone numbers from, 10.4 to 10.6 
editing/ deleting cards, 10.4 
flipping through cards , 10.3 
linking to GeoPlanner calendar, 10.8, 13.11 to 13.12 
printing from , 10.8 
Quick Dial feature, 10.4 to 10.5 

GeoDraw, 11.1 to 11.2 
colors/ patterns/ styles of objects , 11.11 to 11.13 
copying and pasting objects, 11.11 
copying spreadsheets into , 17 .6 
creating objects , 11.3 to 11.7 
deleting objects, 11.11 
editing text , 11.13 to 11.14 
fusing and defusing objects, 11.14 to 11.15 
importing images from other applications , 11.16 
main window, 11 .2 to 11.3 
moving and rotating objects, 11.8 to 11.9 
pasting images into documents, 2.21 
selecting objects , 11. 7 to 11 .8 
setting document size, 11 .3 
speeding up, 11.10 
stacking objects , 11 .14 

GeoManager, 1.6 , 12 .1 to 12.2 
customizing, 12 .14 to 12.15 
directory and file handling, 12 to 3 to 12.12 
disk handling, 12.12 to 12.14 
exiting, 12.15 
launching DOS programs or batch files, 12.3 
main window , 12.2 to 12 .3 
viewing charts or spreadsheets from , 17 .4 

GeoPlanner, 13.1 to 13.2 
alarm function, 13.5, 13.11, 16.2 , 16.5 
customizing , 13 .10 to 13.11 
linking to GeoDex card file , 10.8, 13 .11 to 13 .12 
printing calendars/ event schedules, 13.9 
scheduling/ deleting events , 13.3 to 13.4 
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scheduling repeating events , 13.5 to 13.8 
searching for events , 13.9 
viewing ca lendar, 13.2 to 13.3 
View menu , 13.10 

GEOWORKS directory, 2.3 
GeoWorks Pro 

customizing, 16.1 to 16.5, 16.9 to 16.12 
in the DOS environment , 21.1 to 21.3 
in the DR-DOS and TaskMAX environment, 21.3 to 

21.8 
exiting , 2.30 
installing , 2.2 
overview of, 1.1 to 1. 7 
returning to after DOS operations, 6 .2 to 6 .3 
starting, 2.3 
in the Windows 3.0 environment , 21.8 

GeoWrite, 14.1 to 14.3 
borders , 14. 11 to 14.12 
color, 14 .12 to 14 .14 
columns , 14 .17 to 14. 18 
compared to Notepad, 15.2 
copying spreadsheets into , 17.6 
creating documents in , 2.10 
customizing , 14 .18 to 14.19 
file exchanges, 14.22 to 14.23 
formatting text , 14.5 to 14.6 , 14.8 to 14 .9 
graphics, 14.14 to 14 .15 
headers and footers , 14.15 to 14.16 
main window , 14.4 to 14 .5 
margins , 14.8 
page breaks , 14 .17 
paragraph spacing, 14 .9 to 14 .10 
spell checking , 14 .19 to 14 .22 
styles , 14. 10 to 14.11 
tables, 14.12 
tabs , 14 .6 to 14.7 
title pages , 14. 16 

graphics 
in GeoWrite docume nts , 14 .14 to 14 .15 
handling with clipboard , 3 .28 to 3.29 
placement of, 16.4 

H 
halftones , 11.13 , 14.13 , 14 .14 
handles, for handling objects , 2.21 , 11 .4 
handshake , 9 .3 
hanging indents, 14. 8 
Hayes-compatible modems , 9. 4, 10.4 
headers and footers , 14.4 , 14 .15 to 14.16 
help 

accessing, 3.43 
for installing GeoWorks Pro , 2.2 

hidden files , 12.8 to 12.9 , 12.12 
highlighting 

button options, 2.9, 3.12 



items o n screen , 3 .22 
HIMEM.SYS fil e , 16 .8 
ho urglass-s tyle po inte r, 2.5 , 3.2 

I 
I-beam s tyle po inter, 2.5 , 2.10, 3 .2, 11 .4 
icons , 3.4 

convert ing w indows to , 3.8 
for di rectories (fo lde rs), 2.7 , 2.8 , 12.3 
fo r docume nts , 2.7 , 2.9 , 8 .3 
fil es as , 1.6 , 12. 1 
fo r pa ragraph styles , 2. 15 
pus h-pin , 3. 14 
fo r temp la tes , 8.3 
for Tex t Tool, 2.22 
used in Fil e Cabine t, 8 .2 to 8.3 

images. See cli p a rt ; GeoD raw ; Sc rap book 
importing 

fil es in to GeoDraw , 11 .16 
fi les into GeoWrite , 14. 22 to 14. 23 

inches (in), 3. 19 , 14.9 
indentin g p aragraphs , 2.15 , 14 .3 
inserting text , 2. 12, 3.27 
Inse rt (I ns) key, 3.27 
insertion po int ( text cursor), 2.10 , 3.24 
inse rt mode , 3.27 
ins ta lling 

GeoWo rks Pro , 2.2 
mouse fo r Qu attro Pro SE , 17 .3 
printe rs, 16.6 to 16.7 
Quatt ro Pro SE, 17.2 to 17 .3 

Inte rmedia te Wo rksp ace 
described , 1. 5 
e ntering , 2. 4, 8 .1 

inte rrupt levels , 16.8 , 16 .14 
invis ib le w indows, 3 .32 
ita li cs, 2. 13, 3.4 1, 14. 3 

J 
jus tifying text 

in GeoDraw, 11 .13 to 11 .14 
in GeoWrite , 14.8 to 14 .9 
w ith rul e r, 2. 15 

K 
ke rning, 14.5 

i.7 

keyboard 
of Ca lculato r, 5.2 
custo mizing , 16 .12 to 16.13 
resp o nding to dialog boxes w ith , 3.19 to 3. 20 
this ma nual's de pictio ns of, 1. 3 
us ing ins tead o f the mouse , 3.15 

keyboa rd accele ra to rs , 2.29, 3. 14 

L 
labels , printing fro m GeoDex, 10.8 
la nguage acce nt ma rks, 3. 27, A.2 to A.3, A.6 
LANs (loca l a rea ne two rks), 21. 2 
leade rs , 14.7 
le ading , 14.9 to 14. 10 
line p ro pe rti es , 11 .12 
lines 

drawing in GeoDraw , 11 .4 to 11 .5 
ve rtica l, 14. 7 , 14 .18 

lines o f text , highli ghting , 2.14 
lis t w indows, 3.32 
Lo tus 1-2-3 

sta rting , 17 .12 
viewing fil es fro m , 17. 2 

LPT1 / LPT2 p o rts , 16.6 

M 
.MAC fil e n ame extens io ns, 9 .10 
magnifying images or text, 2.20 , 3 .41 to 3 .42 

in GeoDraw , 11. 3 
mailing labe ls, printing from GeoDex, 10 .8 
margins 

w ith headers and foo te rs, 14. 15 
usi ng rul e r for, 2.15, 14.8 

mathemati ca l o peratio ns . See Calculato r 
mathe mati ca l symbo ls , A.4 
Maximize/ Restore butto n , 3 .7 , 3.9 , 3. 10 
measure ments, abbreviati ons and units o f, 3.1 9 , 14 .9 
meeting cale ndar 

w ith Planner appliance , 4 .4 
See also GeoPlanner 

memory 
exp anded , 16 .8 
free ing by closing applicatio ns, 3.29 
using in Ca lcula to r, 5.3 
viewing u se o f (Pe rf utility) , 7.7 to 7 .8 

me nu ba rs , 2.13, 3.7 
me nu names, 3.7 
menus , 2.13 , 3. 11 

cascading , 3. 13, 3.15 
exiting , 3. 15 
ho w to use, 3 .12 to 3.15 
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items "dimmed" versus lit up, 2.9, 3.12 
navigating with keyboard , 3 .15 
pinning, 3.13 to 3.14 
See also individual menus by name 

millimeters (mm), 3.19, 14.9 
Minimize button, 3.8, 3.9, 3.10 
minus sign(-), as expanded directory display indicator, 

12 .11 
mm (millimeters), 3.19 , 14.9 
mnemonics 

for dialog box options , 3.20 
for menu items, 3.15 

modem 
customizing, 16.14 to 16.15 
Hayes compatible , 10.4 
required for phone dialing , 10.2 
setting up for GeoComm, 9.3 , 9.4 to 9.5 
signaling pauses for, 9 .5, 10.3 

monitors , customizing , 16.8 to 16.9 
monospaced fonts , 14.2 
mouse 

clicking, 2.6 , 3.2 , 3.5 
customizing , 16.13 to 16.14 
double-clicking , 2.13 , 3.5 
dragging, 2.12, 3 .6 
how to use, 2.5, 3.3 
installing for Quattro Pro SE , 17.3 
multiple-clicking, 2.14, 3.5 
pressing the , 3.5 
selecting paragraphs with , 2.14 
using keyboard instead of, 3.15 

move handle , 11.4 
moving 

files and directories, 8.5 to 8 .7, 12 .6 to 12 .7 
objects, 2.24 
and rotating GeoDraw objects, 11.8 to 11. 9 
windows , 3.8 

multitasking, demonstration of (30 Font Demo) , 7.8 

N 
naming 

batch files , 6 .5 
directories, 3.6 
documents, 2.16, 3.6, 3.35 
files in Notepad, 15.3 

New (File menu option), 3 .36 
newsletter templates, 8 .3 
Nimbus Font Converter, 7.6 to 7.7 
No (dia log box option), 3.18 
Notepad, 4.2, 15.1 to 15 .2 

compared to GeoWrite , 15.2 
NOTES .TXT file , 15.2 
nudging GeoDraw objects, 11.9 
number formats, 16.10 
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Number of Copies (Print dialog box option), 3.36 to 
3.37 

numeric keypad, using with Calculator, 5.2 

0 
objects 

GeoDraw, 2.21 , 11.3 to 11 .4 
moving, 2.24 
rotating , 2.23 

OK (dialog box option), 3.18 
on-line communications with GeoComm, 9.5 
Open (Fi le menu option), 3 .36 
opening 

app liances , 4 .2 
CLIPART fo lder, 2.19 
directories, 3.21, 8.4 , 12 .3 to 12.4 
directories on other disks, 8.4 , 12 .4 
documents, 3.31 to 3.32, 3 .36 , 8.3 
documents in GeoWrite , 2.10 
documents in Scrapbook, 2.19 
folders, 2.8 
templates , 2.9, 8.3 to 8.4 
windows, 3.8 

order of operations, for Calculator calcu lations, 5.2 
overlapping objects, 1 l .4 
overlapping windows, 3.11 , 3.33 , 3.34 , 12.4 
overtype mode (overstrike) , 3.27 , 16.3 

p 
page breaks, 14.17 
page size, in spreadsheets, 17.7 
pages of text, highlighting , 2 .14 
pagination of documents , 14.16 
paging areas , 3 .10 
paper, changing options for , 3.38 to 3.39 
paragraphs 

current , 2.15 
highlighting, 2.14 
indenting, 2.15, 14.3 , 14.8 to 14.9 
spacing, 14.9 to 14.10 
symbol for, A.4 

paragraph spacing, in GeoWrite documents, 14 .9 to 
14 .10 

parallel printers, 16.6 
parent directories , 2.8 , 12.4 
parentheses (()) 

changing order of calculations with , 5.2 
in phone numbers, 10.3 

parity, 9.3 
Paste (Edit menu option) , 3.28 
paste operations, 2.20 



into GeoWrite docume nts , 2.26 
to / from GeoDraw, 2.21, 11.11 
See also cut and pas te ope ratio ns 

path , 2.8 
di s pl ayed , 8.2 
se lecting for fil e saves , 2 .17 

patte rn , filling GeoDraw objects w ith , 11 .12 to 11 .13 
paus ing 

keyboa rd resp o nse, 16 .12 
mode m di a ling , 9.5, 10.3 

PCX files 
importing into GeoDraw , 11.16 
importing into Sc rapboo k , 18.5 to 18.6 

percent s ig n (%), w ith Screen Dumper fil e na mes , 7 .2 
Perf, 7.7 to 7 .8 
pe rsona l seri al numbe rs , 2.4 
phone numbe rs. See GeoComm; GeoDex 
picas (p i), 3. 19, 14.9 
pictures. See clip art ; GeoDraw ; Scrapbook 
PIF files, and Windows 3.0 , 21.8 
pinning menus , 3.13 to 3.14 
pi (p icas), 3.19, 14 .9 
pixe ls, 3.42 
Planner a ppliance , 4.4 
plus s ign ( + ) , as co ll apsed directory dis pl ay indica to r, 

12 .11 
pointers 

a rrow-s tyle , 2. 15 , 3.2, 11 .3 
blinking line , 3 .27 
circ le/ s las h- style , 3.2 , 3.17 
crossha ir-s tyle , 11 .4 
hou rglass-s tyle, 2.5, 3 .2 
how to use , 3.3 
I-bea m style, 2.5, 2.10 , 3.2, 11 .4 
Quick Co py, 3.29 
Ro tate, 11 .3 
ro tati o n (c urve d a rrow-style) , 2.23 , 11 .4 
and tex t cursor, 2.10 
triangle-style , 2.15 
See a lso c ursor 

points 
as fo nt s ize measurement , 2.13, 3.40 
"pt" abb revia ti o n fo r, 3.19 

polygons , drawing in Ge oDraw , 11.6 
ports 

inte rrupt leve ls o f, 16.8 , 16.14 
fo r mo use, 16. 13 to 16. 14 
fo r printe rs, 16 .6 

posters , with Banner app li a nce , 4.4 
Postscript-compatible printe rs , 14. 12 
Postscript fo rm at files , 7.2 , 7 .3 
Preference Desk Tool, for modem se tup , 10.4 
preferences 

choos ing for GeoPlanner, 13. 10 to 13. 11 
choos ing with Syste ms Pre fe re nces (Express menu 

option), 3.16 
setting for mode ms , 10.4 

Pre fix box, of GeoDex Dialing Options window, 10 .3 

i.9 

press ing the mouse , 3.5 
Print dialog box, 2.27, 3.36 to 3.39 
Printer Control Pane l (Express menu option) , 3. 16 , 3.39 
Printer Options (Print dialog box option) , 3.36 to 3.37 
printers 

changing options for, 3.38 to 3.39 
customizing, 16.6 to 16.7 
ins ta lling , 16.6 to 16.7 
Postscript-compatibl e, 14. 12 

Print (File menu o ptio n), 3.36 to 3.39 
printing 

ca lendars/ event schedules from GeoPlanner, 13.9 
da ta from GeoDex card fil e , 10.8 
docume nts, 2.27 , 3.36 to 3.39 

Print Pages (Print di a log box option) , 3.36 to 3.37 
print qu ality, 3.37 
Print Quality (P rint di a log box o ptio n) , 3.36 to 3.37 
prope rti es boxes, 11 .11 
proportional fo nts , 14.2 
protoco ls for te lecommunica ti o ns, 9 .3 
pt (po ints), 3.19 
pull-down me nus, 3.11 
punctuation characte rs , A.4 
push-pin icon , 3. 14 

Q 
QEMM.SYS file, 16.8 
quadruple-clickin g th e mouse , 2.14, 3.5 
Qu attro Pro SE 

fi le impo rts into GeoDraw, 11.1 6 
ins ta lling , 17 .2 to 17.3 
s tarting, 17.5 

Quick Copy fea ture , 3.29 
Quick Dia l (GeoComm Dia l me nu o ptio n), 9.5 
Quick Dial (GeoDex Dial me nu o ptio n), 10.4 to 10 .5 
Quick Move feature , 3.29 
quintuple-clicking th e mo use , 2. 14 , 3.5 
q uota tio n marks fo rmats , 16.10 to 16.11 , A. 4 

R 
rad io buttons , 2.18, 3. 18 
read-only fil es, 12.8 to 12.9, 12. 15 
rectangles , drawing in GeoDraw, 11 .5 to 11.6 
rectangular aspect ra ti o , 3.42 
reducing images , 2.20 
registration ca rd , 2.2 
renaming 

file s and directo ri es, 8.5, 12 .6 
floppy dis ks, 12.13 to 12 .14 
Scrapbook pages, 18.4 
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Repeating Events dialog box, 13.6 to 13.7 
repeat rate (keyboard), 16.12 
rescanning drives in GeoManager, 12.14 
Reset (dialog box option), 3.18 
Restore button, 3.7, 3.9 
Return (Enter) key 

for default option, 3.19, 3.20 
unnecessary at end of lines, 2.11, 14.2 

Reverse Polish Notation (RPN), 5.3 to 5.4 
Revert command, 3.36 
Revert (File menu option), 3.36 
Rotate pointer, 11.3 , 11.4 
rotating 

Geo Draw objects, 11 .8 to 11. 9 
text, 2.23 

RPN (Reverse Polish Notation), 5.3 to 5.4 
ruler, 2.15, 14.4 , 14 .9 

"snap-to" feature , 14.18 
rul es, drawing for tables and columns, 14 .7 

s 
Save As (File menu option), 3.36 
Save (File menu option), 3.36 

versus Save As command, 2.28, 3.35 
saving 

documents, 2.16, 2.28, 3.34 to 3.35, 3.36 
to other directories or disk drives , 3.21 to 3.22 

scaling Scrapbook images, 18.4 
scheduling events 

with Planner appliance, 4.4 
See also GeoPlanner 

Scrapbook, 18.1 
adding and deleting scraps, 18.2 to 18.4 
browsing in, 2.20 
cutting and pasting images to/ from, 2.21 to 2.26 
importing images to , 18.5 to 18.6 
main window, 18.2 
and multiple scrapbooks, 18. 5 
opening documents in , 2.19 
sca ling images from , 18.4 

screen blanking, 16.8 to 16.9 
Screen Dumper, 7 .1 to 7. 5 
screens 

capturing "pictures" of, 7.1 to 7.5 
capturing within GeoComm, 9.7 to 9 .8 

scripting language commands, 9.11 to 9 .12 
scripts, using with GeoComm, 9.10 to 9.12 
scroll arrows, 3.10 
scroll-back buffer, 9. 7 
scroll bars , 2.20 , 3.8, 3.10 

hiding, 14.18 to 14. 19 
scrolling, windows, 3.10 to 3.11 
scrolling list, 3 .19 
searching 

for card file data , 10.6 to 10.7 
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for GeoPlanner events/ names, 10.8, 13.9 
selecting, 2.8, 3.22 

by clicking, 2.6, 3.2 
by double clicking, 2.13 
by multiple clicking, 2.14 
fonts, 2.13 
Geo Ora w objects, 11. 7 to 11.8 
groups of items, 3.22 to 3.24 
single items, 3.22 
text, 3 .24 to 3.26 

selection cursor, 3 .19 
serial numbers ., 2.4 
serial printers , 16.6 
Setup utility , 2.2 
Shift key combinations, 3.14 
SIGNS folder, 8.3 
Sizes menu , 3.40 to 3.41 
slider, 3 .10 
Solitaire card game , 4.5, 19.1 to 19.4 
sorting , file and directory lists, 12.10 
sound, controlling in GeoWorks Pro, 16.5 
source directory , 8.6, 12.6 
spaces 

after punctuation/ periods , 2.11, 14.2 
in phone numbers, 10.3 

special characters, 3.27, 14.3 , A.1 to A.6 
spell checking, 14. 19 to 14 .22 
spinners, 3.19 
spreadsheets 

creating or changing from Quattro Pro SE, 17.5 to 
17.6 

viewing from Viewer, 17 .1 to 17. 5 
stacked objects, 11 .4, 11 .14 
starting 

applications, 2.9, 3.16 , 3.29 to 3.30 
batch files from GeoManager, 12.3 
the File Cabinet, 2.7 
GeoWorks Pro , 2.3 
Lotus 1-2-3 , 17.12 
Quattro Pro SE, 17 .5 
telecommunications in GeoComm, 9.5 

stop bits , 9 .3 
Stop (dialog box option), 3.18 
strike-through, 3.41 
styles, for GeoWrite documents , 14.10 to 14.11 
subscripting, 3.41 
superscripting, 3.41 
switching 

between applications, 2.18 , 3.8, 3.16, 3.30 
between documents , 3.33 to 3.34 
drives , 3.21 
between GeoWorks Pro and other tasks , 21.1 to 21.8 

symbols and special characters, 3.27, 14.3, A.1 to A.6 
system dictionary , 14.19 
system files, 12 .8 to 12.9, 12.12 
Systems Preferences (Express menu option), 3.16 



T 
tab lea ders, 14.7 
tabl es , crea ting in GeoWrite, 14.12 
tahs, 14.3, 14 .6 to 14.7 

in spreadsheets, 17.6 
tab we ll , 14.6 
Tas k MAX and DR-DOS env i ronm ent , 21.3 to 21. 8 
task sw itchers, and GeoWork s Pro, 21.1 to 21. 2 
te lecommuni ca ti o ns appli cat io n . See GeoComm 
telepho ne numbers. See GeoComm ; GeoD ex 
templ ates, 1. 5, 1.7 , 8 .3 

icons for, 8 .3 
opening , 2.9 , 8.3 to 8 .4 

termin al emulati o n , 9.4 
Tetri s ga me, 20. 1 to 20.4 
tex t 

adding to documents, 2. 10 to 2. 11 
adding to pi ctures, 2.22 
centerin g, 14.3, 14.8 to 14.9 
d eleting, 1.3, 2. 11 , 3 .24 , 3.26 
ed iting in GeoWrite, 2. 12 
enterin g and editing , 3.24 to 3.27 
fo rm atting in GeoWritc , 14.5 to 14.6, 14.8 to 14.9 
handling in GeoDraw, 11 .6 to 11.7, 11 .13 to 11 15 
h andling w ith clipboa rd , 3.28 to 3. 29 
indentati o n o f , 2. 15 
ju stify ing, 2. 15 , 14.8 to 14.9 
ro tat ing , 2.23 
syste m , 16.3 
See also fonts 

text boxes, 2.22 
text curso r, 2.1 0, 3.24 
text fi e lds, 3.19 
text fil es ( ASCII fil es) , 14.22 to 14.23 
Text M ode O nl y (Print dialog box o pti o n), 3.37 
text size 

chang ing in Notep ad , 15.2 to 15.3 
See a lso fonts 

text w rapping , 2.11 
3D Fon t Dem o , 7 .8 
TIFF fil es 

impo rt ing in to GeoDraw, 11.16 
impo rting into Scrapbook , 18.5 to 18.6 

TIFF fo rmat , sav ing sc reen dumps in , 7.4 
time 

fo rm atting , 16. 12 
se tting o n your computer, 16.3 to 16.4 

title bars, 3.7 
titl e p ages, 14. 16 
Too lbox, entering , 2.22 
too l box 

in GeoDraw, 11. 2 
in V iewer, 17 .1 0 

tree, d ispl ayin g directo ri es as, 12. 11 to 12 .12 
tri ang le-sty le p o inter, 2. 15 
triple-c li cking the m o use, 2. 14 
typ ographical ch arac ters, A .4 

i.11 

u 
underlining, 3.4 1 
U ndo o p erati o ns 

in GeoD ex, 10.4 
in GeoPl anner, 13.4 
w ith Revert command, 3.36 

units o f measu re, 3. 19 
URW fonts, convertin g w ith N imbus Font Converter, 7.6 

to 7.7 
user d icti o nary, 14. 19, 14.21 
utilities . See appli ca ti o ns; extras 

v 
ve rti ca l lines o r rul es, 14 .7, 14 .1 8 
v ideo adapters, customi zing, 16.8 to 16.9 
V iewe r, 17. 1 to 17.2 

and charts, 17.8 to 17. 10 
cop y ing spreadshee ts, 17.6 
crea ting spreadsheets, 17. 5 to 17 .6 
customi zing, 17. 11 to 17. 12 
dea ling w i th large spread sheets, 17.7 to 17.8 
too l b ox , 17. 10 
v iewing spreadshee ts, 17. 2 to 17.5 

V iew menu, enl argi ng images from , 2 .20 

w 
Wasteb ask et , fo r fil e del eti o n , 3.4 
Welco m e sc reen , 1.3, 2.4 

by p ass ing, 16.3 
returning to, 3. 16, 6.2 

we ll , o f Tetri s, 20.2 
w hi te-on-b lac k text , 14 .1 3 
Wi ndow menu , 3.34 
w indows, 2.7, 3.7 

activat ing , 2.20 , 3.8 
ca pturing w ith Screen Dumper, 7.4 to 7.5 
cl os ing, 3.11 , 3.34 
converting to icons, 3.8 
enl arg ing/ r edu cing, 3 .7, 3 .8, 3.9 
full- si zed ( inv isible) , 3.32, 3.34, 12.4 
moving, 3.8 
overl apping , 3.11 , 3 .33, 3.34 , 12.4 
scro lling, 3. 10 to 3.11 
switching b etween , 2. 18 

.WKl fil enam e extensio ns, 17.3 
word processors, 14.2 to 14.3 
worksp ace, 2.6 

back ground o f , 16.4 to 16 .5 
WORLD directo ry, 12.3 to 12.4 

I N D E X 



.WQl filename extensions , 17.3 
wrapping of text , 2.11, 14.2 

during telecommunications , 9.4 
WYSIWYG, 14. 4 

x 
XMODEM protocol, 9 .8 to 9.9 

y 
Yes (dia log box option), 3.18 

z 
zip codes, using as indexes in card file , 10.2 
zooming in and out , 3.41 to 3.42 

in GeoDraw, 11.3 

I N D E X i.12 

COLOPHON 

DESIGN AND MANAGEMENT 

MI C HAEL EGGER S 

T E X T 

MI C HAEL STOK OWS KI 

T ONY Rocco 

STEVE HAIL ES 

MI C HAEL E GGE RS 

BHE NDA K I ENAN 

DO NN A H AWLEY 

ARTWORK 

TO N Y LIJ PHAHT 

J EANNA RI C H 

CHHIST I NE METAWATI 

INSIDE PHOTOGRAPHY 

J OS H P UTNA M 

I N D E X 

LA SSE LLE-RAMSAY 

P U I3LI C ATIO N SEHVI CES 

PRODUCTION 

GE O W O llK S DO CUM ENTATI O ' A SSAU LT T EA M 
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GI~W~RK~ PRff 
Geo Works Pro™ delivers two great products for the price 
of one-GeoWorks Ensemble"' and Borland's Quattro"' 
Pro Special Edition. Together, these two award winning 
products give you the easiest and most complete 
integrated solution for your business computer. 

Everything You Need in One Package • Quattro Pro Special 

Edition spreadsheet with Database and Charting • GeoWrite'" 

word processor • GeoDraw'" drawing program • GeoManager'" 

file and disk manager • GeoDex® address book and label 

I 
maker • GeoPlanner'" schedule planner • GeoComm® 

communications program • Six software "Appliances" 

designed for the beginner, including Banner Maker • 

Two games: Solitaire and Tetris'" • America Online® 

electronic information service . 

Making it Work Whether you've never touched a computer 

before or already have some computer experience under 

your belt, GeoWorks Pro is a breeze to use. All GeoWorks 

applications are based on PC/GEOS~ the incredibly easy, 

windowing, graphical environment, so they work the same 

easy "point-and-click" way. Quattro Pro Special Edition features 

intuitive pull down menus and dialog boxes which make it 

the easiest to use full featured spreadsheet for the PC. 

~GEOWOR.K<i 
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